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1.1 Overview 

This manual introduces the block-type high-end applicational DVP-ES3/EX3 Series PLC CPU and slim-type 

high-end applicational DVP-SV3/SX3 Series PLC CPU; their functions, electrical specifications, hardware 

configuration, appearances, dimensions, as well as wiring and so forth are presented here. Refer to DVP 

Series Module Manual for more information on the extension I/O modules of DVP-ES3/EX3 and DVP-SV3/SX3 

Series PLC CPU.  

 

Related Manuals 

The related manuals for DVP-ES3/EX3/SV3/SX3 Series programmable logic controllers are listed below. 

 DVP-ES3/EX3/SV3/SX3 Series Programming Manual 

This introduces programming for the DVP-ES3/EX3/SV3/SX3 Series programmable logic controllers, basic 
instructions, and applied instructions. 

For DVP-ES2/SX2 Series PLC, refer to DVP-ES2-/EX2-SS2/SA2/SX2/SE & TP Operation Manual – 
Programming; for DVP-SV2 Series PLC, refer to DVP-PLC Operation Manual – Programming.  

 ISPSoft User Manual / DIADesigner Software User Manual.  

 This introduces the use of the ISPSoft software / DIADesigner Software, programming language (Ladder, 
SFC, FBD, and ST), POUs, and tasks. 
DVP-ES3 Series PLC can only use ISPSoft / DIADesigner for programming, NOT WPLSoft.  

DVP-ES300TEC/EX3/SV3/SX3 can only use DIADesigner for programming, Neither ISPSoft nor WPLSoft.  

 DVP-ES3/EX3/SV3/SX3 Series Hardware and Operation Manual 

 This introduces electrical specifications, dimensions, CPU functions, devices, extension I/O module 
placement, troubleshooting, and so forth. 

 DVP Series Module Manual 

This introduces the extension modules, e.g. network modules, analog modules and temperature 
measurement modules.  
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1.1.1 DVP-ES3/EX3 Series CPU Modules and Their Extension Modules 

Classification Model Name Description 

DVP-ES3 

Series CPU 

module 

DVP32ES311T 

24 VDC powered CPU module 

Transistor, NPN output (sinking), 1x Ethernet port, 2x RS-485 ports, 1x 

USB & CAN port, 1x Micro SD interface, supporting 32 I/Os (16 DI + 

16 DO) and up to 256 I/Os. Program capacity: 64K steps, removable 

terminal blocks 

DVP32ES300T 

100-240 VAC powered CPU module 

Transistor, NPN output (sinking), 1x Ethernet port, 2x RS-485 ports, 1x 

USB & CAN port, 1x Micro SD interface, supporting 32 I/Os (16 DI + 

16 DO) and up to 256 I/Os. Program capacity: 64K steps, removable 

terminal blocks 

DVP32ES300R 

100-240 VAC powered CPU module 

Relay output, 1x Ethernet port, 2x RS-485 ports, 1x USB & CAN port, 

1x Micro SD interface, supporting 32 I/Os (16 DI+16 DO) and up to 

256 I/Os. Program capacity: 64K steps, removable terminal blocks 

DVP48ES300T 

100-240 VAC powered CPU module 

Transistor, NPN output (sinking), 1x Ethernet port, 2x RS-485 ports, 1x 

USB & CAN port, 1x Micro SD interface, supporting 48 I/Os (24 DI + 

24 DO) and up to 256 I/Os. Program capacity: 64K steps, removable 

terminal blocks 

DVP48ES300R 

100-240 VAC powered CPU module 

Relay output, 1x Ethernet port, 2x RS-485 ports, 1x USB & CAN port, 

1x Micro SD interface, supporting 48 I/Os (24 DI + 24 DO) and up to 

256 I/Os. Program capacity: 64K steps, removable terminal blocks 

DVP64ES300T 

100-240 VAC powered CPU module 

NPN output, 1x Ethernet port, 2x RS-485 ports, 1x USB & CAN port, 

1x Micro SD interface, supporting 64 I/Os (32 DI + 32 DO) and up to 

256 I/Os. Program capacity: 64K steps, removable terminal blocks 

DVP64ES300R 

100-240 VAC powered CPU module 

Relay output, 1x Ethernet port, 2x RS-485 ports, 1x USB & CAN port, 

1x Micro SD interface, supporting 64 I/Os (32 DI + 32 DO) and up to 

256 I/Os. Program capacity: 64K steps, removable terminal blocks 
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Classification Model Name Description 

 

DVP80ES300T 

100-240 VAC powered CPU module 

Transistor, NPN output (sinking), 1x Ethernet port, 2x RS-485 

ports, 1x USB & CAN port, 1x Micro SD interface, supporting 80 

I/Os (40 DI + 40 DO) and up to 256 I/Os. Program capacity: 64K 

steps, removable terminal blocks 

DVP80ES300R 

100-240 VAC powered CPU module 

Relay output, 1x Ethernet port, 2x RS-485 ports, 1x USB & CAN 

port, 1x Micro SD interface, supporting 80 I/Os (40 DI + 40 DO) 

and up to 256 I/Os. Program capacity: 64K steps, removable 

terminal blocks 

DVP-ES3 

EtherCAT 

communication 

CPU module 

DVP32ES300TEC 

100-240 VAC powered CPU module 

Transistor, NPN output (sinking), 1x Ethernet / EtherCAT port, 2x 

RS-485 ports, 1x USB port, 1x Micro SD interface, supporting 32 

I/Os (16 DI +16 DO) and up to 256 I/Os. Program capacity: 64K 

steps, removable terminal blocks;  

Supported EtherCAT Master 8 axes point to point positioning 

control (for Delta drives only) 

DVP-EX3  

Series CPU 

module 

DVP22EX300T 

100-240 VAC powered CPU module 

Transistor, NPN output (sinking), 2x Ethernet ports (can act as a 

switch), 2x RS-485 ports, 1x USB & CAN port, 1x Micro SD 

interface, supporting 22 I/Os (12 DI + 8 DO + 2 AI) and up to 256 

I/Os. Program capacity: 64K steps, removable terminal blocks 

DVP22EX300R 

100-240 VAC powered CPU module 

Relay output, 2x Ethernet ports (can act as a switch), 2x RS-485 

ports, 1x USB & CAN port, 1x Micro SD interface, supporting 22 

I/Os (12 DI + 8 DO + 2 AI) and up to 256 I/Os. Program capacity: 

64K steps, removable terminal blocks 

DVP36EX300T 

100-240 VAC powered CPU module 

Transistor, NPN output (sinking), 2x Ethernet ports (can act as a 

switch), 2x RS-485 ports, 1x USB & CAN port, 1x Micro SD 

interface, supporting 36 I/Os (16 DI + 16 DO + 2 AI + 2 AO) and up 

to 256 I/Os. Program capacity: 64K steps, removable terminal 

blocks 
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Classification Model Name Description 

 

DVP36EX300R 

100-240 VAC powered CPU module 

Relay output, 2x Ethernet ports (can act as a switch), 2x RS-485 

ports, 1x USB & CAN port, 1x Micro SD interface, supporting 36 

I/Os (16 DI + 16 DO + 2 AI + 2 AO) and up to 256 I/Os. Program 

capacity: 64K steps, removable terminal blocks 

DVP28EX300MT 

100-240 VAC powered CPU module 

Transistor, NPN output (sinking), 2x Ethernet ports (can act as a 

switch), 2x RS-485 ports, 1x USB & CAN port, 1x Micro SD 

interface, supporting 28 I/Os (4 Diff. DI + 8 DI + 4 Diff. DO + 2 AI + 

2 AO) and up to 256 I/Os. Program capacity: 64K steps, removable 

terminal blocks 

Digital 

input/output 

module 

DVP08XM211N 8 inputs; 24 VDC; 5 mA 

DVP08XP211R 

4 inputs; 24 VDC; 5 mA 

4 Relay outputs; 250 VAC; Below 30 VDC 

2A/input, 5A/COM 

DVP08XP211T 

4 inputs; 24 VDC; 5 mA 

4 NPN (sinking) outputs; 5 – 30 VDC;  

0.5A/input, 4A/COM 

DVP08XN211R 
8 Relay outputs; 250 VAC; Below 30 VDC 

2A/output, 5A/COM 

DVP08XN211T 
8 NPN (sinking) outputs; 5 – 30 VDC 

0.5A/output, 4A/COM 

DVP16XM211N 16 inputs; 24 VDC; 5 mA 

DVP16XP211R 

8 inputs; 24 VDC; 5 mA 

8 Relay outputs; 250 VAC; Below 30 VDC 

2A/input, 5A/COM 

DVP16XP211T 

8 inputs; 24 VDC; 5 mA 

8 NPN (sinking) outputs; 5 – 30 VDC 

0.5A/input, 4A/COM 

DVP16XN211R 
16 Relay outputs; 250 VAC; Below 30 VDC 

2A/output, 5A/COM 
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16 NPN (sinking) outputs; 5 – 30 VDC 

0.5A/output, 4A/COM 

DVP24XP200R 

16 inputs; 24 VDC; 5 mA 

8 Relay outputs; 250 VAC; Below 30 VDC 

2A/input, 5A/COM 

DVP24XP200T 

16 inputs; 24 VDC; 5 mA 

8 NPN (sinking) outputs; 5 – 30 VDC 

0.5A/input, 4A/COM 

DVP24XN200R 
24 Relay outputs; 250 VAC; Below 30 VDC 

2A/output, 5A/COM 

DVP24XN200T 
24 NPN (sinking) outputs; 5 – 30 VDC 

0.5A/output, 4A/COM 

DVP32XP200R 

16 inputs; 24 VDC; 5 mA 

8 Relay outputs; 250 VAC; Below 30 VDC 

2A/input, 5A/COM 

DVP32XP200T 

16 inputs; 24 VDC; 5 mA 

16 NPN (sinking) outputs; 5 – 30 VDC 

0.5A/input, 4A/COM 

Analog 

input/output 

module 

DVP04AD-E2 

4-channel analog input;  

Hardware resolution 14 bits: -5V ~ +5V, -10V ~ +10V, -20 mA ~ +20 

mA;   

Hardware resolution 13 bits: 0/4 ~ 20 mA;  

Conversion time: 400 μs/channel 

DVP02DA-E2 

2-channel analog input;   

Hardware resolution 14 bits: -10V ~ +10V, -20 mA ~ +20 mA;   

Conversion time: 400 μs/channel 

DVP04DA-E2 

4-channel analog input module;  

Hardware resolution 14 bits: -10V ~ +10V, -20 mA ~ +20 mA;   

Conversion time: 400 μs/channel 

DVP06XA-E2 

4-channel analog input;   

Hardware resolution 14 bits: -5V ~ +5V, -10V ~ +10V, -20 mA ~ +20 

mA;   

Hardware resolution 13 bits: 0/4 ~ 20 mA;  
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Conversion time: 400 μs/channel;  

2-channel analog output  

Hardware resolution 14 bits: -10V ~ +10V, -20 mA ~ +20 mA;   

Conversion time: 400 μs/channel 

Temperature 

measurement 

module 

DVP04PT-E2 

4-channel, 2-wire/3-wire RTD;   

Sensor type: Pt100 / Pt1000 / Ni100 / Ni1000 / 0-300Ω / 0-3000Ω;  

Resolution: 0.1°C/0.1°F (16 bits);  

Conversion time: 200 ms/channel;  

PID controller 

DVP06PT-E2 

6-channel, 2-wire/3-wire RTD;   

Sensor type: Pt100 / Pt1000 / Ni100 / Ni1000 / Cu50 / Cu100 / 

0-300Ω / 0-3000Ω / JPt100 / LG-Ni1000;  

Resolution: 0.1°C/0.1°F (16 bits);  

Conversion time: 200 ms/channel;  

PID controller 

DVP04TC-E2 

4-channel thermocouple;  

Sensor type: J, K, R, S, T, E, N and -80 to +80 mV;   

Resolution: 0.1°C/0.1°F (16 bits);  

Conversion time: 200 ms/channel;  

PID controller 

Positioning  

module 
AS02PU-A 

2-axis motion control;  

5-24 VDC, 1 differential input (A/B/Z phase), maximum hardware 

input frequency at 200 kHz, 24 VDC, 5 mA, 5 inputs, maximum 

hardware input frequency at 1 kHz, 

5 VDC, 2-axis (4 points) differential outputs, maximum output 

frequency at 200 kHz 

Connection kit  DVPAEXT01-E2 For connecting I/O extension modules  
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1.1.2 DVP-SV3/SX3 Series CPU Modules and Their Extension Modules 

Classification Model Name Description 

Power supply 

module 

DVPPS01 
Input: 100-240 VAC, 50/60 Hz  

Output: 24 VDC/1A, 24 W 

DVPPS02 
Input: 100-240 VAC, 50/60 Hz 

Output: 24 VDC/2A, 48 W 

DVPPS05 
Input: 100-240 VAC, 50/60 Hz 

Output: 24V DC/5A, 120 W 

DVP-SV3 

Series  

CPU module 

DVP28SV311T 

24 VDC powered CPU module 

Transistor, NPN output (sinking), 1x Ethernet port, 2x 

RS-485 ports, 1x USB & CAN port, 1x Micro SD interface, 

supporting 28 I/Os (16 DI + 12 DO) and up to 256 inputs 

and 252 outputs. Program capacity: 64K steps, removable 

terminal blocks 

DVP28SV311R 

24 VDC powered CPU module 

Relay output, 1x Ethernet port, 2x RS-485 ports, 1x USB & 

CAN port, 1x Micro SD interface, supporting 28 I/Os (16 DI 

+ 12 DO) and up to 256 inputs and 252 outputs. Program 

capacity: 64K steps, removable terminal blocks  

DVP28SV311S 

24 VDC powered CPU module 

Transistor, PNP output (sourcing), 1x Ethernet port, 2x 

RS-485 ports, 1x USB & CAN port, 1x Micro SD interface, 

supporting 28 I/Os (16 DI + 12 DO) and up to 256 inputs 

and 252 outputs. Program capacity: 64K steps, removable 

terminal blocks 

DVP-SX3 

Series  

CPU module 

DVP20SX311T 

24 VDC powered CPU module 

Transistor, NPN output (sinking), 1x Ethernet port, 2x 

RS-485 ports, 1x USB & CAN port, 1x Micro SD interface, 

supporting 20 I/Os (8 DI + 6 DO + 4 AI + 2 AO) and up to 

248 inputs and 246 outputs. Program capacity: 64K steps, 

removable terminal blocks 
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DVP20SX311R 

24 VDC powered CPU module 

Relay output, 1x Ethernet port, 2x RS-485 ports, 1x USB & 

CAN port, 1x Micro SD interface, supporting 20 I/Os (8 DI + 

6 DO + 4 AI + 2 AO) and up to 248 inputs and 246 outputs. 

Program capacity: 64K steps, removable terminal blocks 

DVP20SX311S 

24 VDC powered CPU module 

PNP output, 1x Ethernet port, 2x RS-485 ports, 1x USB & 

CAN port, 1x Micro SD interface, supporting 20 I/Os (8 DI + 

6 DO + 4 AI + 2 AO) and up to 248 inputs and 246 outputs. 

Program capacity: 64K steps, removable terminal blocks  

Digital I/O 

module 

DVP06SN11R 
6 Relay outputs; 250 VAC; Below 30 VDC 

6A/output 

DVP08SN11R 
8 Relay outputs; 250 VAC; Below 30 VDC 

1.5A/output, 5A/COM 

DVP08SN11T 

Transistor, 8 NPN outputs (sinking), 30 VDC;  

55°C, 0.1A/output; 50°C, 0.15A/output; 45°C, 0.2A/output;  

40°C, 0.3A/output; 2A/COM 

DVP16SN11T 

Transistor, 16 NPN outputs (sinking), 30 VDC;  

55°C, 0.1A/output; 50°C, 0.15A/output; 45°C, 0.2A/output;  

40°C, 0.3A/output; 2A/COM 

DVP08SP11R 

4 inputs; 24 VDC; 5 mA 

4 Relay outputs; 250 VAC; Below 30 VDC;  

1.5A/output, 5A/COM 

DVP08SP11T 

4 inputs; 24 VDC; 5 mA 

4 transistor outputs, 30 VDC; 55°C 0.1A/output; 50°C 

0.15A/output; 45°C, 0.2A/output;  

40°C, 0.3A/output, 2A/COM 

DVP08SM11N 8 inputs; 24 VDC; 5 mA 

DVP08SM10N 8 inputs; 85-132 VAC (50~60Hz) ; 9.2 mA (10VAC/60Hz) 

DVP08SN11TS 
8 transistor outputs (sourcing); 30 VDC;  

55°C, 0.3A/output, 2A/COM 

DVP08ST11N 8 inputs (dip switch) 
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8 inputs; 24 VDC; 5 mA 

8 Relay outputs; 250 VAC; Below 30 VDC;  

1.5A/output, 5A/COM  

DVP08SP11TS 

4 inputs; 24 VDC; 5 mA 

4 transistor outputs (sourcing), 30 VDC;  

55°C 0.3A/output, 2A/COM 

DVP16SP11T 

8 inputs; 24 VDC; 5 mA 

8 transistor outputs (sinking), 30 VDC; 55°C 0.1A/output; 

50°C, 0.15A/output; 45°C, 0.2A/output; 40°C, 0.3A/output, 

2A/COM 

DVP16SP11TS 

8 inputs; 24 VDC; 5 mA 

8 transistor outputs (sourcing); 30 VDC; 55°C, 0.3A/output, 

2A/COM 

DVP16SN11TS 
16 transistor outputs (sourcing); 30 VDC; 55°C, 

0.3A/output, 2A/COM 

DVP16SM11N 16 inputs; 24 VDC; 5 mA 

DVP32SN11TN 32 inputs; 24 VDC; 5 mA 

DVP32SM11N 
32 transistor outputs (sinking); 5-30 VDC; 0.1A/output; 

55°C, 1.0A/COM; 25°C, 2.2A/COM 

Analog I/O 

module 

DVP04AD-S2 

4 channel analog inputs (differential) 

14-bit resolution: -10 to 10 V, -6 to 10 V 

13-bit resolution: -20 to 20 mA, -12 to 20 mA 

Conversion time: 3ms/channel 

DVP04DA-S2 

4 channel analog outputs  

12-bit resolution: 0 to 10 V, 2 to 10 V, 0 to 20 mA, 4 to 20 mA 

Conversion time: 3ms/channel 

DVP06XA-S2 

4 channel analog inputs (differential) 

12-bit resolution: -10 to 10 V, -6 to 10 V 

11-bit resolution: -20 to 20 mA, -12 to 20 mA 

Conversion time: 3ms/channel  

2 channel analog outputs  

12-bit resolution: 0 to 10 V, 2 to 10 V, 0 to 20 mA, 4 to 20 mA 

Conversion time: 3ms/channel  
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2 channel analog outputs  

12-bit resolution: 0 to 10 V, 2 to 10 V, 0 to 20 mA, 4 to 20 mA 

Conversion time: 3ms/channel 

DVP06AD-S 

6 channel analog inputs  

14-bit resolution: -10 to 10 V, -6 to 10 V 

13-bit resolution: -20 to 20 mA, -12 to 20 mA 

Conversion time: 3ms/channel  

Left-side 

high-speed 

analog I/O 

module 

DVP04AD-SL 

4 channel analog inputs (differential) 

16-bit resolution: -10 to 10 V, -5 to 5 V, -20 to 20 mA 

15-bit resolution: 0 to 20 mA, 4 to 20 mA 

Conversion time: 250 µs/channel 

DVP04DA-SL 

4 channel analog outputs (differential) 

16-bit resolution: 0 to 10 V, -10 to 10 V 

15-bit resolution: 0 to 20 mA, 4 to 20 mA 

Conversion time: 250 µs/channel  

Left-side 

high-speed 

load cell 

module 

DVP201LC-SL 

1 channel 

24-bit resolution: 0~80mV/V 

With one RS-485 port, it can work alone. 

 

DVP211LC-SL 

1 channel 

24-bit resolution: 0~80mV/V 

I/O: 2DI/4DO/1AO 

With one RS-485 port, it can work alone. 

DVP202LC-SL 

2 channels 

24-bit resolution: 0~80mV/V 

With one RS-485 port, it can work alone. 

DVP02LC-SL 
2 channels 

20-bit resolution: 0~6mV/V 

DVP01LC-SL 
1 channel 

20-bit resolution: 0~6mV/V  
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Temperature 

measurement 

module 

DVP04PT-S 

4-channel, 2-wire/3-wire RTD;   

Sensor type: Pt100 / Pt1000 / Ni100 / Ni1000 / LG-Ni1000 / 

Cu100 / Cu50 / 0~300Ω / 0~3000Ω;  

Resolution: 0.1°C/0.18°F;    

Conversion time: 200 ms/channel;  

PID controller 

DVP06PT-S 

6-channel, 2-wire/3-wire RTD;   

Sensor type: Pt100 / Pt1000 / Ni100 / Ni1000 / LG-Ni1000 / 

Cu100 / Cu50 / 0~300Ω / 0~3000Ω;  

Resolution: 0.1°C/0.18°F;    

Conversion time: 160 ms/channel  

DVP04TC-S 

4-channel thermocouple;  

Sensor type: J, K, R, S, T;  

Resolution: 0.1°C/18°F;   

Conversion time: 200 ms/channel 

PID controller  

DVP08NTC-S 

8-channel thermistor (NTC) 

Sensor type: Pt1000, Ni1000, LG-Ni1000, CTN10K, 

CTN100K, NTC20K, NTC30K, PT-42H, PT-43, PT-51F, 

PT-25E2, PT-312, KTY81, two user-defined tables 

Resolution: 0.1°C 

DVP02TUN-S 

2 generic analog inputs: 0~10V, 0~20 mA, 4~20 mA 

Thermocouple: J, K, R, S, T, E, N, B, C, L, U, TXK (L), PLII 

Thermistor: Pt100, JPt100, Pt1000, Cu50, Cu100, Ni100, 

Ni120, Ni1000, LG-Ni1000 

Resolution: 0.1°C (16-bit)  

4 transistor (sinking) outputs: 24 VDC/300 mA 

Output points: controlled by PID or manual  
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DVP02TUR-S 

2 generic analog inputs: 0~10V, 0~20 mA, 4~20 mA 

Thermocouple: J, K, R, S, T, E, N, B, C, L, U, TXK (L), PLII 

Thermistor: Pt100, JPt100, Pt1000, Cu50, Cu100, Ni100, 

Ni120, Ni1000, LG-Ni1000 

Resolution: 0.1°C (16-bit) 

4 relay outputs: 240 VAC/2 A 

Output points: controlled by PID or manual  

DVP02TUL-S 

2 generic analog inputs: 0~10V, 0~20 mA, 4~20 mA 

Thermocouple: J, K, R, S, T, E, N, B, C, L, U, TXK (L), PLII 

Thermistor: Pt100, JPt100, Pt1000, Cu50, Cu100, Ni100, 

Ni120, Ni1000, LG-Ni1000 

Resolution: 0.1°C (16-bit)  

2 analog outputs: 0~10V, 0~20 mA, 4~20 mA 

Resolution: 12-bit 

Output points: controlled by PID or manual  

Remote 

temperature 

measure 

module 

DVP02TKN-S 

2 generic analog inputs: 0~10V, 0~20 mA, 4~20 mA 

Thermocouple: J, K, R, S, T, E, N, B, C, L, U, TXK (L), PLII 

Thermistor: Pt100, JPt100, Pt1000, Cu50, Cu100, Ni100, 

Ni120, Ni1000, LG-Ni1000 

Resolution: 0.1°C (16-bit) 

4 transistor (sinking) outputs: 24 VDC/300 mA 

Output points: controlled by PID or manual  

DVP02TKR-S 

2 generic analog inputs: 0~10V, 0~20 mA, 4~20 mA 

Thermocouple: J, K, R, S, T, E, N, B, C, L, U, TXK (L), PLII 

Thermistor: Pt100, JPt100, Pt1000, Cu50, Cu100, Ni100, 

Ni120, Ni1000, LG-Ni1000 

Resolution: 0.1°C (16-bit) 

4 relay outputs: 240 VAC/2 A 

Output points: controlled by PID or manual 
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DVP02TKL-S 

2 generic analog inputs: 0~10V, 0~20 mA, 4~20 mA 

Thermocouple: J, K, R, S, T, E, N, B, C, L, U, TXK (L), PLII 

Thermistor: Pt100, JPt100, Pt1000, Cu50, Cu100, Ni100, 

Ni120, Ni1000, LG-Ni1000 

Resolution: 0.1°C (16-bit)  

2 analog outputs: 0~10V, 0~20 mA, 4~20 mA 

Resolution: 12-bit 

Output points: controlled by PID or manual 

Positioning 

module 
DVP01PU-S Single axis positioning module; 200k Hz 

Left-side 

positioning 

module 

DVP02PU-SL 

2-axis motion control 

5-24 VDC, 1 differential input (A/B/Z phase), maximum 

hardware input frequency at 200k Hz, 24 VDC, 5 mA, 5 

inputs, maximum hardware input frequency at 1 kHz, 

5 VDC, 2-axis (4 points) differential outputs, maximum 

output frequency at 200k Hz  

Left-side 

high-speed 

communication 

module 

DVPEN01-SL Ethernet module; 10/100Mbps 

DVPDNET-SL DeviceNet Master module; 500k bps 

DVPCOPM-SL CANopen Master module; 1Mbps 

DVPPF02-SL PROFIBUS DP Slave module; 12Mbps 

DVPSCM12-SL RS-485/RS-422 series communication module; 460k bps 

DVPSCM52-SL BACnet MS/TP Slave module; 460k bps 
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1.2 Overview 

An DVP-ES3/EX3 PLC CPU is an advanced block controller and DVP-SV3/SX3 is an slim-type advanced 

controller. With up to 4-axis (pulse) for positioning outputs and Delta Servos, they can optionally work with a 

total of 8-axis (CANopen) communication positioning outputs. Up to 4 high speed input counters, it provides a 

strong network function and users can create connection among devices on the network through software. An 

DVP-ES3/EX3/SV3/SX3 PLC CPU also provides structured programming. Users can assign programs to 

different tasks, and write a program which is frequently executed in a function block. Moreover, users can 

choose different programming languages ladder diagrams (LD), structured texts (ST), sequential function 

charts (SFC), and continuous function chart (CFC) dealt with by IEC 61131-3 according to their needs when 

writing programs. They can create the DVP-ES3 PLC CPU hardware configuration by software. They can also 

restore or back up a system rapidly through the built-in SD interface in this DVP Series PLC CPU. This manual 

introduces the basic operation and help users familiarize themselves with the DVP-ES3/EX3/SV3/SX3 PLC 

CPU. 
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1.3 Characteristics 

(1) High efficiency 

 A 32-bit high-speed processor is used. The module executes each basic instruction at 25 ns speed 

and each moving instruction at 150 ns. The module executes instructions at a speed of 40k steps/ms 

(40% of the instructions are basic instructions, and 60% of the instructions are applied instructions).  

 The CPU uses the Soc architecture, built with 4 high speed counters. The maximum frequency is 200k 

Hz for each counter; four-axis (8 points) high speed position output at 200k Hz. 

(2) Supporting more inputs and outputs 

 The DVP-ES3/EX3 PLC CPU supports up to 256 digital I/Os (inputs + outputs) or 8 analog I/O 

modules.  

 The DVP-SV3/SX3 PLC CPU supports up to 512 digital I/Os (256 inputs + 256 outputs). The 512 I/Os 

are shared by the PLC CPU (16DIs and 16 Dos), 8 right-side extension modules and 8 left-side 

high-speed extension modules. It is recommended not to connect more than 14 right-side slim type 

extension modules.   

(3) Larger program capacity and memory 

 The CPU modules have 64k steps of program capacity. 60000 general registers (30000 for specific 
use and 30000 for programming editing), and 64k words of memory (that can be used for storing 
parameters).  

(4) Supporting IEC 61131-3 

 The DVP-ES3/EX3/SV3/SX3 PLC CPU supports IEC 61131-3. 

 There are four types of programming languages: ladder diagram (LD), sequential function chart (SFC), 
structure text (ST) and continuous function chart (CFC).  
NOTE: ISPSoft version 3.08 or higher support ES3 Series PLC. DIADesigner V1.30 or higher support 
ES300TEC, EX3/SV3/SX3 Series PLC.  

 You can select a programming language according to your preference. Programming languages 
support one another so that programs written by different users are compatible. 
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ISPSoft DIADesigner 

 

 
 

 

(5) Strong function block 

 Both standard IEC61131-3 function blocks and convenient functions blocks provided by Delta 

Electronics, Inc. are supported. You can use function blocks for frequently used programs for greater 

structure and convenience. 

 The symbol for a function block in a ladder diagram is similar to an integrated circuit (IC) in a circuit 

diagram. Because the ladder diagram is based on the traditional circuit diagram, the operation of a 

function block is similar to the function of an integrated circuit. You only need to send the signal to the 

corresponding input of the function block.  You do not need to consider the processing procedure 

inside the function block. 

          

 A function block is a program element equipped with the operation function. It is similar to a subroutine, 

and is a type of POU (Program Organization Unit). It cannot operate by itself, and must be called 

through the main program POU. The function defined by the function block is executed after being 

called with the related parameters. The final result can be sent to the device or variable in the superior 

POU after the function block completes.  

 You can set passwords in ISPSoft to provide function block security. The program inside a function 

block cannot be read, and business patents cannot be compromised. 
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(6) Task 

 You can assign 283 tasks at most to a program. Among these tasks, 32 are cyclic/noncyclical, 32 are 

I/O interrupts, 4 are timer interrupts, two are communication interrupts, one is an external 24 V 

low-voltage interrupt, and 212 are user-defined tasks.  

 You can enable and disable a task when running a program by using the TKON and TKOFF 

instructions. 

ISPSoft 

 

 
 

DIADesigner 

 

 
 

(7) Increasing hardware configuration efficiency through a USB cable and ISPSoft 

 The DVP-ES3/EX3/SV3/SX3 PLC CPU provides a standard USB 2.0 interface. USB 2.0 increases the 

data transfer rate and decreases the time it takes to download the program, monitor the program, and 

configure the hardware. You do not need to buy a special communication cable for the CPU module. 

You can use a general USB cable to connect to the DVP PLC CPU module. 

(8) Serial control interface (RS-485 and CAN) with multiple functions 

 DVP-ES3/EX3/SV3/SX3 Series CPU modules provide two RS-485 serial control interfaces, COM1 

and COM2, which can be set as a either master or slave. 
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 Built-in CAN communication port is for Delta Special Drive (8-axis servo and 8 motor drive) and 

CANopen DS301 communication mode (up to 64 Slaves). 

(9) High-speed Ethernet communication interface 

 DVP-ES3/EX3/SV3/SX3 Series CPU modules are equipped with a 10/100 M Ethernet communication 

interface and support webpage, Modbus TCP, Ethernet/IP Scanner/Adapter and socket services.  

 DVP-EX3 Series PLC CPU is built with 2x Ethernet ports (can act as a switch).  

(10) Memory card 

 The memory card has the following functions. 

System backup: user program, CPU parameters, module table, and the device setting values 

System recovery: user program, CPU parameters, module table, and device setting values 

Parameter storage: device value 

Log storage: system error log and system status log 

(11) Supporting on-line debugging mode 

 You can use the on-line debugging mode in the DVP-ES3/EX3/SV3/SX3 PLC CPU after a single 

instruction step completes, or after a breakpoint is specified, to find bugs in the program.  

 The CPU module must be running to enter the debugging mode. After enabling the on-line monitoring 

function, click . The debugging screen varies from programming language to programming 

language, but the same operation applies to these programming languages. For the 

DVP-ES3/EX3/SV3/SX3 PLC CPU, structured text (ST) does not support debugging mode, and 

sequential function charts (SFC) supports debugging mode during the action and the transition. 
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 ISPSoft 

Step 1: Set the PLC to RUN 

 

 

 

 

 

 

 

Step 2: Entering the on-line mode 

 

 Step 2: Enter online mode 
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Step 3: Enter debugging mode 

 

 

 DIADesigner 

Step 1: Set the PLC to RUN 

 

 

Step 2: Entering the on-line mode 

 
 

 
Step 3: Enter debugging mode 
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(12) On-line editing mode 

 The on-line editing mode allows you to update the program without affecting the system operation. 

 ISPSoft 

1. When the system is in the on-line monitoring mode, enter the on-line editing mode by clicking . 

 

 

2. After the program is modified and compiled, you can update the program in the CPU module by 

clicking  to download it to the CPU. 
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 DIADesigner 

1. When the system is in the on-line monitoring mode, enter the on-line editing mode by clicking  

 
 

2. After the program is modified and compiled, you can update the program in the CPU module by 

clicking  to download it to the CPU. 
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2.1 DVP-ES3/EX3 Series  
2.1.1 General Specifications 

Item Specifications 
Operating temperature -0 to 55°C 
Storage temperature -40 to 70°C 

Operating humidity 5–95% 
No condensation 

Storage humidity 5–95% 
No condensation 

Work environment No corrosive gas exists. 
Installation location In a control box 
Pollution degree 2 
Ingress protection 
(IP ratings) 

IP20 (NOT UL Certified) 

EMC (electromagnetic 
compatibility) Refer to Appendis C for more information. 

Vibration resistance 

Tested with: 
5 Hz ≦ f ≦ 8.4 Hz, constant amplitude 3.5 mm;  

8.4 Hz ≦ f ≦ 150 Hz, constant acceleration 1g 

Duration of oscillation: 10 sweep cycles  
per axis on each direction of the three mutually perpendicular axes 
International Standard IEC 61131-2 & IEC 60068-2-6 (TEST Fc) 

Shock resistance 

Tested with: 
Half-sine wave: 
Strength of shock 15 g peak value, 11 ms duration; 
Shock direction: The shocks in each in direction per axis, on three mutually 
perpendicular axes (total of 18 shocks) 
International Standard IEC 61131-2 & IEC 60068-2-27 (TEST Ea) 

Safety Conforms to IEC 61131-2, UL 61010-2-201, UL508 
Ambient air 
temperature-barometric 
pressure-altitude 

Operating: 1013 ~ 795hPa (0 ~ 2000 m) 
Storage:1013 ~ 660hPa (0 ~ 3500 m) 

UL 94 Flame Cl UL 94 V-0 
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2.1.2 CPU Module Specifications  

2.1.2.1 Functional specifications 

Item 
DVP32ES311T, DVPxxES300R/T, 

DVP32ES300TEC, DVPxxEX300R/T, 
DVP28EX300MT 

Remark 

Execution The program is executed cyclically.  

Input/Output control 
Regenerated inputs/outputs  
Direct inputs/outputs 

The inputs and 
outputs can be 
controlled through the 
direct inputs (DX) and 
direct outputs (DY). 

Programming language 
IEC 61131-3   
Ladder diagrams, continuous function charts, 
structured text, and sequential function charts  

Instruction execution speed 40K steps/ms  
Number of instructions Over 600 instructions  

Constant scan cycle (ms) 
1-32000  
(The scan cycle can be increased by one 
millisecond.) 

Setting the parameter 

Program capacity (step) 64K steps (128K bytes)  

Installation DIN rails or screws  
Installation of a module No backplane installation; only module after module   

Maximum number of 
modules which can be 
installed 

Up to 256 digital I/Os are supported. The 256 I/Os 
are shared by the PLC CPU (8 DIs and 8 Dos). It is 
recommended not to connect more than 8 analog 
modules.  

 

Number of tasks 283 tasks (32 cyclic tasks; 16 I/O interrupts; four 
timed interrupts, etc.)  

Refer to ISPSoft 
Manual for more 
information. 

Number of inputs/outputs 256 

Number of 
inputs/outputs 
accessible to an 
actual input/output 
module 

Input relays [X] 256 (X0 ~ X377) Octal format 
Output relays [Y] 256 (Y0 ~ Y377) Octal format 
Internal relays [M] 8192 (M0–M8191)  
Timers [T] 512 (T0–T511)  
Counters [C] 512 (C0–C511)  
32-bit counter [HC] 256 (HC0–HC255)  
Data register [D] 30000 (D0–D29999)  

Data register [W] 30000 (W0–W29999) For programming in 
software 

Stepping relay [S] 2048 (S0–S2047)  
Index register [E] 10 (E0–E9)  
Special auxiliary relay [SM] 4096 (SM0–SM4095)  
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Item 
DVP32ES311T, DVPxxES300R/T, 

DVP32ES300TEC, DVPxxEX300R/T, 
DVP28EX300MT 

Remark 

Special data register [SR] 2048 (SR0–SR2047)  
Serial communication port 2x RS-485   

Ethernet port 
10/100 M; ES3 Series: single port; EX3 Series: two 
ports; supporting Modbus TCP and Ethernet/IP 
Adapter protocols 

Refer to the section 
9.3 for more details on 
Ethernet 
specificaitons 

USB port Mini B type USB  
Storage interface SD Card (Micro SD); maximum storage: 32G  

Real-time clock 

Years, months, days, hours, minutes, seconds and 
weeks  
The accuracy  

Environment 
Cold Normal Hot 

0°C  
/32°F 

25°C 
/77°F 

55°C 
/131°F 

Deviation 
(seconds per 

month) 
-117 52 -132 

 

Active about one 
week, storing in an 
electric double layer 
capacitor 

CANopen DS301 (Master) Maximum node: 64; maximum bytes: 2000 Built-in CAN 
communication port 
(except 
DVP32ES300TEC) 

CANopen DS301 (Slave) Maximum PDO: 8; maximum bytes: 8 

EtherCAT communication 
port 

Supports EtherCAT Master 8 axes point-to-point 
positioning control; transmission rate: 100Mbps  
Note: only Delta servos ASDA-A2-E, ASDA-A3-E, 
ASDA-B3-E and Delta inverters C2000 and CH2000 
are supported. 

Only applicable to 
DVP32ES300TEC 
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2.1.2.2 Electrical specifications 

          Model 
Item 

DVP32ES311T 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 

Communication 
port isolation  USB, COM1, COM2, and Ethernet ports: 500 VAC 

Weight (g) 390 g 

 
         Model 
Item 

DVPxxES300R/T, DVP32ES300TEC, DVPxxEX300R/T, DVP28EX300MT 

Supply voltage 100 ~ 240VAC (-15% ~ 10%), 50 / 60Hz ± 5% 
Fuse capacity 2.5 A / 250 VAC 
Power 
consumption 70 VAMAX  

DC24V current 
output 500mA 

Protection DC24Voutput with short-circuit protection 
Over voltage 
category OVC II 

Surge voltage 
protection 3,000 VAC (Primary-secondary), 3,000 VAC (Primary-FE), 500 VAC (Secondary-FE) 

Insulation 
impedance 

≧5 MΩ  

(the isolation between each input/output point and the ground should be 500 VAC） 

Grounding The diameter of the ground should not be less than the diameters of the cables connected 
to the terminals L and N. If using multiple pieces of PLC, use a single-point ground.  

Communication 
port isolation  

USB, COM1, COM2, Ethernet, EtherCAT (applicable to DVP32ES300TEC) ports:  
500 VAC 

 
 Weight 
 DVP-ES3 Series 

Model 32ES 
300T 

32ES 
300R 

48ES 
300T 

48ES 
300R 

64ES 
300T 

64ES 
300R 

80ES 
300T 

80ES 
300R 

32ES 
300TEC 

Weight (g) 571 627 657 732 758 868 863 997 538 
 

 DVP-EX3 Series 

Model 22EX 
300T 

22EX 
300R 

36EX 
300T 

36EX 
300R 

28EX 
300MT 

Weight (g) 538 588 637 675 637 
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 Electrical specifications for the inputs on DVP-ES3 Series PLC CPU. The signals passing through 
the inputs are 24 VDC signals. 

Model 
Item 

DVP32ES311T 
DVP32ES300T 

DVP32ES300TEC 
DVP32ES300R 

DVP48ES300T 
DVP48ES300R 

DVP64ES300T 
DVP64ES300R 

DVP80ES300T 
DVP80ES300R 

Number of inputs 16 (X0 ~ X17) 24 (X0 ~ X27) 32 (X0 ~ X37) 40 (X0 ~ X47) 

Connector type Removable terminal blocks 

Input type Digital input 

Input form Direct current (sinking or sourcing) 

Input voltage/ current 
24VDC 

S/S, S/S0: 80mA; S/S1: 120mA; X0 ~ X47: 5mA 

Action 
level 

OFF→ON >15 VDC 

ON→OFF <5 VDC 

Response 
time 

OFF→ON X0 ~ X7: 1.5μs 
X10 ~ X17: 50μs 
X20～X47: 10ms ON→OFF 

Maximum input 
frequency 

X0 ~ X7: 200kHz 
X10 ~ X17: 10kHz 
X20～X47: 50Hz 

Input impedance 
X0 ~ X7: 3.9kΩ 

X10 ~ X47: 5.6kΩ 

Input isolation 500 VAC 

Input display When the optocoupler is driven, the input LED indicator is ON. 
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 Electrical specifications for the inputs on DVP-EX3 Series PLC CPU. The signals passing through 
the inputs are 24 VDC signals. 

Model 
Item 

DVP22EX300T 
DVP22EX300R 

DVP36EX300T 
DVP36EX300R 

DVP28EX300MT 

Number of inputs 12 (X0~X13) 16 (X0~X17) 12 (X0~X13) 
Connector type Removable terminal blocks 

Input type Digital input 

Input form Direct current (sinking or sourcing) 
X0+~X3+/X0-~X3- differential 
X4~X7 / X10-X13: Direct current 
(sinking or sourcing) 

Input voltage/ current 
24VDC 
S/S：80mA 
X0~X17：5mA 

X0+~X3+/X0-~X3-：5VDC，5mA 

X4~X7 / X10-X13: 24VDC, 5mA 
S/S：40mA 

Action 
level 

OFF→ON >15VDC 
X0+~X3+/X0-~X3-：>0.2VDC 

X4~X7 / X10-X13: >15VDC 

ON→OFF <5VDC 
X0+~X3+/X0-~X3-：<-0.2VDC 

X4~X7 / X10-X13: <5VDC 

Response 
time 

OFF→ON X0~X7：1.5μs 

X10~X17：50μs 

X0+~X3+/X0-~X3-：0.125μs 

X4~X7：1.5μs 

X10~X13：50μs  ON→OFF 

Maximum input 
frequency 

X0~X7：200kHz 

X10~X17：10kHz 

X0+~X3+/X0-~X3-：4MHz 

X4~X7：200kHz 

X10~X13：10kHz 

Input impedance 
X0~X7：3.9kΩ 

X10~X17：5.6kΩ 
5.6kΩ 

Input isolation 500 VAC 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Analog input 

channels 
2 

Analog input 
conversion 

time*1 
3 ms / channel 

Analog input 
resolution 

12 bits 

Analog input mode -10V~10V; -20mA~20mA; 4mA~20mA; channels closed 
Analog linearity 

deviation  
Normal temperature environment: ±0.5%; All temperature environment: ±1.0% 

Analog input 
impedance 

≧1MΩ (Voltage mode) 
250Ω (Current mode) 

Analog input 
isolation 

When there is isolation between analog and digital electricals and there is no 
isolation among analog channels.  
Isolation between analog electrical and grounding: 500 VAC 
Isolation between analog and digital electrical: 500 VAC 

*1: Analog input data updates automatically in every PLC scan cycle. Use REF instruction, if you need to update 
the input data before the PLC scan cycle, you can use REF instruction. 
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 Electrical specifications for the outputs on DVP-ES3 Series.  

Model 
Item 

DVP-ES3 
Series 

32ES300
R 

48ES300
R 

64ES300
R 

80ES300
R 

32ES311
T 

32ES300
T/TEC 

48ES300
T 

64ES300
T 

80ES300
T 

Number of outputs 16 24 32 40 16 16 24 32 40 
Connector type Removable terminal blocks 

Output form  Relay Transistor-T (sinking) 

Voltage 10～250 VAC, 5～30VDC 5 ~ 30 VDC 

Leakage current - <100uA 

Max. inrush current - 
Transistor-T (sinking): 0.8A 

Tested when Ta = 25 oC, VDS = 30 VDC, and  
inrush current = 1 ms 

Maximum 
load 

Resistance 2A/output, 5A/COM 0.5A/output, 4A/COM*2 
Inductance Life cycle curve*3 N/A 

Bulb 20WDC/100WAC N/A 
Minimum load 1 mA / 5V 
Input isolation 300 VAC 500 VAC 

Switching frequency*1 ≦1Hz 
Y0～Y7: 200kHz 

Y10～Y47 ≦1kHz 

Maximum 
Response 
time 

OFF→ON 
Approximately 10ms 

Y0～Y7: 1.5μs 

Y10～Y47: 100μs 

ON→OFF 
Y0～Y7: 1.5μs 

Y10～Y47: 100μs 

*1: The scan cycle affects the frequency.  

*2: UP, ZP should include external aid power 24VDC (-15% ~ +20%) and the rated consumption is around  
   1mA/point.  

*3: Life cycle curve: The lifetime of a relay terminal varies with the working voltage, the load type (the power 

   factor cosψ, the time constant t(L/R)), and the current passing through the terminal. The relation is shown in 

   the life cycle curve below. The life cycle curve is shown below. 

 

Contact Current(A)
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Inductive
    (t=40ms)
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 Electrical specifications for the outputs on DVP-EX3 Series.  

Model 
Item 

22EX300R 36EX300R 22EX300T 36EX300T 28EX300MT 

Number of 
outputs 

8 16 8 16 12 

Connector type Removable terminal blocks 

Output form  Relay Transistor 
Y0+~Y3+/Y0-~Y3-: Differential; 

 Y4~Y7 /Y10-Y13:  Transistor 

Voltage 10～250 VAC; 5～30 VDC 5~30 VDC 
Y0+~Y3+/Y0-~Y3-：5VDC;   

 Y4~Y7 /Y10-Y13: 5~30VDC 

Leakage current – <100uA 

Max. inrush 
current 

– 
Transistor-T (sinking): 0.8A 

Tested when Ta = 25 oC, VDS = 30 VDC, and  
inrush current = 1 ms 

Maximum 
load 

Resis
tance 

2A/output, 5A/COM 0.5A/output, 4A/COM*2 

Y0+~Y3+/Y0-~Y3-：20mA/COM; 

+ and – are grouped, e.g. Y0+ 
and Y0-);   
Y4~Y7 /Y10-Y13: 0.5A/output; 
4A/COM*2 

Induc
tance 

Life cycle curve*3 N/A 

Bulb 20 WDC/100 WAC N/A 

Minimum load 1mA/5V 

Input isolation 3000 VAC 500 VAC 

Switching 
frequency*1 

≦1Hz 
Y0～Y7：200kHz  

Y10～Y17 ≦1kHz 

Y0+~Y3+/Y0-~Y3- : 4MHz ;  
Y4~Y7: 200kHz 
Y10~Y13: 1kHz 

Response 
time 

OFF→
ON 

Around 10ms 

Y0～Y7：1.5 μs  

Y10～Y17：100 μs 

Y0+~Y3+/Y0-~Y3-：0.125 μs;  

Y4~Y7 : 1.5 μs 
Y10~13: 100 μs 

ON→ 
OFF 

Y0～Y7：1.5 μs  

Y10～Y17：100 μs 

Y0+~Y3+/Y0-~Y3-：0.125 μs;  

Y4~Y7 : 1.5 μs 
Y10~13: 100 μs 

Analog output 
channels 

2 (applicable for 36EX3/28EX3) 

Analog output 
conversion 

time*4 
2 ms / channel (36EX3/28EX3) 

Analog output 
resolution 

12-bit (applicable to 36EX3/28EX3) 

Analog output 
mode 

-10V~10V (voltage mode) / 0~20mA (current mode) (applicable to 36EX3/28EX3) 
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Model 
Item 

22EX300R 36EX300R 22EX300T 36EX300T 28EX300MT 

Analog output 
isolation 

When there is isolation between analog and digital electricals and there is no 
isolation among analog channels. 

Isolation between analog electrical and grounding: 500 VAC 
Isolation between analog and digital electrical: 500 VAC 

 
*1-*3: Refer to the electrical specifications for the outputs on DVP-ES3 Series from the previous table.  
*4: Analog input data updates automatically in every PLC scan cycle. Use REF instruction, if you need to    
   update the input data before the PLC scan cycle, you can use REF instruction. 
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2.1.2.3 CPU Module Profiles 

 DVP32ES300R / DVP32ES300T / DVP32ES311T / DVP48ES300R / DVP48ES300T / DVP64ES300R / 
DVP64ES300T / DVP80ES300R / DVP80ES300T 

L1
L

90 98 10
6

11
0

61 .5
78

4.5x2

7

8

1

4
5

3

6

2

DVP32 ES3
16DI / 1 6DO

8

6

9

10

14

12

13
11

C AN

 
Unit: mm 

 
 DVP22EX300R/DVP22EX300T/DVP36EX300R/DVP36EX300T/DVP28EX300MT/32ES300TEC 

78
61.54.5x2

L1
L

10
6

11
0

9890

14

12

1310

11

8

6

8

9

7

1

4
5

3

6

2

LINK/
 ACT

 Unit: mm 
 

 
 Diameter chart  

DVP 32ES311T 32ES311T 
32ES300R/T 
32ES300TEC 
22EX300R/T 

64ES300R/T 80ES300R/T 

L 165 mm 165 mm 216 mm 267 mm 310 mm 

L1 157 mm 157 mm 208 mm 259 mm 302 mm 
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 LED indocaor descriptions  
Number Name Description 

1 Output type 
R: Relay output 
T: Transistor output 

2 Input/Output LED 
If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

3 

CAN communication LED 
(applicable to ES3 Series) 

ON: In communication  
OFF: No communication 

LINK/ACT E1, E2 
communication LED 
(application to EX3 / 
32ES300TEC)  

ON: Communication port is connected. 
Blinking: Data in transmission 
OFF: Communication port is NOT connected.  

Power LED Power status of the CPU module 

Run LED  

Operating status of the module 
ON: PLC program is running. 
OFF: PLC program is stopped.  
Blinking: PLC program detects an error  

Error LED  

Error status of the module 
Blinking slowly (1 second ON, 3 seconds OFF): Warning  
Blinking (0.5 seconds ON and OFF): Error 
Blinking rapidly (0.2 seconds ON and OFF): Low voltage  
ON: Scan timeout  

USB communication LED 
Communication status  
OFF: No communication  
Blinking: In communication  

COM1/COM2 
communication LED 
CAN communication LED 
(applicable to EX3) 

ECAT communication LED 
(applicable to 
32ES300TEC) 

EtherCAT status 
Green LED ON: Communication card is working normally. (Slaves   
are all in Operational State.) 
Red LED ON: The connection between Master and Slave is NOT  
connected.  
Red LED Blinking (2 seconds ON and OFF): Slave is NOT  
connected. 
Red LED Blinking (0.5 seconds ON and OFF): Slave status is  
abnormal. 
OFF: EtherCAT Master is NOT activated.  

LINK/ACT LED (applicable 
to ES3) 

ON: Communication port is connected. 
Blinking: Data in transmission 
OFF: Communication port is NOT connected. 

4 SD card slot For inserting a SD card 

5 RJ45 communication port 

An interface for RJ45 communication 
ES3 is built with a single RJ45 port (Ethernet);  
EX3 is built with a dual RJ45 ports (Ethernet);  
32ES300TEC is built with two RJ45 ports: #1 EtherCAT port,  
#2 Ethernet port 

6 Removable terminal blocks Connects the module and the wiring module 
7 Mounting hole Secures the module on the set 
8 Terminal number Terminal number 

9 RUN/STOP  
RUN: executes the program 
STOP: stops the program 
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Number Name Description 
10 USB port Mini USB communication port 
11 Model name Name of the CPU module. 

12 External module 
connection port Connects the modules 

13 DIN rail slot (35 mm) For the DIN rail 
14 I/O module securing clip Secures the modules 
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2.1.2.4 CPU Module Input/Output Terminals 

 DVP32ES300R 

X2X1X0S/S24 G+2 4V X5X4X3

Y4 C1Y3Y2Y 1Y 0C 0D - Y 7Y6Y5D+D-D +

DVP32ES300R (16DI/16DO) 
X15X1 4X 12X11X10X7X 6

Y1 0

X16

Y11 Y13Y12 Y14

X13

SG

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22 23

1 2 3 4 5 6 7 8 9 10 11 12 1 3 14 1615 17 18 19 20 21 22 2 3 24 2 5

L N X 17
24

CA N+CAN- GND Y 15 Y1 7Y16
26 27 28  

 

 DVP32ES300T 

X2X1X0S/S24 G+2 4V X5X4X3

Y4Y3Y2Y 1Y 0D - Y 7Y6Y5D+D-D +

DVP32ES300T (16DI/16DO) 
X15X1 4X 12X11X10X7X 6

Y1 0

X16

Y11 Y13Y12 Y14

X13

SG

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22 23

1 2 3 4 5 6 7 8 9 10 11 12 1 3 14 1615 17 18 19 20 21 22 2 3 24 2 5

L N X 17
24

CAN+CAN- GND Y 15 Y1 7Y16
26 27 28

U P0 ZP 0  U P1 ZP1

 

 

 DVP32ES300TEC 
X2X1X0S /S

24 G+24 V

X5X4X3

Y4Y3Y2Y 1Y 0D- Y 7Y6Y5D +D -D+

DVP32ES300TEC (16DI/16DO) 
X 15X14X1 2X11X 10X7X6

Y1 0

X16

Y11 Y13Y12 Y14

X13

S G

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21

1 2 3 4 5 6 7 8 9 10 11 12 1 3 14 1615 17 18 19 20 21 22 2 3 24 2 5

L N X1 7

Y 15 Y1 7Y16
26 27 28

U P0 ZP 0  U P1 ZP1

 
 

 DVP32ES311T 

X2X1X0S/S0 V24 V X5X4X3

Y4Y3Y2Y 1Y 0D - Y 7Y6Y5D+D-D +

DVP32ES311T (16DI/16DO) 
X15X1 4X 12X11X10X7X 6

Y1 0

X16

Y11 Y13Y12 Y14

X13

SG

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22 23

1 2 3 4 5 6 7 8 9 10 11 12 1 3 14 1615 17 18 19 20 21 22 2 3 24 2 5

X 17
24

CA N+CAN- GND Y 15 Y1 7Y16
26 27 28

 U P0 ZP0  U P1 ZP1

 

 

 DVP48ES300R 

 

Y3Y2Y1Y0C0D- Y5Y4D+D-D+
DVP48ES300R (24DI/24DO) 

X4X2X1X0S/S0 X7X6X5 X17X16X14X13X12X11X10

Y7Y6 C1 Y12Y11Y10

X27X26X24X23X22X21

Y15Y14 Y16 Y20C2Y17 Y22Y21 Y23 Y25Y24

X3 X15

X25

SG Y13

X20

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

25 26 27 28 29 30 31 32 33

25 26 27 28 29 30 31 32 33 34 35 36 37

23 24

S/S1

24 G+24 VL N

23 24
CA N+ CA N- GND

Y26
38
Y27

 

 

 DVP48ES300T 

 

Y3Y2Y1Y0D- Y5Y4D+D-D+
DVP48ES300T (24DI/24DO) 

X4X2X1X0S/S0 X7X6X5 X17X16X14X13X12X11X10

Y7Y6 Y12Y11Y10

X27X26X24X23X22X21

Y15Y14 Y16 Y20Y17 Y22Y21 Y23 Y25Y24

X3 X15

X25

SG Y13

X20

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

25 26 27 28 29 30 31 32 33

25 26 27 28 29 30 31 32 33 34 35 36 37

23 24

S/S1

24 G+24 VL N

23 24
CAN+ CA N- GND

Y26
38
Y27

U P 0 ZP0 UP 1 ZP1

 U P2 ZP 2
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 DVP64ES300R 

 

Y3Y2Y1Y0C0D- Y5Y4D+D-D+
DVP64ES300R (32DI/32DO) 

X4X2X1X0S/S0 X7X6X5 X17X16X14X13X12X11X10

Y7Y6 C1 Y12Y11Y10

X34X33X31X30

Y20C2 Y22Y21 Y23 Y25Y24

X3 X15

X32

SG Y13

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

25 26 27 28 29 30 31 32 33

44 45 46 47 4830 31 32 33 34 35 36 37

23 24
24 G+24 VL N

23 24
CA N+ CAN- GND

Y26
38

Y27
39 40 41 42 43

Y15Y14 Y16 Y17
25 26 27 28 29

35 36 37 3834
X27X26X24X23X22X21 X25X20S/S1 X37X36X35

39 40 41

Y30C3 Y32Y31 Y33 Y35Y34 Y36 Y37

 

 DVP64ES300T 

 

Y3Y2Y1Y0D- Y5Y4D+D-D+
DVP64ES300T (32DI/32DO) 

X4X2X1X0S/S0 X7X6X5 X17X16X14X13X12X11X10

Y7Y6 Y12Y11Y10

X34X33X31X30

Y20 Y22Y21 Y23 Y25Y24

X3 X15

X32

SG Y13

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

25 26 27 28 29 30 31 32 33

44 45 46 47 4830 31 32 33 34 35 36 37

23 24
24 G+24 VL N

23 24
CA N+ CA N- GN D

Y26
38

Y27
39 40 41 42 43

Y15Y14 Y16 Y17
25 26 27 28 29

35 36 37 3834
X27X26X24X23X22X21 X25X20S/S1 X37X36X35

39 40 41

Y30 Y32Y31 Y33 Y35Y34 Y36 Y37

 U P0 ZP0

U P3 ZP3

 U P1 ZP 1

U P 2 ZP2

 

 DVP80ES300R 

 

Y2Y 1Y0C0D- Y5Y4Y3D+D -D+

DVP80ES300R (40DI/40 DO) 
X 4X2X 1X 0S/S0 X 7X6X5 X14X 13X12X11X10

Y7Y6 Y11Y10C 1 Y13 Y 15Y14

X30

Y1 6 Y17

X3 5X 34 X36

Y25Y24

X4 1X 40 X 42

Y27Y2 6

X3 X15

X31 X32 X33 X37 X43

S G Y12

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 2 1 22 23 24 25

31 3 2 3 3 34 35 37 38 39 40 41 4 2
1 2 3 4 5 6 7 8 9 1 0 11 12 13 14 1615 17 18 1 9 20 21 22 2 3 24 25

28 2 9 30 3 1 32 33 34 35 37 38 39 40 41 42

43 44 45 4 636
X4 5X44 X46 X47

Y2 1Y20 Y 22 Y23

28 29 30
X27X26X2 4X 23 X25

36
Y 31Y30 Y3 3Y32C3 Y35Y34 Y37Y 36 Y41Y40 Y43Y42C4 Y45Y44

43 44 45 4 6 4 7 48 49 50 5 1 52 53 54 55

 

26 27

26 27
24G+2 4VL N CAN+CAN- GND X17X16

47 48 4 9 5 0 51 5 2
X22X2 1X2 0S/S1

C2

Y4 7Y46

 

 DVP80ES300T 

ZP 0U P0 ZP1UP 1 ZP2U P2

ZP3U P 3 ZP4U P4

 

Y2Y 1Y0D- Y5Y4Y3D+D -D+

DVP80ES300T (40DI/40DO) 
X 4X2X 1X 0S/S0 X 7X6X5 X14X 13X12X11X10

Y7Y6 Y11Y10 Y13 Y 15Y14

X30

Y1 6 Y17

X3 5X 34 X36

Y25Y24

X4 1X 40 X 42

Y2 7Y2 6

X3 X15

X31 X32 X33 X37 X43

S G Y12

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 2 1 22 23 24 25

31 3 2 3 3 34 35 37 38 39 40 41 4 2
1 2 3 4 5 6 7 8 9 1 0 11 12 13 14 1615 17 18 1 9 20 21 22 2 3 24 25

28 2 9 30 3 1 32 33 34 35 37 38 39 40 41 42

43 44 45 4 636
X4 5X44 X46 X47

Y2 1Y20 Y 22 Y23

28 29 30
X27X26X2 4X 23 X25

36
Y 31Y30 Y3 3Y32 Y35Y34 Y37Y 36 Y41Y40 Y43Y42 Y45Y44

43 44 45 4 6 4 7 48 49 50 5 1 52 53 54 55

 

26 27

26 27
24G+2 4VL N CAN+CAN- GND X17X16

47 48 4 9 5 0 51 5 2
X22X2 1X2 0S/S1

Y4 7Y46

 

 DVP22EX300R 
 

 X2X1X0S/S24G+24V X5X4X3

Y4C1Y3Y2Y1Y0C0D- Y7Y6Y5D+D-D+

DVP22EX300R (12DI/8DO/2AI) 
X12X11X10X7X6

I0+V0+

X13

SG

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 21 22 24

L N

CAN+ CAN- GND V1+ VI1-I1+
27262523 2820

VI0-
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 DVP22EX300T 
 

 X2X1X0S/S24G+24V X5X4X3

UPD-D+D-D+

DVP22EX300T (12DI/8DO/2AI) 
X12X11X10X7X6

I0+V0+ VI0-

X13

SG

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 21 22 24

L N

CAN+ CAN- GND V1+ VI1-I1+
27262523 2820

Y3Y2Y1Y0 Y4 Y7Y6Y5ZP

 
 
 DVP28EX300MT 
 

 

D-D+D-D+

DVP28EX300MT (12DI/12DO/2AI/2AO) 
X2+X1+X0- S/S

Y12Y11Y10

SG

Y13

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

25 26 27 28 29 30

25 26 27 28 29 30 31 33 34 35 36

23 24
24G+24VL N

23 24
CAN+ CAN- GND UP ZP

X0+ X1- X4 X7X6X5 X13X12X11X10

Y5Y4

Y7Y6

X2- X3+ X3-

SG0 Y2+Y1+Y0-Y0+ Y1- Y2- Y3+ Y3-

I0+V0+ VI0- V1+ VI1-I1+

VO0 IO0 AG VO1 IO1 AG

SG1

 
 DVP36EX300R 
 

 

Y3Y2Y1Y0D- Y5Y4D+D-D+

DVP36EX300R (16DI/16DO/2AI/2AO) 
X4X2X1X0S/S X7X6X5 X17X16X14X13X12X11X10

Y7Y6

Y12

Y11Y10

Y15Y14 Y16 Y17

X3 X15

SG

Y13

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

25 26 27 28 29 30

25 26 27 28 29 30 31 33 34 35 36

23 24
24G+24VL N

23 24
CAN+ CAN- GND C0 C2C1

I0+V0+ VI0- V1+ VI1-I1+

VO0 IO0 AG VO1 IO1 AG

 
 DVP36EX300T 
 

 

Y3Y2Y1Y0D- Y5Y4D+D-D+

DVP36EX300T (16DI/16DO/2AI/2AO) 
X4X2X1X0S/S X7X6X5 X17X16X14X13X12X11X10

Y7Y6

Y12

Y11Y10

Y15Y14 Y16 Y17

X3 X15

SG

Y13

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1615 17 18 19 20 21 22

25 26 27 28 29 30

25 26 27 28 29 30 31 33 34 35 36

23 24
24G+24VL N

23 24
CAN+ CAN- GND

I0+V0+ VI0- V1+ VI1-I1+

VO0 IO0 AG VO1 IO1 AG

UP0 ZP0 UP1 ZP1
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2.1.2.5 DVP-EX3 Analog Inputs / Outputs 

 Two Analog Inputs 

Item Voltage Input Current Input 

Analog signal -10~+10 V -20~20 mA / 4~20 mA 

Resolution 12-bit 11-bit 

Input impedance ≧1M Ω 250 Ω 

Conversion time 3 ms / CH 

Analog to digital 
conversion range 

-2000~2000 
-1000~1000 (-20~20 mA) 

0~1000 (4~20 mA) 

Digital value 
output 

SR168 (CH1), SR169 (CH2) 

You can use the program to read the values in SR to obtain the corresponding A/D conversion value for the 

channel. 

 

 Two Analog Outputs (applicable to DVP36EX3 and DVP28EX3) 

Item Voltage Output Current Output 

Analog signal -10~+10 V 0~20 mA  

Resolution 12-bit 12-bit 

Input impedance ≧1 KΩ ≦500 Ω 

Conversion time 2 ms / CH 

Analog to digital 
conversion range 

-2000~2000 0~4000 

Digital value 
output 

SR172 (CH1), SR173 (CH2) 

You can use the instruction MOV to move the value to the SR to obtain the corresponding voltage output 

value. 
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2.2 DVP-SV3/SX3 Series  
2.2.1 General Specifications 

Item Specifications 
Operating temperature -0 to 55°C 
Storage temperature -25 to 70°C 

Operating humidity 5–95% 
No condensation 

Storage humidity 5–95% 
No condensation 

Work environment No corrosive gas exists. 
Installation location In a control box 
Pollution degree 2 
Ingress protection 
(IP ratings) 

IP20 (NOT UL Certified) 

EMC (electromagnetic 
compatibility) Refer to Appendis C for more information. 

Vibration resistance 

Tested with: 
5 Hz ≦ f ≦ 8.4 Hz, constant amplitude 3.5 mm;  

8.4 Hz ≦ f ≦ 150 Hz, constant acceleration 1g 

Duration of oscillation: 10 sweep cycles  
per axis on each direction of the three mutually perpendicular axes 
International Standard IEC 61131-2 & IEC 60068-2-6 (TEST Fc) 

Shock resistance 

Tested with: 
Half-sine wave: 
Strength of shock 15 g peak value, 11 ms duration; 
Shock direction: The shocks in each in direction per axis, on three mutually 
perpendicular axes (total of 18 shocks) 
International Standard IEC 61131-2 & IEC 60068-2-27 (TEST Ea) 

Safety Conforms to IEC 61131-2, UL 61010-2-201, UL508 
Ambient air 
temperature-barometric 
pressure-altitude 

Operating: 1013 ~ 795hPa (0 ~ 2000 m) 
Storage:1013 ~ 660hPa (0 ~ 3500 m) 

UL 94 Flame Cl UL 94 V-0 
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2.2.2 CPU Module Specifications  

2.2.2.1 Functional specifications 

Item 
DVP28SV311T 

DVP28SV311R 

DVP28SV311S 

DVP20SX311T 

DVP20SX311R 

DVP20SX311S 
Remark 

Execution The program is executed cyclically.  

Input/Output control 
Regenerated inputs/outputs  
Direct inputs/outputs 

The inputs and 
outputs can be 
controlled through the 
direct inputs (DX) and 
direct outputs (DY). 

Programming language 
IEC 61131-3   
Ladder diagrams, continuous function charts, 
structured text, and sequential function charts  

Instruction execution speed 40K steps/ms  
Number of instructions Over 600 instructions  

Constant scan cycle (ms) 
1-32000  
(The scan cycle can be increased by one 
millisecond.) 

Setting the parameter 

Program capacity (step) 64K steps (128K bytes)  

Installation DIN rails or screws  
Installation of a module No backplane installation; only module after module   

Maximum number of 
modules which can be 
installed 

Up to 240 digital inputs and 240 outputs are 
supported. It is recommended NOT to connect more 
than 8 right-side extension modules or 8 left-side 
extension modules.  

 

Number of tasks 283 tasks (32 cyclic tasks; 16 I/O interrupts; four 
timed interrupts, etc.)  

Refer to ISPSoft 
Manual for more 
information. 

Number of inputs/outputs 512 

Number of 
inputs/outputs 
accessible to an 
actual input/output 
module 

Input relays [X] 256 (X0 ~ X377) Octal format 
Output relays [Y] 256 (Y0 ~ Y377) Octal format 
Internal relays [M] 8192 (M0–M8191)  
Timers [T] 512 (T0–T511)  
Counters [C] 512 (C0–C511)  
32-bit counter [HC] 256 (HC0–HC255)  
Data register [D] 30000 (D0–D29999)  

Data register [W] 30000 (W0–W29999) For programming in 
software 

Stepping relay [S] 2048 (S0–S2047)  
Index register [E] 10 (E0–E9)  
Special auxiliary relay [SM] 4096 (SM0–SM4095)  
Special data register [SR] 2048 (SR0–SR2047)  
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Item 
DVP28SV311T 

DVP28SV311R 

DVP28SV311S 

DVP20SX311T 

DVP20SX311R 

DVP20SX311S 
Remark 

Serial communication port 2x RS-485   

Ethernet port 
10/100 M; ES3 Series: single port; EX3 Series: two 
ports; supporting Modbus TCP and Ethernet/IP 
Adapter protocols 

Refer to the section 
9.3 for more details on 
Ethernet 
specificaitons 

USB port Mini B type USB  
Storage interface SD Card (Micro SD); maximum storage: 32G  

Real-time clock 

Years, months, days, hours, minutes, seconds and 
weeks  
The accuracy  

Environment 
Cold Normal Hot 

0°C  
/32°F 

25°C 
/77°F 

55°C 
/131°F 

Deviation 
(seconds per 

month) 
-117 52 -132 

 

Active about one 
week, storing in an 
electric double layer 
capacitor 

CANopen DS301 (Master) Maximum node: 64; maximum bytes: 2000 Built-in CAN 
communication port CANopen DS301 (Slave) Maximum PDO: 8; maximum bytes: 8 
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2.2.2.2 Electrical specifications 

          Model 
Item 

DVP28SV 
311T 

DVP28SV 
311R 

DVP28SV 
311S 

DVP20SX 
311T 

DVP20SX 
311R 

DVP20SX 
311S 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Fuse capacity 4 A / 30 VDC 
Power 
consumption 4 W 4.5 W 4 W 5 W 5.5 W 5 W 

Protection 24 VDC output with short-circuit protection 
Surge voltage 
protection 0.5 KV 

Grounding 
1. Grounding spring should be used under rail grounding. 
2. The wire diameter of the power supply grounding wiring shall not be smaller than that 

of the 24V and 0V wire diameter at the power supply end. 
Communication 
port isolation  Coupling voltag: 1 KV 

Weight (g) 249.4 g 278.9 g 249 g 253.9 g 270 g 255.5 g 

 
 Electrical specifications for the inputs on DVP-SV3/SX3 Series PLC CPU. The signals passing 

through the inputs are 24 VDC signals. 

Model 
Item 

DVP28SV311T 

DVP28SV311R 

DVP28SV311S 

DVP20SX311T 

DVP20SX311R 

DVP20SX311S 
Number of inputs 16 (X0 ~ X17) 8 (X0 ~ X7) 

Connector type Removable terminal blocks 

Input type Digital input 

Input form Direct current (sinking or sourcing) 

Input voltage/ current 24 VDC, 5 mA 

Action 
level 

OFF→ON >15 VDC 

ON→OFF <5 VDC 

Response 
time 

OFF→ON 
X0~X7：< 2.5 μs 

X10~X17：< 50 μs 

ON→OFF 
X0~X7：< 2.5 μs 

X10~X17：< 50 μs 

Maximum input 
frequency 

X0 ~ X7: 200 kHz 
X10 ~ X17: 10 kHz 

Input impedance 4.7 kΩ 

Input isolation Coupling voltage: 1 KV 

Input display When the optocoupler is driven, the input LED indicator is ON. 

Analog input channels N/A 4 

Analog input 
conversion 

time*1 
N/A 3 ms / channel 

Analog input 
resolution 

N/A 12 bits 
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Model 
Item 

DVP28SV311T 

DVP28SV311R 

DVP28SV311S 

DVP20SX311T 

DVP20SX311R 

DVP20SX311S 

Analog input mode N/A 
-10V~10V; -20mA~20mA; 4mA~20mA; 

channels closed 

Analog linearity 
deviation  

N/A 
Normal temperature environment: 

±0.5%; All temperature environment: 
±1.0% 

Analog input 
impedance 

N/A 
≧1MΩ (Voltage mode) 
250Ω (Current mode) 

Analog input isolation 

When there is isolation between analog and digital electricals and there is no 
isolation among analog channels.  
Isolation between digital electrical and grounding: 500 VAC 
Isolation between analog and digital electrical: 500 VAC 
Isolation between analog electrical and grounding: 500 VAC 
Isolation between 24 VDC and grounding: 500 VAC 

*1: Analog input data updates automatically in every PLC scan cycle. 
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 Electrical specifications for the outputs on DVP-SV3/SX3 Series.  

Model 
Item 

DVP28SV311R 
DVP20SX311R 

DVP28SV311T 
DVP20SX311T 

DVP28SV311S 
DVP20SX311S 

Connector type Removable terminal blocks 

Output form Relay Transistor-T (sinking) Transistor-P (souring) 

Number of digital outputs 
SV3: 12 points (Y0~Y7, Y10~Y13) 

SX3: 6 points (Y0~Y5) 

Voltage 
10～250VAC; 

5～30VDC 
5~30 VDC 5~30 VDC 

Maximum 
load 

Resistance 1.5A/output, 
4.5A/COM 

0.5A 0.5A 

Inductance Life cycle curve*3 N/A N/A 

Bulb 
20W (24 VDC) 

100W (230 VAC) 
N/A N/A 

Switching 
frequency*1 

Resistance 1Hz 200kHz 200kHz 

Inductance 0.5Hz N/A N/A 

Bulb 1Hz N/A N/A 

Response 
time 

OFF→ON 
10ms 2.5μs 2.5μs 

ON→OFF 
Analog output channels 2 (applicable to SX3) 
Analog output conversion 
time*4 

2 ms / channel (applicable to SX3) 

Analog output resolution 12-bit (applicable to SX3) 

Analog output mode -10 V~10 V/0~20 mA (applicable to SX3) 

Digital output isolation Coupling Voltage：1KV 

Analog output isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, but the analog channels are not isolated from one another. 
Isolation between a digital circuit and a ground: 500 VAC 
Isolation between an analog circuit and a ground: 500 VAC 
Isolation between an analog circuit and a digital circuit: 500 VAC 
Isolation between the 24 VDC and a ground: 500 VAC 

*1: The scan cycle affects the frequency.  

*2: UP, ZP should include external aid power 24VDC (-15% ~ +20%) and the rated consumption is around  
   1mA/point.  

*3: Life cycle curve: The lifetime of a relay terminal varies with the working voltage, the load type (the power 

   factor cosψ, the time constant t(L/R)), and the current passing through the terminal. The relation is shown in 

   the life cycle curve below. The life cycle curve is shown below. 
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*4: Analog input data updates automatically in every PLC scan cycle. 

  

2.2.2.3 CPU Module Profiles 
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 LED indocaor descriptions  
Number Name Description 

1 

Power LED 
Power status of the CPU module 
ON: Power is being supplied. 
OFF: Power is NOT supplied. 

Run LED  

Operating status of the module 
ON: PLC program is running. 
OFF: PLC program is stopped.  
Blinking: PLC program detects an error  

Error LED  

Error status of the module 
Blinking slowly (1 second ON, 3 seconds OFF): Warning  
Blinking (0.5 seconds ON and OFF): Error 
Blinking rapidly (0.2 seconds ON and OFF): Low voltage  
ON: Scan timeout  

USB communication LED Communication status  
OFF: No communication  
Blinking: In communication  

COM1 communication LED 
COM2 communication LED 

2 Removable terminal blocks Connects the module and the wiring module 

3 RUN/STOP  
RUN: executes the program 
STOP: stops the program 

4 
Input/Output LED 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

CAN communication LED 
ON: In communication  
OFF: No communication 

5 SD card slot For inserting a SD card 
6 USB port Mini USB communication port 
7 Ethernet port An interface for Ethernet communication 
8 I/O module securing clip Secures the modules 

9 10-pin removable terminal 
block  Connects the COM1, COM2, CAN ports  

10 DIN rail slot (35 mm) For the DIN rail 

11 Left-side external module 
connection port Connects the left-side modules 

12 Label Nameplate 

13 Right-side external module 
connection port Connects the right-side modules 

14 COM1/COM2/CAN port An interface for RS-485/CAN communication 
15 Power port For power supply 
16 Grounding spring For grounding 
17 Power cable For transmitting electrical power 
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2.2.2.4 CPU Module Input/Output Terminals 

DVP20SX311R DVP20SX311T DVP20SX311S 

 V0+
I0+

V I0-
V1+
I1+

V I1-
V2+
I2+

V I2-

V3+
I3+

V I3-
FE

V O0

V O1
IO1
AG
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X1
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X7
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X3
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Y5

C0

C1

 

 V0+
I0+
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2.2.2.5 DVP-SX3 Analog Inputs / Outputs 

 Four Analog Inputs 

Item Voltage Input Current Input 

Analog signal -10~+10 V -20~20 mA / 4~20 mA 

Resolution 12-bit 11-bit 

Input impedance ≧1M Ω 250 Ω 

Conversion time 3 ms / CH 

Analog to digital 
conversion range 

-2000~2000 
-1000~1000 (-20~20 mA) 

0~1000 (4~20 mA) 

Digital value 
output 

SR168 (CH1), SR169 (CH2), SR170 (CH3), SR171 (CH4) 

You can use the program to read the values in SR to obtain the corresponding A/D conversion value for the 

channel. 

 

 Two Analog Outputs 

Item Voltage Output Current Output 

Analog signal -10~+10 V 0~20 mA  

Resolution 12-bit 12-bit 

Input impedance ≧1 KΩ ≦500 Ω 

Conversion time 2 ms / CH 

Analog to digital 
conversion range 

-2000~2000 0~4000 

Digital value 
output 

SR172 (CH1), SR173 (CH2) 

You can use the instruction MOV to move the value to the SR to obtain the corresponding voltage output 

value. 
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2.3 Power Supply Module  
2.3.1 General Specifications 
 
 DVPPS01 / DVPPS02 / DVPPS05 

          Model 
Item 

DVPPS01 DVPPS02 DVPPS05 

Supply voltage 100~240VAC (-15%~+10%), 50/60Hz 

Output voltage 24VDC (±3%) 

Maximum output 
current 

1A 2A 5A 

Ripple & Noise Less than 100mVp-p @ full load Less than 240mVp-p @ full load 

Efficiency 78%~87% @ full load  More than 88% @ full load 

Overcurrent / 
short circuit 
protection 

Auto recovery 

Overvoltage / 
overtemperature 

protection 
-- 

Overvoltage protection: When 
the device is experiencing 
overvoltage, power it off for 5 
seconds and it will be back to 
normal after powering on again.  
Overtemperature protection: 
When the device is 
experiencing overtemperature, 
power it off for 5 seconds and 
after the internal temperature is 
below 85oC, powering it on 
again. 

Ground 
The diameter of the ground should not be less than the diameters of the 

cables connected to the terminals L and N. (When multiple PLCs are used at the same time, be 
sure to ground each one separately.) 

Weight 158 g 250 g 488 g 
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2.3.2 Power Supply Module Profiles 
 DVPPS01 
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 DVPPS05 
 

 
2

3 2 1

4
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Unit: mm 

 

Number Name Description 
1 Power LED Power status of the power module 

2 Output terminal 
configuration 

24V: DC power output: 24VDC 
0V: DC power output reerence ground 

2 Input terminal 
configuration 

LG: Line ground 
L: AC power input (Line) 
N: AC power input (Neutral) 
：Earth ground terminal 

3 DIN rail clip Secures the module onto the DIN rail 
4 DIN rail slot (35 mm) For the DIN rail 
5 Label Nameplate 

6 Mounting hole Used for the module to be securely attached or mounted to a surface 
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Before developing an DVP-ES3/EX3/SV3/SX3 Series system, you need to install ISPSoft / DIADesigner and 

COMMGR. ISPSoft / DIADesigner is a software platform for integrating the hardware, network configuration, and 

program development for a system. COMMGR functions as middleware between a computer and devices. It functions 

as a communication management interface between ISPSoft / DIADesigner and DVP-ES3/EX3/SV3/SX3 Series 

hardware. 

3.1 Installing and Uninstalling ISPSoft 

 System requirements 

Item System requirement 

Operating system Windows XP / 7 / 8 / 10 

CPU Pentium 1.5 G or above 

Memory 256 MB or above (512 MB or above is recommended.) 

Hard disk drive Capacity : 5000 MB or above 

CD-ROM drive This is optional for installing ISPSoft. 

Monitor 
Resolution: 800×600 or above  

(suggested setting: 1024x768/96 dpi) 

Keyboard/Mouse A general keyboard/mouse or devices compatible with Windows 

Printer A printer with a driver for Windows. This is needed to print projects. 

RS-232 port For connecting to a PLC 
One of them is used, but a PLC that is 

connected must have a corresponding port. (*1) 
USB port For connecting to a PLC 

Ethernet port For connecting to a PLC 

Communication 

software 
COMMGR, a communication manager, must be installed. (*2) 

Supported Models  
AH500 series PLCs/DVP series PLCs (exclusive of DVP-PM series PLCs)/ AS series, AC 

motor drives: VFD with PLC built-in series, and Text panel HMI with PLC built-in series. 

*1. ISPSoft supports several ways to connect a computer to a PLC. Make sure the port and the mode supported by the 

PLC are correct before you connect a computer to the PLC. 

*2. Refer to section 3.3 for more information about COMMGR. 

*3. The functions and specifications mentioned above are only applicable to ISPSoft version 3.00 or above. The older 

versions are not equipped with complete functions. 
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3.1.1 Installing ISPSoft 

When the previous version of ISPSoft is detected on a computer, that version is advised to be uninstalled first before 

the latest ISPSoft can be installed. 

(1) Start your computer and enter the operating system. You have to log in to the system as a system administrator 

before installing ISPSoft.  

(2) Put an ISPSoft CD in the CD-ROM drive, or download the installation program from the official Delta website 

http://www.deltaww.com/ to download ISPSoft. (The installation programs need to be decompressed if 

downloaded from the internet.) 

(3) Click Start, and Run… to open the Run window. Specify the path denoting the executable file which is used to 
install COMMGR in the Open box, and then click OK. Alternatively, you can double-click the ISPSoft setup icon 
to execute the installation program. 

 
 

(4) When a previous version of the ISPSoft is found, click OK and then Yes to uninstall that version shown in the 
pop-up windows (see below).     

 
 
 

http://www.deltaww.com/
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(5) Click Install once Shield Wizard window appears. 
 

 
 
 

(6) It is required to have Microsoft Visual C++ 2013 on your computer. If Microsoft Visual C+ 2013 is NOT installed 
on your computer, the system will ask your permission to start the installation. Follow the steps below.  
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(7) Then, click Next for the next step.  
 

 
 
 

(8) Choose I accept the terms in the license agreement. Click Next to proceed to the next step. 
 

 

 
 

(9) Fill in the blanks and then click Next for the next step.  
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(10) Check the installation information, and then click Install. 
 

 
 
 

(11) After installation is complete, click Finish to continue the next step. 
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(12) After that HWONFIG will be installed. If there is a previous version of HWCONFIG, the system will ask if you want 
to replace the old HWCONFIG with a new one. Click OK and then make sure if you want to delete your 
HWCONFIG settings. And then the old version of HWCONFIG is removed.  

 

 
(13) After the old version of HWCONFIG is removed, an installation of a new HWCONFIG will begin.  
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(14) After the installation of HWCONFIG is complete, click Finish. 
 

 

 
 
(15) When installation is complete, shortcuts to the software is created on the desktop and Start menu. Click Close to 

exit the setup.   
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3.1.2 Uninstalling ISPSoft 

(1) Generally, you can click ISPSoft Uninstall or choose Programs under Control Panel to remove the ISPSoft; 

when ISPSoft Uninstall is not found, there are two methods to uninstall the software: 

 Method 1: Choose ISPSoft x.xx from the Windows list, click More then select Open file location. 

 Method 2: Place %ProgramData%\Microsoft\Windows\Start Menu\Programs\Delta Industrial 

Automation\PLC\ in the address box and press Enter. Then, double click ISPSoft x.xx file.  

 

 

(2) Remove the software by double-clicking the ISPSoft UnInstall. 
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(3) To uninstall ISPSoft, click Yes shown in the pop-up window. The window will automatically close once the 
software is removed.    
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3.2 Installing DIADesigner 

 System requirements 

Project System Requirement 

Operating System Windows 10 (32/64 bits) 

CPU Intel Core i5 M520 2.4 GHz or later 

Memory 4GB or more 

Hard Disk Drive 15GB or more 

Monitor Resolution: 1024 x 768 pixels or 1920 x 1080 pixels 

Keyboard/Mouse General Keyboard Mouse or Windows compatible device 

PC interface Ethernet, USB, Serial port (depends on product interface) 

Software Need to install .Net Framework 4.7.2 

 

Before installation begins, make sure the computer used for installing DIADesigner meets the minimum system 

requirements listed above.  

Note: DIADesigner V1.2.3 is NOT compatible with Windows 7 operating systems. If you are installing DIADesigner 

V1.2.3 on Windows 7, an error message will be shown as below. 

 

 

The DIAInstaller is a software installer which assists you to download and install DIAStudio software applications. 

You can download, install, and update products such as DIASelector, DIADesigner, DIAScreen, and COMMGR. Go 

to https://diastudio.deltaww.com/ to download the DIAStudio for DIAInstaller.    

 

Refer to Software Download manual for detailed information.  

 

 

https://diastudio.deltaww.com/
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After installing DIADesigner, double-click its shortcut icon to launch DIADesigner. 

 
 
DIADesigner displays the startup screen as shown in the following figure. 
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3.3 Installing and Uninstalling COMMGR 

3.3.1 Installing COMMGR 

COMMGR is an independent software. It must be installed separately. When the previous version of COMMGR is 

detected on a computer, that version is advised to be uninstalled first before the latest COMMGR can be installed. 

(1) Start your computer and enter the operating system. You have to log in to the system as a system administrator 

before installing COMMGR. 

(2) Put a COMMGR CD in the CD-ROM drive, or download the installation program from the official Delta website 

http://www.deltaww.com/. (The installation programs need to be decompressed if downloaded from the internet.) 

(3) Click Start, and then click Run… to open the Run window. Specify the path denoting the executable file which is 

used to install COMMGR in the Open box, and then click OK. Alternatively, you can double-click the Delta 

COMMGR setup icon to execute the installation program. 

 

(4) When the previous version of COMMGR is installed, click OK to remove that version shown in the pop-up 

window (see below) and when uninstall is complete, click OK again.  

 

http://www.deltaww.com/
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(5) Click Next after the Setup window appears. 

 
 

(6) Use default setup in the destination folder. Click Install to start the installation. 
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(7) When the installation is complete, the shortcut for COMMGR is created on the Start menu, click Finish to close 

the setup.    
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3.3.2 Uninstalling COMMGR 
(1) Enter the settings of Apps & features in Windows, select COMMGR x.xx and click Uninstall. 

 

 

 
(2) Click Yes and then OK to complete COMMGR uninstallation.   
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4.1 DVP-ES3/EX3 Series 

4.1.1 DVP-ES3/EX3 Hardware Framework 

The DVP-ES3/EX3 series programmable logic controller is a small programmable logic control (PLC). The 

execution speed and memory capacity are increased. Use of function blocks is also supported. In order to 

meet more advanced application requirements, the DVP-ES3/EX3 series programmable logic controllers 

provide more flexible system extension framework. Under such hardware framework, you do not need to use 

several CPU modules to control the system if there are excessive I/O points or the device is too far away. This 

new hardware framework maintains the integrity of the system and allows users to work more efficiently during 

the project development process.   

One CPU module is the minimum requirement for DVP-ES3/EX3 hardware framework.   

DVP-ES3/EX3 CPU module (the example below uses DVP-ES3 AC power supply model) 

X 0 X10E thernet X1 X2 X 3 X11 X 12 X13 X14 X 15 X16 X17S/S X4 X5 X 6L N X7

Y 0 Y10 Y 11 Y 12 Y13 Y14 Y15 Y16 Y17DDSG Y 1 Y2 Y 3 Y4 Y5 Y 6 Y7DD ++ C0

 

The following lists the limits for setting up a common framework of the DVP-ES3/EX3 PLC system. Exceeding 

the first two limits causes the PLC to send an error message.  

Limit 1: The maximum number of digital I/O points is 256. The built-in digital I/O points of the CPU module are 

included. If DI points are 200, you have no more than 56 DO points. 

Limit 2: You can connect up to 8 modules (AD, DA, XA, PT, TC or PU) to the PLC.  

Limit 3: The maximum power consumption of CPU module and extension module should be within the range 

of what a CPU module or a power module can supply. Refer to section 4.1.5.4 for the maximum power 

consumption of modules. 
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4.1.1.1 Necessary Components 

A functioning DVP-ES3/EX3 Series system consists of the following two necessary components. 

 CPU module (AC power) 

A CPU module is the nucleus of a complete DVP Series system. It is responsible for controlling and 

managing the whole system. Delta Electronics, Inc. provides various business sectors with several types 

of CPU modules. Select a CPU module according to your needs. 
 

X 0 X10E thernet X1 X2 X 3 X11 X 12 X13 X14 X 15 X16 X17S/S X4 X5 X 6L N X7

Y 0 Y10 Y 11 Y 12 Y13 Y14 Y15 Y16 Y17DDSG Y 1 Y2 Y 3 Y4 Y5 Y 6 Y7DD ++ C0

 
 
 Communication cable 

Several communication interfaces are included in a CPU module, and many types of network modules 

are available. You can choose communication cables to use according to the actual usage situation. 

The following table lists information about communication interfaces and main applications. 

Interface Connector Application 

Communication port 
5-pin removable 

terminal block 

Computer, HMI communication, industrial control network  

(2x RS-485)  

Ethernet RJ45 
Computer, HMI communication, remote control, data 

exchange, industrial control network 

USB Mini USB Computer communication 

 

4.1.1.2 Optional Components 

 Extension modules 

Apart from the standard communication ports on a CPU module, the CPU module is equipped with I/O 

functions. Refer to section 1.1.2 for a selection of extension modules. You can find a suitable extension 

module according to your needs.  
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4.1.2 Notes on Installation  

 System integrators shall be responsible for assembly of the control system and the safety of the system 

integration.     

 If using the device other than those described in the standard, or in environments that do not meet the 

specifications in this manual, the designed protection for the device in the presence of conducted and/or 

radiated interference may be reduced. 

 DVP32ES311T: For power supplies, it is required to use safety extra-low voltage circuit (SELV) or a 

galvanic separation with double insulation (DI) or reinforced insulation (RI) between the primary and 

secondary side.   

 Use only a clean, dry and soft cloth to clean this module.  

 Before a module is installed, please make sure of the size of the module. To ensure sufficient installation 

space, you must take into account the size of the communication cable connector and the room which 

needs to be reserved. 

 Make sure that the work environment conforms to the specifications for the products. It is necessary to 

take into account basic temperature/humidity control and dust/corrosion prevention. 

 Electromagnetic interference can result in system malfunction. Therefore, you must design the EMC 

carefully. Please refer to Appendix C in this manual for more information on EMC standards. 

 If components such as screws and washers are specified in the manual, use components conforming to 

the specifications. 

 If a cable is connected to a communication port, make sure the cable connector is properly joined to the 

port on the module. 
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4.1.3 Installation 

A PLC has to be installed in a closed control box. In order to ensure that the PLC radiates heat normally, the 

space between the PLC and the control box must be larger than 50 millimeters. 

 

>50mm

>50mm

>50mm
 

 Keep the PLC away from high-voltage equipment, high-voltage wires, and high-voltage motors. 

 In order to prevent the PLC from overheating, do not install the PLC vertically on the bottom or top of the 

control box. 

 Install the PLC horizontally in the control box, as shown above. 

 If you intend to increase the number of modules, you must leave some space for installing the modules in 

the control box. 

 

4.1.3.1 Mounting the Module 

 Direct mounting: Use M4 screws to mount the module through the mounting hole. 

 DIN rail installation and removal: The module can be secured onto a cabinet by using the DIN rail. To 

secure the module onto the DIN rail, link it onto the rail as the figure below shown (1) and gently push it 

up on the clip as the figure below shown (2) until you hear a click. To remove it, use a flat head 

screwdriver and press it gently on the groove of the retaining clip, pull down the retaining clip and gently 

pull the PLC away from the DIN rail. 
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4.1.3.2 Linking the CPU Module and a Module 

Step 1: Use a flat head screwdriver to open the side cover on the CPU module for linking a module.  

 

Step 2: Use a flat head screwdriver to release the I/O module securing clip.  

 

Step 3: Connect the CPU module and the module with the I/O connecting ports. 
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Step 4: Push the two I/O module securing clips towards the directions as the arrows below shown to hook 

the modules together.   
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4.1.4 Wiring  

 
 
 
 
 
 
 
 

 

 Before installing or wiring a module, you must verify that the external power supply is turned 

off. Otherwise, you may get an electric shock, or the product may be damaged. 

 After you complete installing or wiring the module, make sure that a terminal block cover is 

installed on the module before turning on the power supply or operating the module. If the 

terminal block cover is not installed properly, you may get an electric shock, or the module 

may not operate normally.  

 Be sure the protective ground connection (PE)  and functional ground (FE)  FE are 

with protective grounding conductors. Otherwise, you may get an electric shock, or the 

module may not operate normally. 

 To ensure that a PLC is wired correctly, you must check the rated voltage of the product and 

the arrangement of the terminals. If the PLC is connected to a power supply that does not 

conform to the rated voltage, or the product is not wired correctly, a fire may occur, or the 

product may be damaged. 

 The external connections should be crimped, press-welded by specific tools, or soldered 

correctly. Improper connections may result in a short circuit, fire, or malfunction. 

 Tighten the terminal screws to the specified torque. If the terminal screws are loose, a short 

circuit, fire, or faulty operation may occur. Tightening the terminal screws too far may cause 

damage to the terminal screws or the module, resulting in a short circuit or malfunction. 

 Make sure there are no foreign substances such as iron filings or wiring debris inside the 

module. Foreign substances may result in a fire, damage, or malfunction. 

 Things to note while wiring an I/O module 

(1) Terminal definitions 

◆ Two-/three-wire (passive sensor): the sensor and the system share the same power circuit.   

◆ Four-wire (active sensor): the sensor uses an independent power supply and should not share the 

same power circuit with the system. 

(2) Terminals with insulation sleeves cannot be used as a terminal block. It is recommended that the 

terminals be covered with insulation tubes. 

(3) For wiring, use single-wire cables or two-wire cables with a diameter of 24 AWG to 12 AWG and use 

it with a less than 2 mm needle type terminal (with the insulated coating crimp sleeve). Only use 

copper conducting wires with a temperature rating of 60/75°C. The tightening torque of the PLC 

terminal screw is 3.8 kgf-cm (3.3 lbf-in). 

8-10 mm< 2 mm 24-12 AWG  
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Note: The wire diameter specifications are different, since the output wiring of the relay model varies  

      depending on the type of power supply provided. For details, refer to section 4.1.7.1. 

(4) Keep the input cables, output cables, and power cable separate from one another.  

(5) If the main circuit and the power cable cannot be separated from each other, use a shielded cable, 
and ground it at the side of the I/O module. In some cases, the shielded cable can be grounded at 
the opposite side. 

 

(6) If you wire a module through conduit, you must ground the conduit correctly. 

(7) Keep 24 VDC input cables separate from 110 VAC input cables and 220 VDC input cables. 

(8) If the wiring length is more than 200 meters (686.67 inches), leakage current can result from parasitic 
capacitance, and the system will not function properly. 

 

 Things to note while grounding 

1. Use correct and independent method to grounding. 

2. Use single-wire cables or two-wire cables in a diameter of 18 AWG to 12 AWG and with less than 2 mm 
pin-typed terminals. 

                      8-10 mm< 2 mm 18-12 AWG  

3. Make the grounding point close to the PLC and make sure ground the surge protector and the PLC 
system. 
 

Notes:  

(1) Use 110 V/220 V power cable and the 24 VDC power cable with a diameter of 18-12AWG and with less 
than 2 mm pin-type terminals. Be sure to twist the power cables at the terminal screws. To prevent a 
short circuit from loose screws, you must use solderless terminals with insulation sleeves. 

8-10 mm< 2 mm 18-12 AWG  

(2) If cables are connected to the terminals / , you must ground the cables. Do not connect /  to 
any devices. If /  are not grounded, the PLC will be susceptible to noise. Since /  carries 
electric potential, you will get an electric shock if you touch the metal parts. 

Shielded cable 

AC power  
supply 

Load through which the 
alternating current passes 
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4.1.5 Connecting Power Cables 

4.1.5.1 Precautions 

 Connecting AC power cables 

(1) The cables carrying the 110 VAC, 220 VAC, and 24 VDC should be single or two-wire cables. 

(2) Do not bundle 110 VAC cable, 220 VAC cable, 24 VDC cable, the (high-voltage high-current) main 

circuit, and the I/O signal cable together. The distance between adjacent cables should be more 

than 100 millimeters (3.94 inches). 

(3) To prevent electrical surge from lightning, install a surge protector as shown below. 

        

Surge absorber

Power Supply
100~240VAC

ES3/EX3
CPU 

Module

 

 

Things to note while grounding  

1. Ground the surge protector and the PLC system. 

2. Select the surge protector with a working voltage that is not less than the maximum allowable input voltage. 

 

4.1.5.2 Grounding 

 The diameter of the ground should not be 
less than the diameters of the cables 
connected to the terminals L and N. 

 If using multiple pieces of equipment, use 
a single-point ground. 

ES3/EX3
CPU Module

Another piece of 
equipment

The single-point ground is better.

 
 

 If you cannot use a single-point ground, 
use a common-point ground. 

      

ES3/EX3
CPU Module

The common-point ground i s permitted.

Another piece of 
equipment

               
 Do not connect equipment ground wires 

together as shown on the right.  
ES3/EX3 

CPU Module
 

The equipment can not be grounded in t his way.

Another p iece of 
equipment

 
 
 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual   

4-12  

_4 

4.1.5.3 Wiring Power Supply  

• Connecting an AC power cable 

 

 

 

 

 

 

 

The power input of DVP-ES3/EX3 is the AC input. 

 The alternating-current input voltage is between 100 VAC–240 VAC. Connect the power supply to the 

terminals L and N. If you connect the 110 VAC or the 220 VAC power supply to the input terminals +24V 

and 24G, you will damage the PLC. 

 If a power outage lasts for less than 10 milliseconds, the PLC keeps running without being affected. If the 

power outage lasts longer, or if the voltage of the power supply decreases, the PLC stops running, and 

there is no output. When the power supply returns to normal, the PLC resumes operating. Note that there 

are latched auxiliary relays and registers in the PLC when you write the program. 

 Use single-wire cables or two-wire cables in a diameter of 12 AWG to 18 AWG and with less than 2 mm 

pin-typed terminals. Only use copper conducting wires with a temperature rating of 60/75°C. 

  
 

  

L N DV P-E S3/EX3 06XA

  2 4V0V

     1 00~240V

 

AC/DC
Con ve rter

Cont rol bo x

 

18 12
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• Connecting an DC power cable 

 
 

 

 

 

 

 

 

Note: Use appropriate power supply according to your device choice.  

 

4.1.5.4 Power Consumption  

Classification  Model name Internal power 
consumption (mA) 

Internal power 
consumption (W) 

External power 
consumption (W) 

CPU 
 module 

DVP32ES311T 100 2.4 0.48 
DVP32ES300T 100 2.4 0.48 
DVP32ES300R 180 4.32 - 
DVP48ES300T 100 2.4 0.72 
DVP48ES300R 220 5.28 - 
DVP64ES300T 110 2.64 0.96 
DVP64ES300R 260 6.24 - 
DVP80ES300T 110 2.64 1.2 
DVP80ES300R 300 7.2 - 

DVP32ES300TEC 130 3.12 0.48 
DVP22EX300T    
DVP22EX300R    

DVP28EX300MT 150 3.6 0.48 
DVP36EX300T 150 3.6 0.72 
DVP36EX300R 210 5.04 0.72 

Digital /O 
module 

DVP08XM211N 10 0.24 - 
DVP08XP211R 30 0.72 - 
DVP08XP211T 12 0.29 0.12 
DVP08XN211R 55 1.32 - 
DVP08XN211T 12 0.29 0.24 
DVP16XM211N 14 0.34 - 
DVP16XP211R 14 0.34 1 
DVP16XP211T 14 0.34 0.36 
DVP16XN211R 14 0.34 1.9 
DVP16XN211T 16 0.38 0.72 
DVP24XP200R 12 0.29 - 
DVP24XP200T 14 0.34 0.36 
DVP24XN200R 14 0.34 - 
DVP24XN200T 18 0.43 0.72 
DVP32XP200R 14 0.34 - 

E S3/EX3 06XA

24V 0V

24V0V

Co ntro l box
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Classification  Model name Internal power 
consumption (mA) 

Internal power 
consumption (W) 

External power 
consumption (W) 

DVP32XP200T 16 0.38 0.72 

Analog I/O 
module  

DVP04AD-E2 15 0.36 1 
DVP02DA-E2 15 0.36 1.5 
DVP04DA-E2 15 0.36 3 
DVP06XA-E2 16.7 0.4 2.5 

Temperature 
measurement 

module 

DVP04PT-E2 15 0.36 1.5 
DVP06PT-E2 16.7 0.4 1.5 
DVP04TC-E2 15 0.36 1.2 

Positioning 
module DVP02PU-E2 60 1.44 - 
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4.1.6 Wiring Digital Input Terminals on CPU Modules  

4.1.6.1 Direct Current Power Supply (24 VDC) 

When the digital input signal is DC input, there are two DC input types, Sinking and Sourcing. See the 

definition below. 

 Sinking  Sourcing 

Sink = The current flows into the X end. 

S/S

 X0

 

Source = The current flows from the X end. 

 S/S

 X0

 
 

4.1.6.2 Relay Types 

• Sinking 

 

S/S

 X0

I/O

Internal ci rcuit

24VDC
+

Internal circuit

Sourcing 

 

S/S

 X0

I/O

Internal c ircuit

24VD C
+

Internal circuit
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4.1.6.3 Open-collector Input Types 

• Sinking (PNP input type) 

 

S/ S

 X0
I/O

Inter nal c ircuit

24VDC
+

+ Vcc

0V

PNP

Internal circuit

 
• Souring (NPN input type) 

 

S/S

 X0
I/O

Internal Circuit

+Vcc

0V

24VDC

+

NPN

Internal circuit

 

 
4.1.6.4 Two-wire Proximity Switch 

Use the two-wire proximity switch whose leakage current IL is less than 1.5 mA when the switch is OFF. If the 

leakage current is larger than 1.5 mA, connect the divider resistance Rb using the formula below. 

5.1
6
−

≤
IL

Rb （k Ω） 

 
 
• Sinking 

S/S

 X0
I/O

Internal C ircuitRb

I L

24VDC
+

Two-wir e Proxim ity Sw itch  
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• Souring  

S/S

 X0
I/O

Internal CircuitRb

IL

24 VDC
+

Two-wir e Proxim ity Sw itch  

 

4.1.6.5 Three-wire Proximity Switch 

• Sinking  

S/S

 X0

I/O

Internal Circuit

24VDC

+

Three-w
ire Proxim

ity S
w

itch

 
 
• Souring  

 

S/S

 X0
I/O

Internal Circuit

24VDC
+

Three-w
ire P

roxim
ity S

w
itch
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4.1.6.6 Optoelectronic Switch 

• Sinking  

 

 
• Souring  

 

Above 
15 V DC

O p to e le c t r o n ic  s w it c h

In te r n a l 

c ir c u it

S/S

 X0.0

I/O

24VDC

Above 
15 V DC

O p to e le c t r o n ic  s w it c h

In t e r n a l 

c ir c u it

S/S

 X0.0

I/O

24VDC
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4.1.7 Wiring Digital Output Terminals on CPU Modules  

Use single-wire cables or two-wire cables in a diameter of 24 AWG to 12 AWG and with less than 2 mm pin-

typed terminals. Only use copper conducting wires with a temperature rating of 60/75°C. The tightening torque 

of the PLC terminal screw is 3.8 kgf-cm (3.3 lbf-in). 

8-10 mm< 2 mm 24-12 AWG  
 

4.1.7.1 Output Circuits 

There are two types of output units. They are relay outputs and transistor outputs. 

1. Relay output 

The wire diameter specifications are different, since the output wiring of the relay model varies depending on 
the type of power supply provided. Only use copper conducting wires with a temperature rating of 60/75°C. 
And the tightening torque of the PLC terminal screw is 3.8 kgf-cm (3.3 lbf-in). 

 AC Power DC Power 

Specification 
 

8-10 mm< 2 mm 18-16 AWG-  8-10 mm< 2 mm 24-12 AWG  

Wiring 10 250VAC~
Max. 2A

I/O Relay
Y0

C0
 

 I/O Relay
Y0

C0

5~30VDC
Max. 2A

 

Note: Use the same voltage (10-250 VAC or 5-30 VDC) for the output terminals of the relays in the same 

common point COM (those with the same color in the figure below).  

C0 Y0 Y1 Y2 Y3 ˙ C1 Y4 Y5 Y6 Y7 

 

2. Transistor output 

ZP

Y0

UP

+  24
VDC0.5A

 ZP

Y0

UP

+
  24
VDC0.5A

+
5-30
VDC
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4.1.7.2 Relay Output Circuit 

Relay terminals have no polarity. They can be used with alternating current that passes through a load, or with 

direct current that passes through a load. The maximum current that can pass through every relay terminal is 

2 A, and refer to each product specification for the maximum current that can pass through every common 

terminal. The lifetime of a relay terminal varies with the working voltage, the load type (the power factor cosψ), 

and the current passing through the terminal. The relation is shown in the life cycle curve below. 

Contact Current(A)

20

0.50.1 0.2

30
50

0.3 0.7 1 2

200
300
500

100

1000
2000
3000

O
pe

ra
tio

n(
X

10
)3

120VAC Resistive
30VDC Inductive(t=7ms)

240VAC Inductive(cos 0.4)ψ=
120VAC Inductive(cos =0.4)ψ

30VDC 
Inductive
    (t=40ms)

 

 Relay output circuit 

 Y0 Y1 Y2 C0 Y3 Y4 Y5 Y6 Y7C0

 
 

① Direct-current power supply 

② Emergency: stop using an external switch. 

③ Fuse: to protect the output circuit, a fuse having a breaking capacity between 5 A to 10 A is connected 
to the common terminal.  

④ Alternating-current power supply 
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⑤ 

A relay or a solenoid valve is used as a DC load. A diode is connected in parallel to absorb the surge 
voltage that occurs when the load is OFF. 

 

⑥ 

An electromagnetic contactor is used as an AC load. A resistor and a capacitor are connected in 
parallel to absorb the surge voltage that occurs when the load is OFF. 

 Electromagnetic contactor

Y7

C0

 

 

V D C power supply  

C0
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⑦ 

A bulb (incandescent lamp) is used as a DC load. A thermistor is connected in series to absorb the 
surge current that occurs when the load is ON. 

V DC power supply

Y1 Y2/

C0

 
A bulb (neon lamp) is used as an AC load. A thermistor is connected in series to absorb the surge 
current that occurs when the load is ON. 
 

Y6/Y7

C 0

 

○8  

Mutually exclusive output: For example, Y3 controls the clockwise rotation of the motor, and Y4 
controls the counterclockwise rotation of the motor. This interlock circuit and the program in the PLC 
ensure that there are protective measures if an abnormal condition occurs. 
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4.1.7.3 Transistor Output Circuit (NPN) 

 

 

 

① Direct-current power supply 

② Emergency stop 

③ Fuse 

④ 

Using surge absorbing diodes to extend the lifespan of contacts 
1. A diode is connected in parallel to absorb the surge voltage: used in low-power situations.  

VDC
+

D

ZP

Y

UP
Low power

D: 1N4001 Diode or its equivalent  
 

2. A diode and Zener are connected in parallel to absorb the surge voltage: used in high-power and 
power-on/off frequently situations. 

ZD D

VDC
+

ZP

Y

UP
High power and 
ON/OFF frequen tly

ZD: 9V Zener, 5W
D: 1N4001 Diode or its equivalent

 

⑤ 
Mutually exclusive output: For example, Y2 controls the clockwise rotation of the motor, and Y3 
controls the counterclockwise rotation of the motor. This interlock circuit and the program in the PLC 
ensure that there are protective measures if an abnormal condition occurs. 
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4.1.8 Wiring Differential Input/Output Module 
(28EX300MT) 

X3+
 X3-

5V

SG

4.7k

10k

5V

GND

X2+
 X2-

5V

SG

4.7k

X1+
 X1-

5V

SG

4.7k

X0+
 X0-

5V

SG
10k

4.7k

10k

5V

GND

FP Y3+
Y3- 100k

2k

2k

FP Y2+
Y2-

100k

2k

2k

FP Y1+
Y1- 100k

2k

2k

FP Y0+
Y0.0-

100k

2k

2k
Y0-

Y0.0-SG0 GND

ASDA-A2

Y0.0-SG1

Shielded cable

5V

GND

5V

GND

10k

10k

10k

10k

10k

Dif ferent ial inputs

Shielded cable

Shielded cable

Shielded cable

Shielded cable

Shielded cable

Shielded cable

Shielded cable
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4.1.9  Wiring PLC CPU Analog Input /Output Module  
        (EX3 Series) 

 
1M

AG

1M

1M

AG

1M

250

250

VO1
IO1
 AG

Current output
0mA~20m A

AG

VO0

IO0
 AG

Voltage output
- 10V~+10V

*5

AG

1M

AG

1M

250

Shi elded cable*1
4-w ire: voltage i nput

-10V~+ 10V CHX-I

2 wi re: Curr ent i nput- :

*3

*2

+

-

- 20m A~+ 20mA

V0+
I0+

 VI0-

*2+
-

+
-

+24V

0V

+24V

0V

4m A~+ 20m A
+24V

0V

1M

AG

1M

250

3 wi re: Vol tage i nput- :

1M

AG

1M

250

- 20m A~+ 20mA

3 wi re: Current i nput-  :

+24V +

-

*2

-10V~+ 10V

+24V +

-0V

0V

*6

CHX-I
*6

CH X- I
*6

CHX-I
*6

CHX-I
*6

CH X- O
*6

C HX-O
*6

V1+
I1+

 VI1-

V1+

I1+
 VI1-

V0+
I0+

 VI0-

V1+
I1+

 VI1-

Shi elded cable*1

Shi elded cable*1

Shi elded cable*1

Shi elded cable*1

Shi elded cable*4

Shielded cable*4

AC motor drive, 
recorder, 
proportion ing valve

AC motor drive, 
recorder, 
proportion ing valve

4 w ire: Curr ent i nput-

 
*1. Use shielded cables to isolate the analog input signal cable from other power cables. 
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*2. If the module is connected to a current signal, the terminals Vn and In+ (n=0–1) must be short-circuited. 

*3. If variability in the input voltage results in interference within the wiring, connect the module to a capacitor 
   having a capacitance between 0.1–0.47 μF and a working voltage of 25 V. 

*4. Use shielded cables to isolate the analog output signal cable from other power cables. 

*5. If variability in the input loading results in interference within the wiring, connect the module to a capacitor 
   having a capacitance between 0.1–0.47 μF and a working voltage of 25 V. 

*6. The wording “CHX-I” indicates that you can use those five wiring methods for every input channel. The 
   wording “CHX-O” indicates that you can use those two wiring methods for every output channel. 

*7. Use terminals with the same length (less than 200 m) and use terminal resistors of less than 100 ohm. 

 

4.1.10 Wiring RS-485 Terminals  

 
D+ D- SG D+ D- SG SG D+ D-
Master Slave Slave

Terminal resistor
(120 ohm)

Shielded cable Shielded cable
 

①  Master ②  Slave ③  Terminal resistor ④  Shielded cable 

Note: Use two-wire shielded cables in a diameter of 20 AWG to ensure a quality communication. 

 

 

4.1.11 Wiring CANopen Terminals  

 GNDCAN+ CAN-

3

4

1 2

3

GNDCAN+CA N- 2GND CAN+CA N-

 

①  Master ②  Slave ③  Terminal resistor ④  Shielded cable 

Note:  

1. It is recommended to use Daisy Chain for connection and be sure to use 120Ω terminal resistor in 

the beginning and the end of the terminal arrangement.  

2. GND is the grounding signal for CANopen network.  
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4.1.12  Recommended USB Wiring for the PLC CPU  

Pin Function 

 

1 VBUS (4.4–5.25 V) 

2 D− 

3 D+ 

4 Ground 

5 Ground 

 When it is the first time to use USB communication, follow the steps below.  
 Refer to Appendix A : Installing a USB Driver, if it is the first time to use USB port to communicate.     
 Time to use the USB port: uploading/downloading PLC programs, monitoring during calibration 

and upgrading firmware.  
 NOT suggested to use the USB port: applications that require a long and un-interruptible 

communication.  
 What to do when a communication failure occurs: unplug any communication connector from the 

USB port and then plug the connector back. After that reconnect and try communication again.   

 
4.1.13 Recommend Ethernet/EtherCAT Wiring for the PLC  
        CPU 

Pin Signal Description 

 

1 TX+ Transmitting data (positive pole) 

2 TX- Transmitting data (negative pole) 

3 RX+ Receiving data (positive pole) 

4 -- N/C 

5 -- N/C 

6 RX- Receiving data (negative pole) 

7 -- N/C 

8 -- N/C 

Refer to Chapter 9 and 11 for more details on Ethernet/EtherCAT Wiring.  
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4.2 DVP-SV3/SX3 Series 

4.2.1 DVP-SV3/SX3 Hardware Framework 

The DVP-SV3/SX3 series programmable logic controller is a small programmable logic control (PLC). The 

execution speed and memory capacity are increased. Use of function blocks is also supported. In order to 

meet more advanced application requirements, the DVP-SV3/SX3 series programmable logic controllers 

provide more flexible system extension framework. Under such hardware framework, you do not need to use 

several CPU modules to control the system if there are excessive I/O points or the device is too far away. This 

new hardware framework maintains the integrity of the system and allows users to work more efficiently during 

the project development process.  

 

The minimum framework of the DVP-SV3/SX3 series system consists of one CPU module (DVP-SV3/SX3 

PLC CPU) and one power supply module (DVPPS01 /DVPPS02/DVPPS05). The power supply module 

converts AC into DC, providing PLC CPU with direct current power supply. A CPU module is the nucleus of a 

complete DVP Series system. It is responsible for controlling and managing the whole system. DVP Series 

PLC CPU provides various business sectors with several types of CPU modules. Select a CPU module 

according to your needs. 

 

Example of a minimum framework: power supply module (on the left side of the PLC CPU) and DVP-SV3/SX3 

CPU module (the example below uses DVP28SV3) 

 



Chapter  4  Ins ta l l ing Hardware  

4-29 
 

4_  

 Communication cable 

Several communication interfaces are included in a CPU module, and many types of network modules 

are available. You can choose communication cables to use according to the actual usage situation. 

The following table lists information about communication interfaces and main applications. 

Interface Connector Application 

Communication port 
10-pin removable 

terminal block 

Computer, HMI communication, industrial control 

network (2x RS-485)  

Ethernet RJ45 
Computer, HMI communication, remote control, 

data exchange, industrial control network 

USB Mini USB Computer communication 

 
 Extension modules 

Apart from the standard communication ports on a CPU module, the CPU module is equipped with I/O 

functions. Refer to section 1.1.3 for a selection of extension modules. You can find a suitable extension 

module according to your needs.  

 

The following lists the limits for setting up a common framework of the DVP-SV3/SX3 PLC system. Exceeding 

the first three limits causes the PLC to send an error message.  

Limit 1: The maximum number of digital I/O points is 512 (256 inputs and 256 outputs). The built-in digital I/O 

points of the CPU module are included. (If DI points are 262, and DO points are 60, that means the DI 

points exceed the limit range.) 

Limit 2: On the right side of the PLC CPU, you can connect up to 8 modules including analog I/O modules, 

temperature measurement modules, positioning modules, communication modules.  

Limit 3: On the left side of the PLC CPU, you can connect up to 8 modules including high-speed analog I/O 

modules, high-speed load cell modules, high-speed communication modules. 

Limit 4: The maximum power consumption of CPU module and extension module should be within the range 

of what a CPU module or a power module can supply. Refer to section 4.2.5.4 for the maximum power 

consumption of modules. 

Limit 5: Up to 14 right-side extension modules can be connected to a DVP slim type PLC CPU. The input point 

starts from X20 and output point starts from Y20. Refer to the combination example below.  
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MPU EXT

1 2
EXT

3
EXT

4
EXT

 

PLC Model Number 
of inputs 

Number 
of outputs Input number Output 

number 

MPU SX3 8 6 X0~X7 Y0~Y5 

EXT1 16SP11T 8 8 X20~X27 Y20~Y27 

EXT2 08SM11N 8 0 X30~X37 - 

EXT3 06SN11R 0 6 - Y30~Y35 

EXT4 08SP11R 4 4 X40~X43 Y40~Y43 

• Though the 3rd extension module 06SN11R will be regarded as a module with 8 output points, the 
number of corresponding actual output points will only be 6; the last 2 output points are excluded.  

• Though the 4th extension module 08SP11R will be regarded as a module with 8 input points and 8 
output points, the number of corresponding actual output points will only be 4 and input points will only 
be 4; the last 4 input and 4 output points are excluded.  

• To have a more orderly arrangement, it is recommended to install modules with true to number of points 
first.  
 

4.2.2 Notes on Installation  

 System integrators shall be responsible for assembly of the control system and the safety of the system 
integration.     

 If using the device other than those described in the standard, or in environments that do not meet the 
specifications in this manual, the designed protection for the device in the presence of conducted and/or 
radiated interference may be reduced. 

 Make sure to use certified power supplies with dual insulation and Safety Extra-Low Voltage (SELV) 
output and ensure that they comply with UL60950 or UL62368 or UL61010-1 and UL61010-2-201, either 
LPS (Limited Power Source) or LE (Limited Energy) requirements.  

 Use only a clean, dry and soft cloth to clean this module.  

 Before a module is installed, please make sure of the size of the module. To ensure sufficient installation 
space, you must take into account the size of the communication cable connector and the room which 
needs to be reserved. 

 Make sure that the work environment conforms to the specifications for the products. It is necessary to 
take into account basic temperature/humidity control and dust/corrosion prevention. 

 Electromagnetic interference can result in system malfunction. Therefore, you must design the EMC 
carefully. Please refer to Appendix C in this manual for more information on EMC standards. 

 If components such as screws and washers are specified in the manual, use components conforming to 
the specifications. 

 If a cable is connected to a communication port, make sure the cable connector is properly joined to the 
port on the module. 
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4.2.3 Installation 

A PLC has to be installed in a closed control box. In order to ensure that the PLC radiates heat normally, the 

space between the PLC and the control box must be larger than 50 millimeters. 

 

>50mm

>50mm

>50mm

>50mm

 

 Keep the PLC away from high-voltage equipment, high-voltage wires, and high-voltage motors. 

 In order to prevent the PLC from overheating, do not install the PLC vertically on the bottom or top of the 

control box. 

 Install the PLC horizontally in the control box, as shown above. 

 If you intend to increase the number of modules, you must leave some space for installing the modules in 

the control box. 

 

4.2.3.1 Mounting the Module 

 Direct mounting: Use M4 screws to mount the module through the mounting hole. 

 DIN rail installation and removal: The module can be secured onto a cabinet by using the DIN rail. To 

secure the module onto the DIN rail, link it onto the rail as the figure below shown (1) and gently push it 

up on the clip as the figure below shown (2) until you hear a click. To remove it, use a flat head 

screwdriver and press it gently on the groove of the retaining clip, pull down the retaining clip and gently 

pull the PLC away from the DIN rail. 

                      

1

2
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4.2.3.2 Linking the CPU Module and a Module 

Step 1: Use a flat head screwdriver to open the side cover on the CPU module and you will see a 

connecting port.  

 

Step 2: Use a flat head screwdriver to release the I/O module securing clip.  

 

Step 3: Connect the CPU module and the module through the connecting port. 
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Step 4: Push the two I/O module securing clips towards the directions as the arrows below shown to hook 

the modules together.   

 

The following is a left-side extension module; you can connect it to the CPU module the same way as the 

right-side extension module does as the example shown above.    

 2

2

11  
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4.2.4 Wiring  

 
 
 
 
 
 
 
 
 

 

 Before installing or wiring a module, you must verify that the external power supply is 

turned off. Otherwise, you may get an electric shock, or the product may be damaged. 

 After you complete installing or wiring the module, make sure that a terminal block cover is 

installed on the module before turning on the power supply or operating the module. If the 

terminal block cover is not installed properly, you may get an electric shock, or the module 

may not operate normally.  

 Be sure the protective ground connection (PE)  and functional ground (FE)  FE are 

with protective grounding conductors. Otherwise, you may get an electric shock, or the 

module may not operate normally. 

 To ensure that a PLC is wired correctly, you must check the rated voltage of the product 

and the arrangement of the terminals. If the PLC is connected to a power supply that does 

not conform to the rated voltage, or the product is not wired correctly, a fire may occur, or 

the product may be damaged. 

 The external connections should be crimped, press-welded by specific tools, or soldered 

correctly. Improper connections may result in a short circuit, fire, or malfunction. 

 Tighten the terminal screws to the specified torque. If the terminal screws are loose, a 

short circuit, fire, or faulty operation may occur. Tightening the terminal screws too far may 

cause damage to the terminal screws or the module, resulting in a short circuit or 

malfunction. 

 Make sure there are no foreign substances such as iron filings or wiring debris inside the 

module. Foreign substances may result in a fire, damage, or malfunction. 

 Things to note while wiring an I/O module 

(1) Terminal definitions 

◆ Two-/three-wire (passive sensor): the sensor and the system share the same power circuit.   

◆ Four-wire (active sensor): the sensor uses an independent power supply and should not share the 

same power circuit with the system. 

(2) Terminals with insulation sleeves cannot be used as a terminal block. It is recommended that the 

terminals be covered with insulation tubes. 

(3) For wiring, use single-wire cables or two-wire cables with a diameter of 24 AWG to 16 AWG and use 

it with a less than 2 mm needle type terminal (with the insulated coating crimp sleeve). Only use 

copper conducting wires with a temperature rating of 60/75°C. The tightening torque of the PLC 

terminal screw is 2.0 kgf-cm (1.77 lbf-in).  

       6-8 mm< 2 mm 24-16 AWG-  
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Note: The wire diameter specifications are different, since the output wiring of the relay model varies 

depending on the type of power supply provided. Refer to sections 4.2.7.1 and 4.2.9.1 for more details. 

(4) Keep the input cables, output cables, and power cable separate from one another.  

(5) If the main circuit and the power cable cannot be separated from each other, use a shielded cable, 

and ground it at the side of the I/O module. In some cases, the shielded cable can be grounded at 

the opposite side. 

 

(6) If you wire a module through conduit, you must ground the conduit correctly. 

(7) Keep 24 VDC input cables separate from 110 VAC input cables and 220 VDC input cables. 

(8) If the wiring length is more than 200 meters (686.67 inches), leakage current can result from parasitic 

capacitance, and the system will not function properly. 

Note: If cables are connected to the terminals / , you must ground the cables. Do not connect /  

to any devices. If /  are not grounded, the PLC will be susceptible to noise. Since /  carries 

electric potential, you will get an electric shock if you touch the metal parts. 

Shielded cable 

AC power  
supply 

Load through which the 
alternating current passes 
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4.2.5 Connecting Power Cables 

4.2.5.1 Precautions 

1. Connect the power supply to the 24 VDC and 0 V terminals. The power supply ranges from 20.4 to 28.8  
   VDC. When the power supply voltage drops below 20.4VDC, the PLC will stop operating, all outputs will      
   turn off, and the ERROR LED will flash rapidly. 

2. If the power-off time is less than 10 ms, the PLC operates unaffected. If the power-off time is longer than 10  
  ms, the PLC will stop operating and all the outputs will be Off. When the power resumes, the PLC resumes      
  to operate. (There are auxiliary relays and registers with power-off retention in the PLC. You need to pay  
  attention to their use when planning a program.) 

3. Use O-type or Y-type terminals for I/O wiring terminals. The specification for the terminals is as shown on  
  the left. Tighten PLC terminal screws to a torque of 5 ~ 8kg-cm (4.3 ~ 6.9 in-lbs). 

 

To suitM3.5 screwterminals

Below6.2

Below6.2

Below 6.2 mm

Below 6.2 mm

Use M3.5 screws

  
4. Avoid tiny metal material enter DVPPS01/02/05 when screwing and wiring. After finishing wire, remove the   
  affix that pasted on the heat sink for heat dissipation.  

5. Only use copper conducting wires with a temperature rating of 60/75°C. 

6. To prevent electrical surge from lightning, install a surge protector as shown below. 

Surge absorber

Power Supply
100~240VAC

DVPPS01
DVPPS02
DVPPS05

 
 

 Environment 

1. DO NOT install the DVPPS01/02/05 in environments with heavy dust, oil fumes, metallic dust, or     
    corrosive or flammable gases.  

2. DO NOT install the DVPPS01/02/05 in environments with high temperature or high humidity. 

3. DO NOT install the DVPS01/02/05 in areas with direct vibration and impact.   
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4.2.5.2 Grounding 

 The diameter of the ground should not be 
less than the diameters of the cables 
connected to the terminals L and N. 

 If using multiple pieces of equipment, use 
a single-point ground. 

ES3/EX3
CPU Module

Another piece of 
equipment

The single-point ground is better.

 
 

 If you cannot use a single-point ground, 
use a common-point ground. 

      

ES3/EX3
CPU Module

The common-point ground i s permitted.

Another piece of 
equipment

               
 Do not connect equipment ground wires 

together as shown on the right.  
ES3/EX3 

CPU Module
 

The equipment can not be grounded in t his way.

Another p iece of 
equipment

 

4.2.5.3 Wiring Power Supply  

PS02 SX3 SV3/ 06XA

24V
0V

Co nt rol Box

24V
0V

L
N

     1 00~240V

2 4V
0 V
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4.2.5.4 Power Consumption  

Classification  Model name 
Internal power 
consumption 

(mA) 

Internal power 
consumption  

(W) 

External power 
consumption  

(W) 

CPU 
 module 

DVP28SV311T 166.67 4 4 
DVP28SV311R 187.5 4.5 4 
DVP28SV311S 166.67 4 4 
DVP20SX311T 208.3 5 4 
DVP20SX311R 229.2 5.5 4 
DVP20SX311S 208.3 5 4 

Digital I/O 
module 

DVP06SN11R 82 1.5 36 
DVP08SN11R 55 1.5 5 
DVP08SN11T 55 1.5 1.2 
DVP16SN11T 65 1 1.2 
DVP08SP11R 35 1.5 5 
DVP08SP11T 35 1.5 1.2 
DVP08SM11N 15 1 0.05 
DVP08SM10N 40 1 0.08 
DVP08SN11TS 15 1.5 2 
DVP08ST11N 55 0.5 0 
DVP16SP11R 65 2 5 
DVP08SP11TS 15 1.5 1.25 
DVP16SP11T 65 2 1.2 

DVP16SP11TS 30 2 2 
DVP16SN11TS 30 1 2 
DVP16SM11N 25 2 0.1 
DVP32SN11TN 40 1.5 2 
DVP32SM11N 40 1 0.16 

Analog I/O 
module 

DVP04AD-S2 30 2 0.083 
DVP04DA-S2 30 4 0.167 
DVP06XA-S2 30 2 0.083 
DVP02DA-S 30 3 0.125 
DVP06AD-S 30 2 0.083 

Left-side high-
speed analog I/O 

module 

DVP04AD-SL 40 3.5 0.015 

DVP04DA-SL 40 3.5 0.08 

Left-side high-
speed load cell 

module 

DVP201LC-SL 100 5 - 
DVP211LC-SL 150 5 4.03 
DVP202LC-SL 140 5 - 
DVP02LC-SL 40 3 0.125 
DVP01LC-SL 40 3 0.125 

Temperature 
measurement 

module 

DVP04PT-S 30 2 0.083 
DVP06PT-S 83 2 - 
DVP04TC-S 30 2 0.083 

DVP08NTC-S 30 1 - 
DVP02TUN-S 55 2.4 0.6 
DVP02TUR-S 60 2.4 0.6 
DVP02TUL-S 75 2.4 0.04 
DVP02TKN-S 55 2.4 - 
DVP02TKR-S 60 2.4 - 
DVP02TKL-S 75 2.4 - 
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Classification  Model name 
Internal power 
consumption 

(mA) 

Internal power 
consumption  

(W) 

External power 
consumption  

(W) 
Positioning 

module DVP01PU-S 100 2.52 0.105 

Left-side 
positioning 

module 
DVP02PU-SL 45 1.08 - 

Left-side high 
speed 

communication 
module 

DVPEN01-SL 62.5 1.5 - 
DVPDNET-SL 50 1.2 0.026 
DVPCOPM-SL 50 1.2 - 
DVPPF02-SL 60 1.5 - 

DVPSCM12-SL 62.5 1.5 - 
DVPSCM52-SL 62.5 1.5 - 
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4.2.6 Wiring Digital Input Terminals on DVP-SV3 Series  

4.2.6.1 Direct Current Power Supply (24 VDC) 

When the digital input signal is DC input, there are two DC input types, Sinking and Sourcing. See the 

definition below. 

 Sinking  Sourcing 

Sink = The current flows into the X end. 

S/S

 X0

 

Source = The current flows from the X end. 

 S/S

 X0

 
 

4.1.6.2 Relay Types 

• Sinking 

 

S/S

 X0

I/O

Internal ci rcuit

24VDC
+

Internal circuit

 

• Sourcing 

 

S/S

 X0

I/O

Internal c ircuit

24VD C
+

Internal circuit
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4.2.6.3 Open-collector Input Types 

• Sinking (PNP input type) 

 

S/ S

 X0
I/O

Inter nal c ircuit

24VDC
+

+ Vcc

0V

PNP

Internal circuit

 
• Souring (NPN input type) 

 

S/S

 X0
I/O

Internal Circuit

+Vcc

0V

24VDC

+

NPN

Internal circuit

 
 

4.2.6.4 Two-wire Proximity Switch 

Use the two-wire proximity switch whose leakage current IL is less than 1.5 mA when the switch is OFF. If the 

leakage current is larger than 1.5 mA, connect the divider resistance Rb using the formula below. 

5.1
6
−

≤
IL

Rb （k Ω） 

 
 
• Sinkin 

S/S

 X0
I/O

Internal C ircuitRb

I L

24VDC
+

Two-wir e Proxim ity Sw itch
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• Souring  

S/S

 X0
I/O

Internal CircuitRb

IL

24 VDC
+

Two-wir e Proxim ity Sw itch
 

 

4.2.6.5 Three-wire Proximity Switch 

• Sinking  

S/S

 X0

I/O

Internal Circuit

24VDC

+

Three-w
ire Proxim

ity S
w

itch

 

 
• Souring  

 

S/S

 X0
I/O

Internal Circuit

24VDC
+

Three-w
ire P

roxim
ity S

w
itch
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4.2.6.6 Optoelectronic Switch 

• Sinking  

 

 
• Souring  

 

Above 
15 V DC

O p to e le c t r o n ic  s w it c h

In te r n a l 

c ir c u it

S/S

 X0.0

I/O

24VDC

Above 
15 V DC

O p to e le c t r o n ic  s w it c h

In t e r n a l 

c ir c u it

S/S

 X0.0

I/O

24VDC
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4.2.7 Wiring Digital Output Terminals on DVP-SV3 Series  

1. There are two types of output modules: relays and transistors. When wiring the output terminals, pay 

attention to the connection of the common terminals.  

2. For relay models, the output terminals Y0, Y1, and Y2 share the common terminal C0; Y3, Y4, and Y5 

share the common terminal C1; Y6, Y7, and Y10 share the common terminal C2; Y11, Y12, and Y13 share 

the common terminal C3. Operation indication: When there is any activity on the output point, its indicator light 

on the front will be ON.  

 

3. For transistor models (NPN), the output terminals Y0, Y1, Y2 and Y3 share the common terminal C0; Y4, 

Y5, Y6 and Y7 share the common terminal C1; Y10, Y11, Y12 and Y13 share the common terminal C2. 

C2 Y10 Y11 Y12 Y13C0  Y0  Y1  Y2 Y3 C1  Y4  Y5  Y6 Y7  

4. For transistor models (PNP), the output terminals Y0 to Y7 share the common terminals UP0 and ZP0; Y10 

to Y13 share the common terminals UP1 and ZP1. 

 

5. Isolation circuit: Optocouplers are used between the internal circuit of the PLC and the input module to 

achieve signal isolation.  
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4.2.7.1 Output Circuits (Relay & Transistor) 

There are two types of output units. They are relay outputs and transistor outputs. 

• Relay output 

The wire diameter specifications are different, since the output wiring of the relay model varies depending on 

the type of power supply provided. Only use copper conducting wires with a temperature rating of 60/75°C. 

The tightening torque of the PLC terminal screw is 2.0 kgf-cm (1.77 lbf-in). 

 AC Power DC Power 

Specification 
 

6-8 mm< 2 mm 18-16 AWG-  6-8 mm< 2 mm 24-16 AWG-  

Wiring 10 250VAC~
Max. 1.5A

I/O Relay
Y0

C0
 

 I/O Relay
Y0

C0

5~30VDC
Max. 1 .5A

 

Note: Use the same voltage (10-250 VAC or 5-30 VDC) for the output terminals of the relays in the same 

common point COM (those with the same color in the figure below).  

C0 Y0 Y1 Y2 ˙ C1 Y3 Y4 Y5  C2 Y6 Y7 Y10 ˙ C3 Y11 Y12 Y13 

 

• Transistor output 

ZP

Y0

UP

+
  24
VDC

0.5A
+5-30

VDC

 

 

C0

Y0

 
5~30VDC
Max. 0.5A
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4.2.7.2 Relay Output Circuit 

Relay terminals have no polarity. They can be used with alternating current that passes through a load, or with 

direct current that passes through a load. The maximum current that can pass through every relay terminal is  

1.5 A and the maximum current that can pass through every common terminal is 4.5A. The lifetime of a relay 

terminal varies with the working voltage, the load type (the power factor cosψ), and the current passing 

through the terminal. The relation is shown in the life cycle curve below. 

Contact Current(A)

20

0.50.1 0.2

30
50

0.3 0.7 1 2

200
300
500

100

1000
2000
3000

O
pe

ra
tio

n(
X

10
)3

120VAC Resistive
30VDC Inductive(t=7ms)

240VAC Inductive(cos 0.4)ψ=
120VAC Inductive(cos =0.4)ψ

30VDC 
Inductive
    (t=40ms)

 

 Relay output circuit 

Y0 Y1 Y2 C1 Y3 Y4 Y5C0

 
① Direct-current power supply 

② Emergency: stop using an external switch. 

③ Fuse: to protect the output circuit, a fuse having a breaking capacity between 5 A to 10 A is connected 
to the common terminal.  
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④ 

Using surge absorbing diodes to extend the lifespan of contacts 
 A diode is connected in parallel to absorb the surge voltage: used in low-power situations 

  

 

+

Y

C0

D

I /O relay ou tpu t
Low p ower

D: 1N40 01 Diod e or it s equivalent 

VDC

 
A diode and Zener are connected in parallel to absorb the surge voltage: used in high-power and 
power-on/off frequently situations. 

 

VDC 
+

Y

C0

I /O relay ou tpu t H ig h powe r a nd 
ON/OFF freq ue ntly

ZD 9 V Zener, 5W

  
     

 

⑤ A bulb (incandescent lamp) is used as a resistive load.  

⑥ Alternating-current power supply 

⑦ 

Mutually exclusive output: For example, using Y3 and Y4 to control the forward and reverse rotation 
of the corresponding motor, creating an interlock in the external circuit. Combined with the PLC 
internal program, this ensures that there are safety measures in place for any abnormal or sudden 
situations. 

○8  

Surge absorber: noises can be reduced on AC loads. 
AC loads

Y

C1

I/O  re lay output
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4.2.7.3 Transistor Output Circuit  

DVP28SV311T (NPN) DVP28SV311S (PNP) 

 

 

 

 

① Direct-current power supply 

② Emergency stop 

③ Fuse 

④ 

Since the output of the transistor module is open collector, if Y0/Y1 is set as pulse outputs, the 
output current of the resistors must be greater than 0.1 A to ensure normal operation. 
1. A diode is connected to absorb the surge voltage: used in low-power situations 

DVP20SX311T (NPN) DVP20SX311S (PNP) 

VDC
+

D

D: 1N4001 Diode or its equiva lent 
C

Y
Low power

 

VDC
+

D
Y

UP

ZP

D: 1N4001 Diode or its equvalent

Low power

 
2. A diode and Zener are connected to absorb the surge voltage: used in high-power and power-
on/off frequently situations. 

DVP20SX311T (NPN) DVP20SX311S (PNP) 

ZD D

C

Y

VDC
+

ZD: 9V Zener, 5W

High power and 
ON/OFF frequently 

D: 1N4001 Diode or its equivalent

 

ZDDZP

UP

VDC +

Y

VDC

+

ZD: 9V Zener, 5W
D: 1N4001 Diode or its equivalent

High power and
ON OFF frequent ly/  
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④ 

Using surge absorbing diodes to extend the lifespan of contacts 
A diode is connected in parallel to absorb the surge voltage: used in low-power situations. 

 

+

Y

C0

D

I /O relay ou tpu t
Low p ower

D: 1N40 01 Diod e or it s equivalent 

VDC

 
 
A diode and Zener are connected in parallel to absorb the surge voltage: used in high-power and 
power-on/off frequently situations. 

ZD D

VDC
+

ZP

Y

UP
High power and 
ON/OFF frequen tly

ZD: 9V Zener, 5W
D: 1N4001 Diode or its equivalent

 

⑤ 

Mutually exclusive output: For example, using Y3 and Y4 to control the forward and reverse rotation 
of the corresponding motor, creating an interlock in the external circuit. Combined with the PLC 
internal program, this ensures that there are safety measures in place for any abnormal or sudden 
situations. 

 
 

4.2.8 Wiring Digital Input Terminals on DVP-SX3 Series  

Refer to section 4.2.6 for more information.  
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4.2.9 Wiring Digital Output Terminals on DVP-SX3 Series  

1. There are two types of output modules: relays and transistors. When wiring the output terminals, pay 

attention to the connection of the common terminals.  

2. For relay models, the output terminals Y0, Y1, and Y2 share the common terminal C0; Y3, Y4, and Y5 

share the common terminal C1; Y6, Y7, and Y10 share the common terminal C2; Y11, Y12, and Y13 share 

the common terminal C3. Operation indication: When there is any activity on the output point, its indicator light 

on the front will be ON.  

 

3. For transistor models (NPN), the output terminals Y0, Y1, Y2 and Y3 share the common terminal C0; Y4, 

Y5, Y6 and Y7 share the common terminal C1; Y10, Y11, Y12 and Y13 share the common terminal C2. 

C2 Y10 Y11 Y12 Y13C0  Y0  Y1  Y2 Y3 C1  Y4  Y5  Y6 Y7  

4. For transistor models (PNP), the output terminals Y0 to Y7 share the common terminals UP0 and ZP0; Y10 

to Y13 share the common terminals UP1 and ZP1. 

 

5. Isolation circuit: Optocouplers are used between the internal circuit of the PLC and the input module to 

achieve signal isolation.  
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4.2.9.1 Output Circuits (Relay & Transistor) 

There are two types of output units. They are relay outputs and transistor outputs. 

• Relay output 

The wire diameter specifications are different, since the output wiring of the relay model varies depending on 

the type of power supply provided. Only use copper conducting wires with a temperature rating of 60/75°C. 

The tightening torque of the PLC terminal screw is 2.0 kgf-cm (1.77 lbf-in). 

 AC Power DC Power 

Specification 
 

6-8 mm< 2 mm 18-16 AWG-  6-8 mm< 2 mm 24-16 AWG-  

Wiring 10 250VAC~
Max. 1.5A

I/O Relay
Y0

C0
 

 I/O Relay
Y0

C0

5~30VDC
Max. 1 .5A

 

Note: Use the same voltage (10-250 VAC or 5-30 VDC) for the output terminals of the relays in the same 

common point COM (those with the same color in the figure below).  

C0 Y0 Y1 Y2 ˙ C1 Y3 Y4 Y5 

 

• Transistor output 

ZP

Y0

UP

+
  24
VDC

0.5A
+5-30

VDC

 ZP

Y0

UP

+
  24
VDC0.5A

+
5-30
VDC

 

 
 

4.2.9.2 Relay Output Circuit 

Refer to section 4.2.7.2 for more information.  
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4.2.9.3 Transistor Output Circuit  

DVP20SX311T (NPN) DVP20SX311S (PNP) 

 

 C0

 
 

 

 

① Direct-current power supply 

② Emergency stop 

③ Fuse 

④ 

Since the output of the transistor module is open collector, if Y0/Y1 is set as pulse outputs, the 
output current of the resistors must be greater than 0.1 A to ensure normal operation. 
1. A diode is connected to absorb the surge voltage: used in low-power situations 

DVP20SX311T (NPN) DVP20SX311S (PNP) 

VDC
+

D

D: 1N4001 Diode or its equiva lent 
C

Y
Low power

 

VDC
+

D
Y

UP

ZP

D: 1N4001 Diode or its equvalent

Low power

 
2. A diode and Zener are connected to absorb the surge voltage: used in high-power and power-
on/off frequently situations. 

DVP20SX311T (NPN) DVP20SX311S (PNP) 

ZD D

C

Y

VDC
+

ZD: 9V Zener, 5W

High power and 
ON/OFF frequently 

D: 1N4001 Diode or its equivalent

 

ZDDZP

UP

VDC +

Y

VDC

+

ZD: 9V Zener, 5W
D: 1N4001 Diode or its equivalent

High power and
ON OFF frequent ly/  

 

⑤ 

Mutually exclusive output: For example, using Y3 and Y4 to control the forward and reverse rotation 
of the corresponding motor, creating an interlock in the external circuit. Combined with the PLC 
internal program, this ensures that there are safety measures in place for any abnormal or sudden 
situations. 
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4.2.10  Wiring SX3 Series Analog Input /Output  

Terminal definitions 

• Two-/three-wire (passive sensor): the sensor and the system share the same power circuit.  

• Four-wire (active sensor): the sensor uses an independent power supply and should not share the same 

power circuit with the system. 

• Use terminals with the same length (less than 200 m) and use terminal resistors of less than 100 ohm. 

 
1M

AG

1M

1M

AG

1M

250

250

VO1
IO1
 AG

AG

VO0

IO0
 AG

Voltage o utput
-10V~+10V

*5

AG

24VDC
D C/DC

Converter

+15V

-15V
AG

*7

*6

*6

 FE

 FE

1M

AG

1M

250

Shi elded cable*1

4 voltage i nput-: 

-10V~+10V
V1+
I1+

 VI1-

CHX-I

V0+
I0+

 VI0-

*3

*2

+

-

V2+
I2+

 VI2-

*2+
-

+
-

+ 24V

0V

+24V

0V

*6
 FE

+24V

0V

1M

AG

1M

250

1M

AG

1M

250
+24V +

-

V1+
I1+

 VI1-

*2

+ 24V +

-

*6
 FE

*6
 FE

0V

0V

 FE
*6

 FE
*6

0V

 24V

*8

CHX-I
*8

C HX-I
*8

CHX-I
*8

CHX-I
*8

C HX-O
*8

CHX-O
*8

V3+
I3+

 VI3-

Shi elded cable*1

Shi elded cable*1

-20mA~+20mA
4 wi re current i nput- : 

4mA~+20mA
4 wi re current i nput- : 

Shi elded cable*1

Shi elded cable*1-20mA~+20mA
3 wi re current i nput- : 

-10V~+10V
3 wire vol tage i nput- : 

0mA~20m A
Voltage o utput

Shielded cable*4

Shielded cable*4

AC motor dri ve,
recorder,
proport ioning value

AC motor dri ve,
recorder,
proport ioning value
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*1. Use shielded cables to isolate the analog input signal cable from other power cables. 

*2. If the module is connected to a current signal, the terminals Vn and In+ (n=0–3) must be short-circuited. 

*3. If variability in the input voltage results in interference within the wiring, connect the module to a capacitor 
   having a capacitance between 0.1–0.47 μF and a working voltage of 25 V. 

*4. Use shielded cables to isolate the analog output signal cable from other power cables. 

*5. If variability in the input loading results in interference within the wiring, connect the module to a capacitor 
   having a capacitance between 0.1–0.47 μF and a working voltage of 25 V. 

*6. Connect the shielded cable to the terminal FE and to the ground terminal. 

*7. Connect the  to the terminal FE. 

*8. The wording “CHX-I” indicates that you can use those five wiring methods for every input channel. The 
   wording “CHX-O” indicates that you can use those two wiring methods for every output channel. 
 

4.2.11  Wiring DVP-SV3/SX3 Communication Ports  

USB

Ethernet

RS-485
CAN

 
 

 USB port 

Pin Function 

 

1 VBUS (4.4–5.25 V) 

2 D− 

3 D+ 

4 Ground 

5 Ground 

 
 Refer to Appendix A : Installing a USB Driver, if it is the first time to use USB port to communicate.     
 Time to use the USB port: uploading/downloading PLC programs, monitoring during calibration 

and upgrading firmware.  
 NOT suggested to use the USB port: applications that require a long and un-interruptible 

communication.  
 What to do when a communication failure occurs: unplug any communication connector from the 

USB port and then plug the connector back. After that reconnect and try communication again.   
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 Ethernet port 

Pin Signal Description 

 

1 TX+ Transmitting data (positive pole) 

2 TX- Transmitting data (negative pole) 

3 RX+ Receiving data (positive pole) 

4 -- N/C 

5 -- N/C 

6 RX- Receiving data (negative pole) 

7 -- N/C 

8 -- N/C 

 
RS-485 Pins and Wiring 
 RS485 Pins  

Pin Signal Description 

1
3
5
7
9

2
4
6
8

10
 

1 + COM1 D+ 

3 - COM1 D- 

5 RSG Signal Ground 

2 + COM2 D+ 

4 - COM2 D- 

 RS-485 Wiring 
 

D+ D- RSG D+ D- RSG RSG D+ D-

Master Slave Slave
Terminal 
resist or

(120 ohm)

Shielded 
cable

Shie lded
cable

 
CAN Pins and Wiring 
 CAN Pins 

Pin Signal Description 

1
3
5
7
9

2
4
6
8

10
 

7 CAN+ CAN_H 

9 CAN- CAN_L 

6 CSG GROUND 

8 
120Ω Terminal resistor 

10 

Note: Pin8 and Pin10 must be short-circuited to activate the built-in terminal resistor 120Ω and work as an 

impedance to reduce noise inference when signal reflections occur and ensure signal can be transmitted 

normally.  
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 CAN Wiring 
 

 
CSGCAN+ CAN-

Master Slave Slave

Shie lded cable

CAN+ CAN- CAN+ CAN-
  Pin10 Pin8  Pin 10 Pin8CSGCSG Pin 10Pin 8

 
1. It is recommended to use Daisy Chain for connection and be sure to use terminal resistor in the 

beginning and the end of the terminal arrangement.  

2. Pin4 and Pin5 must be short-circuited to activate the built-in terminal resistor 120Ω. 
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5.1 Introduction on CPU Devices 
This section describes the values and strings processed by the PLC. It also describes the functions of devices, including 
input, output and auxiliary relays, as well as timers, counters, and data registers. The PLC simulates external devices in 
the PLC’s internal memory, so the word “device” is a generic name that refers to all the internal memory locations in the 
PLC. A device can be a bit device or a word device. Bit devices simulate coils, contacts and flags, while word devices 
simulate registers.  

5.1.1 Device Table 
Type Device name Number of devices Range 

Bit device 

Input relay X 256 X0–X377*1 
Output relay Y 256 Y0–Y377*2 

Data register 
D 48,0000 D0.0–D29999.15 

W 48,0000 W0.0–W29999.15*6 

Auxiliary relay M 8192 M0–M8191 
Special auxiliary relay SM 2048 SM0–SM4095 
Flag S 2048 S0–S2047 
Timer T 512 T0–T511 
Counter C 512 C0–C511 
32-bit counter HC 256 HC0–HC255 

Word device 

Input relay X 64 X0–X63 
Output relay Y 64 Y0–Y63 

Data register 
D 30000 D0–D29999 

W 30000 W0–W29999*6 

Special auxiliary relay SR 2048 SR0–SR2047 

File register FR 65536 FR0–FR65535 

Timer T 512 T0–T511 
Counter C 512 C0–C511 

32-bit counter HC 256（512 words） HC0–HC255 

Index register E 
10 E0–E9 

5 E10–E14*6 

Constant*3 Decimal system K 
16 bits: -32768 to 32767 
32 bits: -2147483648 to 2147483647 

Constant*4 
Hexadecimal system 16# 

16 bits: 16#0–16#FFFF 
32 bits: 16#0–16#FFFFFFFF 

Single-precision floating-
point number F 32 bits: ±1.17549435-38 to ±3.40282347+ 38 

String*5 String “$” 1–31 characters 

*1. For DVP-SV3/SX3 series PLC, 16 inputs (X0-X17) and 16 outputs (Y0-Y17) are taken. For DVP20SX3, only 8 inputs
(X0-X7) are taken but since X10-X17 are reserved, the input point for extension is starting from X20.

*2. For DVP-SV3/SX3 series PLC, 16 inputs (X0-X17) and 16 outputs (Y0-Y17) are taken. For DVP28SV3, only 12 inputs
(Y0-Y13) are taken but since Y14-Y17 are reserved, the output point for extension is starting from Y20. For DVP20SX3,
only 6 outputs (Y0-Y5) are taken, but since Y6-Y17 are reserved, the output point for extension is starting from Y20. 



 Chapter  5 CPU and Module Devices 

5-3 

5_  

 
*3: Constants are indicated by K in the device lists in Chapter 5 and Chapter 6 in the DVP-ES3/EX3/SV3/SX3 Series 
Programming Manual. When “K50” appears in the DVP-ES3/EX3/SV3/SX3 Series Programming Manual, enter only 
the number 50 in ISPSoft/DIADesigner. 

*4: Floating-point numbers are indicated by F/DF in the device lists in Chapter 5 and Chapter 6 in the DVP-
ES3/EX3/SV3/SX3 Series Programming Manual, but they are represented by decimal points in ISPSoft/DIADesigner. 
For example, for the floating-point number F500, enter 500.0 in ISPSoft/DIADesigner.  

*5: Strings are indicated by $ in Chapter 5 and Chapter 6 in the DVP-ES3/EX3/SV3/SX3 Series Programming Manual, 
but they are represented by quotes (“ ”) in ISPSoft/DIADesigner. For example, for the string of 1234, enter “1234” in 
ISPSoft. 

*6: Used for editing in ISPSoft/DIADesigner only.  

 

5.1.2 Basic Structure of I/O Storage 

Device Function Access by 
bits 

Access by 
words 

Modify by 
ISPSoft/ 

DIADesigner 
Force the bit ON/OFF 

X Input relay OK OK OK OK 
Y Output relay OK OK OK OK 
M Auxiliary relay OK - OK - 

SM Special auxiliary 
relay OK - OK - 

S Flag OK - OK - 
T Timer OK OK OK - 
C Counter OK OK OK - 

HC 32-bit counter OK OK OK - 
D Data register OK OK OK OK 

SR Special data register - OK OK - 
FR File register - OK*1 - - 
E Index register - OK OK - 

*1: Use an instruction for writing to an FR.  
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5.1.3 Relation Between the PLC Action and the Device Type 

Device type 
 
PLC action 

Non-latched area Latched area 

Device Y Other 
devices File register Other devices 

Power: OFF→ON Cleared Cleared Retained Retained 

Restore to defaults Cleared Cleared Cleared Cleared 

STOP=> 
RUN*1 

The non-latched area is cleared. Cleared Cleared Retained Retained 
The state of the non-latched area is 

retained. Retained Retained Retained Retained 

RUN=> 
STOP*1 

The state of 
device Y is 

cleared. 
SM203=OFF Cleared Retained Retained Retained 

The state of 
device Y is 
retained. 

SM203=OFF Retained Retained Retained Retained 

The state of 
device Y is 

cleared. 
SM203=ON*3 Cleared Cleared Retained Retained 

The state of 
device Y is 
retained. 

SM203=ON Retained Cleared Retained Retained 

SM204 is ON. 
(All non-latched areas are cleared.) *2 Cleared Cleared Retained Retained 

SM205 is ON. 
(All latched areas are cleared.) *2 Retained Retained Retained Cleared 

*1: For more on setting the states, see HWCONFIG in ISPSoft or Hardware Configuration in DIADesigner. The default for 
PLC STOP->RUN is “clear not-latched area”. The default for PLC RUN->STOP is “clear the state of device Y”. 

*2: The SM switches from OFF to ON, the latched areas are cleared. After the clearing is complete, SM switches from 
ON to OFF automatically. 

*3: When SM203=ON, the system clear the non-latched area once. This is available for ES3/EX3 PLC CPU with 
firmware V1.04.00 or later and for SV3/SX3 PLC CPU with firmware V1.00.00 or later.  
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5.1.4 Latched Areas in the Device Range 

Device Function Device range Latched area 

X Input relay X0–X377 All devices are non-latched. 

Y Output relay Y0–Y377 All devices are non-latched. 

M*1 Auxiliary relay M0–M8191 The default range is M6000–M8191. 

SM Special auxiliary relay SM0–SM2047 
Some devices are latched, and cannot be 
changed. Refer to the list of special auxiliary 
relays for more information. 

S*1 Flag S0–S2047 The default range is S512–S1023 

T Timer  T0–T511 All devices are non-latched. 

C*1 Counter C0–C511 The default range is C448–C511 

HC*1 32-bit counter HC0–HC255 The default range is HC128–HC255 

D*1 Data register 
D0–D29999 The default range is D20000–D23999 

W0–W29999 *2 

FR File register FR0–FR65535 All devices are latched. 

SR Special data register SR0–SR2047 
Some are latched, and cannot be changed. 
Refer to the list of special data registers for more 
information. 

E Index register 
E0–E9 All devices are non-latched. 

E10–E14 *2 

*1: For more information on setting the latched area, see HWCONFIG in ISPSoft or Hardware Configuration in 
DIADesigner.. Setting the latched area means the other areas are seen as non-latched areas. The range of latched 
areas cannot exceed the device range. For example, setting M600–M7000 as latched areas makes M0–M5999 and 
M7001–M8191 non-latched areas. 

*2: Used for editing in ISPSoft/DIADesigner only.  
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5.2. CPU Device Functions 
The following flow chart shows the procedure for processing a program in the PLC. 

Input terminal X

D e vic e  m e m o ry

P ro c e s s in g th e p rog ra m

D
e

v
ic

e
 m

e
m

o
ry

R e g en e r a t in g  th e  o utp u t s ig na l

a n d s e n d in g it to th e  o u tp ut  te r m in a l

 

R e g en e r a t in g  th e  in p u t s ig n a l 

D e vic e  m e m o ry

 

 Regenerating the input signal 
1. Before the program is executed, the state of the 

external input signal is read into the memory location 
for the input signal.  

2. When program is executed, the state in the memory 
location for the input signal does not change even if 
the input signal changes from ON to OFF or from OFF 
to ON. The input signal is not refreshed until the next 
scan begins. 

 Processing the program 
After the input signal is refreshed, the instructions in the 
program are executed in order from the start address of 
the program. The results are stored in the device memory.  

 Regenerating the state of the output  
After the instruction END is executed, the state in the 
device memory is sent to the specified output terminal. 

 

5.2.1 Values and Constants 
Name Description 

Bit A bit is the basic unit in the binary system. Its state is either 1 or 0. 

Nibble 
A nibble is composed of four consecutive bits (for example b3–b0). Nibbles 

can represent 0–9 in the decimal system, or 0–F in the hexadecimal system. 

Byte 
A byte is composed of two consecutive nibbles (8 bits, b7–b0). Bytes can 

represent 00–FF in the hexadecimal system. 

Word 
A word is composed of two consecutive bytes (16 bits, b15–b0). Words can 

represent 0000–FFFF in the hexadecimal system. 

Double word 
A double word is composed of two consecutive words (i.e. 32 bits, b31–b0). 
Double words represent 00000000–FFFFFFFF in the hexadecimal system. 

The relation among bits, nibbles, bytes, words, and double words in the binary system is shown in the picture below. 

b31b30 b29 b28 b27b26 b25 b24b23 b22 b21 b20b19 b18 b17 b16 b15b14 b13 b12b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

NB0NB1NB2NB3NB4NB5NB6NB7

BY3 BY2 BY1 BY0

W1

DW

W0

D o u b le  w o rd

W o rd

B yt e

N ib b le

B it
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The PLC uses four types of values to execute the operation according to different control purposes. 

1. Binary number (BIN) 

The PLC uses the binary system to operate on the values. 

2. Octal number (OCT) 
DVP-PLC uses the octal number on the external inut and output device number. For example:  

External input device number: X0~X7, X10~X17, to X377.  

External output device number: Y0~Y7, Y10~Y17, to Y377.  

3. Decimal number (DEC) 

The PLC uses decimal numbers for: 

 The setting value of a timer (T) or the setting value of a counter (C/HC); for example, TMR C0 50 (constant K). 

 The device number S, M, T, C, D, E; for example, M10 and T30 (device number) 

 The constant K, used as the operand in an applied instruction. For example, MOV 123 D0 (constant K). 

4. Binary-coded decimal (BCD) 

A decimal value that is represented by a nibble or four bits so that sixteen consecutive bits represent a four-digit  
  decimal value.  

5. Hexadecimal number (HEX) 

The PLC uses hexadecimal numbers for: 

 The constant 16#, used as the operand in an applied instruction; for example, MOV 16#1A2B D0   

(hexadecimal constant).  

The following table shows the corresponding values. 

Binary Number 
(BIN) 

Octal Number  
(OCT) 

Decimal Number 
(DEC) 

Binary Code Decimal 
(BCD) 

Hexadecimal Number 
(HEX) 

PLC internal 
execution 

X and Y device 
number 

Constant K,  
Device number 

BCD related 
instruction 

Constant 16#,  
Device number 

0000  0 0000 0 
0001  1 0001 1 
0010  2 0010 2 
0011  3 0011 3 
0100  4 0100 4 
0101  5 0101 5 
0110  6 0110 6 
0111  7 0111 7 
1000  8 1000 8 
1001  9 1001 9 
1010  10 - A 
1011  11 - B 
1100  12 - C 
1101  13 - D 
1110  14 - E 
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Binary Number 
(BIN) 

Octal Number  
(OCT) 

Decimal Number 
(DEC) 

Binary Code Decimal 
(BCD) 

Hexadecimal Number 
(HEX) 

1111  15 - F 
10000  16 0001 0000 10 

10001  17 0001 0001 11 
 

5.2.2 Floating-point Numbers 

Floating-point numbers are represented by decimal points in ISPSoft/DIADesigner. For example, the floating-point 
number 500 is represented as 500.0.  

 

5.2.2.1 Single-precision Floating-point Numbers 

Floating-point numbers are represented by a 32-bit register. The representation adopts the IEEE754 standard, and the 
format shown in the following picture.  

S Exponent Mantissa

8-b it 23-bi t

b31 b0

Sign b it
0 : Positive
1: Negative  

Equation: ( ) 127;.121 =××− − BMBES
 

 

The single-precision floating-point numbers range between ±2-126 to ±2+128, and correspond to the range between 

±1.1755×10-38 to ±3.4028×10+38. 

The DVP-ES3/EX3/SV3/SX3 Series PLC uses two consecutive registers for a 32-bit floating-point number. Take (D1, D0) 
for example. 

S E7 E6 E5 E1 E0 A22 A21 A20 A6 A5 A4 A3 A2 A1 A0

b0b1b2b3b4b5b6b20b21b22b23b24b28b29b30b31

2 2 2 2 2 2 2 2 2 2 2 2 22 2

D1(b15~b0) D0(b15~b0)

E xp on e n t ( 8 b its ) Ma n t is s a  (2 3b its)

Ma n t is s a  s ig n  b it (0 : P o s it iv e ; 1 : Ne ga tiv e )
W he n  b 0~b3 1 a re zeros, the con te nt is zero .

T h e p o s it io n  w h e re  th e  d e cim a l p o in t  is  h id d e n
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Example 1: 

23 is represented by a single-precision floating-point number. 
Step 1: Convert 23 into the binary number, 23.0=10111. 

Step 2: Normalize the binary number, 10111=1.0111 ×24 (0111 is the mantissa, and 4 is the exponent.).  

Step 3: Get the value of the exponent. 

∵ E-B=4→E-127=4 ∴ E=131=100000112 

Step 4: Combine the sign bit, the exponent, and the mantissa to form the floating-point number. 

0 10000011 011100000000000000000002=41B8000016 

 

Example 2: 

-23 is represented by a single-precision floating-point number. 

Converting -23.0 into the floating-point number uses the same steps as converting 23.0 into the floating-point number, 
except that the sign bit is 1. 

1 10000011 011100000000000000000002=C1B8000016 

 

5.2.2.2 Decimal Floating-point Numbers 

 Single-precision floating-point numbers and double-precision floating-point numbers can be converted into decimal 
floating-point numbers so people can read them. However, internally the PLC uses single-precision floating-point 
numbers and double-precision floating-point numbers. 

 A 32-bit decimal floating-point number is represented by two consecutive registers. The constant is stored in the 
first register whose number is smaller while the exponent is stored in the register whose number is bigger. Take 
(D1, D0) for example. 

10D e c im a l f lo a ting -po in t nu m b e r= [C on s ta n t        ]*D0
[Ex p on e n t      ]D1

 

Base number D0=±1,000 to ±9,999 

Exponent D1=-41 to +35 

The base number 100 does not exist in D0 because 100 is represented by 1,000×10-1. 32-bit decimal floating-point 
numbers range between ±1175×10-41 to ±402×10+35. 
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5.2.3 Strings 
The PLC can process strings composed of ASCII codes (*1). A complete string begins with a start character, and ends with 
an ending character (NULL code). Strings can have maximum length of 31 characters, and ISPSoft/DIADesigner 
automatically adds the ending character (16#00).  

1. No string (NULL code) is moved. 

 

D0=0 (NULL) 

 

2. The string has an even number of characters. 

 

D0 16#62 (b) 16#61 (a) 

D1 16#64 (d) 16#63 (b) 

D2 0 (NULL) 

 

3. The string has an odd number of characters. 

 

D0 16#62 (b) 16#61 (a) 

D1 16#64 (d) 16#63 (b) 

D2 0 (NULL) 16#65 (e) 
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*1: ASCII code chart 

Hex 0 1 2 3 4 5 6 7 8 9 A B C D E F 

ASCII                 

Hex 10 11 12 13 14 15 16 17 18 19 1A 1B 1C 1D 1E 1F 

ASCII                 

Hex 20 21 22 23 24 25 26 27 28 29 2A 2B 2C 2D 2E 2F 

ASCII SP ! " # $ % & ' （ ） * + ， - . / 

Hex 30 31 32 33 34 35 36 37 38 39 3A 3B 3C 3D 3E 3F 

ASCII 0 1 2 3 4 5 6 7 8 9 ： ; < = > ? 

Hex 40 41 42 43 44 45 46 47 48 49 4A 4B 4C 4D 4E 4F 

ASCII @ A B C D E F G H I J K L M N O 

Hex 50 51 52 53 54 55 56 57 58 59 5A 5B 5C 5D 5E 5F 

ASCII P Q R S T U V W X Y Z      

Hex 60 61 62 63 64 65 66 67 68 69 6A 6B 6C 6D 6E 6F 

ASCII ` a b c d e f g h i j k l M n o 

Hex 70 71 72 73 74 75 76 77 78 79 7A 7B 7C 7D 7E 7F 

ASCII p q r s t u v w x y z { | } –  

Note:  represents an invisible character. Do not use it in strings. 

 

5.2.4 Input Relays (X) 

 Input function 

The input is connected to the input device (external devices such as button switches, rotary switches, and number 
switches), and the PLC reads the input signal. You can use input contact A or contact B several times in the 
program, and the ON/OFF state of the input varies with the ON/OFF state of the input device. 

 Input number (the octal number) 

For the PLC, the input numbers start from X0. The number of inputs varies with the number of inputs on the digital 
input/output modules. The inputs are numbered according to the order in which the digital input/output modules are 
connected to the CPU module. The maximum number of inputs for the PLC is 256, and the input number range is 
between X0 to X377. 

 Refreshing time for inputs 

Inputs are classified into two types. 

1. Regenerated inputs: The PLC reads the state of a regenerated input before the program is executed; for 
example, LD X0. 

2. Direct input: The state of a direct input is read by the PLC during the execution of the instructions; for example, 
LD DX0. 

Note: To refresh the inputs immediately during the scan cycle is only possible for the built-in input points (DX0 
to DX17); not available for inputs points on digital I/O modules.  
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5.2.5 Output Relays (Y) 
 Output function 

The output sends the ON/OFF signal to drive the load connected to the output, such as an external signal lamp, a 
digital display, or an electromagnetic valve. There are four types of outputs. They are relays, transistors (NPN and 
PNP), and TRIACs (thyristors). You can use the output contact A or contact B several times in the program. Use output 
Y only once in the program; otherwise, according the PLC’s program-scanning function, the state of the output depends 
on the circuit connected to the last output Y in the program.  

 Output number (the octal number) 

For the PLC, the output numbers start from Y0. The number of outputs varies with the number of outputs on the digital 
input/output modules. The outputs are numbered according to the order in which the digital input/output modules are 
connected to the PLC. The maximum number of outputs on the PLC is 256, and the range is between Y0 and Y377. 

An output that is not used as an output device can be used as a general device.  

 Refreshing time for outputs 

Outputs are classified into two types. 

1. Regenerated output: The state of a regenerated output is not written until the program executes the END instruction, 
according to the states of the outputs; for example, OUT Y0. 

2. Direct output: The state of a direct output is written by the PLC during the execution of the instructions, according 
to the states of the outputs; for example, OUT DY0. 

Note: To refresh the outputs immediately during the scan cycle is only possible for the built-in output points (DY0 
to DY17); not available for outputs points on digital I/O modules.  

 
 

 

5.2.6 Auxiliary Relays (M) 
The auxiliary relay has contact A and contact B. It can be used several times in the program. You can combine the 
control loops by using the auxiliary relay, but you cannot drive the external load using the auxiliary relay. You can use the 
auxiliary relays in either of the following two ways. 

1. For general use: In general use, if an electric power failure occurs when the PLC is running, the 
auxiliary relay resets to the OFF state. When the power is restored, the auxiliary 
relay remains in the OFF state. 

2. For latched use: In latched use, ff an electric power failure occurs when the PLC is running, the state 
of the auxiliary relay is retained. When the power is restored, the relay state 
remains the same as before the power failure. 

 
5.2.7 Special Auxiliary Relays (SM) 

Every special auxiliary relay has its specific function. Do not use the special auxiliary relays which are not defined. Refer 
to section 2.2.7 in DVP-ES3/EX3/SV3/SX3 Series Programming Manual for more reference.  
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5.2.8 Flags (S) 

You can easily use the flags in industrial automation to set a procedure. It is the most basic device in ladder diagram 
programming.  

There are 2048 flags, (S0–S2047). Every flag is like an output relay in that it has an output coil, contact A, and contact B. 

You can use a flag several times in a program. There are two kinds of flags. 

A. General-purpose flags 

When the power is OFF during execution, all the device states are cleared to OFF. When the power is turned back 
ON, the device states are kept as OFF.  

B. Latch-purpose flags 

When the power is OFF during execution, all the device states are remembered. When the power is turned back 
ON, the devices states are restored as they are before the power interruption.   

 

5.2.9 Timers (T) 

This topic describes the timers available in ISPSoft. Refer to the ISPSoft User Manual for more information on timers. 

 100 millisecond timer: The timer specified by the TMR instruction takes 100 milliseconds as the timing unit. 

 10 millisecond timer: The timer specified by the TMR instruction takes 10 milliseconds as the timing unit. 

 1 millisecond timer: The timer specified by the TMRH instruction takes 1 millisecond as the timing unit. 

 The accumulative timers are ST0–ST511. If you want to use the device-monitoring function, these timers can 
monitor T0–T511. 

 If you use the same timer repeatedly in a program, including in different TMR, TMRM and TMRH instructions, the 
timer setting value is the one that the timer matches first. 

 If you use the same timer repeatedly in a program, the timer is OFF when one of the conditional contacts is OFF. 

 If you use the same timer in a program as the timer for a subroutine’s exclusive use and an accumulative timer in the 
program, it is OFF when one of the conditional contacts is OFF. 

 When the timer switches from ON to OFF and the conditional contact is ON, the timer is reset and counts again but 
the ST timer will not be reset.  

 When the TMR instruction is executed, the specified timer coil is ON and the timer begins to count. When the value 
of the timer matches the timer setting value (value of the timer ≧ setting value), the state of the contact is ON. 

 

A. General-purpose timers 

When the TMR instruction is executed, the general-purpose timer begins to count. When the value of the timer 
matches the timer setting value, the output coil is ON. 

• When M0=ON and the timer takes 100 ms as the timing unit, the output coil T0 is ON when the value of the 
timer = timer setting value100.  

• When M0=OFF, the value of the timer is 0 and the output coil T0 is OFF.  
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X0. 0

T0( P V)

Y0. 0

S V: K100

10se c

M 0

M1

 

B. Accumulative timers 

When the TMR instruction is executed, the accumulative timer begins to count. When the value of the timer matches 
the timer setting value, the output coil is ON. As long as you add the letter S in front of the letter T, the timer 
becomes an accumulative timer. When the conditional contact is OFF, the value of the accumulative timer is not 
reset. When the conditional contact is ON, the accumulative timer counts from the current value. 

• When M0=ON and the timer T250 takes 100 ms as the timing unit, the output coil T250 is ON when the value 
of the timer = timer setting value 100.  

• When M0=OFF, the accumulative timer ST250 stops counting, and the value of the timer stays the same. 
When M0=ON, the value of the timer is the accumulating value. When the accumulated value = timer setting 
value 100, the output coil T250 is ON. 
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X0.0

T2

Y0. 0

S V: K100

T1+T2=10 sec

T250( PV)

T1

M 1

M 0

 

C. Timers used in function blocks 

T412–T511 are the timers that you can use in the function block or in interrupts. 

When the TMR or END instruction is executed, the timer in the functional block begins to count. When the value of 
the timer matches the timer setting value, the output coil is ON. 

If you use a general-purpose timer in a function block or an interrupt, and the function or interrupt is not executed, the 
timer cannot count correctly. 

 

5.2.10 Counters 

 Characteristics of the 16-bit counter 

Item 16-bit counter 
Type General type 
Number C0–C511 
Direction Counting up 
Setting value 0–32,767 

Specifying the counter setting value The setting value can be either the constant or the value in the data 
register. 

Change of the current value The counter stops counting when the value of the counter matches 
the counter setting value. 

Output contact The contact is ON when the value of the counter matches the counter 
setting value. 

Reset When the instruction RST is executed, the current value is cleared to 
zero, and the contact is reset of OFF. 

Action of the contact After the scan is complete, the contact acts. 

 

 Function of the counter 

Each time the input switches from OFF to ON, the value of the counter is the same as the output coil. You can use 
either the decimal constant or the value in the data register as the counter setting value. 

 

16-bit counter: 

1. Setting range: 0–32,767. The setting values 0 and 1 mean the same thing in that the output contact is ON when the 
counter counts for the first time. 

2. For the general-purpose counter, the current value of the counter is cleared when power is lost. If the counter is 
latching, the current value of the counter and the state of the contact before power was lost power are retained. The 
latched counter counts from the current value when the power supply is restored. 
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3. If you use the MOV instruction or ISPSoft/DIADesigner to transmit a value larger than the counter setting value to 
the current value register C0, the contact of the counter C0 is ON and the current value becomes the same as the 
counter setting value the next time X0.1 switches from OFF to ON. 

4. You can use either the constant or the value in the data register as the counter setting value. 

5. The counter setting value can be positive or negative. If the counter counts up from 32,767, the next value is 0. 

6. This counter should work with CNT instruciotn (API1003); below shows an example of common usage.  

 

 
 

 
1. When M0=ON, the RST instruction is executed, the current value of C0 is reset to zero, and the output contact of 

the counter C0 is FF. And M0=OFF, the execution of RST instruction is done.  

2. When M1 changes from OFF to ON, the value of the counter increments by one.  

3. When the value of the counter C0 reaches the counter setting value of 5, the contact of the counter C0 is ON (the 
current value of C0 = the counter setting value = 5). After that the trigger from M1 is not accepted by C0 and the 
current value of C0 stays at the value 5.  

 X0.0

X0.1

Y0.0,C0 

C0 (PV )

0
1

2
3

4
5
(SV )

0

M1

M0

M 3
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5.2.11 32-bit Counters (HC) 

 Characteristics of the 32-bit counter 

Item 32-bit counter 
Type Up/down counter Up counter High-speed counter 

Number HC0–HC63 HC64–HC199 HC200–HC255 
Direction Counts up/down Counts up Counts up/down 

Setting value -2,147,483,648 to +2,147,483,647 
Specification of the 

counter setting value 
The counter setting value can be either the constant or the value occupying two 
data registers (32-bit). 

Change of the current 
value 

The counter keeps counting even after the value of the counter matches the counter 
setting value. 

Output contact 

The contact is ON when the value of the addition counter matches the counter 
setting value. 
The contact is reset to OFF when the value of the subtraction counter matches the 
counter setting value. 

Reset When the RST instruction is executed, the current value is cleared to zero, and the 
contact is reset to OFF. 

Action of the contact After the DCNT instruction scan is complete, the contact acts. 

 

 32-bit general-purpose addition/subtraction counter 

1. The difference between the 32-bit general-purpose addition counters and the 32-bit general-purpose subtraction 
counters depends on the states of the special auxiliary relays SM621–SM684. For example, the counter HC0 is 
an addition counter when SM621 is OFF, whereas HC0 is a subtraction counter when SM621 is ON. 

2. You can use either the constant or the value in the data registers as the counter setting value, and this setting 
value can be positive or negative. If you use the value in the data registers as the counter setting value, this 
setting value occupies two consecutive registers. 

3. For the general-purpose counter, the current value of the counter is cleared when power is lost. If the counter is 
latching, the current value of the counter and the state of the contact before loss of power is retained. The 
latched counter counts from the current value when power is restored. 

4. If the counter counts up from 2,147,483,647, the next incremental value is -2,147,483,648. If the counter counts 
down from -2,147,483,648, the next incremental value is 2,147,483,647. 

5. This HC counter should work with DCNT instruciotn (API1004); below shows an example of common usage.  

 

 32-bit high speed addition/subtraction counter 

Refer to the instruction description of API1004 DCNT in DVP-ES3/EX3/SV3/SX3 Series Programming Manual for more 
details. 
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Example:  

 

1. M10 drives SM621 to determine the counting direction (up/down) for HC0. 

2. When M11 changes from OFF to ON, the RST instruction is executed and the PV in HC0 is cleared to 0 and its 
contact is OFF.  

3. When M12 changes from OFF to ON, PV for HC0 will count up (plus 1) or count down (minus 1). 

4. When PV in HC0 changes from -6 to -5, the contact HC0 changes from OFF to ON. When PV in HC0 changes from 
-5 to -6, the contact HC0 changes from ON to OFF. 

 

 

 

 

 

 

 

 

 

 

  

X10.0

X11.0

X12.0

 Whe n the outp ut con tact wa s ON 

Y0.0,
HC0 Contacts

HC0 
( )PV
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5.2.12 Data Registers (D) 

The data register stores 16-bit data. The highest bit represents either a positive sign or a negative sign, and the values 
that the data registers can store range between -32,768 to +32,767. 

Two 16-bit registers can be combined into a 32-bit register; for example, (D+1, D) in which the lower number register 
represents the low 16 bits. The highest bit represents either a positive sign or a negative sign, and the values that the 
data registers can store range between -2,147,483,648 to +2,147,483,647.  

 Four 16-bit registers can be combined into a 64-bit register; for example, (D+3, D+2, D+1, D) in which the lower 
number register represents the lower 16 bits. The highest bit represents either a positive sign or a negative sign, 
and the values that the data registers can store range between -9,223,372,036,854,776 to 
+9,223,372,036,854,775,807. 

 You can also use the data registers to refresh the values in the control registers in the modules other than digital 
I/O modules. Refer to the ISPSoft/DIADesigner User Manual for more information on refreshing the values in the 
control registers. 

There are three types of registers. 

 General-purpose registers: When the PLC changes to RUN, or is disconnected, the value in the register is cleared 
to zero. If you want to retain the data when the PLC changes to RUN, Refer to the ISPSoft/DIADesigner User 
Manual for more information. Note that the value is still cleared to zero when the PLC is disconnected. 

 Latched register: If the PLC is disconnected, the data in the latched register is not cleared. In other words, the 
value before the disconnection is retained. If you want to clear the data in the latched area, you can use the RST or 
ZRST instructions.  

 Data mapping area for extension modules: When the PLC is connected to a module, the PLC exchanges data with 
the connected module at every scan cycle. The data is stored in data registers in PLC CPU and the data will be 
mapped to the control registers (CRs) in the extension modules. Refer to the following table for more details.  

Types of extension modules Data mapping areas Remarks 

Right-side extension module D28000~D28079 Work with SM228 to enable/disable data mapping 

Left-side extension module D29000~D29079 Work with SM265 to enable/disable data mapping 

Left-side DNET/COPM  
extension module 

D16000~D19999 
 

   

5.2.13 Special Data Registers (SR) 

Every special data register has its own definition and specific function. System status and the error messages are stored 
in the special data registers. Refer to section 2.2.14 in DVP-ES3/EX3/SV3/SX3 Series Programming Manual for more 
reference. 

 

5.2.14 Index Register (E) 

The Index register is a 16-bit data register. It is similar to the general register in that data can be read from it and written 
to it; however, it is mainly used as the index register. The range of index registers is E0–E9. Refer to section 4.4 in DVP-

ES3/EX3/SV3/SX3 Series Programming Manual for more reference. 
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5.2.15 File Registers (FR) 

 The DVP-ES3 Series PLC provides you with File registers for storing larger numbers of parameters.  

 You can edit, upload, and download the parameters in the File registers through ISPSoft/DIADesigner.  

 You can read the values in File registers while operating the PLC. Refer to the MEMW instruction (API 2303) in 
DVP-ES3/EX3/SV3/SX3 Series Programming Manual for more information about how to write to the File registers. 
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Since ISPSoft and DIADesigner are similar in terms of program editing, this chapter will use ISPSoft software 

as an example for explanation. Refer to Chapter 8 of the DIADesigner User Manual for information related to 

DIADesigner software.  

 
6.1 Quick Start 

This chapter provides a simple example showing you how to create a traditional ladder diagram in ISPSoft.  

Because you may not be familiar with IEC 61131-3 and may not understand the functions provided by ISPSoft, 

the chapter does not introduce programming concepts related to IEC 61131-3.  For example, the chapter 

does not include POUs, function blocks, variables, and so on.  

 

6.1.1 Example 

When the equipment in this example operates, the parts on the conveyor move from left to right. If a sensor 

senses that a part is under an injector, the PLC sends a trigger signal to the injector, and the injector injects 

the glue. The injection length is set externally and is not controlled by the PLC program . However, the PLC 

program must be able to turn the trigger signal OFF so that the trigger signal can be sent next time. There are 

two injectors above the conveyor, and the two injectors inject glue in the same way. 

There is a sensor at the left side of the conveyor. When a part passes the sensor, the sensor value increases 

by one increment. When the sensor value is 100, the internal completion flag is set to ON. The flag state can 

be used by other procedures later. However, this example does not introduce the use of flag states. 
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6.1.2 Hardware 

In this example, the DVP-ES3 series CPU module used is the DVP32ES311T. 

Type ID Description 

Digital input X0 START button 

Digital input X1 STOP button 

Digital input X2 In position sensor 1 

Digital input X3 In position sensor 2 

Digital input X4 Counting sensor 

Digital output Y0 Conveyer 

Digital output Y1 Trigger signal for injector 1 

Digital output Y2 Trigger signal for injector 2 

 

6.1.3 Program 

(1) When the START button (X0) switches from OFF to ON, the internal operation flag is set to ON, and the 

conveyor (Y0) starts. When the STOP button (X1) switches from OFF to ON, an error occurs (the error 

flag is ON), the operation flag is reset to OFF, and the conveyor stops. 

(2) When the in position sensor 1 (X2) is ON, the trigger signal for injector 1 (Y1) is set to ON. When the in 

position sensor 1 is OFF, the trigger signal for injector 1 is reset to OFF. 

(3) When the in position sensor 2 (X3) is ON, the trigger signal for injector 2 (Y2) is set to ON. When the in 

position sensor 2 is OFF, the trigger signal for injector 2 is reset to OFF. 

(4) When the counting sensor (X4) switches from OFF to ON, the sensor value increases by one increment. 

If the sensor value is larger than or equal to 100, the internal completion flag is set to ON. 
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6.2 Procedure for Creating a Project in ISPSoft 

This section shows you the procedure for creating a project in ISPSoft. You can adjust the procedure 

according to your needs.  

 Hardware configuration 

You set the parameters such as a range of latched devices and a port number in a PLC. You configure 

the modules with a DVP-ES3 Series CPU module, and set the parameters in these modules. 

 Network configuration 

If a system uses a network architecture, or devices need to exchange data, use the network configuration 

tool NWCONFIG in ISPSoft to configure a network and exchange data with COM as well as Ethernet.  

 Programming 

After you write a program in ISPSoft, compile the program. If the compiling is unsuccessful, messages in 

the Compile Message page show where the errors occur. 

 Testing and debugging 

Download the compiled program, the hardware configuration, and the network configuration to a PLC. 

You can then test and debug the program online with the functions provided by ISPSoft. 

Because the example introduced in this chapter does not discuss a network configuration, you only perform 

the following procedure.  
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6.3 Creating a Project 

This section will use ISPSoft software as an example for explanation. Refer to section 4.2.2.3 of the 

DIADesigner User Manual for information related to DIADesigner software.  

After you start ISPSoft, on the File menu, point to New, and then click New to create a new project. You can 

also create a new project by clicking  on the toolbar after you start ISPSoft. 

 

 
In the Create a New Project dialog box, type a project name in the Project Name box and a path in the 

Drive/Path box, select a PLC in the PLC Type drop-down list box, and then click OK. The PLC in this 

example is the DVP32ES3. 

  

 
After you create the project, a project management area appears at the left side of the main screen. The 

relation between the items listed in the project management area is represented by a hierarchical tree 

structure. If the project management area does not appear, on the View menu, click Workspace , or click 

 on the toolbar. 
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6.4 Hardware Configuration 

This section will use ISPSoft software as an example for explanation. Refer to section 6.1 of the DIADesigner 

User Manual for information related to DIADesigner software.  

 

After you double-click HWCONFIG in the project management area, the HWCONFIG window appears. 

 

 

 

 

 

 

 

 

 

 

 
 

6.4.1 Configuring a Module 

In the HWCONFIG window, the default setting is with a CPU module. Refer to Chapter 8 for more information.   
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6.4.2 Setting the Parameters 

After you double-click the CPU module or the extension module, the Device Setting dialog box appears with 
the module information.  

 

 
Click the setting tabs for specific parts of the setup at the top of the window and then select the setting items 
on the left for configuration. 

 

 
When the hardware configuration is complete, download the configuration and the settings to the CPU 

module.  Save the configuration and settings, and you can download them with the program later in the 

project.   

On the File menu, click Save or  on the toolbar to save the configuration and settings, and then close the 

HWCONFIG window.  

         or       

 
*. Refer to Chapter 8 for more information about HWCONFIG. 
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6.5 Creating a Program 

The following sections show you how to create a traditional ladder diagram in ISPSoft. The sections include 

creating a POU, editing a traditional diagram, and compiling a program. 

This section will use ISPSoft software as an example for explanation. Refer to Chapter 8 of the DIADesigner 

User Manual for information related to DIADesigner software.  

6.5.1 Adding a Ladder Diagram 

(1) Right-click Programs in the project management area, point to POU (program organization unit), and 
then click New…. 

 

(2) In the Create Program dialog box, type a program name in the POU Name box, select Ladder Diagram 

(LD) in the Language section, and keep the other default values. Click OK after the setting is complete. A 

new program organization unit (POU) appears under Programs in the project management area.  
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(3) After you add the POU, a program editing window appears in the main working area. 

 

 
 
 
 
 
 
 
 
 
 

  
 

  
 
After the program editing window opens, the corresponding toolbar appears in the window. The list below 

describes the functions. 

 
 

Icon Keyboard shortcut Function 

 None Switches to the address mode 

 Shift+Ctrl+C Display/hides the comments on the networks 

 None Displaying/hides the commands on the devices 

 Shift+Ctrl+A Activates/deactivates the selected network 

 Shift+Ctrl+B 
Adds a bookmark to the selected network selected or 

deletes a bookmark from the selected network 

 Shift+Ctrl+P Goes to the previous bookmarked position 

Local symbol table

Program edit ing area
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Icon Keyboard shortcut Function 

 Shift+Ctrl+N Goes to the next bookmarked position 

 Ctrl+I Puts a network above the selected network 

 Shift+Ctrl+I Put a network under the selected network 

 ESC Selects an item 

 Typing an instruction Inserts a contact 

 Typing an instruction Inserts a coil 

 Typing an instruction Inserts a comparison contact 

 Typing an instruction Selects a type of comparison contact 

 Typing an instruction 
Inserts a block logic instruction 

(NP/PN/INV/FB_NP/FB_PN) 

 Typing an instruction 
Selects a type of block logic instruction 

(NP/PN/INV/FB_NP/FB_PN) 

 Shift+Ctrl+U Inserts an instruction or a function block 

*. Refer to Section 6.5.3 for more information about typing an instruction. 

 
6.5.2 Basic Editing ─ Creating a Contact and a Coil 

(1) Click  on the toolbar, and then move the mouse cursor to the red frame in Network 1. The mouse 

cursor changes to a contact when the mouse cursor is moved to the left, right, or bottom of the red frame. 

Decide where to insert a contact. If you edit a ladder diagram, the mouse cursor must be near a position 

you want to edit. The system automatically arranges an inserted object; you cannot move the object. 

In this example, you do not need to decide where to insert the contact. Place the mouse cursor near the 

red frame and click the left mouse button. 
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(2) Click  on the toolbar, or press Esc on the keyboard. After you double-click the contact, a list appears. 

The items on the list are Normally Open, Normally Close, Rising-edge Trigger, and Falling-edge 

Trigger. In this example, click Rising-edge Trigger. 

 

 
(3) Click the line at the right side of the contact, click  on the toolbar, and then move the mouse cursor to 

the red frame. The mouse cursor changes to a coil when the mouse cursor is above or under the red 

frame. Decide where to insert the coil. 

In this example, you do not need to decide where to insert the coil. Place the mouse cursor near the red 

frame and click the left mouse button. 
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(4) Click  on the toolbar, or press Esc on the keyboard. After you double-click the coil, a list appears. 

The items on the list are Out, Set, and Reset. In this example, click Set. 

 

 
(5) Click ??? above the contact, type a device address in the box, and then press Enter on the keyboard to 

jump to the next box in the network. After you type a device address in the box, press Esc on the 

keyboard to complete the editing. In this example, type X0 in the box for the contact, and type M0 in the 

box for the coil. 
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Additional remark 

After you click a network and press Enter on the keyboard, you can edit a box. Press Enter on the keyboard to 

edit the next box in the network. Press Tab on the keyboard to select the next network. Use the keyboard to 

edit boxes. After you finish the editing, press Enter on the keyboard to jump to the next box. Press Esc on the 

keyboard to exit editing. 

If you have declared symbols, the device is editable, clear the value in the device and then you can see the 

available symbols for you to assign to the object. Select a symbol with the mouse or the up/down key on the 

keyboard. Refer to Chapter 6 in the ISPSoft User Manual for more information about symbols. 

 

 
 
6.5.3 Basic Editing ─ Inserting a Network and Typing an Instruction 

Click  on the toolbar to select a network. Click  on the toolbar to place another network above the 

selected network. In this example, Network 2 is under Network 1. 
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Create a contact and a coil by clicking  and  on the toolbar or by typing instructions. 

(1) Click the line in Network 2. 

 

(2) Type the IL instruction “LD M0”. This instruction is not case-sensitive. As soon as you type the IL 

instruction,  a box which you can edit appears. After you finish typing the IL instruction, press Enter on 

the keyboard or click OK at the right side of the box. 

 

 

 
(3) Type the IL instruction “OUT Y0”, and write the program shown below. 
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Additional remark 

You create a contact and a coil by typing simple instructions. Refer to the description below. The instructions 

typed are not case-sensitive. 

 To Insert a normally-open contact (contact A), type “A <device address>” 

 

 

 

 To insert a normally-closed contact (contact B), type “B <device address>” 

 

 

 To insert an output coil (OUT), type “O <device address>” 
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6.5.4 Basic Editing ─ Selecting a Network and Operation 

Before you select an object in a network, press Esc on the keyboard, or click  on the toolbar. After the 

cursor appears as a small arrow, click the object in the network. The basic selection shows below. 

 

 Select the network 

 Select the input contact 

 Select the network 

 Select the output coil 

 Select the block 

To select a group of devices, click a device and drag it to draw a frame around the group of devices. You can 

also select the group of devices by clicking the first device, pressing Ctrl+B on the keyboard, clicking the last 

device, and then pressing Ctrl+B on the keyboard. You must draw a frame around devices that are in the 

same network, and the devices must be adjacent to one another. Input and output devices cannot be in the 

same frame. 

 

To select several networks, press and hold the Ctrl key on the keyboard and click the networks. You can also 

select a range of networks by pressing and holding Shift on the keyboard, clicking the first network within the 

range, and then clicking the last network within the range. 
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Right-click an object after selecting it to show the context menu. 

Item Function 

Undo 
Undo the last action. 

You can undo up to 20 previous actions. 

Redo You can redo an action that has been undone. 

Cut Cut a device, block, or network. 

Copy Copy a device, block, or network. 

Paste Paste an object that has been copied or cut into the present position. 

Paste right 
Paste an object at the right side of the selected position. 

The object is connected in series to the selected position. 

Paste under 
Paste an object under the selected position. 

The object is connected in parallel to the selected position. 

Delete Delete a device, block, or network. 

Activate/Inactivate 

Network 

Activate or deactivate the selected network. 

The deactivated network is ignored when you compile the program. 

Auto Generate 

Symbols 
Used on the contacts of the function block to generate symbols automatically. 

Add to Device 

Monitor 

Table 

Used on the selected contacts to quickly add the device to the Monitor Table. 

 
Proceed with the steps in the example below. 

(1) Select Network 1, then right-click Network 1, and then click Copy. 
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(2) Select Network 2, right-click Network 2, and then click Paste. A copy of Network 1 is put above Network 

2, and Network 2 becomes Network 3. 

      

 

6.5.5 Basic Editing ─ Connecting a Contact in Parallel 

(1) Click  on the toolbar, and then move the mouse cursor to the input contact in Network 2. The mouse 

cursor changes to a contact. Move the mouse cursor to the input contact in Network 2. After the mouse 

cursor changes to , click the left mouse button. This connects a contact in parallel with the input 

contact in Network 2. 
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(2) Write the program in Network 2 shown below. 

 

 
 

Additional remark 

After you select a group of contacts, connect a contact to the group of contacts as described above. 
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6.5.6 Basic Editing ─ Editing a Comment 

(1) Press  on the toolbar. Click the position above a device name, type a comment in the box, and then 

press Enter on the keyboard. 

 

(2) Press  on the toolbar. Click the position under a network number, and then type a comment in the 

box. To start a new line of text, press Shift+Enter on the keyboard. Press Enter on the keyboard after the 

you complete the editing. 

 

(3) Write the program shown below. 
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6.5.7 Basic Editing ─ Inserting an Applied Instruction 

Add Network 6 under Network 5, and then write the program shown below. Insert an applied instruction in one 

of the three ways described below. 

 

 Method 1 

Click the position where you want to insert an instruction, type the instruction (INC in this example), and 

then press Enter on the keyboard. 

 

 

 

 Method 2 

Click APIs in the project management area and find the instruction type. 
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Click the instruction (INC in this example) that you want to insert, and then drag it to the desired position. 

 

 
 

 Method 3 

Click the position where you want to insert an instruction, click  on the toolbar, select the instruction 

(INC in this example) to insert in the API/FB dialog box, and then click Insert. 

 

 
 

 

  

 

After you insert the instruction, assign a device address to the operand, and write the program shown 

below.  
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6.5.8 Basic Editing ─ Creating a Comparison Contact and Typing a 
Constant 

You can insert a comparison contact with the following steps. Add Network 7 under Network 6, and write 

the program shown below. 

 

 
(1) Click  on the toolbar, and then select a operator (>= in this example). 

 

(2) Click  on the toolbar, and then move the mouse cursor to the position where you want to insert the 

comparison contact. The mouse cursor changes to a comparison contact when you move the mouse to 

the left, right, or bottom of the red frame. Decide where to insert the comparison contact, and then click 

the left mouse button to insert the comparison contact.  
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Write the program shown below. In ISPSoft, K precedes a decimal value and H precedes a hexadecimal 

value. To type a decimal value in ISPSoft, type it directly. To type a hexadecimal value in ISPSoft, type “16#” 

and the hexadecimal value; e.g. 16#7FFF. In ISPSoft, 8# precedes an octal value, and 2# precedes a binary 

value. 

 

6.5.9 Writing a Program 

The previous sections introduced creating a traditional ladder diagram in ISPSoft. Write the program shown 

below. Because the program is not yet compiled for the PLC, the mother line at the left side of the ladder 

diagram is colored red while you write the program. The following sections show how to compile and 

download the compiled program for testing. 

 

*1. The program above saves in the folder …\ISPSoft x.xx\Project\Example\Gluing_System_C. 

*2. Refer to Chapter 10 in the ISPSoft User Manual for more information about creating a ladder diagram. 
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6.5.10 Checking and Compiling a Program 

After you write a program, check the syntax of the programming language or compile the program. The syntax 

and structure in the present window are checked after you run the Check function. The system checks the 

entire project after you run the Compile function. If the system does not find any errors in the project, it 

automatically generates execution code. After you successfully compile the program, the mother line at the left 

side of the ladder diagram becomes black. 

 Check 

From the Compile menu, click Check, or  on the toolbar. 

 

 Compile 

From the Compile menu, click Compile, or  on the toolbar. 

 

After you complete the check, the Compile Message page shows the check result. If there are any errors in 

the project, the Compile Message window shows the related message. After you click the message, the 

system automatically shows you where the error occurs. You can run the Check function or the Compile 

function after you correct the error. 
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6.6 Testing and Debugging a Program 

This section will use ISPSoft software as an example for explanation. Refer to Chapter 5 of the DIADesigner 

User Manual for information related to DIADesigner software.  

 

6.6.1 Creating a Connection 

Before you download a program and parameters to a PLC or monitor them online, connect ISPSoft to the 

PLC. In this example, connect ISPSoft to the CPU module DVP32ES311T with a USB cable. Refer to Section 

2.4 in the ISPSoft User Manual for more information about connecting ISPSoft to a PLC in other ways. Refer 

to the AS Operation Manual for more information about wiring. 

You can skip this section if you have connected ISPSoft to a PLC successfully as described in Section 
2.4 in the ISPSoft User Manual. 

(1) Make sure that the wiring is correct, and then power on the CPU module. 

(2) Connect the CPU module to the computer with a USB cable. If the USB driver for the DVP-ES3 series 

CPU module is installed on the computer, Delta PLC appears in the Device Manager window, and a port 

number is assigned to Delta PLC. Refer to Appendix A for more information about installing a USB driver. 

(3) Make sure that COMMGR is started and the icon representing COMMGR is displayed on the system tray. 

If the icon representing COMMGR is not displayed on the system tray, start COMMGR by clicking the 

shortcut on the Start menu (Start > Programs > Delta Industrial Automation > Communication > 

COMMGR). 

 

(4) Double-click the icon representing COMMGR on the system tray to open the COMMGR window. Click 

Add in the COMMGR window to create a driver. 
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(5) Set the parameters in the Driver Properties dialog box, and then click OK. 

 

 Type a driver name in the Driver Name box. 

 Select USB (Virtual COM) in the Type list in the Connection Setup section. 

 Select a communication port in the COM Port list. If the first two steps are complete, the connected 

PLC and its communication port display in the COM Port list. 

 Select the number of times to retry the sending of a command if a connection error occurs in the Time 

of Auto-retry box, and select a retry interval in the Time Interval of Auto-retry box. 

 

(6) After you finish the setup, check if the Status of Driver is OK, you can close the window. And COMMGR is 
successful installed in Windows.   
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(7) Start ISPSoft, and then on the Tools menu, click Communication Settings…. In the Communication 

Setting dialog box, select the driver you created in the Driver list, select 0 in the Station Address list, 

and then click OK. The driver information displays in the ISPSoft status bar. 

 

 

 

 

 

 

 

(8) On the PLC menu, click System Information. ISPSoft retrieves related information from the PLC. If the 

computer communicates with the CPU module normally, the related information retrieved from the PLC 

displays in the System Information dialog box. 
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6.6.2 Downloading a Program and Parameters 

If ISPSoft is correctly connected to a PLC, you can download the parameters and program in the project to the 

PLC. First, start ISPSoft and open the project you created in the previous sections. In this example, you 

download two types of parameters to the CPU module: hardware configuration and the program itself. 

 Downloading the hardware configuration 

(1) Double-click HWCONFIG in the project management area to open the HWCONFIG window. 

 

(2) The hardware configuration displays in the window. Before you download the hardware configuration 

to the CPU module, make sure the actual hardware configuration is the same as the hardware 

configuration in the window. 

(3) On the Options menu, click Download, or  on the toolbar. The Transfer Items dialog box 

appears. Click OK to download the hardware configuration to the CPU module. 
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(4) After you successfully download the hardware configuration to the CPU module, the BUS FAULT 

LED indicator on the CPU module is OFF. Close the HWCONFIG window. If the BUS FAULT LED 

indicator on the CPU module is still ON or blinking, the CPU module is in an abnormal state. Make 

sure the actual hardware configuration is the same as the hardware configuration in the HWCONFIG 

window, and refer to the operation manual for more information about eliminating the error. Refer to 

Chapter 8 for more information about HWCONFIG. 

 Downloading the program 

After the program compiles, on the PLC menu point to Transfer, and then click Download. You can also 

click  on the toolbar after the program compiles. In the Transfer Setup dialog box select the 

Program checkbox and the Comments checkbox so that you can upload the program in the CPU 

module later, and then click OK. 

 

 

6.6.3 Connection Test 

After you download a program to a PLC, you can monitor the execution status of the PLC through ISPSoft. 

ISPSoft provides two monitoring modes; device monitoring mode and program monitoring mode. 

Monitoring mode Description 

  

Device monitoring mode 

You can monitor the status of the devices in the PLC through the 

monitoring table. In this mode, ISPSoft updates only the status of the 

devices. The current program in ISPSoft does not have to be the same as 

the program in the PLC. 

  

Program monitoring mode 

In this mode, the operating status of the program is displayed in the 

program editing window. The present program in ISPSoft must be the 

same as the program in the PLC. 

*. You can enable the device monitoring function without program monitoring; however, if you enable the program 

monitoring function, the device monitoring function is also enabled. 
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On the PLC menu, click Online Mode, or  on the toolbar, to enable the online monitoring function. The 

system also enables device monitoring mode and program monitoring mode. 

 

In the online monitoring mode, you can view the present scan time, the communication status, and the status 

of the PLC in the status bar in ISPSoft. 

 

The present status of the devices display in the original program editing window after you enable the program 

monitoring function. 

 

 

You can change the operating state of a PLC with the RUN/STOP switch on the PLC. You can also change the 

operating status of a PLC with the functions provided by ISPSoft. On the PLC menu, click Run or  on the 

toolbar to start the PLC. On the PLC menu, click Stop or  on the toolbar to stop the PLC. 
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In the online monitoring mode, you can select a device, then right-click the device, and the click a command 

on the context menu. During a test, you can change the status of a device or the value in a device by clicking 

an item on the context menu. 

 Before you change the status of a device, make sure the operation does not cause damage to 

equipment or personnel. 

        

 

The table below describes the items in the context menu. The Force command only applies to input and 

output contacts. 

Item Description 

Set On Set the contact selected to ON 

Set Off Set the contact selected to OFF 

Rising-edge Trigger 
No matter what the state of the selected contact is, the system sets the contact 

to OFF, and then sets it to ON. 

Falling-edge Trigger 
No matter what the state of the selected contact is, the system sets the contact 

to ON, and then sets it to OFF. 

Force Force an input contact or output contact ON or OFF 

Force Device List Force several input contacts or output contacts in the tables ON or OFF  

To change the value in a device, right-click the device, click Change Present Value, and set a present value 

in the Enter Present Value dialog box. 
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The list below describes the Enter Present Value dialog box. 

 

 Message 

 Type a value in the Present Value box. 

 Type the name of a device or a symbol whose present value you want to change 

 Type a 16-bit or 32-bit value. 

 Value change history (Format: Device name Value) 

 In binary mode, use the mouse to set the bit states. 

 Click OK to apply the setting values. Click Cancel to close the window without applying the values. 

 Display or hide binary mode. 
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In this example, X0–X17 and Y0–Y17 are input and output devices assigned to the digital I/O module 

DVP32ES311T. After you download the hardware parameters to the CPU module, the states of X0–X17 are 

the same as the states of the inputs on the actual module. Even if you set X0–X17 to ON or OFF in the 

program editing window, the actual input signals update the states of X0–X17. 

   
 

However, you can force an input contact ON or OFF during a test. Click an input or output contact to set, right-

click the contact, point to Force, and click On (X/Y), Off (X/Y), Release (X/Y), or Release All. If you force an 

input or output contact ON or OFF, a lock symbol appears at the left side of the contact. 

 

Force Description 

On (X/Y) Force the selected input or output contact ON 

Off (X/Y) Force the selected input or output contact OFF 

Release (X/Y) Release the contact from the locked state 

Release All Release all the contacts from the locked states 

 

If you force an output contact in the program ON or OFF, the program execution result does not affect the 

output state of this contact. 

 

*. If you disable the online monitoring function, the contacts are not automatically released from the locked states. 
You must check whether the contacts need to be released from the locked states after you complete the test. 

You can create a monitoring table online or offline. 
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 Method 1 

On the PLC menu, click New Devices Table, or  on the toolbar. 

 

 Method 2 

Right-click Device Monitoring Table in the project management area, and click New. 

 

Type a table name in the Add Monitor Table dialog box, and then click OK. An item appears under Device 

Monitor Table in the project management area. Double-click the item to open the monitoring table. You can 

create several monitoring tables in the project, and the monitoring tables are saved with the project. 
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After you double-click the item, a item monitoring window appears. You can add items to be monitored to the 

window. To add an item to the window, double-click the blank space in the monitoring table, type a device 

name, type a start address, and the number of devices to be monitored in the Device Monitor Input dialog 

box. You can add up to 100 items to a monitoring table. 

 

Press Insert on the keyboard to switch between inserting and replacing an item in the monitoring table. The 

selected mode displays in the status bar in ISPSoft. 

If you select insert mode, the new item is added above the selected item in the monitoring table. If you select 

replacement mode, the new item overwrites the selected item in the monitoring table. 

 

To hide certain columns in the monitoring table, right-click the monitoring table, point to Set the Fields, and 
clear certain items. After you clear an item, the corresponding column disappears. 
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The following describes the columns in the monitoring table. 

Column Description 

Source Source of a symbol 

Identifier Identifier of a symbol 

Device name Name of a monitored device  

Status State of a monitored bit device or a contact (ON or OFF). 

Data type Data type of a monitored symbol. 

Value (16 bits) In online mode, displays a 16-bit value. 

Value (32 bits) In online mode, displays a 32-bit value. 

Float In online mode, displays a 32-bit floating-point number. 

Radix Select a format to represent a value. 

Comment Display the comments on a device or on a symbol. 

 

After you create the monitoring table, you can monitor the items in the monitoring table in online mode. Right-

click an item in the monitoring table in online mode to display a context menu which is the same as the context 

menu in the program editing window. You can change the item state or the item value by clicking an item in 

this context menu. 

 

You can text and debug the program you created in this chapter through the monitoring table you created in 

this section. Refer to Chapter 18 in the ISPSoft User Manual for more information about testing and debugging 

a program. 
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6.7 Setting a Real-time Clock 

After you connect an DVP-ES3/EX3/SV3/SX3 Series CPU module to a computer, you can set the real-time 

clock in the CPU module through ISPSoft/DIADesigner. 

 ISPSoft 

(1) On the Tools menu, click Set RTC. 

 

 

(2) Select Computer, and then click Synchronize to complete setting the real time clock. 

 

(3) RTC setting is complete.  
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 DIADesigner 

(1) Go to Project Explorer > Controller > Auxiliary > Set RTC. And double-click Set RTC to open the 

setting page.  

 
 
 

(2) Select Computer and click Synchronize to have the time synchronized with the computer.  
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(3) Check the status to see if the setting is complete.  
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7.1 Overview of Memory Cards 

You can use either ISPSoft or DIADesigner to edit DVP-ES3. But only use DIADesigner to edit 

DVP-ES300TEC/EX3/SV3/SX3. 

The DVP-ES3/EX3/SV3/SX3 CPU modules support standard MicroSD cards that meet the specifications in this 

chapter. This chapter describes the specifications and usage for the MicroSD cards supported by the 

DVP-ES3/EX3/SV3/SX3 CPU modules. 

7.1.1 Appearances of Memory Cards 

SD cards are classified into three types according to size: SD cards, MiniSD cards, and MicroSD cards. 

DVP-ES3/EX3/SV3/SX3 CPU modules support MicroSD cards. 

 

7.1.2 Memory Card Specifications  

SD cards are also classified into three types according to capacity: SD cards, SDHC cards, and SDXC cards. 

The DVP-ES3/EX3/SV3/SX3 currently only supports a maximum of 32GB in FAT32 format. SD card families 

are shown in the table below. The Micro SDHC in the SDHC column indicates the specifications supported by 

the DVP-ES3/EX3/SV3/SX3. Be sure to purchase products that meet these specifications. 

 SD card families  

Type SD SDHC SDXC 
Capacity 32 MB~2 GB 4 GB~32 GB 32 GB~2 TB 

File 
system FAT16/FAT32 FAT32 exFAT (FAT64) 

Size SD SDHC SDHC Mini 
SDHC 

Micro 
SDHC SDXC Micro SDXC 

Speed 
class 
rating 

N/A 

CLASS 2 (Min. 2 MB/Sec.) 
CLASS 4 (Min. 4 MB/Sec.) 
CLASS 6 (Min. 6 MB/Sec.) 
CLASS 10 (Min. 10 MB/Sec.) 

CLASS 2 (Min. 2 MB/Sec.) 
CLASS 4 (Min. 4 MB/Sec.) 
CLASS 6 (Min. 6 MB/Sec.) 
CLASS 10 (Min. 10 MB/Sec.) 
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7.2 Before using a Memory Card 

7.2.1 Formatting a Memory Card 

You may need to format a new SDHC memory card with the FAT32 file system before you use it for the first 

time. You cannot use an unformatted SDHC memory card in a DVP-ES3/EX3/SV3/SX3 CPU module. 

The following example introduces the most common way to format an SDHC card: formatting an SDHC card 

through a card reader. Also carefully read the documents provided by the SDHC card manufacturer. 

 

(1) Insert the SDHC card into a card reader. The operating system detects a new storage device. 

(2) Right-click the new storage device, and then click Format. 

(3) You must format the memory card with the FAT32 file system. Do not change any other default settings. 

Click Quick Format, and then click Start. 

(4) After you click OK in the warning window, the SDHC card formats. 

 

When you format a memory card, you also delete all the data in the memory card. Verify whether you 
need to back up the data in a memory card before you format the memory card. 
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7.3 Installing and Removing a Memory Card 

7.3.1 Memory Card Slot in a CPU Module 

The memory card slot is on the front side of the DVP-ES3/EX3/SV3/SX3 PLC.  

DVP-ES3/EX3 DVP-SV3/SX3 
  

 

 

 
 

 
 



Chapter  7 Memory Card 

 7-5 

7_
 

7.3.2 Installing a Memory Card 

Insert a memory card into the CPU module memory card slot and push it in until it clicks. Be sure the memory 

card is fixed firmly in the slot; if the memory card is loose, it is not installed correctly. The memory card can only 

be inserted in one direction. Do not force the memory card or you may damage the CPU module. The correct 

way to insert the memory card is shown below. 

DVP-ES3/EX3 

 

 
 
 

 

 

 

 

 
 
 

 

 

DVP-SV3/SX3 

 

 
 

 
 

 
 

 
 

 
 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 7-6 

_7 

7.3.3 Removing a Memory Card 

You can remove a memory card by pushing it in. The card then springs from the slot. 

DVP-ES3/EX3 

 

 

 
 
 
 

 

 

 
 

 

 
 
 
 

 
 

DVP-SV3/SX3 
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7.4 Memory Card Contents  

7.4.1 Initializing a Memory Card 

When you insert an SDHC card into a CPU module that is powered on, and use ISPSoft / DIADesigner -> 

CARD Utility to back up a project, the system initializes the SDHC card, and creates a default folder named 

according to the model of the CPU module. (If the folder is already existed, the system does not create a 

second folder for the same model.)  

When the system initializes an SDHC card, it automatically adds any missing folders to the directory structure. 

However, if the initialization of a SDHC card fails, you cannot initialize the SDHC card again until you reformat it. 

When you initialize a memory card, the SYSTEM indicator in the software blinks. 

 

7.4.2 Folder Structure in a Memory Card 

The image below shows the default folder group created by a DVP-ES3/EX3/SV3/SX3 System. The folder 

name is ES3. Several subfolders are contained inside the ES3 folder. Related files created by you and the 

DVP-ES3/EX3/SV3/SX3 system are stored in the subfolders. 

 

PLC CARD SDCard ES3 Firmware 

Log 

SysDup 

DevMem 

Setup 

UserProg 
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Folder Description 

Firmware Stores firmware files (.ext) 

Log Stores Log files (.log) 

SysDup Stores backup files (.dup) 

UserProg Stores device memory files (.txt, .dmd, .csv) 

DevMem, Setup Reserved for the system use 
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7.5 Introduction to the CARD Utility 

The DVP-ES3/EX3/SV3/SX3 CPU modules include SDHC slots, and you can back up and restore module data 
with a memory card. DIADesigner/ISPSoft includes the CARD Utility for the DVP-ES3/EX3/SV3/SX3 CPU 
modules. With this utility, you can back up and restore data in a DVP-ES3/EX3/SV3/SX3 CPU module or 
backup and restore an ISPSoft project. The backup can include the program code, parameter settings, 
hardware configuration, and network configuration, as well as the values in the devices in a CPU module. You 
can use either ISPSoft or DIADesigner to edit DVP-ES3. But only use DIADesigner to edit 
DVP-ES300TEC/EX3/SV3/SX3. 

The list below describes the functions supported by the CARD Utility, including a flowchart. 

 If you export data from a CPU module as a backup file (*.dup), you can save the exported data in the 
memory card in the module or in a folder on the computer. You can also decide whether to back up the 
values in the devices in the CPU module. 

 If you export an ISPSoft project for a CPU module as a backup file (*.dup), you can only save the exported 
ISPSoft project in a folder in the computer. You can see data such as register editing (*.dvl), device status 
editing (*.dvb), file register editing (*.wft) for the CPU module as values in the device and back them up. You 
can put a memory card with the backup file into the CPU module. You can copy a backup file (*.dup) saved 
on the computer into the CPU module connected to the computer, or restore the backup file to an ISPSoft 
project. If you choose to restore the backup file to an ISPSoft project, the system automatically skips the 
values in the devices and the hardware configuration in the backup file.  

 If you restore the backup file (*.dup) from the PC to an ISPSoft project for a CPU module, you can also 
restore data such as register editing (*.dvl), device status editing (*.dvb), and file register editing (*.wft) for 
the CPU module.  

 

Note: The CARD Utility of DIADesigner does not include project restoration. 

For ISPsoft, double-click CARD Utility in the project management area to open the CARD Utility wizard. After 
selecting the controller type, click “Next” to proceed.  
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For DIADesigner, add a device in and then go to Controller -> Auxiliary -> CARD Utility.    
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7.6 Backing Up a Project 

If the backup source or backup destination is a DVP series CPU module or memory card, make sure that 

ISPSoft/DIADesigner is connected to the module. During backup, the CPU LED and Error LED blinks 

alternatively and SM452 flag is ON. After the backup is done, the CPU LED and Error LED stops blinking and 

SM452 flag is OFF. For ISPoft operation, refer to Section 2.4 in the ISPSoft User Manual or for DIADesigner, 

refer to Chapter 5 in the DIADesigner User Manual for more information. 

The following operation demonstration is for ISPSoft. 

(1) Select the Backup (To DUP File) option button in the CARD Utility wizard and then click Next. 

 

(2) Select a backup source, and then click Next. 

a. If you select the CPU (Need Connection), the backup file is stored in the memory card.  
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b. If you select the ISP Project (Compiled and saved), the backup file is stored in your computer. Click 

 and select an isp file in the Open dialog box. If the program in the isp file selected is not compiled, a 

message appears when you back up the isp file. Open the isp file with ISPSoft, compile the program in the 

isp file, and then save the isp file. After the program in the isp file is compiled, you can back up the isp file. 

 

 

(3) After you select CPU (Need Connection) / ISP Project (Compiled and saved), click Next,  

a. If you select the CPU (Need Connection), a prompted window appears. And you need to decide 

whether to back up the values in devices on the CPU module that is connected to ISPSoft. 
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b. If you select the ISP Project (Compiled and saved), the backup file is stored in your computer. Click 

 and select an isp file in the Open dialog box and then decide the file path where you’d like to store 

the backup file in your computer and then define its file name.  

 

 

(4) Select a backup destination. If the backup source is an ISPSoft project, the backup destination must be a 

computer. 

a. If you select Memory Card (PLC Side), the filename of the backup file is AUTOEXEC.dup, and the 

backup file paths are shown below.   

DVP-ES3: Root directory of the memory card\SDCard\PLC CARD\ES3\SysDup\AUTOEXEC.dup 

DVP-EX3: Root directory of the memory card\SDCard\PLC CARD\EX3\SysDup\AUTOEXEC.dup 

DVP-SV3: Root directory of the memory card\SDCard\PLC CARD\SV3\SysDup\AUTOEXEC.dup 

DVP-SX3: Root directory of the memory card\SDCard\PLC CARD\SX3\SysDup\AUTOEXEC.dup 

 

 
 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 7-14 

_7 

b. If you select PC (DUP File), click , select a folder in the Save in list in the Save As dialog box, and 

type a filename in the File name box. When you select the backup source for the ISPSoft Project, set 

the PLC password. You can set the password to be the same as the Project password, set a new PLC 

password, or not set a PLC password. If you do not set a password for the Project, the PLC password 

is also not set. When you select Setting new PLC password, the wizard looks like the following 

image. And you can set new PLC password and number of the attempt times.  

   

 
(5) After that you can see the summary. Make sure that the summary in the CARD Utility wizard is 

consistent with the data backup you want to perform, and then click Execute.  

a. When the source for back up is from CPU: 
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b. When the source for back up is from ISP Project: 

 

 

(6) The CPU module still performs the data backup even if you click Cancel. You can turn off the CPU 

module to stop the data backup; however, the backup file produced is not a complete backup file, and you 

must delete the backup file from the memory card. 

If you select Memory Card (PLC Side), the filename of the backup file is AUTOEXEC.dup, and the 

backup file path is Root directory of the memory card\ES3\SysDup\AUTOEXEC.dup. If there is an old 

backup file in the memory card, the Warning message appears. Click Replace, Archive, or Cancel in the 

Warning message. 

 

If the backed up data is protected by passwords, these passwords are also backed up. 

Data backup Description 

CPU module  Memory card 
The backed up data includes the PLC ID and the PLC password set 

in the CPU module. 

ISPSoft project  Computer 
The backed up data includes the program ID and the project 

password set in the ISPSoft project. 
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(7) After you perform the data backup, click Home or Close in the CARD Utility wizard. 
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7.7 Restoring a Project 

If the restoration source or restoration destination is a CPU module or memory card, make sure that ISPSoft is 

connected to the CPU module. During restoration, the CPU LED and Error LED blinks alternatively and SM452 

flag is ON. After restoration is done, the CPU LED and Error LED stops blinking and SM452 flag is OFF. For 

ISPoft operation, refer to Section 2.4 in the ISPSoft User Manual or for DIADesigner, refer to Chapter 5 in the 

DIADesigner User Manual for more information. 

The following operation demonstration is for ISPSoft. 

(1) Select Restore (From DUP File) in the CARD Utility wizard and then click Next.  

 

(2) Select a restoration source, click  and then select a backup file to be restored. 

a. If you select Memory Card (PLC side) (Need Connection), the backup files in the memory card 

display in a window after you click . Double-click a backup file in the window to choose it. 
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b. If you select PC (Need Connection), the backup files in the PC display in a window after you click . 

Double-click a backup file in the window to choose it. (Note: The CARD Utility of DIADesigner does not 

include project restoration.) 

 

 

(3) Select a restoration destination, and then click Next.  

a. To put the selected backup file into the CPU module, select CPU (Need Connection). If the 

restoration source is the CPU (Need Connection), the restoration destination must be the CPU 

module.  
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b. If you select ISP Project, click , and then specify a filename and a path. If the path specified point 

to a file that already exists, the file is overwritten when you restore the data. 

 

(4) Make sure that the summary in the CARD Utility wizard is consistent with the data restoration you want 

to perform and then click Execute. 

a. The source for restoration is from SD Card.  

 

b. The source for restoration is from the CPU. 
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If you click Cancel in the process of restoring data to the CPU module, the data is not completely restored. 

The CPU module still performs the data restoration even if you click Cancel in the process of restoring a 

backup file in the memory card. You can turn off the CPU module to stop the data restoration from being 

performed. To prevent the CPU module from operating incorrectly, restore the CPU module to the factory 

setting, or perform the data restoration again.  

The restoration source or restoration destination may contain a password and an ID. The following table 

describes the password and the ID process. 

Data restoration Description 

Memory card 

 PU module 

a. The ID in the backup file must be the same as the ID in the CPU module; 

otherwise the data is not restored. 

b. If there is a PLC password in the CPU module, the password in the backup file 

must be the same as the PLC password in the CPU module. Otherwise the 

data is not restored. 

c. If there is no PLC password in the CPU module, and there is a password in the 

backup file, the system restores the data, and the password in the backup file 

becomes the PLC password in the CPU. 

Computer 

ISPSoft project 

The ID and the password in the backup file become the program ID and the 

project password in the ISPSoft project. 
 

(5) After you perform the data restoration, click Home or Close in the CARD Utility wizard. 
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7.8 Restoration Starts Once CPU is supplied with Power 

When the backup file in the memory card is consistent with the specific path and file name, the CPU can 

perform restoration once it is supplied with power. During restoration, the CPU LED and Error LED blinks 

alternatively and SM452 flag is ON. After restoration is done, the CPU LED and Error LED stops blinking and 

SM452 flag is OFF.  

Operation Steps: 

(1) Set up the backup file path and file name for the memory card backup file. The filename of the backup file 

is BACKUP.dup and the backup file paths are shown below.   

DVP-ES3: Memory card root directory\SDCard\PLC CARD\ES3\SysDup\ES3_BACKUP.dup  

DVP-EX3: Memory card root directory\SDCard\PLC CARD\ES3\SysDup\EX3_BACKUP.dup  

DVP-SV3: Memory card root directory\SDCard\PLC CARD\ES3\SysDup\SV3_BACKUP.dup  

DVP-SX3: Memory card root directory\SDCard\PLC CARD\ES3\SysDup\SX3_BACKUP.dup  

(2) Insert the memory card into the card slot when the CPU power is off.  

(3) When the CPU power is on, it automatically checks if the memory card data is consistent with the PLC 

data. If not, the restoration begins. The data check is specifically on the data in CPU programs and 

HWCONFIG parameters.     

(4) During the restoration, the CPU LED and Error LED blinks alternatively. Once the restoration is done, the 

blinking stops.  



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 7-22 

_7 

7.9 CPU Error Log  
The system stores CPU error messages in the memory card whenever the quantity of the error messages 

reached to 20. You can also use special flag SM36 and special device SR36 to read the CPU error messages 

and state change logs. If there is error logs recorded in the memory card, the memory card keeps storing the 

error logs. You can change the file path to store other error logs or change the file name to store other error 

logs.   

Special Device Function Code Description 

SR36 

a. when the value is 0, it indicates there is no recording.  
b. when the value is 1234, it indicates the logs are stored in the memory card.  
c. when the value is 3456, it indicates the error logs and state change logs are stored in 

the memory card.  

 

Operation Steps to read CPU error logs and state change logs: 

Make sure the memory card is in the slot before reading the CPU error logs and state change logs.  

(1) Set SM36 to ON and the value in SR36 to 1234 or 3456 to read the CPU error logs and state change logs.  

(2) The root directory path of the memory card for the error log is  

DVP-ES3: Memory card root directory\SDCard\PLC CARD\ES3\Log\Error.log 

DVP-EX3: Memory card root directory\SDCard\PLC CARD\EX3\Log\Error.log  

DVP-SV3: Memory card root directory\SDCard\PLC CARD\SV3\Log\Error.log  

DVP-SX3: Memory card root directory\SDCard\PLC CARD\SX3\Log\Error.log  

Use ISPSoft to read the error logs. ISPSoft Tools -> Review Error Log File -> Open Log File  

 

(3) The root directory path of the memory card for the status log is  

DVP-ES3: Memory card root directory\SDCard\PLC CARD\ES3\Log\STATUS.log 

DVP-EX3: Memory card root directory\SDCard\PLC CARD\EX3\Log\STATUS.log 

DVP-SV3: Memory card root directory\SDCard\PLC CARD\SV3\Log\STATUS.log 

DVP-SX3: Memory card root directory\SDCard\PLC CARD\SX3\Log\STATUS.log 

Use ISPSoft to read the status logs. ISPSoft Tools -> Review Status Log File -> Open Log File  
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8.1 Hardware Configuration Tool for DVP-ES3 Series Modules – 
ISPSoft HWCONFIG 

HWCONFIG is a built-in hardware configuration tool in ISPSoft. You can set up CPU and module parameters, 

download/upload parameters, detect a hardware configuration online, and make a diagnosis through HWCONFIG. 

You must download all parameters set in HWCONFIG to the CPU module for them to take effect.  

 

8.1.1 Introduction of the HWCONFIG Environment  

In ISPSoft, double-click HWCONFIG in the project management area to start HWCONFIG. 

 

 

 

 

 

 

 

 

Delta Electronics provides you with specific configuration tools for some CPU modules. You can add extension 

modules to the right side of the DVP-ES3 Series CPU module. The system configuration area displays the present 

system configuration. When you modify the configuration in the system configuration area, the information in the 

information list updates.  

Parameter: settings for CPU 

AIO Wizard: settings for the right-side extension modules  

CANopen Builder: for CANopen communication  

EIP Builder: for EIP communication   

You can use tools such as CANopen Builder and EIP Builder to set advanced network assignments for the modules. 

Refer to the manuals for the communication software tools for more information on setting up communications.  
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8.1.2 Configuring a Module 

For DVP-ES3 Series, you need AIO Wizard to configure its right-side modules. Click AIO Wizard Setting to open the 

wizard. You can Upload Module or Enter Edit Mode by clicking the relevant radio buttons. The following example 

demonstrates how to upload module data for a project of ES3+04DA-E2+DVP04AD-E2+04PT-E2.  

Step 1. Go to AIO Wizard from HWCONFIG of ISPSoft and then click Upload Module.  

 

 

 

 

 

 

 

 

 

 
Step 2. Click the module that you need to set up in the section of Allocation of Links to enter its setting page.  
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Step 3. Set up the parameters for the selected modules.   
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Step 4. Tick the option Select ALL and then click Download to have the parameters downloaded to your PLC. Click 

Next to enter the conversion setting page.  
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If the PLC is connected with a special extension module, the PLC uses data registers and the registers in this 

area correspond to CRs to update data. If you need to use this area, you need to pay attention not to use the 

same area repeatedly.  

Extension module Data mapping area Remark 

Right side extension module D28000~D28079 Used with SM228 to enable/disable 
the data exchange 

Left side extension module (DVP-SV3/SX3) D29000~D29079 Used with SM265 to enable/disable 
the data exchange 

Left side extension module DNET/COPM 
(DVP-SV3/SX3 D16000~D19999  

Refer to section 2.2.16 from DVP-ES3/EX3/SV3/SX3 Series Programming Manual for more information.  

 

 

8.1.3 Editing a Comment 

You can add a comment directly in the Comment box.  
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8.2 Hardware Configuration Tool for DVP-ES3/EX3/SV3/SX3 
      Series Modules – DIADesigner 

You must download all parameters set in DIADesigner to the CPU module for them to take effect.  

 
8.2.1 Introduction of the DIADesigner Environment  

Double click Network View under Network Config. in the project tree to open the setting page. After that, click the 

scan icon to search for the devices to be added.  

 

Double-click Parameter Setting to open the setting page. 
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Delta Electronics provides you with specific configuration tools for some CPU modules. You can add extension 

modules to the right side of the DVP-ES3/EX3 Series CPU module. And for DVP-SV3/SX3 series, you can install 

extension modules on its both sides (left and right). There are Configurations (for CPU modules) and Parameter 

Setting (for CPU parameters) under the Hardware Configuration. And the built-in CAN communication setting allows 

you to change the CAN port work mode.  

 

Use Network View to set up different communication protocols. After the network is established, you can find the 

communications in the Network View and by double-clicking the created communications, e.g. Ethernet and CANopen, 

you can open the setting page for advanced configuration and parameter settings.  
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8.2.2 Configuring a Module 

For DVP-ES3/EX3 Series, you can configure its right-side modules. For DVP-SX3/SV3, you can configure either left 

and right modules. Double-click on the module icon you’d like to set up to open its configuration window. After 

configuration, the module will execute accordingly.  

 

 

 

After configuration is done, download the parameters to the module.  
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If the PLC is connected with a special extension module, the PLC uses data registers and the registers in this 

area correspond to CRs to update data. If you need to use this area, you need to pay attention not to use the 

same area repeatedly. For DVP-SV3/SX3 series, you can use FROM/TO instruction to set up the module 

parameters. 

Extension module Data mapping area Remark 

Right side extension module D28000~D28079 Used with SM228 to enable/disable 
the data exchange 

Left side extension module (DVP-SV3/SX3) D29000~D29079 Used with SM265 to enable/disable 
the data exchange 

Left side extension module DNET/COPM 
(DVP-SV3/SX3 D16000~D19999  

Refer to section 2.2.16 from DVP-ES3/EX3/SV3/SX3 Series Programming Manual for more information.  

 

8.2.3 Editing a Comment 

You can add a comment directly in the Comment box.  
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8.3 Setting the Parameters in a DVP-ES3 Series CPU Module – 
ISPSoft  

8.3.1 Opening the PLC Parameter Setting Window 

After you double-click HWCONFIG in the project management area, the ES3 Series setting page appears. Click 

Settings button to set up the CPU parameters. 

* You must download the set parameters to the CPU module before they take effect.  

 

 
 

 

 

 

 

 

 

 

Here shows present 

system configurations 

and the product 

specifications.  
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The parameters are classified into several types. Click the tabs at the top of the Device Setting dialog box and then 

click the setting options in the tree on the left. The setting parameters for the selected setting option appear on the 

right in the Device Setting dialog box. Click the option on the left, and then set Value, Unit, Default, Minimum and 

Maximum for each parameter. Refer to section 8.3.2 for more information.  

 

 

8.3.2 Setting the Basic CPU Parameters 

8.3.2.1 System Settings 

In the Device Setting dialog box, click the Options tab, and unfold the System settings to set up the settings of 

System Information, System Parameter, Device Range Setting, Input Point Filter Time, Position Control Para, 

and Daylight Saving Timing.  
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System Information  

On the System Information page, you can edit two parameters: Name and Comment. You can enter up to 15 

characters in the Name section and up to 30 characters in the Comment section. You can use spaces and special 

characters in these two sections, but note that a Chinese character occupies two characters.   

After you create an ISPSoft project, the default project name is the name of the CPU module, and it is attached to the 

model in the project management area. You can change the default name of the CPU module in the Value box of the 

PLC Label. 

 

 

You can identify a device by means of device name. When several devices are connected on a network, you can 

check whether a device connected to the computer is the device you expect by the device name. If you want to 

download or upload the program, but the name of the CPU module is different from the name attached to the model in 

the project management area, the system reminds you to check the name of the CPU module and the name attached 

to the model in the project management area. 
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System Parameter 

On the System Parameter page, you can set parameters by entering appropriate values or by selecting from a list. 

 

 Clear Non-latched area when Run  Stop 

This determines whether the states and values of the non-latched devices are cleared when the PLC changes 

from Run to Stop. 

 Disable: all the states and values in the non-latched devices stay the same. 

 Enable: all the states and values in the non-latched devices are cleared and restored to defaults. 

 

 Y keeps outputting when RUNStop 

This determines the states of the Y devices when the CPU module begins to run or stop.  

 Off: all Y devices are set to OFF. 

 Retain: the states of the Y devices stay the same. 

 

 Setting delay time to detect I/O Module 

This sets the time to detect an I/O module after powering on the CPU module.  

 

 Assign X Input Point Control Run/Stop 

This assigns an input point to have the CPU module run or stop. 

 Disable: run or stop the CPU module with the dip switch of the CPU module. 

 Enable: run or stop the CPU module with the assigned input point, and the dip switch of the CPU module still 

controls the run stop state of the CPU module.   
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 Select X Input Point 

If you select Enable in the previous option, you can select one input point to control the Run or Stop state of the 

CPU module from the dropdown list.  

 

 Constant Scan Cycle Time 

This sets the minimum scan cycle time. 

 Disable: disables this function. 

 Enable: when the actual scan cycle time is less than the setting time, the CPU module waits until the setting 

time is met, and then starts the next scan. When the actual scan time is longer than the setting time, 

the CPU module starts the next scan after the actual scan time completes.   

 

 Input Constant Time 

If you selected Enable in the previous option, you set the scan cycle time here. If the actual scan time is larger 

than the setting time, a watchdog timeout occurs when the CPU module operates.  

 

 Setting Watchdog Time 

This parameter sets a timeout during which the program is scanned. The CPU module sends an error if the 

program execution exceeds the watchdog time. 

 

 Save Error History Info 

This specifies where to store the error log. 

 PLC: store error logs in the PLC. The PLC can store up to twenty error logs. If there are more than twenty error 

logs, the oldest error log is overwritten by the latest error log.  

 PLC & SD Card: when there are more than twenty error logs, the oldest error log is backed up to the memory 

card before the oldest error log is overwritten in the PLC.  

 

 COM Communication Error Record 

This parameter sets whether to enable the error record when there is an error at the COM port. 

 Disable: disables this function. 

 Enable: enables this function and starts recording COM errors in the error log.  

 

 Select Action When 24 Vdc Input Unstable  

When the 24 Vdc power is unstable and insufficient for 20 to 100 ms, it will be recorded in the error log and SM7 

will be ON. What to do when the 24 Vdc power is unstable:  

 Continue Running when power stable: all the operation will be stopped and PLC CPU waits till the power is 

stable for 2 seconds and then PLC begins to run.  
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 Into Error Status: When the 24 Vdc power is unstable, PLC CPU Stops and the ERROR LED blinks rapidly.  

   Check and solve the problem. After all the problem is solved, supply PLC CPU with power and turn it on. If the   

   power voltage is too low, the communication cannot go on. If the communication is working that means, the  

   power is back on. But you still need to clarify what caused the power unstable.  

 

 I601 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1601 timer interrupt. This function is used together with Timer Interrupt 0. 

During PLC execution, you can use SR421 to modify the interrupt timing.   

 

 I602 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1602 timer interrupt. This function is used together with Timer Interrupt 1. 

During PLC execution, you can use SR422 to modify the interrupt timing.   

 

 I603 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1603 timer interrupt. This function is used together with Timer Interrupt 2. 

During PLC execution, you can use SR423 to modify the interrupt timing.   

 

 I604 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1604 timer interrupt. This function is used together with Timer Interrupt 3. 

During PLC execution, you can use SR424 to modify the interrupt timing.   

 

Device Range Setting  

The parameters on Device Range Setting table are shown in the following window. 
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Click  to open the parameter dialog box to set the start and end address. In the dialog box, click Default to restore 

the setting to the default values; click Clear to clear the set values; click OK to save the values and close the dialog 

box; click Cancel to discard the setting and close the dialog box.  

 

Input Point Filter Time  

On the Input Point Filter Time page, you can set the input point filter time for each input. If the duration of the received 

signal time is less than the filter time setting value, it is processed as noise and filtered out. Select an appropriate filter 

time according to your needs. 

 

 X Input Point Filter for CPU module  

 Default Setting: uses the default values in the input point filter. 

 Manual Setting: uses the values you enter for the filter time for each X input point. 

 

 X0–X17 Input Point Filter Time 

 If you select Manual Setting for the previous parameter, you can set the filter time individually for X0–X17. 
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Position Control Parameter 

The parameters on Position Control Parameter table set to specify input points as the positive and 

negative limits of axis 1~ axis 4 channels. 12 limit points can be set at most. Axis No. 1~4 can also be set 

as Z phase triggers, home function finish points and clear output selects or positive/negative limited 

position.  

 

 Axis1 (Y0/Y1) Positive/negative Limited Select~ Axis4 (Y6/Y7) Positive/negative Limited 

Select: select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0/Y1) Z Phase Trigger ~ Axis4 (Y6/Y7) Z Phase Trigger:   

  Select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0/Y1) Home Function Finish and Clear Output Select ~ Axis4 (Y6/Y7) Home Function Finish and Clear 

Output Select: select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0/Y1) Positive/negative Limited Position ~ Axis4 (Y6/Y7) Positive/negative Limited Position: set up the 

number of pulses as the positive or negative limited position in axis 1~4; setting range is -2147483647～

2147483647.  
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Daylight Saving Timing 

Enable or disable this function on the Daylight Saving Timing page. Set daylight saving time and the set the time 

zones for daylight saving and the system acts accordingly.    

 

 Disable/Enable D.S.T Function 

Sets whether or not to use daylight saving time. 

 Start Date – Month 

Sets the month to start daylight saving 

 Start Date – Day 

Sets the day to start daylight saving 

 End Date – Month 

Sets the month to end daylight saving 

 Start Date – Day 

Sets the day to end daylight saving 

 Saving time 

Sets daylight saving time in minutes 

 Example explanation: example from the above image and all the options are enabled. 

 Date shown in SR Time shown in SR  
PLC time  

(Real Time Clock) 
Remarks 

3/31 23:59:58 23:59:58 
Normal 

3/31 23:59:59 23:59:59 

4/01 01:00:00 00:00:00 

Shown after 60 minutes 
4/01 01:00:01 00:00:01 

: (to) : (to) : (to) 
9/30 23:59:59 22:59:59 
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10/01 00:00:00 (9/30) 23:00:00 

: (to) : (to) : (to) 
10/01 00:59:59 (9/30) 23:59:59 

10/01 00:00:00 00:00:00 
Normal 

10/01 00:00:01 00:00:01 

8.3.2.2 COM1 & COM2 Port Setting 

The DVP-ES3 Series CPU module has two communication ports. There are two areas to set the parameters, one for 

each communication port.  

 

 Set a station address. You can identify a device on a network by the station address. The station address cannot be 

the same as the station address for another device on the same network. If the communication port functions as a 

slave, and there are other slaves, the station address of the communication port cannot be 0. Station address 0 

broadcasts to all slaves in a communication protocol. If a master specifies in a data packet that data must be sent to 

station address 0, the data is sent to all slaves. No matter what the station address of these slaves are, these slaves 

receive the data packet addressed to station address 0. 

 Set when the communication port runs. Select Stop --> Run, and communication works when the CPU module 

switches from Stop to Run. If you instead select Power-on, the communication starts working when you Power-on the 

module.  

 Select a communication speed in the Baud Rate list, or select Custom and enter a new rate.  

 Set the communication parameters for the port.  

 Set the Delay Time to Reply when the DVP-ES3 CPU module receives communication and how long it waits 

before responding to the remote modules.  

 Received Data Timeout applies when the DVP-ES3 Series CPU module acts as a server to send out 

communications. The timeout is how long the module waits before the received data times out.    
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8.3.2.3 Ethernet Port Basic Setting 

Click Ethernet Port Basic Setting to see the setup page. Set the communication parameters for the Ethernet port in 

the CPU module on this page.  

 

Select Static in the Mode list to specify an IP address. Select Dynamic or BOOTP in the Mode list to assign an IP 

address from a DHCP/BOOTP server.  

8.3.2.4 Ethernet Port Advanced Setting 

Click Ethernet Port Advanced Setting to see the setup page. There are setups for IP Filter, NTP, Email, Socket, 

and RTU mapping.  

IP Filter  

Devices whose IP addresses are listed in the table are allowed to communicate with the CPU module; the CPU 

module discards data packets sent from devices whose IP addresses are not in the table. Devices on a network are 

filtered. This setting ensures that objects communicating with the CPU module are known devices. You can set up to 8 

address ranges for allowed devices.  
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NTP 

Click NTP to synchronize the real-time clock in the CPU module to an NTP server. Please refer to related documents 
or manuals for more information about NTP. 

Select the NTP Client Function Enable check box, and then set the related parameters. 

 

 Set the IP address for an NTP server. The CPU module corrects its internal time by connecting periodically to the 
server. 

 Set a time interval for correcting the time in the CPU module. If the interval is thirty minutes, the CPU module 
connects to the NTP server every thirty minutes. 

 Select a time zone in the Time Zone list. 

Email  

Click Email to set the email-related functions. The system sends email to the set email address after you enable the 
email function. You can set up to four sets of conditions for sending email to up to four groups of email addresses. 
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 Select Email Function Enable to enable the function. 

 Set an IP address for the SMTP server. Set the COM port of SMTP server at the COM port and set the sender’s 
local email address. Type the Mail Subject to appear at the start of the subject of every email.  

 Select Account identification checkbox to enable the function to authenticate the connection with a user name 
and a password when logging into an SMTP server. 

 Type the target email addresses. 

 

Click 1st Trigger Setting and enter a Trigger Name and a minimum interval in Trigger Min Cycle. Then select a 
Trigger Mode. When the sending condition is met, the system sends an email periodically. However, during the same 
period, the system does not send the same email again, even if the condition occurred again and again.  

 

You can set email trigger modes as follows. 
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 CPU Error 

Trigger sending an email if an error occurs in the CPU module. Refer to the Operation manuals for more information 
about errors occurring in CPU modules. After you select CPU Error, select Fatal Error Only or All Errors in the list at 
the right side of the option. 

a) Fatal Error Only: Send an email if a fatal error occurs in the CPU module. 

b) All Errors: Send an email if an error occurs in the CPU module. 

 CPU (RUN<=>STOP) 

Trigger sending an email when the CPU module begins to run, or when the CPU module stops running. 

 Bit Status Change 

Trigger sending an email if the state of a bit device specified meets a set condition. For example, if X0 switches from 
OFF to ON, it triggers sending an email. To set a condition, click the   button in the following dialog box. 

 

 

 

 

 

 

 

 Device Name: Select a device type. 

 Device Number & Bit: Type a device address; if the device type selected is X/Y, you must specify a bit 
number as well. 

 State: Select Rising or Falling. 

 

Register Value Change 

Trigger sending an email if the value in a device specified meets a set condition. For example, if the value in D0 is 
larger than 10. To set a condition, click the   button in the following dialog box.              
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 Device Name: Users can select a device type in the Device Name drop-down list. 

 Device Number: Users can type a device address in the Device Number field. 

 State & Value: Users can set s condition of triggering the sending of an email here. 

 

 Periodic Timer 

The system periodically sends an email. How often the system sends an email depends on the Trigger Min Cycle 
interval in the Trigger Setting section. 

When you set any trigger mode, the user message and error log related parameters appear. 

 

Select the Trigger User Message Enable check box and then click the  to the right side of Trigger User 
Message. Type some content for the email text in the dialog box. 

If you select the Error Log Enable check box, the system automatically adds the error log to the email content.  

Trigger Attachment Mode determines whether to add an attachment to the email. Check the maximum size allowed 
for the email file before adding an attachment. Refer to the relevant email operation manuals for more information.  

If you select None, no attachment is inserted. 

 File 

Allows you to select an error log or the system backup file from the memory card as the email attachment.  

 PLC Device 

The system automatically retrieves the device states or values listed in the table as the email attachment. After you 
select this option, click  in the following dialog box to open the Attachment dialog box. You can set a maximum of 
two groups of devices. For example, if the condition is met, the values in D0–D9 are sent as an attachment.  
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Select the recipient’s remote address for the triggered email in the Trigger Recipient table. You can set the specific 
email address in the setting option of Email. 
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Sockets 

You can set the parameters for sockets through which data is transmitted. You must use this function with specific 
applied instructions. Refer to the DVP-ES3 Series Programming Manual for more information, as sockets are not 
described here. Refer to the related documents or manuals for more information about sockets. In the Socket table, 
set COM port parameters for data transmission through Ethernet; however, you should use this function only with 
specific API instructions. For relevant details, refer to DVP-ES3/EX3/SV3/SX3 Series Programming Manual.  

 

 

The system for the DVP-ES3 Series module supports data transmission between the CPU module and other CPU 
modules or devices through a socket as well as through TCP and UDP protocols. You can set up four connections in 
each of the four groups. Select the Socket Function Enable checkbox and then select settings in the TCP and UDP 
setting pages. 
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The parameters in the TCP Socket Setting are the same as the parameters in the UDP Socket Setting except that 
there is no Keep Alive Timer parameter in the UDP Socket Setting. 

 Remote IP: Sets a remote IP address. 

 Remote Port: Sets a communication port used by the remote device for this TCP connection. The port number   
            must be between 0–65535. 

 Local Port: Sets a communication port used by the local CPU module for this connection. The port number must be  
         between 0–65535. 

 Send Address: Sets an initial device in the CPU module where sent data is stored. 

 Send Length: Sets the length of data sent by the local CPU module. The length must be between 0–200 bytes. 

 Receive Address: Sets an initial device in the CPU module where received data is stored. 

 Receive Length: Sets the length of data received by the local CPU module. The length must be between 0–200   
              bytes. 

 Keep Alive Timer: Sets a maximum time to keep the connection alive. If no data is transmitted, and the keep alive   
               period has elapsed, the CPU module automatically terminates the connection. 

The port number used by the local CPU module and the port number used by the remote device cannot be the same, 
and the devices where you store the sent data cannot overlap the devices where you store the received data. If the IP 
address of the remote device is 192.168.1.100, the port number used by the remote device is 65500, the port number 
used by the local CPU module is 65501, and the remote device and the local CPU module can transmit data through 
this TCP connection. 

If the local CPU module sends 10-word data to the remote device, the data is stored in D0–D9 before the data is sent. 
If the local CPU module receives 20-word data from the remote device, the data is stored in D100–D119.  

If the length of data received is larger than the setting value for the length, the first 20 words of data are stored in 
D100–D119, and the remainder of the data is discarded. Likewise, if the length of data received is less than the setting 
value for the length, the data is stored in the devices starting from D100, and the values in devices where no new data 
is stored are unchanged.  
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If no data is transmitted, and 60 seconds have elapsed, the CPU module closes the socket and terminates the 
connection. 

In the RTU Mapping table, you can set a Delta RTU-EN01 slave in connection with a DVP-ES3 Series module. The 
remote device is controlled through Ethernet and you can connect up to 4 groups of RTU-EN01 in the network. Refer 
to the operation manual for setting and operation of RTU-EN01. 

 

Select RTU Mapping Enable checkbox to enable the function of connection between RTU module and DVP-ES3 
Series module. Set the update cycle in Cycle box and a timeout in Timeout box. It means a timeout when RTU does 
not give a reply within the timeout set. 

The data mapping between each group of RTU-EN01 and DVP-ES3 Series module is set in the RTU Mapping section. 
RTU-EN01 and I/O module connected to it are set via DCISoft. For more information on DCISoft, refer to the operation 
manual. 
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 Select RTU1 Enable to enable this RTU function. You can set each RTU individually. 

 Set a station address and an IP address. 

 Set the RX mapping address and RX mapping length to make the digital input points for the DI module 
connected to RTU and mapped to X/M devices, as well as the length for the DVP-ES3 Series module. Set the 
RY mapping address and length to set the digital output points for the DO module mapped to Y/M devices, as 
well as the length for the DVP-ES3 Series module. 

 Set the RCR Read mapping address and RCR Read mapping length to make the analog input points for the AI 
module connected to RTU and mapped to D/SR devices, as well as the length for the DVP-ES3 Series module. 
Use the RCR Write mapping address and length to set the analog output points for the AO module mapped to 
D/SR devices, as well as the length for the DVP-ES3 Series module. 
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8.4 Setting the Parameters in a DVP-ES3/EX3/SV3/SX3 Series 
CPU Module – DIADesigner  

8.4.1 Opening the Controller Parameter Setting Window 

Double click Parameter Setting under Controller in the project tree to open the setting page.  

* You must download the set parameters to the CPU module before they take effect.  
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8.4.2 Setting the Basic CPU Parameters 

8.4.2.1 System Settings 

Unfold the System settings to find settings for System Information, System Parameter, Device Range Setting, 

Input Point Filter Time, Position Control Para, and Daylight Saving Timing.  

System Information  

On the System Information page, you can edit two parameters: PLC Label and Comment. You can enter up to 16 

characters in the Name section and up to 32 characters in the Comment section. You can use spaces and special 

characters in these two sections. But please note that a Chinese character occupies two characters.   

 

The edited name can be found in the Device & Error Information under Controller. You can identify a device by the 

device name.  
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System Parameters 

Select System Parameter and its setting page appears on the right. You can set Description, Unit, Actual Value, 

Default Value, Minimum Value and Maximum Value for each setting items. 

 

 Clear Non-latched area when Stop  Run 

This determines whether the states and values of the non-latched devices are cleared when the PLC changes 
from Stop to Run. 

 Disable: all the states and values in the non-latched devices stay the same. 

 Enable: all the states and values in the non-latched devices are cleared and restored to defaults. 

 

 Y keeps outputting when RUN  Stop 

This determines the states of the Y devices when the CPU module begins to run or stop.  

 Off: all Y devices are set to OFF. 

 Retain: the states of the Y devices stay the same. 

 Setting delay time to detect I/O Module 

This sets the time to detect an I/O module after powering on the CPU module.  

 

 Assign X Input Point Control Run/Stop 

This assigns an input point to have the CPU module run or stop. 

 Disable: run or stop the CPU module with the dip switch of the CPU module. 

 Enable: run or stop the CPU module with the assigned input point, and the dip switch of the CPU module still 
controls the run stop state of the CPU module.   
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 Select X Input Point 

If you select Enable in the previous option, you can select one input point to control the Run or Stop state of the 
CPU module from the dropdown list.  

 

 Constant Scan Cycle Time 

This sets the minimum scan cycle time. 

 Disable: disables this function. 

 Enable: when the actual scan cycle time is less than the setting time, the CPU module waits until the setting 
time is met, and then starts the next scan. When the actual scan time is longer than the setting time, 
the CPU module starts the next scan after the actual scan time completes.   

 

 Input Constant Time 

If you selected Enable in the previous option, you set the scan cycle time here. If the actual scan time is larger 
than the setting time, a watchdog timeout occurs when the CPU module operates.  

 

 Setting Watchdog Time 

This parameter sets a timeout during which the program is scanned. The CPU module sends an error if the 
program execution exceeds the watchdog time. 

 

 Save Error History Info 

This specifies where to store the error log. 

 PLC: store error logs in the PLC. The PLC can store up to twenty error logs. If there are more than twenty error 
   logs, the oldest error log is overwritten by the latest error log.  

 PLC & SD Card: when there are more than twenty error logs, the oldest error log is backed up to the memory  
             card before the oldest error log is overwritten in the PLC.  

 COM Communication Error Record 

This parameter sets whether to enable the error record when there is an error at the COM port. 

 Disable: disables this function. 

 Enable: enables this function and starts recording COM errors in the error log.  

 

 Select Action When 24 VDC Input Unstable  

When the 24 VDC power is unstable and insufficient for 20 to 100 ms, it will be recorded in the error log and SM7 
will be ON. What to do when the 24 VDC power is unstable:  
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 Continue Running when power stable: all the operation will be stopped and PLC CPU waits till the power is 
stable for 2 seconds and then PLC begins to run.  

 Into Error Status: When the 24 VDC power is unstable, PLC CPU Stops and the ERROR LED blinks rapidly.  

   Check and solve the problem. After all the problem is solved, supply PLC CPU with power and turn it on. If the   
   power voltage is too low, the communication cannot go on. If the communication is working that means, the  
   power is back on. But you still need to clarify what caused the power unstable.  

 

 I601 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1601 timer interrupt. This function is used together with Timer Interrupt 0. 
During PLC execution, you can use SR421 to modify the interrupt timing.   

 

 I602 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1602 timer interrupt. This function is used together with Timer Interrupt 1. 
During PLC execution, you can use SR422 to modify the interrupt timing.   

 

 I603 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1603 timer interrupt. This function is used together with Timer Interrupt 2. 
During PLC execution, you can use SR423 to modify the interrupt timing.   

 

 I604 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1604 timer interrupt. This function is used together with Timer Interrupt 3. 
During PLC execution, you can use SR424 to modify the interrupt timing.   
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Device Range Setting  

The parameters on Device Range Setting table are shown in the following window. 

 

 

Click  to open the parameter dialog box to set the start and end address. In the dialog box, click Default to restore 

the setting to the default values; click Clear to clear the set values; click OK to save the values and close the dialog 
box; click Cancel to discard the setting and close the dialog box.  
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Input Point Filter Time  

On the Input Point Filter Time page, you can set the input point filter time for each input. If the duration of the received 
signal time is less than the filter time setting value, it is processed as noise and filtered out. Select an appropriate filter 
time according to your needs. 

 

 X Input Point Filter for CPU module  

 Default Setting: uses the default values in the input point filter. 

 Manual Setting: uses the values you enter for the filter time for each X input point. 
 

 X0–X17 Input Point Filter Time 

 If you select Manual Setting for the previous parameter, you can set the filter time individually for X0–X17. 

 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 8-38 

_8 

Position Control Parameter 

The parameters on Position Control Parameter table set to specify input points as the positive and 
negative limits of axis 1~ axis 4 channels. 12 limit points can be set at most. Axis No. 1~4 can also be set 
as Z phase triggers, home function finish points and clear output selects or positive/negative limited 
position.  

 

 Axis1 (Y0/Y1) Positive/negative Limited Select~ Axis4 (Y6/Y7) Positive/negative Limited 
Select: select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0/Y1) Z Phase Trigger ~ Axis4 (Y6/Y7) Z Phase Trigger:   

  Select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0/Y1) Home Function Finish and Clear Output Select ~ Axis4 (Y6/Y7) Home Function Finish and Clear 
Output Select: select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0/Y1) Positive/negative Limited Position ~ Axis4 (Y6/Y7) Positive/negative Limited Position: set up the 
number of pulses as the positive or negative limited position in axis 1~4; setting range is -2147483647～

2147483647.  
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Daylight Saving Timing 

Enable or disable this function on the Daylight Saving Timing page. Set daylight saving time and the set the time 
zones for daylight saving and the system acts accordingly.    

 

 Disable/Enable D.S.T Function 

Sets whether or not to use daylight saving time. 

 Start Date – Month 

Sets the month to start daylight saving 

 Start Date – Day 

Sets the day to start daylight saving 

 End Date – Month 

Sets the month to end daylight saving 

 Start Date – Day 

Sets the day to end daylight saving 

 Saving time 

Sets daylight saving time in minutes 

 Example explanation: example from the above image and all the options are enabled. 

 Date shown in SR Time shown in SR  
PLC time  

(Real Time Clock) 
Remarks 

3/31 23:59:58 23:59:58 
Normal 

3/31 23:59:59 23:59:59 

4/01 01:00:00 00:00:00 

Shown after 60 minutes 

4/01 01:00:01 00:00:01 

: (to) : (to) : (to) 
9/30 23:59:59 22:59:59 

10/01 00:00:00 (9/30) 23:00:00 

: (to) : (to) : (to) 
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10/01 00:59:59 (9/30) 23:59:59 

10/01 00:00:00 00:00:00 
Normal 

10/01 00:00:01 00:00:01 
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8.4.2.2 COM1 & COM2 Port Settings 

The DVP-ES3/EX3/SV3/SX3 Series CPU module come with one or two communication ports, depending on the 

models. The setting items for COM1 and COM2 are the same; you can set the parameters for COM1 and COM2 ports 

respectively. 

 

 Set a station address. You can identify a device on a network by the station address. The station address cannot be 

the same as the station address for another device on the same network. If the communication port functions as a 

slave, and there are other slaves, the station address of the communication port cannot be 0. Station address 0 

broadcasts to all slaves in a communication protocol. If a master specifies in a data packet that data must be sent to 

station address 0, the data is sent to all slaves. No matter what the station address of these slaves are, these slaves 

receive the data packet addressed to station address 0. 

 Set when the communication port runs. Select Stop --> Run, and communication works when the CPU module 

switches from Stop to Run. If you instead select Power-on, the communication starts working when you Power-on the 

module.  

 Select a communication speed in the Baud Rate list or select Custom Baud Rate and enter a new rate.  

 Set the communication parameters, Data bit, Parity bit, Stop bit, and Modbus mode for the port.  

 Set the Delay time to sending when the DVP-ES3/EX3/SV3/SX3 CPU module receives communication and how 

long it waits before responding to the remote modules.  

 Received Data Timeout applies when the DVP-ES3/EX3/SV3/SX3 Series CPU module acts as a server to send 

out communications. The timeout is how long the module waits before the received data times out.    
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 8.4.2.3 Ethernet Port Basic Setting 

Click Ethernet Port Basic Setting to see the setting page. Set the communication parameters for the Ethernet port in 

the CPU module on this page.  

Select Static in the Mode list to specify an IP address. Select Dynamic or BOOTP in the Mode list to assign an IP 

address from a DHCP/BOOTP server.  

 

 

8.4.2.4 Ethernet Port Advanced Setting 

Click Ethernet Port Advanced Setting to see the setting page. There are setups for IP Filter, NTP, Email, Socket, 

and RTU-EN01 mapping.  

IP Filter  

Devices whose IP addresses are listed in the table are allowed to communicate with the CPU module; the CPU 

module discards data packets sent from devices whose IP addresses are not in the table. Devices on a network are 

filtered. This setting ensures that objects communicating with the CPU module are known devices. You can set up to 8 

address ranges for allowed devices.  
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NTP 

Click NTP to synchronize the real-time clock in the CPU module to an NTP server. Please refer to related documents 
or manuals for more information about NTP. 

Select the NTP Client Function Enable check box, and then set the related parameters. 

 

 Select NTP Client Function Enable to enable this function. 

 Set the IP address for an NTP server. The CPU module corrects its internal time by connecting periodically to the 
server. 

 Update Cycle: Set a time interval for correcting the time in the CPU module. If the interval is thirty minutes, the CPU 
module connects to the NTP server every thirty minutes. 

 Select a time zone in the Time Zone list. 

 

Email  

Click Email to set the email-related functions. The system sends email to the set email address after you enable the 
email function. You can set up to four sets of conditions for sending email to up to four groups of email addresses. 

 

 Select Email Function Enable to enable this function. 

 Set an IP address for the SMTP server. Set the Port of SMTP server and set the sender’s Local Email address. 
Type the Mail Subject to appear at the start of the subject of every email.  
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 Select Account identification checkbox to authenticate the connection with a user name and a password 
when logging into an SMTP server. 

 Type the Remote Addresses. 

 
Click 1st Trigger Setting and enter a Trigger Name and a minimum interval in Trigger Min Cycle. Then select a 
Trigger Mode. When the sending condition is met, the system sends an email periodically. However, during the same 
period, the system does not send the same email again, even if the condition occurred again and again.  

 

You can set email trigger modes as follows. 

 CPU Error 

Trigger sending an email if an error occurs in the CPU module. Refer to the CPU operation manuals for more 
information on errors occurring in CPU modules. After you select CPU Error, you can further select Fatal Error Only 
or All Errors. 

a) Fatal Error Only: Send an email if a fatal error occurs in the CPU module. 

b) All Errors: Send an email if an error occurs in the CPU module. 

 CPU (RUN<=>STOP) 

Trigger sending an email when the CPU module begins to run, or when the CPU module stops running. 

 Bit Status Change 

Trigger sending an email if the state of a bit device specified meets a set condition. For example, if M0 switches from 
OFF to ON, it triggers sending an email. To set a condition, click the   button in the following dialog box. 
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 Register: Select a device type. 

 Address and Bit Number: Type a device address; if the device type selected is X/Y, you must specify a bit  
                           number as well. 

 State: Select Rising or Falling. 

 

Register Value Change 

Trigger sending an email if the value in a device specified meets a set condition. For example, if the value in D0 is 
larger than 10. To set a condition, click the   button in the following dialog box.              

    

 Register: Users can select a device type. 

 Address and Bit Number: Users can type a device address. 

 State & Value: Users can set s condition of triggering the sending of an email here. 

 

 Periodic Timer 

The system periodically sends an email. How often the system sends an email depends on the Trigger Min Cycle 
interval in the Trigger Setting section. 

When you set any trigger mode, the user message and error log related parameters appear. 

 

Select the Trigger User Message Enable and then you can add a message as the email content in the dialog box. 

If you select the Trigger Error Log Enable, the system automatically adds the error log to the email content.  
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Trigger Attachment Mode determines whether to add an attachment to the email. Check the maximum size allowed 
for the email file before adding an attachment. Refer to the relevant email operation manuals for more information.  

If you select None, no attachment is inserted. 

 File 

Allows you to select an error log or the system backup file from the memory card as the email attachment.  

 PLC Device 

The system automatically retrieves the device states or values listed in the table as the email attachment. After you 
select this option, if the condition is met, the values in D0–D9 are sent as an attachment as the example shown here. 

 

Select the recipient’s remote address for the triggered email in the Trigger Recipient table. You can set the specific 
email address in the setting option of Email. 
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Sockets 

You can set the parameters for sockets through which data is transmitted. You must use this function with specific 
applied instructions. For details, refer to DVP-ES3/EX3/SV3/SX3 Series Programming Manual. You can also refer to 
the other documents or manuals for more information about sockets. In the Socket table, set COM port parameters for 
data transmission through Ethernet; however, you should use this function only with specific API instructions.  

 

 

The system for the DVP-ES3/EX3/SV3/SX3 Series module supports data transmission between the CPU module and 
other CPU modules or devices through a socket as well as through TCP and UDP protocols. You can set up 
connections through both protocols in the TCP and UDP setting pages. 

 

The parameters in the TCP Socket Setting are the same as the parameters in the UDP Socket Setting except that 
there is no Keep Alive Timer parameter in the UDP Socket Setting. 

 Remote IP: Sets a remote IP address. 

 Remote Port: Sets a communication port used by the remote device for this TCP connection. The port number   
            must be between 0–65535. 

 Local Port: Sets a communication port used by the local CPU module for this connection. The port number must be  
         between 0–65535. 

 Send Address: Sets an initial device in the CPU module where sent data is stored. 

 Send Length: Sets the length of data sent by the local CPU module. The length must be between 0–512 bytes. 

 Receive Address: Sets an initial device in the CPU module where received data is stored. 
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 Receive Length: Sets the length of data received by the local CPU module. The length must be between 0–512   
              bytes. 

 Keep Alive Timer: Sets a maximum time to keep the connection alive. If no data is transmitted, and the keep alive   
               period has elapsed, the CPU module automatically terminates the connection. 

The port number used by the local CPU module and the port number used by the remote device cannot be the same, 
and the devices where you store the sent data cannot overlap the devices where you store the received data. If the IP 
address of the remote device is 192.168.1.100, the port number used by the remote device is 65500, the port number 
used by the local CPU module is 65501, and the remote device and the local CPU module can transmit data through 
this TCP connection. 

If the local CPU module sends 10-word data to the remote device, the data is stored in D0–D9 before the data is sent. 
If the local CPU module receives 20-word data from the remote device, the data is stored in D100–D119.  

If the length of data received is larger than the setting value for the length, the first 20 words of data are stored in 
D100–D119, and the remainder of the data is discarded. Likewise, if the length of data received is less than the setting 
value for the length, the data is stored in the devices starting from D100, and the values in devices where no new data 
is stored are unchanged.  

 

If no data is transmitted, and 60 seconds have elapsed, the CPU module closes the socket and terminates the 
connection. 

In the RTU-EN01 Mapping table, you can set a Delta RTU-EN01 slave in connection with a DVP-ES3/EX3/SV3/SX3 
Series module. The remote device is controlled through Ethernet and you can connect up to 4 groups of RTU-EN01 in 
the network. Refer to the operation manual for setting and operation of RTU-EN01. 

 

Select RTU Mapping Enable checkbox to enable the function of connection between RTU module and 
DVP-ES3/EX3/SV3/SX3 Series module. Set the update cycle in Cycle box and a timeout in Timeout box. It means a 
timeout when RTU does not give a reply within the timeout set. 

The data mapping between each group of RTU-EN01 DVP-ES3/EX3/SV3/SX3 Series module is set in the RTU 
Mapping section. RTU-EN01 and I/O module connected to it are set via DCISoft. For more information on DCISoft, 
refer to the operation manual. 
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 Select RTU1 Enable to enable this RTU function. You can set each RTU individually. 

 Set a station address and an IP address. 

 Set the RX mapping address and RX mapping length to make the digital input points for the DI module 
connected to RTU and mapped to X/M devices, as well as the length for the DVP-ES3/EX3/SV3/SX3 Series 
module. Set the RY mapping address and length to set the digital output points for the DO module mapped to 
Y/M devices, as well as the length for the DVP-ES3/EX3/SV3/SX3 Series module. 

 Set the RCR Read mapping address and RCR Read mapping length to make the analog input points for the AI 
module connected to RTU and mapped to D/SR devices, as well as the length for the DVP-ES3/EX3/SV3/SX3 
Series module. Use the RCR Write mapping address and length to set the analog output points for the AO 
module mapped to D/SR devices, as well as the length for the DVP-ES3/EX3/SV3/SX3 Series module. 
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8.5 Data Exchange  

8.5.1 Device Settings Dialog Box Descriptions - ISPSoft 

In the Device Settings dialog box, after you click the Data Exchange-COM1, Data Exchange-COM2 or Data 

Exchange-Ethernet tab, you can set the parameters for the data exchange table for the communication port built into 

the DVP-ES3 Series module. 

The DVP-ES3 Series module can be a master and exchange data with remote slave devices through COM1 and 

COM2 using the Modbus protocol, or through an Ethernet port using the Modbus TCP protocol. 

 

 When you set the start Mode to Program Control, the program in the PLC determines whether to perform the set 

data exchange. PLC Run means that the set data exchange is performed automatically when PLC is in the RUN 

state. Always Enable means that the data exchange is performed constantly when the PLC is powered on. 

 Add a new row in the data exchange table in area  by clicking Add. Move the selected data exchange row up or 

down by clicking Move Up and Move Down. Delete the selected data exchange row by clicking Delete. Copy the 

selected data exchange row by clicking Copy. You can then paste it back into the table as the last row. 

 The following table explains the columns in the data exchange table. 

Name Description 

Item The number of the block for data exchange  

Enable 
Selects whether to enable the data exchange table when the data exchange is 

performed. 

Station Address/ 

IP Address 

The slave station address for the data exchange table. You can set one address for 

multiple data exchange tables. It is a station address under the COM1 and COM2 tabs, 
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and IP under the Ethernet tab. 

Local Address The device address range used by the master in the data exchange table 

<< / >> 
「<<」: Input: the data block where the master reads from a slave 

「>>」: Output: the data block where the master writes to a slave 

Remote Address 

This is the device address range used by a slave in the data exchange table. 

The device range is in hexadecimal if the slave in the data exchange table is a 

user-defined Modbus Device. 

Quantity  
This is the size of the data exchange table, which is consistent with the result calculated 

from the device range. 

8.5.1.1 Data Exchange - COM1 and Data Exchange - COM2 

On the Data Exchange-COM1 or Data Exchange-COM2 tab, double-click row in the data exchange table to set to 

open the Item dialog box as shown below. Select the Enable check box to enable the data exchange table in the 

mode mentioned above. Remote Address is the address of the target slave for data exchange. The Shortest Update 

Cycle is the period for data exchange of the data exchange table. The connection times out if the target device does 

not make any response within the time specified by Connection Timeout.  

Select Support Read/write synchronization (Function code 0x17) to have the master complete reading and writing 

in a single command to improve the efficiency of data exchange. This uses the specific Modbus function code. Make 

sure that all devices in data exchange support the Modbus function code for read and write synchronization. Otherwise, 

the attempt to read and write fails due to the failure to identify function codes after receiving the command from the 

master device. 

Remote Device Type is the model of a target slave including the Delta PLC and standard Modbus devices. 

 

 

 

 

 

 

 

 

 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 8-52 

_8 

 Read 

The DVP-ES3 Series module reads data from a remote device. 

Local Start Address: The device type and start address of the devices where the DVP-ES3 Series module stores 

data. 

Remote Start Address: The device type and start address of the remote device to be read. 

Quantity: This is the input data length. 

 Write 

The DVP-ES3 Series module writes data to a remote device. 

Local Start Address: The device type and start address of the source data for the DVP-ES3 Series module. 

Remote Start Address: The device type and start address of the remote device where data is to be written. 

Quantity: The output data length. 

 

8.5.1.2 Data Exchange - Ethernet 

On the Data Exchange - Ethernet tab, double click a row in the data exchange table to set to open the Item dialog 

box as shown below. The settings are almost the same as those for Data Exchange - COM1 and Data Exchange - 

COM2, except that the target slave model option in Remote Device Type contains Delta PLC and standard Modbus 

TCP equipment, as well as the IP address for remote slaves. For other settings, refer to the descriptions of Data 

Exchange - COM1 and Data Exchange - COM2. 
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Select the Apply to all check box on the right side of The Shortest Update Cycle and Connection Timeout and then 

click OK. Selecting the check box writes the settings for The Shortest Update Cycle and Connection Timeout to 

other data tables on the tab Data Exchange - Ethernet. You can also set the data exchange tables separately without 

selecting the Apply to all check box. 
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8.5.2 Device Settings Dialog Box Descriptions - DIADesigner 

In the Network View, you can find the corresponding colors for supported protocols on the upper left, red for Ethernet, 

blue for Serial Port, green for CANopen. Drag the same colored-port icon to the same colored lines to establish 

connections.  

 

These types of parameters are used to create a data exchange table for the built-in communication ports of the 

DVP-ES3/EX3/SV3/SX3 series models. The DVP-ES3/EX3/SV3/SX3 series models can act as masters for 

exchanging data with remote devices acting as slaves. 
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8.5.2.1 Data Exchange - Modbus and Modbus TCP 

You can set up the Ethernet port through the Modbus TCP protocol and the COM1 and COM2 ports (serial port) 

through Modbus protocol. For CANopen port, it is set through CANopen protocol. The setting options for the 

aforementioned ports are the same though they are on different setting pages as the figure shown below.   

 When you set the start Mode to Program Control, the program in the PLC determines whether to perform the set 

data exchange. PLC Run means that the set data exchange is performed automatically when PLC is in the RUN 

state. Always Enable means that the data exchange is performed constantly when the PLC is powered on. 

 Click  to add a new row in the data exchange table. Use and  to move the selected row up or down to  

  change the order of data exchange. Click  to delete the selected row.  

 The following introduces the items shown in the data exchange table.   

Name Description 

No. The order number of the data exchange 

Enable Enable this data exchange table when executing data exchange 

IP address This column is exclusively for Modbus TCP protocol. The IP address can be used in 

multiple data exchange tables.  

Node ID Node ID indicates the slave address of the data exchange table. The same node ID 

can be used in multiple data exchange tables.  
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Slave name 

You can find the supported series name and the standard Modbus devices from the 

drop-down list. If you select a supported series, devices will be used in the slave 

registers. If you select a standard Modbus device or a Delta robot series, a 

hexadecimal format address will be used in the slave registers.  

Master register Here shows the devices used for Maser in the data exchange table.  

 /  : Input: the section where the master reads data from a slave. 

: Output: the section where the master writes data into a slave. 

Slave register Here shows the devices/addresses used for Maser in the data exchange table. 

Length Here shows the quantity of registers used in the row (the quantity varies according to 

the unit).  

Setting The content value of this data exchange can be set here. 

 

Click “Setting” in the page of Modbus Data Exchange Table to open the setting page.  
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Update Cycle (1-6000 ms): Set the cycle time for the execution of data exchange.  

Connection Timeout (1-6000 ms): if the target device does NOT respond within this set time, the connection 
will be seen as timeout. 

Support Read/Write Synchronization (Function Code: 0x17): By using specific Modbus function codes, the 
master can perform both read and write operations in a single command to improve data exchange efficiency. 
However, when configuring, you need to make sure all devices used in the data exchange support the 
synchronous read/write Modbus function codes. Otherwise, upon receiving the command from the master, it 
may result in read/write failure due to the inability to recognize the function code. 
 

Read ( : Input: the section where the master reads data from a slave.) 

The DVP-ES3/EX3/SV3/SX3 Series reads data from a remote device. Here you can set up the start address for both 
master and slave, and then set up the quantity and the data type. 

Write ( : Output: the section where the master writes data into a slave.) 

The DVP-ES3/EX3/SV3/SX3 Series writes data into a remote device. Here you can set up the start address for both 
master and slave, and then set up the quantity and the data type. 
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8.5.2.2 Data Exchange - Ethernet/IP 

The data exchange setting page for EtherNet/IP is as shown below. You can set the master registers / 

variables, slave parameters and a lot more here.  
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8.5.2.3 Data Exchange - CANopen 

The data exchange setting page for CANopen is as shown below. You can set the master registers / 

variables, slave parameters and a lot more here.  
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Since ISPSoft and DIADesigner are similar in terms of program editing, this chapter will use ISPSoft software as an 

example for explanation. Refer to Chapter 7 of the DIADesigner User Manual for information related to DIADesigner 

software. 

9.1 Introduction 
9.1.1 EtherNet/IP  

EtherNet/IP (“IP” stands for “Industrial Protocol”) is an industrial Ethernet network managed by ODVA, Inc. (formerly Open 
DeviceNet Vendors Association, Inc.), a global trade and standards development organization.  

EtherNet/IP works on a TCP/UDP/IP based Ethernet network and uses the most widely deployed collections of Ethernet 
standards to provide a broad range of applications in different industries that require high-speed and stability including 
Factory Automation (FA), Building Automation (BA), Process Automation (PA) and many more.  

Delta covers a full range of controller and drive products supported by EtherNet/IP, including Programmable Logic 
Controllers (PLC), inverters, Human Machine Interfaces (HMI) and so on. Refer to Section 9.9 for a full product list that 
support EtherNet/IP. In addition, you can also use EDS files to connect to other brands of EtherNet/IP devices. You can 
run Delta EtherNet/IP software (EIP Builder) through the ISPSoft software V3.0 or later. Download the ISPSoft software at:    

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&d
ownloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US 

  

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
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9.1.2 Definitions of Common Network Terms  

Term Definition 

ODVA Open DeviceNet Vendor Association for EtherNet/IP  

EIP 
EtherNet/IP, an industrial Ethernet network, provides interoperability for system providers. 

IP stands for Industrial Protocol. The term “EIP” (EtherNet/IP) is used in this manual.  

I/O Connection Use the I/O connection to connect to EtherNet/IP and to exchange data cyclically.  

Explicit Message 
Connect to EtherNet/IP and to exchange data non-cyclically. Data is exchanged piece by 

piece through instructions.  

RPI 
Requested Packet Interval, through the I/O connection to connect to EtherNet/IP to 

exchange data at regular time intervals.  

ACD Address Conflict Detection to detect IP address duplications. 

Produced/Consumed 

TAG (P/C TAG) 

 You use TAGs for assigning and referencing memory locations for Rockwell PLCs, 

the same as registers for Delta PLCs.  

 Produced tag: A tag that a controller makes available for other controllers. Multiple 

controllers can simultaneously consume (receive) the data. A produced tag sends 

its data to consumed tags (consumers) without using logic. 

 Consumed tag: A tag that receives the data of a produced tag. The data type of the 

consumed tag and the produced tag must match (including any array dimensions).  

 The data is transferred over Ethernet/IP. For example, PLC-A needs data from 

PLC-B, so PLC-B sends the data to PLC-A. Therefore, PLC-B is the producer and 

PLC-A is the consumer. 

EDS 

Electronic Data Sheets: EDS files are simple text files used by EtherNet/IP network 

configuration tools to help you identify EtherNet/IP products and easily commission them 

on a network.  

Data Mapping Exchanging data between devices  

EIP Scanner The master station is called an EIP Scanner in EtherNet/IP. 

EIP Adapter The slave station is called an EIP Adapter in EtherNet/IP. 

DLR 

Device Level Ring (DLR) provides fault-tolerant network design for daisy-chain and linear 

topology. The DLR protocol provides high network availability in a ring topology. It was 

intended primarily for implementation in EtherNet/IP end-devices that have two Ethernet 

ports and embedded switch technology, providing fast network fault detection and 

reconfiguration to support the most demanding control applications.  

Modbus TCP This is a Modbus variant used for communications over TCP/IP networks. 
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9.1.3 Ethernet Features  

9.1.3.1 Delta EIP Architecture 

This typical Delta EIP architecture includes an EIP Scanner and Adapters; data mapping is achieved between devices 

through an I/O connection and explicit messaging. The DVP-ES3/SV3/SX3 Series supports single port Ethernet; thus you 

can install and configure devices with embedded switch technology over EtherNet/IP. DVP-EX3 Series supports dual port 

and linear topology.  

 
 

9.1.3.2 EIP Features 

 Flexibility 

- Flexible topology: EIP devices may include single port Ethernet as well as dual port Ethernet, and provide 
applicable networks such as linear topology, ring topology and ring topology for faster expansion and easier 
management.  

- EtherNet/IP works on a TCP/UDP/IP based Ethernet network, uses most widely deployed collections of Ethernet 
standards, and supports Wi-fi connection. Even personnel with no IT background can build the network easily.  

- Applicable networks include linear topology, ring topology, star topology, Ethernet, EtherNet/IP, one or more 
LANs, etc. You can set configuration through USB or an interface. 

 Simplicity 

- With a connector: Delta provides a full range of products, including human machine interfaces (HMI), 
programmable logic controllers (PLC), and inverter drives for application in an industrial operation. You can build 
a network simply through an RJ-45 connector, saving costs on cables and other connecting tools.   

- Single network: in place of the 3-tier industrial architecture, single network architecture provides 100MB/bits 
high-speed cyclical and non-cyclical data mapping functions, ensuring complete network diagnosis and 
effectively shortening debugging time.    
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- Graphical user interface software: the EIP Builder uses a graphical user interface designed for intuitive operation. 

 Integration 

- Data mapping: the EIP Builder provides a consistent setting interface, allowing you to reduce the time to learn 
and set up configurations. 

- Listed device parameters: the EIP Builder presents the device parameters in a list. Instead of looking them up 
in the user manual, you can quickly check on the parameters in the list.  

- EDS file: you can connect to Delta and other brands of EtherNet/IP products with EDS files.   
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9.2 Installation 
9.2.1  EtherNet/IP Device 

A Delta EtherNet/IP (EIP) device allows you to build a linear topology, ring topology, and star topology networks. A Delta 

EIP device includes the EIP Builder software, EIP Scanner, EIP Adapter, EIP Tap, and an Ethernet switch. EIP Scanners 

and EIP Adapters can be further divided into single port and dual port devices. The DVP-ES3/SV3/SX3 Series are single 

port devices. Refer to Section 9.2.2.1 for the single port setup and refer to Section 9.2.2.3 for the software installation. 

DVP-EX3 Series supports dual port and linear topology. Refer to Section 9.2.2.2 for more information on installation. 

9.2.2  Network Cable Installation 

Each EtherNet/IP device is connected to an Ethernet switch with a CAT 5e cable. Please use Delta standard cables and 

the DVS series industrial switches. Refer to the Delta PLC/HMI Cable Selection Guide for more information.  

9.2.2.1. Single Port Device  

You can use a single port device to build up either a linear or a star network topology. An Ethernet switch and an Ethernet 

tab are required to create a star topology or a ring topology. 

Linear Topology 

 Linear Topology 1 

 

 

 Linear Topology 2 

 

 
Star Topology 
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9.2.2.2. Dual Port Device 

You can use a dual port device to build a linear, a star or a ring network topology. A DLR function is required to create a 

ring topology. Refer to Section 9.9.2 for DLR supported series.  

Linear Topology 

 

 
Star Topology 

 

 
 

Ring Topology 

A DLR function is required to create a ring topology. Refer to Section 9.8.2 for DVP-ES3 that support DLR. 
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ES Series PLC CPU does NOT support DLR. If you need to join a DLR network, it is suggested to use a switch with DLR 
function, DVS-103I02C-DLR. 

 

9.2.2.3 EIP Builder Software 

Linear and star topology 
Install the EIP Builder software on your PC to monitor and configure the EIP devices. You can also connect an EIP 
device to your PCs directly, or use a switch to connect to the PCs.  

 
Ring topology 
Install the EIP Builder on your PC to monitor and configure the EIP devices. Be sure to save a network connection for 
your PC to connect to the EIP device.  
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Alternatively, you can use a switch with DLR function, DVS-103I02C-DLR to connect your PC so that the ring topology 
stays intact.  
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9.3 Specifications 

9.3.1 Ethernet Specification 

Model DVP-ES3/SV3/SX3 Series 

Communication Protocols EtherNet/IP Scanner / Adapter, MODBUS TCP 

Protocols  BOOTP, DHCP, SMTP, NTP, Socket, HTTP 

Communication Speed 10/100 BASE-TX, Auto-Detection 

Communication Interface RJ-45 with Auto MDI/MDIX 

Numbers of the Ethernet Port  1 

 
Model DVP-EX3 Series 

Communication Protocols EtherNet/IP Scanner / Adapter, MODBUS TCP 

Protocols  BOOTP, DHCP, SMTP, NTP, Socket, HTTP 

Communication Speed 10/100 BASE-TX, Auto-Detection 

Communication Interface RJ-45 with Auto MDI/MDIX, switched Ethernet 

Numbers of the Ethernet Port  2 

 
 

Item / per transmission 
Specification 

DVP-ES3/EX3/SV3/SX3 Series 

MODBUS TCP 

Maximum connection 

quantity for Client  
16 

Maximum connection 

quantity for Server 
16 

Max. data length  100 words 

Socket  

(communication 

port) *1 

TCP connection quantity 
V1.06.00 or previous versions: 2 

V1.08.00 or later versions: 8 UDP connection quantity 

SMTP (for 

emailing) 
Emailing quantity 4 

*1: Numbering is used for connections via the communication port. You can use connection 1 in TCP mode or UDP 

mode and up to 4 connections can be made per transmission.  

 
 
 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 

9-12 

_9 

9.3.2 EtherNet/IP Specification 

Item DVP-ES3/EX3/SV3/SX3 Series 

General  
Device type Scanner / Adapter 

Topology type Star topology or linear topology (DVP-EX3) 

Periodic I/O 

Connection 

CIP connection number 

(for a data exchange table) 
16 8 

TCP connection number 
8 

(for all connection types) 

Requested Packet Interval (RPI) 5 ms – 1000 ms 

Max. Transmission Speed 3000 pps 

Max. Data Length/per 

transmission 
500 bytes  

Supported devices D/M D/X/Y/SR 

Non-periodic  

Explicit Message 

Class 3 

(Connected Type) 
8 8 

UCMM 

(Non-Connected Type, only uses 

TCP connections) 

Total 8 

(for all connection types) 

CIP Objects 

Identity, Message Router, Assembly, Connection 

Manager, Port, TCP/IP interface, Ethernet link, 

Vendor specific 

CIP Network TAG 

Max. Consumed TAG Number 16 

Max. Produced TAG Number 16 

Max. Data Length 
500 bytes (IO Connection) 

400 bytes (Explicit Message) 

Requested Packet Interval (RPI) 5 ms – 1000 ms 

Maximum number of connections when using DVP-ES3/EX3/SV3/SX3 Series to connect to other devices through 

Ethernet/IP: 

 When DVP-ES3 Series PLC CPU acts as a Scanner, it can connected up to 8 devices. Each device can establish 

up to 16 connections for data mapping. Data mapping types can be I/O connection and Consumed TAG. You can 

use explicit message for data mapping at the same time, up to 8 explicit message connections can be created.  

 When DVP-ES3/EX3/SV3/SX3 Series PLC CPU acts as a Adapter, it can connected up to 8 devices. Each device 

can establish up to 8 connections for data mapping. Data mapping types can be I/O connection and Consumed 

TAG. You can use explicit message for data mapping at the same time, up to 8 explicit message connections can 
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be created. 

 When DVP-ES3/EX3/SV3/SX3 Series PLC CPU acts as a Scanner and an Adapter simultaneously. It can 

connected up to 8 devices (for example 4 Scanners and 4 Adapters). For Scanner, each device can establish up to 

16 connections for data mapping. And for Adapter, each device can establish up to 8 connections for data 

mapping. You can also use explicit message for data mapping at the same time, up to 8 explicit message 

connections can be created for Scanner and Adapter respectively. 

 Using device M takes 2 bytes (16 bits) as a unit in data length for IO connections, for example M0 to M15 (16 bits), 

M12 to M43 (32 bits). If you need to store the data of 200 bits from M100 to M299, the data length should be set in 

a value larger than 200 bits and in bytes it will be 26 bytes (26 bytes = 208 bits), the actual devices to be mapped 

will be M100 to M307. D0.0 will be stored in M100 (the first bit). Pay attention on the data lengthen and the devices 

to be occupied.  

 

9.3.3 EtherNet Communication Port 

9.3.3.1 Communication Port Pin Assignment 

Delta EtherNet/IP devices use CAT5e industrial Ethernet cables and can be connected via RJ-45 communication port.  

Pin Signal Description Pin Signal Description 

 

1 Tx+ Transmit plus 5 -- N/C 

2 Tx- Transmit negative 6 Rx- Receive negative 

3 Rx+ Receive plus 7 -- N/C 

4 -- N/C 8 -- N/C 

 
9.3.3.2 Communication LED Indicator 

LED Indicator LED Status Description 

LINK / ACT Green 

ON 
 Connected to Ethernet 

 No transmission over Ethernet  

Blinking 
 Connected to Ethernet 

 Packets transmitting/receiving over Ethernet 

OFF  Not connected to Ethernet 
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9.4 EIP Builder  

The Delta EtherNet/IP software, EIP Builder, is embedded in ISPSoft. You run it from the ISPSoft software (version 3.0 

or later). Download the ISPSoft software at:   

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&d

ownloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US  

 

9.4.1 Run the EIP Builder   

You can call EIP Builder from Delta EIP Scanner’s HWCONFIG in ISPSoft. You can also call it independently to set up 

parameters for the Adapter. The Delta EIP Scanner is equipped with the EtherNet/IP communication PLC and the 

EtherNet/IP module. Refer to Section 9.9.3 for a list of Delta EIP Scanner products supported by EIP Builder. 

 

9.4.1.1 Run the EIP Builder via an EIP Scanner  

 Steps to run EIP Builder 

Run EIP Builder from an EIP Scanner product.  

Open

 

ISPSoft V3 0.

 

Create
ISPSoft Project

 

Open

 

HWCONFIG

 

Download
HWCONFIG

Open
EIP Builder

 

Start

 

1. Open ISPSoft V3.0: click the Start menu and go to Programs > Delta Industrial Automation > ISPSoft  

2. Create a new project: on the File menu, click New to display the Create a New Project dialog box. 

 

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
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3. Select a PLC: in the Create a New Project dialog box, select a PLC product that is supported by EIP builder.  

 
 

4. Open HWCONFIG: double-click HWCONFIG in the Project window.  

 
5. Save and download the settings from HWCONFIG：on the File menu click Save to save the settings and then 

click the download button  on the toolbar to download the file to PLC. You must save the configuration in 

HWCONFIG before opening the other communication tools. While working in the communication tools, you 

cannot work in HWCONFIG. 

6. Open EIP Builder: right-click the CPU module in the system configuration area point to Communication 

Software and then click EIP Builder. 
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9.4.2 Set up the IP Address 

This section provides an overview of how to set up IP address for DVP-ES3/EX3/SV3/SX3 Series modules. Set up the IP 

address before configuring the EIP related parameters or data mapping settings.  

 

9.4.2.1 IP Address Types 

The DVP-ES3/EX3/SV3/SX3 supports 3 types of IP addressing, BOOTP, DHCP and static IP address.  

Type of IP Address Definition 

BOOTP 

Uses the TCP/IP Bootstrap Protocol (BOOTP) to set up the IP address, netmask and 

gateway. A BOOTP server may require some configuration. The BOOTP protocol is 

designed for a network in which each host has a permanent network connection. 

DHCP 
Uses the Dynamic Host Configuration Protocol (DHCP) to automatically obtain IP address, 

netmask, gateway, main computer name and the WINS server.  

Static IP You manually set the IP address, netmask and gateway.  

 

9.4.2.2 Set the IP Address (Static IP) 

 Steps to set the IP address  

When using an EIP product with a static IP address, set up the IP address in HWCONFIG in ISPSoft. The following 

example uses the DVP-ES3/EX3/SV3/SX3 Series.  

Create
ProjectISPSoft  

Open
HWCONFIG

Set up 
IP Address

Download
HWCONFIG

 
Refer to Section 9.4.1.1 for how to set up an EIP module in HWCONFIG.  

1. Configure the network parameters 

 Double-click HWCONFIG to open the Setting Page.  

 Click Settings to open the Device Setting Page and click Option tab and select the option Ethernet Port  

      Basic Settings to set the IP Address.  
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2. Save and download the settings from HWCONFIG: on the File menu click Save to save the settings and then 

on the Options menu, click Download or click the Download button on the toolbar. 
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9.4.2.3 Set the IP Address (BOOTP/DHCP) 

 Steps to set the IP address 

When using an EIP product with a BOOTP/DHCP IP address, users can set up the IP address through the IP 

Manager in the EIP Builder.   

Create
AddressMAC Set up IP

Same I assign P 
mode after each 
power-on 

Reset I assign P 
mode after each 
power-on 

Y Disable
BOOTP

N 

Open
EIP Bui lder

Open
 IP M anager

Descriptions for the IP Manager:  

1
2
3

4

7

6

8
9

10

5

 

 Item Definition 

 Stop the Server 
Stops the BOOTP/DHCP server; the IP manager does not request an IP 

addresses from the BOOTP/DHCP server. 

 Network Settings 
Opens a dialog box to set up the subnet mask, gateway, primary DNS, 

secondary DNS, and domain name.  

 Clear List Clears the contents of the list. 

 New Adds a new IP/MAC address.  

 Delete Deletes the selected item from the list. 

 Import Imports the IP/MAC address list; the file format is .CSV. 
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 Export Exports the IP/MAC address list; the file format is .CSV. 

 Enable BOOTP Enables the BOOTP to assign an IP address for the selected item.  

 Enable DHCP Enables the DHCP to assign an IP address to the selected item. 

 Disable BOOTP/DHCP 
Disables the BOOTP/DHCP on the device; the device does not request an IP 

addresses from the server.  

 

 Steps to set the IP address:  

1. MAC address: find the MAC address on the EIP device. The MAC address uniquely identifies the device.  

 

2. Open the IP Manager 

 In EIP Builder on the Tool menu, click IP Manager. 

 
 The IP Manager can be the BOOTP/DHCP Server, receiving IP address requests from devices. The IP  

     Manager window is shown below. 
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3. Set up the IP address 

 Double-click the listed MAC address for your device to open the Input Data dialog box.  

 
 

 Enter the IP address and click OK. 

 
 

4. Disable DHCP/BOOTP 

Click the device in the Mapping Table that you want to disable, then click Disable DHCP/BOOTP. The selected 

device does not send DHCP/BOOTP requests. To change the IP address receiving mode, refer to Section 9.4.2.4 

for more information.   
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Notes 

 Enable BOOTP: when the IP address receiving mode is BOOTP (BOOTP is enabled), the IP address is 

assigned, and the device sends out BOOTP requests for IP addresses during each power-on. 

 Enable DHCP: when the IP address receiving mode is DHCP (DHCP is enabled), the IP address is assigned, 

and the device sends out DHCP requests for IP addresses during each power-on. 

 Disable DHCP/BOOTP: when BOOTP is disabled, the device does not send out any DHCP/BOOTP requests 

for IP addresses during each power-on.  

 

9.4.2.4 Re-enable BOOTP/DHCP  

To enable the DHCP or BOOTP function again, use the device software to make the change. Using the DVP-

ES3/EX3/SV3/SX3 Series as an example: from the Start menu, start ISPSoft, then HWCONFIG, and then IP Manager. 

In IP Manager sets the IP address to the receiving mode.  

Open 
HWCONFIG

Set up
parameters

Set up IP
receiving mode

Open
EIP Builder

Download
HWCONFIG

Open
IP Manager

 
 

 Steps to set device parameters  

1. Refer to Section 9.4.1.1 for how to start HWCONFIG. 

2. Set the parameters: enable the IP address receiving mode to BOOTP/DHCP.  
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 Double-click HWCONFIG to open the Setting Page.  

 Click Settings to open the Device Setting Page and click Option tab and select the option Ethernet Port  

      Basic Settings to set the Mode to BOOTP or DHCP.  

 
 

3. Download the settings from HWCONFIG 

◆ Refer to Section 9.4.1.1 for more information. 

4. Open EIP Builder. 

◆ Refer to Section 9.4.1.1 for more information. 

5. Open the IP Manager 

◆ Refer to Section 9.4.2.3 for more information. 

6. Open the IP setup page 

◆ Refer to Section 9.4.2.3 for more information. 
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9.4.3 Network  

EIP Builder provides a graphical user interface, and you can see the devices and their EtherNet/IP connections in the 

Network View. This section provides an overview of how to add your devices to the network connections. 

 

Add Device
(Scan Network)

Create Network
(Set u p Connection)

Set up Device
Settings

IP Manager
(Set up IP)

Add Devices
(Manually)

EIP Builder

 
 

Descriptions of the EIP Builder Window 

 

 Item Definition 

 Toolbar Toolbar buttons 

 Network View Displays the connected devices and their connection status 

 Configuration Area Displays the configurations and allows you to set the parameters 

 Product List Displays the available devices that can be connected to EtherNet/IP  

 
 
 
 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 

9-24 

_9 

 Toolbar buttons 

 
 

Icon Name Definition  

 
New Creates a new EIP Builder project 

 
Open Opens an existing project 

 
Save Saves the project 

 
Output window Opens message 

 
Help Opens the help file 

 
Cut Cuts the selected item 

 
Copy Copies the selected item 

 
Paste Pastes the selected item 

 
Delete Deletes the selected item 

 
Scan Network Scans the network for device availability  

 
Check Checks if the project is planed properly 

 
On-line Mode Switches to on-line mode 

 
Uploader Uploads from a device 

 
Downloader Downloads to a device 

 
Setup Button Opens the communication setting; set up the path connecting the PC to the EIP 

Scanner.  
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 Network View 

 
 Name Definition  

 Station Name Name of the station; you can also add notes here. 

 Device Name Name of the device 

 Ethernet COM Port 
Displays the number of devices with Ethernet communication ports.  

The last digit of the IP address is shown on the COM port. 

 Network_0 
Displays the connection status; devices on the same line indicate they are in the same 

network. 

 
 Product List 

 
 

 Name Definition  

 Search Bar 
Type the module name you want to find; if no match is found, that means there is no 

EDS file in the system matching the module name. 

 Product List 
Categorizes the devices according to the EtherNet/IP definition; devices from third 

parties are in the Others folder. 
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9.4.4 Add Devices 

9.4.4.1 Add Devices by Scanning the Network 

Click   and EIP Builder will start to scan the network and then the available devices will be displayed in the list. 
Check the one you’d like to add.  
 

 
 

 Name Definition  

 Selection checkboxes Select the devices you want to add to the network view. 

 Refresh Refreshes the network view (scans the network again) 

 Join Adds the selected device to the network view 
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9.4.4.2 Add Devices Manually 
1. Select the devices to add from the Product List. You can also enter the module name in the search bar. Drag the 

device onto the Network View.   

 
 

2. Create the network 
Drag the Ethernet communication port of the device to the network to create a new connection.  

 
 

3. Click the tabs in the Information window to view and edit the EIP Parameter and the EDS Parameter.   
 Information Tab 
This tab contains the Module Name, Version, Rack, Slot, Slot, IP address, Mask, Network and Data Exchange 
Setting. After the editing is complete, you need to download the data mapping table to update the changes.  

 
 
 EIP Parameter Tab 
This tab contains parameter information from the EDS file. When offline, you can check only the connection 
parameters for setting up the EDS filtering rules.  

 Disable Keying: Disable key checking the product information versions.  
 Compatible Keying: Check if the product information and its master version match and check the 

minor version for compatibility. 
 Exact Match: Check if the product information, and both the master version and minor version match. 
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When the device is connected, you can click the Upload button to upload the related parameters from the device.  

 
 

 Name Definition  

① Module Status 

 Identification: displays information regarding Vendor, Product 

Type, Product Name, Revision, etc. 

 Status: displays connection status, including Major Fault, 

Minor Fault, Internal State, Configuration Status, and Module 

Identity.  

② IP Setting 

 Port1: indicates port 1 of the device, for editing IP Address, 

Subnet Mask, Gateway Address, and Host Name.   

Note: when there is a Port2, that means there are 2 Ethernet 

communication ports. 

③ Connection 
 EDS parameters filtering rules include Disable Keying, 

Compatible Keying, and Exact Match. 

④ Port Status 
 Displays Link Status, Speed, Duplex, Negotiation Status and 

Hardware Fault.  

 
 EDS Parameter Tab: this is not supported for the DVP-ES3/EX3/SV3/SX3 PLC CPU; the software closes 

itself when this Tab is selected.  
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9.4.5 Data Mapping 

9.4.5.1 Descriptions on the Data Mapping Page 
When the connection between devices is established, you can use data mapping to exchange data between devices. 
This section provides an overview of how to create a data mapping table.  

Download Data ExchangeData Exchange
Set up

Data Exchange
Table

Network View

 
Descriptions for the Data Mapping: 

 
 Name Definition  

 Connection Count 

Data mapping connection count; each IP address corresponds to 
one independent TCP connection and each row represents one 
independent CIP connection. The number of connections cannot 
exceed the maximum number of connections for the Scanner. For 
the DVP-ES3/EX3/SV3/SX3 PLC CPU, the maximum number of 
connections is 8. 

 Enable Enable and disable data mapping for the connection. 

 TAG 

Use TAG to perform data mapping with adapters. 
After selecting this check box,  
 The directional arrow points left of () (READ only) 
 Registers cannot be used in this row. 
 The length format is defined by the data format in the Global 

Symbols; you cannot change the length format here. 
 You must create a Consumed TAG in the Global Symbols in 

ISPSoft before using this function.  

 IP address 

The IP address of the Adapter to connect to. After the data mapping 
connection is established, the system loads the connected device’s 
IP address. You can also select the device’s IP address from the list 
to add and edit the connection.  

 Adapter name 
Once you select the IP address, its name is displayed but cannot be 
modified here. Refer to Section 9.4.3  for more information on  
how to change the device name.     

 
CPU register address 

Starting address of the data mapping’s register. Devices D and M 
are supported. Using device D or device M takes 2 bytes as a unit in 
data length. 

Select the TAG check box.  Select the Consumed TAG name from the list. 

 
Adapter address/parameter Target adapter’s register address / parameters 

Select the TAG check box.  Input the name of the Produced TAG for other connected EIP 
devices. The default name is the same as the name shown in . 

 I/O mapping table 
Set up the IN/OUT parameters. When there is no I/O representative 
table presented for the Adapter, the parameters cannot be opened, 
for example in some PLCs. 

 Length  
Set the data mapping length; unit: byte; the data limit is determined 
by EDS file; the maximum is 500 bytes.  
You cannot change the length format here when using TAG. 

 Property Set the advanced data mapping parameters. 
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 Property 
 

 
 

Name Definition  

Requested Packet Interval (RPI) Time interval to request packets through the I/O connection, unit: ms 

Multicast Communication mode setup: Multicast or Point-to-Point 

Timeout 

Sets the timeout according to the RPI or a multiple of RPI (RPI*X). 

The minimum value is 100 ms to reduce timeout occurrence When a 

value that is less than 100 ms is treated as 100 ms.  

Trigger Mode 

Cyclic: renews data cyclically  

Change of State: renews data once there is any change 

Application: renews data according to the product setup   

Input Instance You can edit input instance, output instance and configure instance 

in some of the EDS files. The instance number is the same as the 

data mapping connection number. You can tell the mapped data is 

from which corresponding device by the instance number.  

Output Instance 

Configure Instance 
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9.4.5.2 Steps to Set up and Download Parameters 

1. Create a data mapping table (*):  

 Right-click the COM port on the Ethernet Scanner, and click Data Mapping to open the Data Mapping Table.  

 
2. Set the Data Mapping Parameters  

 Type the parameters in the data mapping table. The unit for data length is byte. See the example below. 

a) Reading D500–D599 from the Adapter with the IP address 192.168.1.1 to the D0–D99 in the Scanner. 

b) Writing D200–D299 from the Scanner to D100–D199 in the Adapter with the IP address 192.168.1.1

 

c) One Adapter can create multiple connections for data mapping. Each IP address corresponds to one 

independent TCP connection and each row represents one independent CIP connection. The number of 

connections cannot exceed the maximum number of connections for the Scanner. For the ES3 PLC 

CPU, the maximum number of connections is 8.  

d) Properties: Set the advanced data mapping parameters. 

e) Click Download. 

 

* There is no need to use registers when using TAG function to perform data mapping. You can enter the IP 

address to establish a connection to the tag of other device. Refer to the next section for more details on 

TAG.  
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9.4.6 TAG Function 

Users can use TAG function to transmit data among different controllers. Controllers can share TAGs while 
they are attached to the same network, such as EtherNet/IP. TAG can be further defined as Produced TAG 
and Consumed TAG. 
1. Produced TAG: a tag that a controller makes available for other controller. Multiple controllers (EIP 
scanner devices) can simultaneously consume (receive) the data. A produced tag sends its data to 
consumed tags (consumers) without using logic. 
2. Consumed TAG: a tag that receives the data of a produced tag. The data type of the consumed tag and 
the produced tag must be matched (including any array dimensions). 
Before connecting to a Produced TAG, users should check the IP address and the names of the TAGs 
(Prodeuced TAG and Consumed TAG). One controller can have multiple TAGs created, including produced 
TAG and consumed TAG. See the example below: 
Create a General Device in the Network View as shown below and then set the IP address to be used as a Produced 
TAG. For adding a device, please refer to Section 9.4.3. 
 

 
 
The following Delta products support TAG function: 
DVP-ES3/EX3 Series PLC CPU 
DVP-SV3/SX3 Series PLC CPU 
AS Series PLC CPU: V1.08.20 or later 
ISPSoft software: V3.09 or later 
DOPSoft software (Delta HMI editing software for DOP-100 series): V4.00.07 or later 
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9.4.6.1 Produced TAG 
How to create a Produced TAG: 

1. Open the ISPSoft software and unfold the Global Symbols item to see the EtherNet/IP Table (Produced TAG) 
and EtherNet/IP Table (Consumed TAG). Double click the EtherNet/IP Table (Produced TAG). 

 
 
 
 
 
 
 
 

2. After double clicking the EtherNet/IP (Produced TAG) option, the EtherNet/IP Table (Produced TAG) will show 
up for editing. 

3. Right click on the EtherNet/IP Table (Produced TAG) to see the context menu and select the option “Add a 
Symbol”. And then an Add Symbol window will appear. 

 
4. Set up the Produced TAG: as the example shown below. 

 
 

Name Description 
Identifier User can create a name for the TAG in the PLC; up to 40 characters can be used. 

Address The address is corresponding to the registers or bits in the PLC; selections 
are data register and M bits. 

Data Type 
The data type BOOL, WORD, DWORD, INT, DINT, REAL, and ARRAY are 
supported. One-dimensional array is supported; up to 512 byte can be 
used. 

Initial Value N/A 

Comment Descriptions can be added to describe the TAG; up to 128 characters are 
supported. 

 
After the setups are complete, download the parameters to the PLC. Other controllers can receive the data of a produced 
tag via the consumed tag. For the creation of a consumed TAG, refer to the manual from the controller to be used for 
data transmissions. 
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9.4.6.2 Consumed TAG 
The way to create a consumed TAG is the same the way to create a Produced TAG. Refer the section above for more 
information. After the setups are complete, download the parameters to the PLC, even if using one’s own EIP data 
mapping table.  
 
 

9.4.6.3 Use TAG to Execute Data Mapping 
You can enter the IP address to be connected to other TAGs so that creating a General Device is not necessary.  
Once you select the TAG check box, the directional arrow is to the left with () (READ only) 
1. Enter the IP address of the TAG device to be connected  
 

 
 
2. Select the created Consumed TAG from the CPU register address /TAG column. 

 
After you select the TAG, the software shows the same TAG name in the register address / parameters / address for the 
Adapter. You can modify the TAG name to have the same name as the Produced TAG name.  
3. Set the properties  
4. Click the Downloader button on the tool bar to open the Project Downloader window. 
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9.4.7 Diagnosis 

EIP Builder can provide diagnostic information on the connection and data mapping status. For the connection status, 

refer to the Adapter connection status and indicator in the Network View tab; and for data mapping status and error 

codes, refer to Network_0 in the data mapping tab.    

 
 Steps to view network status 

1. Click the On-line Mode button on the toolbar. 

 

2. Network View (Connection Status) 

a) Click the Network View tab to check the device status from the indicators: for example RUN / STOP and 

Error indicators for the PLC.   

b) The dotted line and the warning sign indicate a connection error, as shown below. 

 
 

3. Network_0 (Data Mapping):  

Click the Network _0 tab to check the data mapping status and the error codes for Network_0. For error code 

definitions, refer to Section 9.6.2.    
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9.5 Explicit Message 

All connections in EtherNet/IP can be divided into explicit messaging connections and implicit (or I/O) messaging 
connections. For details on using implicit messages, please refer to Section 9.4.5. This section provides an overview of 
how the DVP-ES3/EX3/SV3/SX3 Series PLC CPU uses explicit messaging instructions.   

When the DVP-ES3/EX3/SV3/SX3 Series PLC CPU acts a Scanner, you can use the EIPRW instruction (API 2208) to 
read and write Objects. When EIP Builder uses Objects as parameters, each Object includes various parameters. For 
details on the EIPRW instruction, please refer to the DVP-ES3/EX3/SV3/SX3 Series Programming Manual.  

For details on Objects that are supported by the ES3 Series PLC CPU, please refer to Section 9.8.  
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9.6 Troubleshooting  

This section provides an overview of error codes and troubleshooting for the DVP-ES3/EX3/SV3/SX3 Series PLC.  

9.6.1 EtherNet/IP Error Codes and Their Solutions 

Here lists the EtherNet/IP error codes and solutions for reference. These error codes can be checked, under the 

connection mode in the EtherNet/IP data exchange table of HWCONFIG. Alternatively, they can also be found in the 

DVP-ES3/EX3/SV3/SX3 series EtherNet/IP status code special registers (SR1020~SR1051).    

Error 

Code 

(HEX) 

Description Solutions 

0100 Duplicated I/O Connections 

 Check the data exchange table to confirm if this I/O Connection 
has already been set up. 

 Change the connection number (for example, from Connection1 
to Connection2). 

0106 

Conflicts in establishing I/O 

connections with multiple 

Scanners. 

 Remove other devices with Scanner functionality from the 
network to ensure that there are no other Scanners connected to 
this Adapter. 

 If multiple Scanners are required, adjust the connection settings 
to Multicast and change the connection established by the second 
Scanner to Listen only. 

0110 
Adapter configuration is set 

incorrectly. 

 Check if the status of I/O connection is STOP. 

 Restart the I/O connection. 

 Contact the adapter manufacturer to obtain the correct EDS file. 

0111 Adapter RPI is set incorrectly. 
 Check if the adapter RPI settings exceed the specifications. 

 Contact the adapter manufacturer to obtain the correct EDS file. 

0113 Insufficient I/O connections 

 Check if the product connection exceeds the specification. 

 Reduce the number of connections to the adapter. 

 Contact the adapter manufacturer to obtain the correct EDS file. 

0114 

The Vender ID or the Product 

Code in the EDS file is 

mismatched.  Check if the product information and the EDS file matched.  

 Reload the EDS file. 

 Contact the adapter manufacturer to obtain the correct EDS file. 
0115 

The device type in the EDS file 

is mismatched. 

0116 
The revision in the EDS file is 

mismatched. 
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Error 

Code 

(HEX) 

Description Solutions 

0119 
Non-Listen only connection 

establishment failed. 

 Check if the I/O connections are established in the system 
configuration. 

 Check if the scanner I/O connections are functioning. 

011C 

The parameters of Transport 

class and Trigger in the EDS 

file are mismatched. 

 Check if the product information and the EDS file matched.  

 Reload the EDS file. 

 Contact the adapter manufacturer to obtain the correct EDS file. 

011E 
The direction in the EDS file is 

mismatched. 

011F 
Output fixed / variable flag in 

the EDS file is incorrect. 

0120 
Input fixed / variable flag in the 

EDS file is incorrect. 

0121 
The output priority in the EDS 

file is incorrect. 

0122 
The input priority in the EDS 

file is incorrect. 

0123 
The output connection type in 

the EDS file is incorrect. 

0124 
The input connection type in 

the EDS file is incorrect. 

0125 

The output redundant 

ownership in the EDS file is 

incorrect. 

0126 
The configuration size in the 

EDS file is incorrect. 

 Check if the product information and the EDS file matched.  

 Reload the EDS file. 

 Contact the adapter manufacturer to obtain the correct EDS file. 

0127 
Adapter input size is set 

incorrectly. 

 Check the input size setting in the connection parameters. 

 Contact the adapter manufacturer to obtain the correct EDS file. 

0128 
Adapter output size is set 

incorrectly.  

 Check the output size setting in the connection parameters. 

 Contact the adapter manufacturer to obtain the correct EDS file. 
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Error 

Code 

(HEX) 

Description Solutions 

0129 
The configuration path in the 

EDS file is incorrect. 

 Check if the product information and the EDS file matched.  

 Reload the EDS file. 

 Contact the adapter manufacturer to obtain the correct EDS file. 

012D 
Incorrect Consumed Tag 

parameter  
 Check if the parameters in the Consumed tag are set correctly.  

012E 
Incorrect Produced Tag 

parameter 
 Check if the parameters in the Produced tag are set correctly. 

0132 
The EDS file does not support 

Null forward open. 

 Check if the product information and the EDS file matched.  

 Reload the EDS file. 

 Contact the adapter manufacturer to obtain the correct EDS file. 

0203 I/O connection timeout  

 There has been a disconnection or no response from the server 
after establishing a connection. 

 Check the network connection status. 

 Check if the Adapter is working properly. 

 Increase the RPI value. 

0204 
Communication timeout when 

establishing I/O connections 

 Connection establishment failed, adapter did not respond. 

 Check if the IP address is correct. 

 Check if there is an IP address conflict. 

 Check if the device to be connected supports EtherNet/IP 
Adapter.  

 Check if the network cable connection is normal.  

 Check if the Adapter is working properly. 

0302 

The network configuration 

exceeds the product's PPS 

specification. 

 Check the IO connection specifications of the Scanner and 
Adapter.  

 Increase the RPI value or reduce the number of connections. 

0315 
Adapter input/output instance 

parameter setting error 

 Check if the product information and the EDS file matched.  

 Reload the EDS file. 

 Contact the adapter manufacturer to obtain the correct EDS file. 
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9.7 Studio 5000 Software Operation 

This section provides an overview using Ethernet/IP to connect to a Delta Ethernet/IP Adapter with third party software. 

For this example we use the Rockwell Automation software Studio 5000.  

 

9.7.1 Architecture 

The Rockwell Automation (RA) EIP Scanner uses Ethernet to connect to a Delta Adapter. The PC connects to the RA 

Scanner through Ethernet or USB. 

 
※ Rockwell Software Studio 5000, ControlLogix, RSLogix are registered trademarks of Rockwell Automation, Inc.  

 Operation Steps:  

Download Data ExchangeData Exchange
Set up

Data Exchange
Table

Network View

 

 

9.7.2 Create a New Project 

 Open Studio 5000 and under Create, click New Project. 

 Select a PLC and select the chassis.  

 Click Finish to create the new project. 

 After creating the project, Studio 5000 displays the Controller Organizer and workspace.  

 
 

9.7.3 Create a Scanner 

Next, add the 1756-EN2TR Ethernet/IP module, and then connect to the Ethernet/IP devices through the Ethernet/IP 

module.  
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9.7.3.1 Create a New Ethernet/IP Module 

 Right-click 1756 Backplane 1756-A7 and then click New Module.  

 Type 1756-EN2TR in the filter field, click the 1756-EN2TR module, and then click Create. 

 Type the Name, IP address and other required information, and then click OK to add the EtherNet/IP module.  

 The new 1756-EN2TR module appears in the Controller Organizer tree.  

 

9.7.4 Connect to a Delta Adapter 

This section provides an overview of connecting to a Delta Ethernet/IP Adapter with the Rockwell Automation software 

Studio 5000. 

9.7.4.1 Import an EDS file 

 In Studio 5000, on the Tools menu, click EDS Hardware Installation Tool.  

 Select Register an EDS file(s) and click Next. 

 Select Register a single file and click Browse to find the EDS file to import.  

 Follow the instructions in the wizard and then click Finish to complete importing the EDS file.  

 
9.7.4.2 Create an Adapter 

 In Studio 5000, in the Controller Organizer under 1756-EN2TR, right-click Ethernet and then click New Module.  

 Type the module number of the imported Delta EDS file in the filter field, click the Delta module, and then click 

Create. 

 Verify that the product name and IP address are the same as the information shown in the Module Definition 

section.  

 Click Change if you need to make a change to the module definition.  

 Modify the module definition 

1) Name: Click the arrow button to select a valid connection. 

2) Size: Rockwell PLC supports maximum 500 bytes data size. (Data for input contains 2 bytes of Serial Number 

and for output contains 4 bytes 32-bit Run-idle header and 2 bytes of Serial Number.) If using DVP-

ES3/EX3/SV3/SX3 Series, you can set the maximum data length 498 SINT for input and 494 SINT for output.  

※ In general, there is no need to change the parameters from the imported EDS files which can usually be used 

without modification.   
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 In the New Module dialog box, click the Connection tab to modify the Requested Packet Interval and Input Type 

settings. The RPI uses the I/O connection to a Scanner to exchange data at regular intervals, and the units are 

micro-seconds. For Input Type select either Unicast or Multicast. The Input Type selections may vary for different 

products.  

 Click OK to create the adapter. The new Delta Adapter appears in the Controller Organizer tree.  

 
9.7.4.3 Editing Corresponding Addresses for DVP-ES3/EX3/SV3/SX3  

Refer to section 9.8.5 Assembly Object for defaults of mapping address. Refer to section 9.7.4.4 on how to open 

Program TAG and modify the contents of TAG:C to edit the mapping addresses. Refer to section 9.8.5 Assembly Object 

for details on TAG:C.  

 

9.7.4.4 Data Mapping 

In the Controller Organizer, you can map data, including Configuration, Input and Output parameters. When you create a 

device I/O Configuration, the tags are added automatically.  

 Click Program TAGs to display the Tags window. 

 Tags are listed in the Name column. Tag names begin with a product name and end with C or I1 or O1. 

 Tag name：C indicates the tag contains information from the Adapter EDS file, including Input and Output 

parameters. You can edit these parameters in Studio 5000.  

 Tag name：I1 indicates that the mapping starts from TAG：I1[0], and is mapped to the first parameters of the 

Adapter output. The length is the output length provided by the Adapter.  

 Tag name: O1, indicates that the mapping starts from TAG：O1[0], and is mapped to the first parameters of the 

Adapter Input. The length is the input length provided by the Adapter. 

Tag:I1[0]

Tag:I1

Tag:I1[1]

Tag:I1[31]

Parameter_0

Parameter_1

Parameter_31

Adapter
Output

Tag:O1[0]

Tag:O1

Tag:O1[1]

Tag:O1[31]

Parameter_0

Parameter_1

Parameter_31

Adapter
Input

Delta Adapter
VFD-C2000

RA EIP Scanner
1756-L71+1756-EN2TR EtherNet/IP

... ...

... ...
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9.8 CIP Object 

9.8.1 Object List 

CIP requires objects (groups of related data and behaviors associated with this data) to describe a device, how it 

functions, communicates, and to define its unique identity. Objects can be further defined by Class (a set of objects 

representing the same type of system), Instance (a copy of an object), and Attribute (data values). An object’s instance 

and class have attributes, providing services and implementing behaviors. Instance 0 contains the basic information for 

every object, that is: version and length. Instance 1–N contains parameters for creating connections. You can get product 

parameters from the supported service code through objects.  

 
The supported EtherNet/IP objects are listed in the following table. Refer to Section 9.8.2 for the data type definitions. 

Refer to Section 9.8.3~9.8.19 for object contents. You can use explicit messages to read and write Objects. DVP-

ES3/EX3/SV3/SX3 Series PLC acts as a Scanner, you can use EIPRW instruction to read and write Objects. Refer to 

DVP-ES3/EX3/SV3/SX3 Series Programming Manual for more details on EIPRW instruction (API2208).   

Object Name Function Class ID 

Identity Object Provides identification of general information about the device.  1 (H’01) 

Message Router Object 

Provides a messaging connection point through which a client 

can address a service to any object class or instance residing in 

the physical device. 

2 (H’02) 

Assembly Object 

Binds attributes of multiple objects, which allows data to or from 

each object to be sent or received over a single connection and 

can be used to bind input data or output data.  

4 (H’04) 

Connection Manager 

Object 

Provides connection and connectionless communications, 

including establishing connections across multiple subnets. 
6 (H’06) 

Port Object Describes the communication interfaces that are present on the 244 (H’F4) 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 

9-44 

_9 

Object Name Function Class ID 

device and visible to CIP, including USB, Ethernet/IP and more. 

TCP/IP Interface Object 

Provides the mechanism to configure a device’s TCP/IP 

network interface; examples of configurable items include the 

device’s IP Address, Network Mask, and Gateway Address. 

245 (H’F5) 

Ethernet Link Object 
Maintains link-specific counters and status information for an 

IEEE 802.3 communications interface.  
246 (H’F6) 

X Register Bit/Word Register 848（H’350） 

Y Register Bit/Word Register 849（H’351） 

D Register Bit/Word Register 850（H’352） 

M Register Bit Register 851（H’353） 

S Register Bit Register 852（H’354） 

T Register Bit/Word Register 853（H’355） 

C Register Bit/Word Register 854（H’356） 

HC Register Bit/Word Register 855（H’357） 

SM Register Bit Register 856（H’358） 

SR Register Word Register 857（H’359） 

 

9.8.2 Data Type 

This section provides an overview of the data types supported by objects.  

Data Type Description 

BOOL False(H’00) or True(H’01) 

SIGNED 

INTEGER 

SINT(1 byte), INT(2 bytes), DINT(4 bytes), LINT(8 bytes) 

Number 1st 2nd 3rd 4th 5th 6th 7th 8th 

SINT 0LSB        

INT 0LSB 1LSB       

DINT 0LSB 1LSB 2LSB 3LSB     

LINT 0LSB 1LSB 2LSB 3LSB 4LSB 5LSB 6LSB 7LSB 

Example: DINT value = H’12345678 

Number 1st 2nd 3rd 4th 

DINT 78 56 34 12 
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Data Type Description 

UNSIGNED 

INTEGER 

USINT(1 byte), UINT(2 bytes), UDINT(4 bytes), ULINT(8 bytes) 

Ex: UDINT value = H’AABBCCDD 

Number 1st 2nd 3rd 4th 

UDINT DD CC BB AA 
 

STRING 

ASCII CODES, 1 or 2 bytes/words 

STRING: 2 bytes character count + 1 byte character  

 Contents (Char count) Contents (String contents) 

STRING 04 00 4D 69 6C 6C 

 

STRING2: 2 bytes character count + 2 byte character 

 Contents (Char count) Contents (String contents) 

STRING2 04 00 4D 00 69 00 6C 00 6C 00 

 

SHORT_STRING: 1 bytes character count + 1 byte character 

 Contents (Char count) Contents (String contents) 

STRING 04 4D 69 6C 6C 
 

Fixed LENGTH 

BIT STRING 

BYTE (1 byte), WORD (2 bytes), DWORD (4 bytes), LWORD (8 bytes) 

  1st 2nd 3rd 4th 5th 6th 7th 8th 

Byte 7…0        

WORD 7…0 15…8       

DWORD 7…0 15…8 23…16 31…24     

LWORD 7…0 15…8 23…16 31…24 39…32 47…40 55…48 63…56 
 

STRINGI 

A single string consists of multiple language representation 

Name Data Type Meaning 

Number USINT 
The number of internationalized character 

strings 

Strings 
Array of: 

Struct of: 

Array of individual internationalized character 

strings 

LanguageChar1 USINT 
The first ASCII character of the ISO 639-2/T 

language 
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Data Type Description 

LanguageChar2 USINT 
The second ASCII character of the ISO 639-2/T 

language 

LanguageChar3 USINT 
The third ASCII character of the ISO 639-2/T 

language 

CharStringStruct USINT 

The structure of the character string, limited to 

the Elementary Data type value 0xD0 

(STRING), 0xD5 (STRING2), 0xD9 (STRINGN) 

and 0xDA (SHORT_STRING) 

CharSet UINT 

The character set which the character string is 

based on which comes from IANA MIB Printer 

Code (RFC 1759). 

International String 
Defined in 

CharStringStruct 

An array of 8-bit octet elements which is the 

actual international character string 

ISO 639-2/T language: 

Language First Character Second Character Third Character 

English e n G 

French f r e 

Spanish s p a 

Italian i t a 
 

STRUCT 

STRUCT of: Composed of any data types. 

Ex.: STRUCT of { BOOL, UINT, DINT } = { TRUE, H’1234, H’56789ABC } 

 1st 2nd 3rd 4th 5th 6th 7th 

Byte 01 34 12 BC 9A 78 56 
 

ARRAY 

Array of: Composed of one data type. 

Ex.: ARRAY of UINTs = { 1，2，3 } 

Number 1st 2nd 3rd 4th 5th 6th 

Array 01 00 02 00 03 00 
 

EPATH 

A path that consists of multiple segments and references the class, instance and attribute of 

another object. 

Example：Identity Object, Instance attribute 5 = “ 20 01 24 01 30 05 “ 
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9.8.3 Identity Object (Class ID: 01 Hex) 

This object stores identity information that consists of the Vendor ID, Device Type, Product Code and Major Revision for 

your device. 

 Service Code 

Service 

code 
Service Name 

Attribute 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’05 Reset X V 
Resets the drive to the start-up 

state. 

H’0E Get_Attribute_Single V V Read one attribute 

 Class 

 Class ID: H’01 

 

 Instance 

 H’00: Class Attribute 

 H’01: Instance Attribute 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’1 Revision of this object 

H’02 Max Instance Get UINT H’1 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’1 

Number of object instances 

currently created at this class level 

of the device 
 

 When Instance = 0, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Vendor ID Get UINT H’31F Delta Electronics, Inc. 

H’02 Device Type Get UINT H’0C Communication Adapter 
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Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’03 Product Code Get UINT H’4000 Product Code 

H’04 

Revision 

Get 

STRUCT -- 
Revision of this device: Major / 

Minor 

Major Revision USINT H’01 Major Revision Range: H’01–H’7F 

Minor Revision USINT H’01 Minor Revision Range: H’01–H’FF 

H’05 Status Get WORD H’00 
Status, refer to the following *1 

table 

H’06 Serial Number Get UDINT H’abcd 
The last 4 characters of the MAC 

address, ab:cd 

H’07 Product Name Get STRING 
Device 

name 

The maximum length of a product 

name is 32 characters. 
   
 

*1 Status Description (H’05) 

Bit (s) Name Description 

0 Owned 

Does the device has an owner connection?. 

0: No 

1: Yes 

1 Reserved 0，Always OFF 

2 Configured 

Is the device configured? 

0: No 

1: Yes 

3 Reserved 0，Always OFF 

4-7 Extended Device Status 

0: Self-testing 

1: Firmware update 

2: At least one faulted I/O connection 

3: No I/O connections established 

4: Non-volatile configuration error 

5: Major fault 

6: At least one I/O connection in run mode 

7: At least one I/O connection established, all in idle 

mode. 

8-15: Reserved 

8 Minor Recoverable Fault 
0: No minor recoverable fault detected 

1: Minor recoverable fault detected 
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Bit (s) Name Description 

9 Minor Unrecoverable Fault 
0: No minor unrecoverable fault detected 

1: Minor unrecoverable fault detected 

10 Major Recoverable Fault 
0: No major recoverable fault detected 

1: Major recoverable fault detected 

11 Major Unrecoverable Fault 
0: No major unrecoverable fault detected 

1: Major unrecoverable fault detected 

 

9.8.4 Message Router Object (Class ID: 02 Hex) 

This object provides a messaging connection point through which a client may address a service to any object class or 

instance residing in the physical device. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V V Read a single attribute 

 Class 

 Class ID: H’02 

 Instance 

 H’00: Class Attribute 

 H’01: Instance Attribute 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’01 Revision of this object 
 

 When Instance = 0, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’02 Number Available Get UINT H’0 
The maximum number of 

connections 

H’03 Number Active Get UINT H’0 
The number of connected 

connections 
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9.8.5 Assembly Object (Class ID: 04 Hex) 

This object binds attributes of multiple objects, which allows data to or from each object to be sent or received over a 

single connection and can be used to bind input data or output data.  

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V V Read a single attribute 

H’10 Set_Attribute_Single X V Edit a single attribute 

 Class 

 Class ID：H’04 

 Instance 

 H’00：Class Attribute 

 H’64：I/O Connection Output 1 

 H’65：I/O Connection Input 1 

 H’66：I/O Connection Output 2 

 H’67：I/O Connection Input 2 

 H’72：I/O Connection Output 8 

 H’73：I/O Connection Input 8 

 H’74-H’7A Reserved 

 H’80：Configuration 1 

 H’81：Configuration 2 

 H’87：Configuration 8 

 H’C：Listen-Only Connection Number 

 When Instance = 0, the Class Attributes are listed below.  
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Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’2 Revision of this object 

H’02 Max Instance Get UINT H’C7 
The maximum number of 

instances 

 
 When Instance = 64–87, the Instance Attributes are listed below. (Length of input and output is editable. The 

maximum length is 250 words; supports only even bytes) 

I/O Message Connection 

Connection No. Function Instance Attribute Length 

Connection 1 

Input (TO) 0x65 D1000~D1099 

Output (OT) 0x64 D0~D99 

Configuration 0x80 Refer to the table below 

Connection 2 

Input (TO) 0x67 D1100~D1199 

Output (OT) 0x66 D100~D199 

Configuration 0x81 Refer to the table below 

Connection 3 

Input (TO) 0x69 D1200~D1299 

Output (OT) 0x68 D200~D299 

Configuration 0x82 Refer to the table below 

Connection 4 

Input (TO) 0x6B D1300~D1399 

Output (OT) 0x6A D300~D399 

Configuration 0x83 Refer to the table below 

Connection 5 

Input (TO) 0x6D D1400~D1499 

Output (OT) 0x6C D400~D499 

Configuration 0x84 Refer to the table below 

Connection 6 

Input (TO) 0x6F D1500~D1599 

Output (OT) 0x6E D500~D599 

Configuration 0x85 Refer to the table below 

Connection 7 

Input (TO) 0x71 D1600~D1699 

Output (OT) 0x70 D600~D699 

Configuration 0x86 Refer to the table below 

Connection 8 

Input (TO) 0x73 D1700~D1799 

Output (OT) 0x72 D700~D799 

Configuration 0x87 Refer to the table below 
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Configure the contents of input and output to edit the mapping address.  

Configuration 

Address 
Data Type Contents 

Defaults 

(Connection 1) 

Word[0] UINT 
Input corresponding element 

0: D, 1:X, 2: Y 
0 

Word[1] UINT Reserved 200 

Word[2-3] DWORD Input corresponding element number 1000 

Word[4] UINT 
Output corresponding element 

0: D, 2: Y 
0 

Word[5] UINT Reserved 200 

Word[6-7] DWORD Output corresponding element number 0 

 

9.8.6 Connection Manager Object (Class ID: 06 Hex) 

Use this object for connection and connectionless communications, including establishing connections across multiple 

subnets. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V X Read a single attribute 

H’4E Forward_Close X V Close a connection 

H’54 Forward_Open X V 
Open a connection; the maximum 

data size is 511 bytes.   

 Class 

 Class ID：H’06 

 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 
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 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT 1 Revision of this object 

H’02 Max Instance  Get UINT 1 
Maximum instance number of this 

object 

 
 

 When Instance = 1, the Instance Attributes are listed below. 

Attribute Name 
Access 

Rule 
Data Type Values Description 

H’01 Open Requests Get UINT H’0 
Number of Forward Open service 

requests received.  

H’02 Open Format Rejects Get UINT H’0 

Number of Forward Open service 

requests that were rejected due to 

bad format. 

H’03 
Open Resources 

Rejects 
Get UINT H’0 

Number of Forward Open service 

requests that were rejected due to 

lack of resources. 

H’04 Open Other Rejects Get STRUCT H’0 

Number of Forward Open service 

requests that were rejected for 

reasons other than bad format or 

lack of resources. 

H’05 Close Requests Get WORD H’0 
Number of Forward Close service 

requests received. 

H’06 Close Format Rejects Get UDINT H’0 

Number of Forward Close service 

requests that were rejected due to 

bad format. 

H’07 Close Other Rejects Get STRING H’0 

Number of Forward Close service 

requests that were rejected for 

reasons other than bad format. 

H’08 Connection Timeouts Get UINT H’0 

Total number of connection 

timeouts that have occurred in 

connections controlled by this 

Connection Manager. 
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9.8.7 Port Object (Class ID: F4 Hex) 

This section describes the communication interfaces that are present on the device and visible to CIP, including USB, 

EtherNet/IP and more. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V 
Returns a predefined listing of this 

objects’ attributes 

H’0E Set_Attribute_Single V V 
Returns the contents of the 

specified attribute. 

 

 Class 

 Class ID：H’F4 

 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 

 H’N: Instance #N Attribute, the number of the Ethernet port 

 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT 1 Revision of this object 

H’02 Max Instance Get UINT 1 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT 1 

Number of object instances 

currently created at this class level 

of the device 

H’08 Entry Port Get UINT 1 Communication port for EtherNet/IP 

H’09 Port Instance Info Get 
ARRAY of 

STRUCT of 
-- 

Port Instance information: Port Type 

+ Port Number 
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Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

Port Type UINT H’04 EtherNet/IP, refer to the following *1 

Port Number UINT H’01 Identifies each communication port 

 

 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Port Type Get UINT H’04 EtherNet/IP, refer to the following *1 

H’02 Port Number Get UINT H’01 Identifies each communication port 

H’03 

Link Object 

Get 

STRUCT of -- 
Identifies Object attached to this 

port. Path length + Link Path 

Path Length UINT -- Path length 

Link Path EPATH -- Path segment 

H’04 Port Name Get 
SHORT_ 

STRING 
EIP1 Name of the communication port 

H’07 
Port Number and 

Node Address 
Get EPATH 01 01 

Communication port number and 

node number of this device on port. 

 
 

*1 Communication Port Type 

Communication Port Type Description 

1 Self-defined 

2 ControlNet 

3 ControlNet Redundant 

4 EtherNet/IP 

5 DeviceNet 

201 Modbus/TCP 

203 SERCOS III 
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9.8.8 TCP/IP Interface Object (Class ID: F5 Hex) 

This object provides the mechanism to configure a device’s TCP/IP network interface. Examples of configurable items 

include the device’s IP Address, Network Mask, and Gateway Address. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’0E Get_Attribute_Single V V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

 

 Class 

 Class ID = H’F5 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 

 H’N: Instance #N Attribute, number of IP addresses that the device supported 

 When Instance = 0, the Class Attributes are listed below.  

 

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’2 Revision of this object 

H’02 Max Instance Get UINT H’2 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’2 

Number of object instances 

currently created at this class level 

of the device 
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 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Status Get DWORD H’2 IP status, refer to the following *1 

H’02 
Configuration 

Capability 
Get DWORD H’15 

Configuration capability, refer to 

the following *2 

H’03 
Configuration 

Control 
Get/Set DWORD H’0 

Configuration Control, refer to the 

following *3 

H’04 

Physical Link 

Object： 

Get 

STRUCT of -- Path to physical link object 

Path Size UINT H’0 Size of Path 

Path EPATH -- 
Logical segments identifying the 

physical link object 

H’05 

Interface 

Configuration： 

Get/Set 

STRUCT of -- 
TCP/IP network interface 

configuration. 

IP Address UDINT H’C0A80005 
The device’s IP address; 

192.168.1.5 

Network Mask UDINT H’FFFFFF00 
The device’s network mask:  

255.255.255.0 

Gateway Address UDINT H’C0A80001 
Default gateway address: 

192.168.0.1 

Name Server UDINT 0 Primary name server 

Name Server 2 UDINT 0 Secondary name server 

Domain Name STRING 00 00 Default domain name 

H’06 Host Name Get/Set STRING Device name Device name 

H’13 
Encapsulation 

Inactivity Timeout 
Get/Set UINT 120 

EIP device active connection time;  

unit:0-3600 seconds 
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*1 Interface Status 

Status Description 

0 The Interface Configuration attribute has not been configured. 

1 
The Interface Configuration attribute contains valid configuration obtained from BOOTP, DHCP or non-

volatile memory. 

2 The Interface Configuration attribute contains valid configuration obtained from hardware. 

 

*2 Interface Capability Flags 

Bit Description 

0 BOOTP Client 

1 DNS Client 

2 DHCP Client 

3 DHCP-DNS Update 

4 Configuration Settable 

5 Hardware Configurable 

6 Interface Configuration Change Requires Reset 

 

*3 Interface Configuration Control 

Status Description 

0 
The device uses the interface configuration values previously stored (for example, in non-volatile 

memory or through hardware switches). 

1 The device obtains its interface configuration values through BOOTP. 

2 The device obtains its interface configuration values through DHCP on start-up. 
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9.8.9 Ethernet Link Object (Class ID: F6 Hex) 

This object maintains link-specific counters and status information for an IEEE 802.3 communications interface. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’0E Get_Attributes_Single V V Read one attribute 

 

 Class 

 Class ID: H’F6 

 

 Instance 

 H’00: Class Attribute 

 H’01: Instance Attribute 

 H’N: Instance #N Attribute, the number of the Ethernet port 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’03 Revision of this object 

H’02 Max Instance Get UINT H’021 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’01 

Number of object instances currently 

created at this class level of the 

device 
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 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Interface Speed Get DWORD H’64 

Interface speed currently in use  

10(H’0A), 100(H’64), 1000(H’3E8) 

Mbps 

H’02 Interface Flags Get DWORD H’F 
Ethernet port status, refer to the 

following *1 

H’03 Physical Address Get 
ARRAY of 

6 USINTs 

By 

Product 
MAC address 

H’0A 

Interface Label 

Get 

SHORT_S

TRING 
NA 

Define the name of the Ethernet port  

For example: for port 1, the definition 

of the name in string is 01 31. 

Length USINT NA 
The maximum length of the name is 

16 words. 

Interface name 
SHORT_S

TRING 
NA 

Use ASCII characters to name the 

Ethernet port name. 

H’0B 

Interface Capability 

Get 

STRUCT 

of: 
-- 

Ethernet interface capability bits table 

*2 

Capability Bits DWORD 
H’0000000

7 

Ethernet interface capability bits 

definition 

Speed/Duplex Options 
STRUCT 

of: 
-- 

Ethernet interface capability speed & 

duplex option definition 

Speed/Duplex Array 

Count 
USINT H’04 

Ethernet interface capability speed & 

duplex array count 

Speed/Duplex Array 

ARRAY of 

STRUCT 

of: 

-- 
Ethernet interface capability speed & 

duplex array contents  

Interface Speed UINT NA 
Ethernet interface speed; ex:  

H’0A: 10 bps and H’64: 100 bps 

Interface Duplex Mode USINT NA 

Ethernet interface duplex mode; H’00: 

duplex mode and H’01: full duplex 

mode 
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*1 Interface Flag Table 

 
※2 Interface Capability Bits 

 

Bit (s) Name Description 

0 Link Status 
0 indicates an inactive link 

1 indicates an active link 

1 Half/Full Duplex 
0 indicates half duplex 

1 indicates full duplex 

2-4 Negotiation Status 

0：Auto-negotiation in progress 

1：Auto-negotiation and speed detection failed 

2：Auto negotiation failed but detected speed 

3：Successfully negotiated speed and duplex 

4：Auto-negotiation not attempted. Forced speed and duplex. 

5 Manual Setting Requires Reset Set to zero 

6 Local Hardware Fault 
0: the interface detects no local hardware fault 

1: a local hardware fault is detected 

7-31 Reserved 0 

Bits  Item Description 

0 
Manual Setting Requires 

Reset 

Indicates if the device requires a reset when instance attribute #6 

(Interface Control attribute) changes. 

0 indicates the device does not require a reset 

1 indicates the device requires a reset 

1 Auto-negotiate 
0 indicates the interface does not support auto-negotiation 

1 indicates the interface supports auto-negotiation 

2 Auto-MDIX 
0 indicates the interface does not support auto MDIX operation 

1 indicates the interface supports auto MDIX operation 

3 Manual Speed/Duplex 

0 indicates the interface does not support speed/duplex setting. 

(Instance attribute #6, Interface Control attribute) 

1 indicates the interface supports speed/duplex setting 

4-31 Reserved Should be 0 
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9.8.10 X Register (Class ID: 350 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’32 Read_Parameter X V Read Parameter 

 

 Class 

 Class ID：H’350 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 X0 Get BOOL H’00 X0 bit register 

H’01 X1 Get BOOL H’00 X1 bit register 

H’02~H’FE X2~X376 Get BOOL H’00 X2 –X376 bit register 

H’FF X377 Get BOOL H’00 X3377 bit register 

 

9.8.11 Y Register (Class ID: 351 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 
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 Class 

 Class ID：H’351 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 Y0 Get/Set BOOL H’00 Y0 bit register 

H’01 Y1 Get/Set BOOL H’00 Y1 bit register 

H’02~H’0FE Y2~Y376 Get/Set BOOL H’00 Y2-Y376 bit register 

H’FF Y377 Get/Set BOOL H’00 Y377 bit register 

 

9.8.12 D Register (Class ID: 352 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’352 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  
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Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 D0.0 Get/Set BOOL H’00 D0.0 bit register 

H’01 D0.1 Get/Set BOOL H’00 D0.1 bit register 

H’02-H’752FE D0.2-D29999.14 Get/Set BOOL H’00 D0.2-D29999.14 bit register 

H’752FF D29999.15 Get/Set BOOL H’00 D29999.15 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 D0 Get/Set INT H’00 D0 word register 

H’01 D1 Get/Set INT H’00 D1 word register 

H’02-H’752E D2-D29998 Get/Set INT H’00 D2-D29998 word register 

H’752F D29999 Get/Set INT H’00 D29999 word register 

 

9.8.13 M Register (Class ID: 353 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’353 

 

 Instance 

 H’01：Instance Attribute, Bit Register 
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 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 M0 Get/Set BOOL H’00 M0 bit register 

H’01 M1 Get/Set BOOL H’00 M1 bit register 

H’02-H’1FFE M2-M8190 Get/Set BOOL H’00 M2-M8190 bit register 

H’1FFF M8191 Get/Set BOOL H’00 M8191 bit register 

 

9.8.14 S Register (Class ID: 354 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’354 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 S0 Get/Set BOOL H’00 S0 bit register 

H’01 S1 Get/Set BOOL H’00 S1 bit register 

H’02-H’7FE S2-S2046 Get/Set BOOL H’00 S2-S2046 bit register 

H’7FF S2047 Get/Set BOOL H’00 S2047 bit register 
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9.8.15 T Register (Class ID: 355 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’355 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 T0 Get/Set BOOL H’00 T0 bit register 

H’01 T1 Get/Set BOOL H’00 T1 bit register 

H’02-H’1FE T2-T510 Get/Set BOOL H’00 T2-T510 bit register 

H’1FF T511 Get/Set BOOL H’00 T511 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 T0 Get/Set INT H’00 T0 word register 

H’01 T1 Get/Set INT H’00 T1 word register 

H’02-H’1FE T2-T510 Get/Set INT H’00 T2-T510 word register 

H’1FF T511 Get/Set INT H’00 T511 word register 
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9.8.16 C Register (Class ID: 356 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’356 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 C0 Get/Set BOOL H’00 C0 bit register 

H’01 C1 Get/Set BOOL H’00 C1 bit register 

H’02-H’1FE C2-C510 Get/Set BOOL H’00 C2-C510 bit register 

H’1FF C511 Get/Set BOOL H’00 C511 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 C0 Get/Set INT H’00 C0 word register 

H’01 C1 Get/Set INT H’00 C1 word register 

H’02-H’1FE C2-C510 Get/Set INT H’00 C2-C510 word register 

H’1FF C511 Get/Set INT H’00 C511 word register 
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9.8.17 HC Register (Class ID: 357 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’357 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 HC0 Get/Set BOOL H’00 HC0 bit register 

H’01 HC1 Get/Set BOOL H’00 HC1 bit register 

H’02-H’FE HC2-HC254 Get/Set BOOL H’00 HC2-HC254 bit register 

H’FF HC255 Get/Set BOOL H’00 HC255 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 HC0 Get/Set DINT H’00 HC0 word register 

H’01 HC1 Get/Set DINT H’00 HC1 word register 

H’02-H’FE HC2-HC254 Get/Set DINT H’00 HC2-HC254 word register 

H’FF HC255 Get/Set DINT H’00 HC255 word register 
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9.8.18 SM Register (Class ID: 358 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’358 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 SM0 Get/Set BOOL H’00 SM0 bit register 

H’01 SM1 Get/Set BOOL H’00 SM1 bit register 

H’02~H’FFE SM2~SM4095 Get/Set BOOL H’00 SM2-SM4095 bit register 

H’FFF SM4096 Get/Set BOOL H’00 SM4096 bit register 

 

9.8.19 SR Register (Class ID: 359 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

 

9-70 

_9 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’359 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 

Data 

Type 
Values Description 

H’00 SR0 Get/Set INT H’00 SR0 word register 

H’01 SR1 Get/Set INT H’00 SR1 word register 

H’02-H’7FE SR2-SR2046 Get/Set INT H’00 SR2-SR2046 word register 

H’7FF SR2047 Get/Set INT H’00 SR2047 word register 
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9.9 Delta EIP Product List 

9.9.1 Delta EIP Products 

Positioning Product Firmware Version 

Mid-range 

PLC 

AHCPU501-EN, AHCPU511-EN, AHCPU521-EN, AHCPU531-EN V2.00 

AHCPU560-EN2 V1.00 

AH10EN-5A V2.00 

AHRTU-ETHN-5A V1.00 

AH10EMC-5A V1.00 

AS300 Series V1.00 

AS200 Series V1.00 

AS100 Series V1.10 

AS300 Series + AS-FEN02 V1.06 (AS-FEN02: V1.00) 

AS00SCM-A + AS-FEN02  V2.02 (AS-FEN02: V1.00) 

Small PLC 

DVPES2-E Series V3.60 

DVP26SE V1.00 

DVP12SE V2.00 

DVP-ES3/EX3 Series  V1.00 

DVP-SV3/SX3 V1.00 

Inverter 

CMM-EIP01/02 Communication Card (+ VFD-MS300 Series)  V1.00 

CMC-EIP01 (+ VFD-C2000 Series) V1.06 

CMM-EIP03 (+ VFD-M300 Series) V1.00 

CMC-EIP02 (+ VFD-C2000 Series) V1.00 

 

9.9.2 Delta EIP Products, DLR (Device Level Ring) supported  

Positioning Product Firmware Version 

Mid-range 
PLC 

AHCPU560-EN2 V1.00 

AH10EN-5A V2.00 

AHRTU-ETHN-5A V1.00 

Inverter 
CMM-EIP03 (+ VFD-M300 Series) V1.00 
CMC-EIP02 (+ VFD-C2000 Series) V1.00 

Switch DVS-103I02C-DLR V1.00 
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9.9.3 Delta EIP Products, Scanner supported 

Positioning Product Firmware Version 

Mid-range 

PLC 

AHCPU501-EN, AHCPU511-EN, AHCPU521-EN, AHCPU531-EN V2.00 

AHCPU560-EN2 V1.00 

AH10EN-5A V2.00 

AS300 Series, AS200 Series  V1.00 

AS100 Series V1.10 

Small PLC 
DVP-ES3/EX3 V1.00 

DVP-SV3/SX3 V1.00 

Motion 

Controller 
AX-3 Series V1.00 

 
 
9.10 Network Security 

To enhance security and performance of the system, it is suggested to use closed network or LAN with firewall 

protection to prevent cyber-attacks. 
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9.11 Operation and Monitor on the Web 

9.11.1 Getting Started 

You can enter DVP-ES3 Series PLC IP address in the search bar of your browser to connect to your device. After that you 

can set up and monitor DVP-ES3/EX3/SV3/SX3 Series PLC.   

 

9.11.1.1 Exploring the webpage 

After connected to the module, you can see the DVP-ES3 webpage with 5 sections as the image shown below.  

 
 
Descriptions:  

Section Contents 

Banner Delta logo and the name of the connected device 

Login Username and password 

Menu 
Sitemap is shown in tree diagram. 
(The menu shows data based on the permission of the current 
user.)  

Context Main contents; click an item on the menu section, its content 
appears here.  

Bottom Copyright information and Delta webpage information  
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9.11.1.2 Using the Webpage 

List of browsers that support DVP-ES3/EX3/SV3/SX3 Series webpage:  

Provider Browser Supported versions 

Microsoft Internet Explorer V10.0 and later 

Microsoft Edge V20 and later 

Google Chrome V14 and later 

Mozilla Firefox V17 and later 

Apple Safari V5.1 and later 

 

 Operation Steps:  

a. Open your browser, enter DVP-ES3 IP address in the search bar to connect to DVP-ES3 PLC.  

 
 

b. After the webpage appears, enter “Admin” in the User section and click Login without entering any password. 
Set up the password after login to ensure security.  
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9.11.1.3 Login  

You need to login to your account to set up.  

 Operation Steps:  

a. Provide the login information to login.  

 
 

b. After login successfully, the user field shows your account name (read only). After setting up, you can click 
Logout here to leave this webpage.   

 
 

Item Description 

User Your account name  

Password Your password 

“Login” / “Logout” Login: to enter the webpage 
Logout: to leave the webpage 

 

9.11.1.4 Menu  

The menu shows data based on the permission of the current user. 

Nodes 
Permission 

Administrator Write/Read Read 

Device information V V V 

Account management V   

Data monitor setup V   

Data monitor table 1 - 4 V V Read-only 

Hardware status V Read-only Read-only 

Save configuration V   
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 Log in as an Administrator, the following nodes appear.  

 
 

 Log in with Write/Read permission, the following nodes appear.  

 
 

 Log in with Read only permission, the following nodes appear.  
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9.11.2 Device Information 

Here provides DVP-ES3/EX3/SV3/SX3 Series PLC product information. 

You do not need to log in to see the device information. This page is read only, not for editing.  

 
 

Item Description 

Device name Product name 

Device description Device description that user defined in ISPsoft 

Firmware version Firmware version  

IP address Product IP address 

MAC address Product MAC address 

Serial number Product serial number 

 

9.11.3 Network configuration 

You can set network related configurations here.  

9.11.3.1 Account management  

You can set 3 kinds of access types for up to 8 user accounts.     
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Item Description 

User ID 

 To name your user ID, you can use up to 16 characters from the following characters, 

A through Z (case-insensitive ), 0 through 9, _ (underscore) , (comma) and . (dot) . 

 The first default user ID is “Admin” (read only). 

Password 

 To name your password, you can use up to 16 characters from the following 

characters, A through Z (case-insensitive ), 0 through 9, _ (underscore) , (comma) 

and . (dot) . 

 No password for the default user ID “Admin” (read only), you can set up the 

password later.  

Access type 

 Administrator: You can set up all parameters and have permission to edit the 

password and permission.  

 Write/Read: You can open the data monitor pages and the diagnostic page. You can 

also edit the parameters.   

 Read: You can open the data monitor pages and the diagnostic page. But you cannot 

edit parameters.  

 Default user is “Administrator”. 

“Delete” Use “Delete” to clear the user ID and password.  

“Apply” Use “Apply” to save the settings.  

 
 Operation Steps:  

a. After log in, double-click Account management to open the setting page.  
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b. Set up the User ID, the password and the access type. After editing, click “Apply” to save the setting or click 

“Delete” to clear the account.  

 
 

c. Double-click Save configuration to open the setting page.  

 
 

d. Click “Save” to save and download the settings to the device.  
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e. After download is complete, it will be prompted with a Download successful message. 

 
 

9.11.4 Data Monitoring 

You can set monitoring related configurations here.  

9.11.4.1 Data Monitoring Setup Page  

You can set up 4 pages of monitoring data and up to 30 items can be monitored on each page.  
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Item Description 

Table name 

 To name your table, you can use up to 16 characters from the following 

characters, A through Z (case-insensitive ), 0 through 9, _ (underscore) , 

(comma) and . (dot) . 

Device quantity  Device quantity to be monitored; default: read only 

Default update cycle  Set up the updated cycle time; default: 5 seconds; unit: second 

“Edit” 
 Click “Edit” to edit the table and the table name column turns green. The 

table contents appear below.  

“Delete”  Click “Delete” to delete the table and its contents.  

Device 
 Devices to be monitored; you can enter the following devices to monitor 

xX, yY, mM, sSmM, sSrR, dD, sS, tT, cC, hHcC and eE. 

Radix 

 Positional numeral system to be shown on the monitoring page; available 

formats are Signed decimal, Unsigned decimal, Hexadecimal, Octal, 

Binary, 32bit Signed decimal, 32bit Unsigned decimal, 32bit Hexadecimal, 

32bit Octal, 32bit Binary, 32bit Float and 64bit Double 

Read only  Set up the monitored devices to read only or not.  

Description  Add a description here for the table.  

“Apply”  Click “Apply” to save the settings.  

 Operation Steps:  

a. After log in, double-click Data monitor setup to open the setting page.  
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b. Use “Edit” to edit the table name, device quantity, and update cycle time.  

 
 

c. The corresponding table contents appear below. 

 
 

d. Edit the devices to be monitored, radix to be shown, read only or not and the description. After editing, click 
“Apply” to save the setting.  
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e. Double-click Save configuration to open the setting page.  

 
 

f. Click “Save” to save and download the settings to the device.  

 
 

g. Once the download is complete, you can see the newly added table to be monitored under the Data Monitor 
node.  

 
 

 

h. Note: The data monitor table must be downloaded to the device otherwise even if the data monitor table is 
created, it cannot be monitored.  
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9.11.4.2 Data Monitor Table Pages 

The setting results are shown as below. 

 

 

Item Description 

Table name Name of the table; read only 

Monitor status 
Status of the monitoring; read only  
Yellow light: reading, Green light: reading complete, Red light: reading 
error  

Update cycle Update cycle time; default is what you set up in data monitor setup 
page; unit: second  

“-“ Minus; click once to decrease 1; the minimum value is 1 

“+“ Plus; click once to increase 1; the maximum value is 60 

Floating format setting Floating point setting; round down; default: round the number down to 
three decimal places  

Device Devices to be monitored; read only 

Radix 

Positional numeral system to be shown on the monitoring page; 
available formats are Signed decimal, Unsigned decimal, Hexadecimal, 
Octal, Binary, 32bit Signed decimal, 32bit Unsigned decimal, 32bit 
Hexadecimal, 32bit Octal, 32bit Binary, 32bit Float and 64bit Double 

Description Add a description here for the table; read only 

Status 
Status of bit; read only 
Green LED: ON; No LED: OFF 

Value 

Values in devices to be monitored; read only 
Signed decimal: K+ Number 
Unsigned decimal: K+ Number 
Hexadecimal: H + hex Number 
Octal: O + octal Number 
Binary: B + binary Number 
32bit Signed decimal: K+ Number 
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Item Description 

32bit Unsigned decimal: K+ Number 
32bit Hexadecimal: H + hex Number 
32bit Octal: O + octal Number 
32bit Binary: B + binary Number 
32bit Float: float Number 
64bit Double: float Number 

“On” / ”Off” 

“ON”: the status of Bit is ON.  
“OFF”: the status of Bit is OFF.  
 If the authority level for the logged in user is READ, this column is 
read only.  

Set Value 

Change the value for the device to be monitored 
 Type the value in and click “SET” and the changed value appears 
in the VALUE column as the image shown above.  
 If the authority level for the logged in user is READ, this column is 
read only. 

“Set” 
Click “Set” to confirm the changed value. 
 If the authority level for the logged in user is READ, this column is 
read only. 

 

9.11.5 Diagnostic 

You can set diagnostic related configurations here.  

9.11.5.1 Hardware Status Page 

This page displays information on hardware status and CPU module. You can set CPU to run or stop. Here also shows 

the CPU running status and error codes.    

 
 For DVP-ES3/EX3/SV3/SX3 Series, the hardware status page looks like below. 

 
 

Item Description 

Refresh cycle Refresh cycle time; default: 10; unit: second 

“-“ Minus; click once to decrease 1; the minimum value is 1 

“+“ Plus; click once to increase 1; the maximum value is 60 

CPU module name Name of the CPU module; read only 
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Item Description 

CPU Run LED 

LED of CPU running status; read only 

Green light: RUN  

LED Not Lit: STOP 

CPU Error LED LED of CPU Error; read only 

CPU Error code Error codes of CPU module; read only 

“Run” / “Stop” 

Click “RUN” to set the running status to RUN 

Click “Stop” to set the running status to STOP 

 If the authority level for the logged in user is WRITE/READ or 

READ, this column is read only. 

 

9.11.6 Configurations 

9.11.6.1 Save Configuration Page 

You can save the configurations and download the parameters to your device here.  

 
 

Item Description 

“Save” Download the saved parameters to the device.  

PLC Status 
LED of PLC running status; read only 

Green light: RUN  

LED Not Lit: STOP 

“Run” / “Stop” 
Click “RUN” to set the running status to RUN 

Click “Stop” to set the running status to STOP 

Note: The data monitor table must be downloaded to the device. If not, once you log out, close the page or restart the 

PLC, all the temporary saved parameters will be cleared.  
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Since ISPSoft and DIADesigner are similar in terms of program editing, this chapter will use ISPSoft software 
as an example for explanation. Refer to Chapter 6 of the DIADesigner User Manual for information related to 
DIADesigner software. 

 
10.1 Introduction to CANopen 
1. Because of its simple wiring, immediate and stable communication, strong debugging ability, and low 

cost, the CANopen network is widely used in fields such as industrial automation, the automotive industry, 
the medical equipment industry, and the building trades. 

2. The DVP-ES3/EX3/SV3/SX3 Series PLC is equipped with CANopen communication port. The CAN port 
conforms to the basic communication protocol CANopen DS301. It supports master and slave modes.  

3. This chapter explains the functions of CANopen. In master mode, CANopen can support up to 64 slaves. 

4. CANopen Builder is the CANopen network configuration software for the DVP-ES3/EX3/SV3/SX3 Series. 
You set the CANopen station address and the communication rate with this software. 
ISPSoft/DIADesigner is the programming software for the DVP-ES3/EX3/SV3/SX3 Series. 

5. This chapter mainly focuses on the CANopen functions. Refer to Section 10.3 for more information. 

 

10.1.1 CANopen Function Descriptions 

The CAN port has the following functions when acting as a master. 

1. It supports the standard CANopen protocol DS301 V4.02. 

2. It supports the NMT (network management object) service. 

 It supports NMT state control. 

Use NMT state control to control the state of a slave in the CANopen network. 

 It supports NMT error control. 

Use NMT error control detect the disconnection of a slave. The NMT error control is classified into 
two types; Heartbeat and Node Guarding. The DVP-ES3/EX3/SV3/SX3 Series PLC does not 
support Node Guarding. 

3. It supports the PDO (process data object) service. 

 Use PDO messaging to transmit immediate input and output data. 

 It supports up to 256 RxPDO and 1894 bytes.  

 It supports up to 256 TxPDO and 1894 bytes. 

 It supports synchronous and asynchronous modes for the PDO transmission type. 

4. It supports the SDO (Service Data Object) service. 

 Use SDO to read, write, or configure the slave parameters.  

 It supports standard SDO transmission mode.  

 It supports automatic SDO functions. You can write up to 20 pieces of data to a slave.  

 It supports using the SDO service in a PLC ladder diagram to read the data from a slave or write 
the data to a slave. 
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5. It supports the reading emergencies from a slave service. 

 Use this service to read an error or an alarm from a slave. 

 You can store up to 5 emergencies in a slave. 

 You can read emergencies from a slave through a PLC ladder diagram. 

6. It supports the SYNC object (synchronous object) service. 

7. Several devices can operate synchronously through the synchronous object service. 

8. The supported CANopen communication rates are: 20K, 50K, 125K, 250K, 500K, and 1Mbps. 

The supported mapping data types are: 

Storage Data type 
8-bit SINT USINT BYTE 
16-bit INT UINT WORD 

32-bit DINT UDINT REAL DWORD 

64-bit LINT ULINT LREAL LWORD 

 

The CAN port has the following functions when acting as a slave. 

 It supports the standard CANopen protocol DS301 V4.02. 

 It supports the NMT (network management object) service. 

 It supports the NMT state control. 

The state of the DVP-ES3/EX3/SV3/SX3 Series in the CANopen network is controlled by a 
master. 

 It supports the NMT error control. 

The DVP-ES3/EX3/SV3/SX3 Series supports Heartbeat but not Node Guarding. 

 It supports the PDO (process data object) service. 

 The PDO message transmits the immediate input data and output data. 

 It supports up to 8 TxPDO and 8 RxPDO. 

 The PDO transmission type: synchronous mode and asynchronous mode 

 It supports the emergency service. 

If an error or an alarm occurs in the DVP-ES3/EX3/SV3/SX3 series, the master is notified through the 
emergency service. 

10.1.2 The Input/Output Mapping Areas 

The following table lists the CANopen DS301 specifications for the AS DVP-ES3/EX3/SV3/SX3 Series PLC.  

Type Item Description 

Master 
Maximum slave nodes Up to 64 nodes 
Maximum transfer size of 
a PDO (Read + Write) Up to 2000 Bytes (including some system configurations) 

Slave Maximum transfer size of 
a PDO (Read + Write) 

Up to 8 PDOs; each PDO with up to 8 bytes can be transferred 
at a time 
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When ES3 Series PLC CPU acts as a Master, the output mapping areas are D25000-D25999, and the input 
mapping areas are D24000-D24999, as the following table shows. 

Device in the PLC Mapping area Mapping length 

D25000–D25031 SDO request information, NMT service information, and 
Emergency request information 64 bytes 

D24000–D24031 SDO reply information, and Emergency reply information 64 bytes 
D25032–D25978 RxPDO mapping area (Master -> Slave) 1894 bytes 
D24032–D24978 TxPDO mapping area (Master <- Slave) 1894 bytes 

 

When ES3 Series PLC CPU acts as a Slave, the output mapping areas are D25032–25063, and the input 
mapping areas are D24032–24063 as the following table shows. 

Device in the PLC Mapping area Mapping length 
D24032~24063 RxPDO mapping area (Slave <- Master) 64 bytes 
D25032~25063 TxPDO mapping area (Slave -> Master) 64 bytes 

 
10.1.3 Refreshing Mechanism in the Input/Output Mapping Areas  

When ES3 Series PLC CPU acts as a Master, the factors including PLC scan time and the synchronization 
options affect the refreshing mechanism for data mapping in the input/output mapping area. Here we list three 
scenarios in synchronous mode and one scenario in non-synchronous mode for your reference.    
 Synchronous mode 
Scenario A: ½ synchronization cycle time (for the slave to send data) > PLC scan time  
A half of the synchronization cycle time is longer than a PLC scan time: at lease one PDO will be sent within 
one synchronization cycle time.  

 
 

Sync cyc le Sync cyc le Sync cycle Sync cyc le

        

½ Sync

    


½ Sync ½ Sync ½ Sync ½ Sync

 
Explanation:  
: Once the synchronization cycle starts, the timer starts to count. The counted time should be longer than a 
half of the set synchronization time (a rounded-down number) for Master to send PDO to Slave.    

: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  

PLC CPU sends PDO and then clears the counted time.  
: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
The counted time of the synchronization cycle is less than half of the synchronization cycle time (for the slave 
to send data), or the PDO had already been sent before, the PDO here cannot be sent and the time of the 
synchronization cycle continues to be counted.  

: From the cases in the green section, we know that the time for the PDO to be sent does NOT equal to the 
time to perform synchronization, but what we can be sure is that a Master can send at lease one PDO within 
every synchronization cycle.  
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Scenario B:  
Synchronous mode; ½ synchronization cycle time (for the slave to send data) < = PLC scan time < 
synchronication cycle time  

A half of the synchronization cycle time is less than a PLC scan time and the PLC scan time is less than or 
equals to a whole synchronization cycle time: it is possible that zero PDO will be sent during a 
synchronization cycle. 
 

Sync cycle Sync cycle Sync cycle Sync cyc le

 #1  

½ Sync ½ Sync ½ Sync ½ Sync ½ Sync

 



      
 

Explanation:  

: Once the synchronization cycle starts, the timer starts to count. The counted time should be longer than a 
half of the set synchronization time (a rounded-down number) for Master to send PDO to Slave.    

 

: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
PLC CPU sends PDO and then clears the counted time. 
 
#1: There was no PDO sent from the previous synchronization cycle. Before PLC scan time ends, the next 
synchronization cycle comes and the counted time is longer than a half of the set synchronization time (a 
rounded-down number), PLC CPU sends PDO and then clears the counted time.  
 
: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
The counted time of the synchronization cycle is less than half of the synchronization cycle time (for the slave 
to send data), the PDO here cannot be sent and the time of the synchronization cycle continues to be counted. 
 
: From the cases in the green section, we know that the time for the PDO to be sent does NOT equal to the 
time to perform synchronization, and it is possible that Master can send zero PDO during a synchronization 
cycle.   
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Scenario C:  
Synchronous mode; synchronization cycle time < = PLC scan time  
The synchronization cycle time is less than a PLC scan time: it is possible that zero PDO will be sent during a 
synchronization cycle. 
 

 

Sync cycle Sync cycle Sync cyc le Sync cycle

  #1 



Sync cycle



    
 

 
Explanation:  

: Once the synchronization cycle starts, the timer starts to count. The counted time should be longer than a 
half of the set synchronization time (a rounded-down number) for Master to send PDO to Slave.    
 
: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
PLC CPU sends PDO and then clears the counted time. 
 
#1: There was no PDO sent from the previous synchronization cycle. Before PLC scan time ends, the next 
synchronization cycle comes and the counted time is longer than a half of the set synchronization time (a 
rounded-down number), PLC CPU sends PDO and then clears the counted time.  
 
: After PLC scan time ends, PLC CPU refreshes to update the synchronization task:  
The counted time of the synchronization cycle is less than half of the synchronization cycle time (for the slave 
to send data), the PDO here cannot be sent and the time of the synchronization cycle continues to be counted. 
 
: From the cases in the green section, we know that the time for the PDO to be sent does NOT equal to the 
time to perform synchronization, and it is possible that Master can send zero PDO during a synchronization 
cycle. The chance of Master not sending any PDO during a synchronization cycle is higher than what 
happened in scenario B.  
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 Non-synchronous mode  
 

  

X X

    PLCScancyc le PLCScancycle PLCScancycle PLCScancyc le PLCScancycle

 
 
Explanation:  

: After PLC scan time ends, PLC CPU refreshes to update the task of sending PDO.  
 
: If the data in PDO changes, PLC CPU sends PDO. 
 
: The data in PDO remains the same, the PDO here is NOT sent.  
 

Note: You can use the function of setting up the PLC scan time to ensure PLC CPU checks the task of 
sending PDO in every set scan time.   
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10.2 Installation and Network Topology 
This section introduces the physical dimensions of DVP-ES3/EX3/SV3/SX3 Series PLC, the HWCONFIG 
settings, the CAN interface, the CANopen network framework, and the maximum communication distance. 

 

10.2.1 CANopen Communication Port 

DVP-ES3/EX3 DVP-SV3/SX3 

DVP32 ES3
16DI / 1 6DO

C AN

 

CAN

 

 
 

10.2.2 Configure the DVP-ES3 Series PLC with HWCONFIG  

1. In ISPSoft, double-click HWCONFIG in the project management area to start HWCONFIG. 
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2. Click Settings to open the Device Setting page. 
 

 

 

 

 

 

 
 
 
 
 
 

 

3. Select the working mode, node ID and the bit rate for DVP-ES3. 

* Working mode: CANopen DS301 

* Node ID: 1 

* Bit rate: 125k bps (the default, or you can select your own bit rate) 

 
 
4. When finished, click the Download button on the toolbar to download the settings to the PLC.  
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10.2.3 The CAN Interface and Network Topology 
10.2.3.1 Definitions of the CAN Signal and Data Types 
The CAN signal is a differential signal. The voltage of the signal is the voltage difference between CAN+ and 
CAN-. The CAN+ and CAN- voltages take SG as a reference point. The CAN network can be in one of two 
states. One state is a dominant level, and is indicated by the logical “0”. The other state is a recessive level, 
and is indicated by the logical “1”. The CAN signal level shows below. 

 
The following picture shows the data frame format. The CAN nodes transmit the CAN messages to the 
network from left to right. 

 
10.2.3.2 The CAN Network Endpoint and the Topology Structure 
In order to make the CAN communication more stable, the two endpoints of the CAN network are connected 
to 120 ohm terminal resistors. The topology structure of the CAN network appears below. 

 
 
 
 
 
 
 

Dominant Recessive 
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10.2.3.3 The Topology Structure of the CANopen Network 

 
1) Use standard Delta cables when wiring the CANopen network. These cables are the thick cable 

UC-DN01Z-01A, the thin cable UC-DN01Z-02A, and the thin cable UC-DN01Z-02A. Separate the 
communication cables from any power cables to avoid interference. 

2) Connect the CAN+ (white) and CAN- (blue), which are at the endpoints of the network, to 120 ohm 
resistors. Purchase the standard Delta terminal resistor (TAP-TR01) for use with the other devices and 
the RJ45 connecter.  

3) Note the limitation on the length of the CANopen network. The transmission distance of the CANopen 
network depends on the transmission rate of the CANopen network. The following table shows the 
relation between the transmission rate and the maximum communication distance. 

Transmission rate 
(bit/seconds) 20K 50K 125K 250K 500K 1M 

Maximum 
communication distance 
(meters) 

2500 1000 500 250 100 25 

 

4) The list below shows the Delta network products for the CANopen network. 

Product Model Function 

 

 

AS332T-A 

AS332P-A 

AS324MT-A 

AS320T-B 

AS320P-B 

AS300N-A 

The AS300 series PLC can function as 
the CANopen master or slave when you 
install an AS-FCOPM function card. The 
AS-FCOPM is equipped with a 120 ohm 
resistor controlled by a switch. 

 

AS228T-A 
AS228P-A 
AS228R-A 
AS218TX-A 
AS218PX-A 
AS218RX-A 

AS200 Series PLC is built with CAN 
communication port. The CAN port 
conforms to the basic communication 
protocol CANopen DS301. It supports 
master and slave modes. The CAN 
communication terminal is equipped with 
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Product Model Function 
a 120 Ω resistor. You can use a short 
circuit to use this resistor.  

 

AS132P-A 
AS132T-A 
AS132R-A 
AS148P-A 
AS148T-A 
AS148R-A 
AS164P-A 
AS164T-A 
AS164R-A 

AS100 Series PLC is built with CAN 
communication port. The CAN port 
conforms to the basic communication 
protocol CANopen DS301. It supports 
master and slave modes. 

 

DVP32ES300R 
DVP32ES300T 
DVP32ES311T 
DVP48ES300R 
DVP48ES300T 
DVP64ES300R 
DVP64ES300T 
DVP80ES300R 
DVP80ES300T  

The DVP-ES3 Series PLC is built with 
CAN communication port. The CAN port 
conforms to the basic communication 
protocol CANopen DS301. It supports 
master and slave modes. 

 

DVP32ES200RC 
DVP32ES200TC 

The DVP-ES2-C series PLC is built with 
CAN communication port. The CAN port 
conforms to the basic communication 
protocol CANopen DS301. It supports 
master and slave modes. 

 

DVP22EX300T 
DVP22EX300R 
DVP36EX300T 
DVP36EX300R 

DVP28EX300MT 

The DVP-EX3 Series PLC is built with 
CAN communication port. The CAN port 
conforms to the basic communication 
protocol CANopen DS301. It supports 
master and slave modes. 

 

DVP28SV311T 
DVP28SV311R 
DVP28SV311S 
DVP20SX311T 
DVP20SX311R 
DVP20SX311S 

The DVP-SV3/SX3 Series PLC is built 
with CAN communication port. The CAN 
port conforms to the basic communication 
protocol CANopen DS301. It supports 
master and slave modes. 

 

DVPCOPM-SL 

DVPCOPM-SL is a module connected to 
the left side of an S series PLC. It can 
function as the CANopen master or slave. 
The PLCs that you can connect to the 
DVPCOPM-SL are the DVP-28SV, 
DVP-28SV2, DVP-SX2, DVP-SA2, and 
DVP-EH2-L. 
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Product Model Function 

 

IFD9503 

The IFD9503 gateway converts CANopen 
to Modbus, and connects a device (with 
an RS-232 or RS-485 interface) that 
conforms to the standard Modbus 
protocol to a CANopen network.  You 
can connect up to 15 devices. 

 

DVPCP02-H2 

The CANopen slave module is connected 
to the right side of an EH2 series PLC. It 
can connect the EH2 series PLC to a 
CANopen network. 

 
IFD6503 

This analyzes CANopen network data, 
and has ports both ends for a CAN 
interface and a USB interface. Use it to 
monitor CAN network data, or allow CAN 
nodes to transmit the data. The product is 
used with the Netview Builder software. 

 

ASD-A2-xxxx-M 

servo driver 

This servo driver has a built-in CANopen 
interface. It controls positioning, speed, 
and torque. 

 

VFD-C2000/CP20
00/C200 series 
AC motor drives 

This AC motor drive has a built-in 
CANopen function, controls positioning, 
speed, and torque. For the 
C2000/CP2000 series AC motor drives, 
you must purchase a CMC-COP01 to 
provide the CAN interface. Only the C200 
series AC motor drive has the built-in 
CANopen interface. 

 

VFD-EC series 
AC motor drive 

The EC series AC motor drive has a 
built-in CANopen interface. It controls 
speed and torque. 
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Product Model Function 

 

TAP-CN01 
This CANopen network topology 
distribution box has a 120 ohm resistor 
enabled with a switch. 

 

TAP-CN02 
This CANopen network topology 
distribution box has a 120 ohm resistor 
enabled with a switch. 

 

TAP-CN03 
This CANopen network topology 
distribution box has a 120 ohm resistor 
enabled with switch. 

 

UC-CMC003-01A 
UC-CMC005-01A 
UC-CMC010-01A 
UC-CMC015-01A 
UC-CMC020-01A 
UC-CMC030-01A 
UC-CMC050-01A 
UC-CMC100-01A 

UC-CMC200-01A 

These CANopen sub cables have RJ45 
connectors at both ends.  
UC-CMC003-01A: 0.3 meters 

UC-CMC005-01A: 0.5 meters 
UC-CMC010-01A: 1 meter 
UC-CMC015-01A: 1.5 meters 
UC-CMC020-01A: 2 meters 
UC-CMC030-01A: 3 meters 
UC-CMC050-01A: 5 meters 
UC-CMC100-01A: 10 meters 

UC-CMC200-01A: 20 meters 

 

UC-DN01Z-01A 

UC-DN01Z-02A 

CANopen network cable 

UC-DN01Z-01A: CANopen main cable 

UC-DN01Z-02A: CANopen sub cable 

 

TAP-TR01 
This 120 ohm resistor has an RJ45 
connector. 
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10.3 The CANopen Protocol 

10.3.1 Introduction to the CANopen Protocol 

The CAN (controller area network) fieldbus only defines the physical layer and the data link layer of a network. 
See the ISO11898 standard for information. The CAN fieldbus does not define the application layer. In 
practice, the hardware contains the physical layer and the data link layer. The CAN fieldbus itself is not 
complete, and needs a superior protocol to define the use of 11/29-bit identifier and 8-byte data. 

The CANopen protocol is the superior protocol based on the CAN fieldbus. It is one of the protocols defined 
and maintained by CiA (CAN-in-Automation) and was developed on the basis of the CAL (CAN application 
layer) protocol, using a subset of the CAL communication and service protocols. 

The CANopen protocol contains the application layer and the communication profile (CiA DS301). It also 
contains a framework for programmable devices (CiA 302), recommendations for cables and connectors (CiA 
303-1), and SI units and prefix representations (CiA 303-2). 

In the OSI model, the relation between the CAN standard and the CANopen protocol is described in the 
following diagram. 

 
 

The object dictionary 

CANopen uses an object-based method to define a standard device. Every device is represented by a set of 
objects and can be visited by the network. The diagram below illustrates the CANopen device model. The 
object dictionary is the interface between the communication program and the superior application program. 

The core concept of CANopen is the device object dictionary (OD). It is an orderly set of objects. Every object 
has a 16-bit index for addressing and also defines an 8-bit subindex. Every node in the CANopen network has 
an object dictionary that includes the parameters that describe the device and the network behavior. The 
object dictionary of a node is also described in the electronic data sheet (EDS) for the device. 

Device profile CiA  Device profile CiA  Device profile CiA  

OSI seventh layer  

Application layer 
Communication profile CiA DS-301 

CAN controller CAN 2.0A 

ISO 11898 + - 
+ - 

CAN network 

OSI second layer  

Data link layer 

OSI first layer  
Physical layer 
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10.3.2 The CANopen Communication Object 

The CANopen communication protocol contains the following communication objects. 

1. PDO (process data object) 

 The PDO provides the direct channel for the device application object, and transmits the real-time data. 
It has high priority. Every byte in the PDO CAN message data list transmits data, and the message 
usage rate is high. 

 There are two kinds of uses for PDOs; data transmission and data reception. They are distinguished 
by Transmit-PDOs (TxPDOs) and Receive-PDOs (RxPDOs). Devices supporting TxPDOs are called 
PDO producers, and devices that receive PDOs are called PDO consumers. 

 The PDO is described by the “producer/consumer mode”. The data transmits from one producer to one 
or many consumers. The data that can be transmitted is limited to between 1-byte and 8-byte data. 
After the producer transmits the data, the consumer does not need to reply to the data. Every node in 
the network detects the transmitted data and decides whether to process the received data . 

 Every PDO is described by two objects in the object dictionary: the PDO communication parameters 
and the PDO mapping parameters 

PDO communication parameters: the COB-ID used by PDO, the transmission type, the prohibition 
time, and the counter cycle 

PDO mapping parameters: the object list in an object dictionary. These objects are mapped into the 
PDO, including the data length (in bits). To explain the contents of the 
PDO, the producer and the consumer both have to understand the 
mapping.  

The PDO transmission modes: synchronous and asynchronous  

Synchronous mode: synchronous periodic and synchronous non-periodic  

Asynchronous: The producer transmits the PDO when the data changes, or after a trigger.  
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The following table lists supported transmission modes. 

Type PDO transmission  
 Periodic Non-periodic Synchronous Asynchronous RTR 

0  X X   
1 – 240 X  X   

254    X  
255    X  

Mode 0: The PDO information is transmitted only when the PDO data changes and the synchronous 
signal is received. 

Modes 1–240: One piece of PDO information is transmitted every 1–240 synchronous signals. 

Mode 254: The trigger is defined the manufacturer. The definition in the PLC is the same as mode 
255. 

Mode 255: The PDO is transmitted when the data changes, or it is transmitted after a trigger. 

All the data in the PDO has to be mapped from the object dictionary. The following diagram shows an 
example of PDO mapping. 

 

 

The following table shows the data format for RxPDO and TxPDO. 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 

Object 
identifier Data 

 

PDO_1  

Application object C zzh zzzzh 

   

Application object B yyh yyyyh 
   

Application object A xxh xxxxh 

Object dictionary 

xxxxh 

zzzzh 

yyyyh 

8 xxh 3 

16 zzh 2 

8 yyh 1 

3 0 

PDO_1 mapping 

Application object A Application object C  Application object B 
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2. SDO (service data object) 

 The SDO builds the client/server relation between two CANopen devices. The client device can read 
the data from the object dictionary on the server device and write the data into the object dictionary on 
the server device. The SDO visit mode is “client/server” mode. The mode which is visited is the SDO 
server. Every CANopen device has at least one service data object that provides the visit channel for 
the object dictionary of the device. SDO can read all the objects in the object dictionary, and write all 
objects into the object dictionary.  

 The SDO message contains the index and subindex information used to position the objects in the 
object dictionary, and the composite data structure can easily be passed by the SDO visit. After the 
SDO client sends the reading/writing request, the SDO server replies. The client and the server can 
stop SDO transmission. The requested message and the reply message are separated by different 
COB-IDs. 

 The SDO can transmit the data in any length. If the data length is more than 4 bytes, the data must be 
transmitted by segment. The last segment of the data contains an end flag. 

 The following table shows the structures of the SDO requested message and reply message. 

The format of the requested message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
600 (Hex) 
+Node-ID 

Requested 
code 

Object index Object 
subindex 

Requested data 
LSB MSB bit7-0 bit15-8 bit23-16 bit31-24 

The definition of the requested code in the requested message: 

Request code (Hex) Description 
23 Writing 4-byte data 
2B Writing 2-byte data 
2F Writing 1-byte data 
40 Reading data 
80 Stopping the current SDO function 

The format of the reply message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
580(Hex) 
+Node-ID 

Reply 
code 

Object index Object 
subindex 

Reply data 
LSB MSB bit7-0 bit15-8 bit23-16 bit31-24 

The definition of the reply code in the reply message: 

Reply code (Hex) Description 
43 Reading 4-byte data 
4B Reading 2-byte data 
4F Reading 1-byte data 
60 Writing 1/2/4-byte data 
80 Stopping the current SDO function 
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3. NMT (network management object) 

The CANopen network management conforms to the master/slave mode. Only one NMT master exists in 
the CANopen network, and all other nodes are considered to be slaves. NMT includes three services: 
module control, error control, and boot-up services. 

 Module control services 

The master node in the CANopen network controls the slave by sending commands. The slave 
receives and executes the command, and does not need to reply. All CANopen nodes have internal 
NMT states. The slave node has four states: initialization, pre-operational, operational, and stop 
states. The following diagram illustrates the device states. 

 

(1) After power is supplied, the device automatically enters the initialization state. 

(2) After the initialization is complete, the device automatically enters the pre-operational state. 

(3), (6) The remote node starts. 

(4), (7) The device enters the pre-operational state. 

(5), (8) The remote node stops. 

(9), (10), (11) The application layer resets. 

(12), (13), (14) The communication resets. 

(15) After the initializing is complete, the device automatically enters the reset application state. 

(16) After the reset application state is complete, the device automatically enters the reset 
communication state. 

Initializing 

Reset application  

Reset communication  

Pre-operational 

Operational  

Stopped 

(1) 

(15) 

(16) 

(2)  

(3) (4) 
(7) 

(5) 

(6) 
(8) (9) 

(10) 

(11) 

(12) 

(13) 

(14) 

Initialization 
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The following table shows the relation between the communication object and the state. You can only 
execute the communication object service in the correct state. For example, you can only execute 
SDO in the operational state and pre-operational states. 

 Initialization Pre-operational Operational Stopped 
PDO   X  
SDO  X X  
SYNC  X X  
Time Stamp  X X  
EMCY  X X  
Boot-up X    
NMT  X X X 

The control message format for the node state: 

COB-ID Byte 0 Byte 1 

0 Command specifier (CS) 
Slave address  

(0: Broadcast) 

The command specifiers: 

Command specifier 
(Hex) 

Function 

01 Start the remote node 

02 Stop the remote node 

80 Enter the pre-operational state 

81 Reset the application layer 

82 Reset the communication 

 

 Error control services 
The error control service detects the disconnection of a network node. The error control services are 
classified into two types: Heartbeat and Node Guarding. The DVP-ES3/EX3/SV3/SX3 Series PLC only 
supports Heartbeat. For example, the master can detect the disconnection of the slave only after the 
slave enables the Heartbeat service. 
The following illustrates the Heartbeat principle. The Heartbeat producer transmits the Heartbeat 
message according to the set Heartbeat producing time. One or many Heartbeat consumers detect the 
message transmitted by the Heartbeat producer. If the consumer does not receive the message 
transmitted by the producer within the timeout period, there is a problem in the CANopen 
communication or the producer is disconnected.  
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 Boot-up services 

After the slave completes the initialization and enters the pre-operational state, it transmits the 
Boot-up message. 

1. Other predefined CANopen communication objects (SYNC and EMCY) 
 SYNC Object (Synchronous object) 

The synchronous object is the message that the master node periodically broadcasts on the CANopen 
network. This object recognizes the network clock signal. Every device decides whether to use the 
event use synchronous communication with other network devices depending on its configuration. For 
example, when controlling a driving device, the devices do not act immediately after they receive the 
command sent by the master. They do act when they receive the synchronous message. This makes 
multiple devices act synchronously. 
The format of the SYNC message: 

COB-ID 

80 (Hex) 

 Emergency object 
The emergency object is used by a CANopen device to indicate an internal error. When an emergency 
error occurs in the device, the device sends the emergency message (including the emergency error 
code), and the device enters an error state. After the error is eliminated, the device sends another 
emergency message with emergency error code 0, and the device enters the normal state. 
The format of the emergency message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 

80 (Hex) 
+Node-ID 

Emergency error 
code Error 

register Factory-defined error code 
LSB MSB 

Note: The value in the error register is mapped to index 1001 (Hex) in the object dictionary. If the value 
is 0, no error occurred. If the value is 1, a normal error occurred. If the value is H’80, an internal error 
occurred in the device.  

Request 

Receiving 

Receiving 

 
Request 

Heartbeat consumer Heartbeat producer 

Heartbeat 
producing 
time Heartbeat 

timeout 
period 

Heartbeat event 

Heartbeat 
timeout 
period 

Receiving 
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10.3.3 The Predefined Connection Set 

In order to decrease the configuration workload of the network, CANopen defines a default identifier. In the 
predefined connection set, the structure of the 11-bit identifier is as follows. 

 
The following tables list the objects that are supported and the COB-IDs that are assigned to the objects. 

1. The broadcast object in the predefined connection setting 

Object Function code COB-ID Index of the 
communication parameter 

NMT 0000 0 - 
SYNC 0001 128 (80h) 1005h, 1006h, 1007h 

Time stamp 0010 256 (100h) 1012h, 1013h 

 

2. The corresponding object in the predefined connection set 

Object Function code COB-ID Index of the 
communication parameter 

Emergency 0001 129 (81h)–255 (FFh) 1014h, 1015h 
PDO1 (TX) 0011 385 (181h)–511 (1FFh) 1800h 
PDO1 (RX) 0100 513 (201h)–639 (27Fh) 1400h 
PDO2 (TX) 0101 641 (281h)–767 (2FFh) 1801h 
PDO2 (RX) 0110 769 (301h)–895 (37Fh) 1401h 
PDO3 (TX) 0111 879 (381h)–1023 (3FFh) 1802h 
PDO3 (RX) 1000 1025 (401h)–1151 (47Fh) 1402h 
PDO4 (TX) 1001 1153 (481h)–1279 (4FFh) 1803h 
PDO4 (RX) 1010 1281 (501h)–1407 (57Fh) 1403h 
SDO (TX) 1011 1409 (581h)–1535 (5FFh) 1200h 
SDO (RX) 1100 1537 (601h)–1663 (67Fh) 1200h 

NMT Error Control 1110 1793 (701h)–1919 (77Fh) 1016h, 1017h 
 

Function code Node ID 
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10.4 Sending SDO, NMT and Reading Emergency Message 
through the Ladder Diagram 
You can edit the request message mapping area to affect the transmission of SDO, NMT and Emergency 
messages. The following table shows the corresponding relations between the request message mapping 
area, response message mapping area, and PLC device. 

PLC device Mapping area Mapping length 

D25000-D25031 SDO request message, NMT service message and 
Emergency request message 64 bytes 

D24000-D24031 SDO response message and Emergency response message 64 bytes 

The CANopen master can only send one SDO, NMT, or Emergency request message to the same device at a 
time. Clear the request message mapping area to zero when sending SDO, NMT, or Emergency request 
message through the WPL program. 

10.4.1 Data Structure of SDO Request Message  
Sending SDO through the ladder diagram reads or writes the slave parameter. 

1. The data format of the SDO request message: 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message Header 

ReqID Command (Fixed to 01) 

D25001 Reserved Size 

D25002 Type Node ID 

D25003 

Message Data 

High byte of main index Low byte of main index 

D25004 Reserved Sub-index 

D25005 Datum 1 Datum 0 

D25006 Datum 3 Datum 2 

D25007 - D25031 Reserved 

 ReqID: the request ID. Whenever an SDO request message is sent out, the message is given a ReqID 
for CANopen master to identify. When reading/writing another SDO message, the original ID number 
must be changed. In other words, reading/writing SDO is triggered by changing of the value of “ReqID”. 
The ReqID range is between 00–FF (Hex). 

 Size: the length of the message data. The counting starts from D6253 with a byte as the unit. When 
reading, it is fixed to four and when writing, it is four plus the byte number of data types of index and 
subindex and the maximum value is eight. But when writing, if the data type of the index and subindex 
is word, the data length is six. The data length is file if the data type is byte. 

 Node ID: the node address for the target equipment on a CANopen network. 

 Type: 01 indicates the read access; 02 indicates the write access. 

The following table shows the data format of the SDO response message. 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message Header 

ResID Status code 
D24001 Reserved Size 

D24002 Type Node ID 

D24003 Message Data High byte of main index Low byte of main index 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual   

 10-24 

_10 

PLC device 
Response message 

 High byte Low byte 
D24004 Reserved Sub-index 

D24005 Datum 1 Datum 0 

D24006 Datum 3 Datum 2 

D24007~D24031 Reserved 

 Status code: 

The following table lists the status code values in the response message. 

Status code Explanation 
0 No data transmission request 
1 SDO message transmission succeeds. 
2 SDO message is being transmitted. 
3 Error: SDO transmission time-out 
4 Error: Illegal command code 
5 Error: the length of the transmitted data is illegal. 
6 Error: the length of the response data is illegal. 
7 Error: Equipment to be sent messages is busy. 
8 Error: Illegal type 
9 Error: Incorrect node address 

0A Error message (See the error code for SDO response message) 
0B-FF Reserved 

 ResID: the same as the request ID in the request message. 

 Size: the length of the message data, maximum of 20 bytes. The unit is bytes. When writing, the 
maximum is four; the data length is decided by the data type of index and subindex when reading. 

 Node ID:  the node address of the target equipment on CANopen network. 

 Type: in the SDO response message, 43 (Hex) refers to reading four bytes of data; 4B (Hex) refers to 
reading two bytes of data; 4F (Hex) refers to reading one byte of data; 60 (Hex) refers to writing 1/2/4 
byte(s) of data; 80 (Hex) refers to stopping SDO command. 

Example 1: write 010203E8 (Hex) to (Index_subindex) 212D_0 in slave of No. 3 through SDO; the data type of 
(Index_subindex) 212D_0 is double words (32 bits). 

 Request data:  

PLC device 
Request message 

 High byte(Hex) Low byte(Hex) 
D25000 

Message 
Header 

ReqID=01 Command =01 
D25001 Reserved =0 Size =8 
D25002 Type =02 Node ID =03 
D25003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D25004 Reserved =0 Subindex =0 
D25005 Datum 1=03 Datum 0=E8 
D25006 Datum 3=01 Datum 2=02 
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 Response data: 

PLC device 
Response message 

 High byte(Hex) Low byte(Hex) 
D24000 

Message 
Header 

ResID =01 Command =01 
D24001 Reserved =0 Size =4 
D24002 Type =60 Node ID =03 
D24003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D24004 Reserved =0 Subindex =0 
D24005 Datum 1=00 Datum 0=00 
D24006 Datum 3=00 Datum 2=00 

 

Example 2: read the value of (Index_subindex) 212D_0 in slave of No. 3 through SDO; the data type of 
(Index_subindex) 212D_0 is double words (32 bits). 

 Request data:  

PLC device 
Request message 

 High byte(Hex) Low byte(Hex) 
D25000 

Message 
Header 

ReqID =01 Command =01 
D25001 Reserved =0 Size =4 
D25002 Type =01 Node ID =03 
D25003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D25004 Reserved =0 Subindex =0 
D25005 Datum 1=0 Datum 0=0 
D25006 Datum 3=0 Datum 2=0 

 
10.4.2 Data Structure of NMT Message 

Use the NMT service to manage the CANopen network such as start, operation, reset of nodes, etc. 
The following table shows the data format of the NMT request message. 

PLC device 
Request message 

 High byte Low byte 

D25000 
Message 
Header 

ReqID Command (Fixed to 01) 

D25001 Reserved Size (Fixed to 04) 

D25002 Type (Fixed to 03) Node ID 

D25003 Message 
data 

Reserved NMT service code 

D25004 Reserved Node ID 

 Command: Fixed to 01. 

 ReqID: the request ID. Whenever an NMT request message is sent, the message is given a ReqID for 
the CANopen master to identify. Before another NMT request message is sent out, the original ID 
number must be changed. In other words, change the value of ReqID. The ReqID range is between 
00–FF (Hex) to trigger sending the NMA request message. 
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 Node ID: the node address for the target equipment on the CANopen network (0: Broadcast). 

 NMT service code: 

NMT service code (Hex) Function 
01 Start remote node 
02 Stop remote node 
80 Enter the pre-operational state 
81 Reset application 
82 Reset communication 

 

The following table shows the data format of the NMT Response message. 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message 
header 

ResID Status code 
D24001 Reserved Reserved 
D24002 Reserved Node ID 

 When status code is 1, the NMT operation has succeeded. When status code is not equal to1, the 
NMT operation has failed and you should verify that the data in NMT request message is correct. 

 Node ID: the node address for the target equipment on the CANopen network. 

 

Example 1: Stop slave of No. 3 through NMT 

 Request data: 

PLC device 
Request message 

 High byte (Hex) Low byte (Hex) 
D25000 

Message 
header 

ReqID =01 Command =01 
D25001 Reserved =0 Size =04 
D25002 Type =03 Node ID =03 
D25003 Message 

data 
Reserved NMT service code =02 

D25004 Reserved Node ID =03 

 Response data: 

 
 
 
 
 
 

PLC device 
Response message 

 High byte (Hex) Low byte (Hex) 
D24000 

Message 
header 

ResID=01 Status code =01 
D24001 Reserved =0 Reserved =0 
D24002 Reserved =0 Node ID =03 
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10.4.3 Data Structure of EMERGENCY Request Message 

The Emergency request message communicates the slave error and alarm information. 

The following table shows the data format of the Emergency request message. 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message 
header 

ReqID Command (Fixed to 1) 
D25001 Reserved Size (Fixed to 0) 
D25002 Type (Fixed to 04) Node ID 

D25003~D25031 Message 
data Reserved 

 Command: Fixed to 01. 

 ReqID: the request ID. Whenever an Emergency message is sent, the message is given a ReqID for 
the CANopen master to identify. Before another Emergency request message is sent out, the original 
ID number must be changed. In other words, change the value of ReqID. The ReqID range is between 
00–FF (Hex) to trigger the sending the Emergency request message. 

 Node ID: the node address of the target equipment on CANopen network. 

 

The following table shows data format of the Emergency response message. 

PLC device 
Response message 

 High byte (Hex) Low byte (Hex) 
D24000 

Message 
header 

ResID Status code 
D24001 Reserved Size Fixed to 2A 
D24002 Type (Fixed to 04) Node ID 
D24003 

Message 
data 

Total number of data Number of data stored 
D24004 Datum 1 Datum 0 
D24005 Datum 3 Datum 2 
D24006 Datum 5 Datum 4 
D24007 Datum 7 Datum 6 

D24008-D24011 Emergency2 
D24012-D24015 Emergency3 
D24016-D24019 Emergency4 
D24020-D24023 Emergency5 
D24024-D24031 Reserved 

 Command: Fixed to 01(Hex). 

 When status code is 1, reading the Emergency message has succeeded. When status code is not 
equal to1, reading the Emergency message has failed and you should verify that the data in the 
Emergency message is correct. 

 Node ID: the node address for the target equipment on the CANopen network. 

 Total number of data: total number of Emergency messages CANopen master receives from the slave. 

 Number of data stored: the latest number of Emergency messages CANopen master receives from the 
slave (5 messages at most). 
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 An Emergency 1 consists of the data in D6004-D6007 and every Emergency message consists of 8 
bytes of data. 

The following table shows the data format of Emergency messages on the CAN bus. Datum 0–datum 
7 in Emergency response message correspond to byte 0–byte 7 respectively. 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
80 (Hex) 
+Node-ID 

Emergency error 
code 

Error storage 
register Vendor custom error code 

Example 1: read the Emergency message from the slave No.2, and the Emergency messages the 
slave sends out successively.  

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
82 (Hex) 43 54 20 14 0 0 0 0 

 
COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
82 (Hex) 42 54 20 15 0 0 0 0 

 Request data: 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message 
header 

ReqID=01 Command =01 
D25001 Reserved Size =0 
D25002 Type =04 Node ID =03 

 

 Emergency response data 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message 
header 

ResID=01 Status code =01 
D24001 Reserved =0 Size =2A (Hex) 
D24002 Type =04 Node ID =03 
D24003 

Message 
data 

Total number of data =1 Number of data stored =1 
D24004 Datum 1=54 Datum 0=42 
D24005 Datum 3=20 Datum 2=14 
D24006 Datum 5=0 Datum 4=0 
D24007 Datum 7=0 Datum 6=0 
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10.4.4 Example of Sending SDO through the Ladder Diagram 

The following uses DVP-ES3 as a demonstration example. For EX3/SV3/SX3, the operations are all the 
same.  

1. Control Requirement: 

Read the value of P0-09 from the servo through SDO. 

 

2. Hardware Connection: 

 

3. The Corresponding Relation between Slave Parameter and Index/Subindex 

The index_subindex corresponding to P0-09 in servo is 2009_0. In the CANopen Builder network 
configuration software, right click the servo icon, and then click Parameter Edit. In the Parameter Edit 
dialog box, you can see the index_subindex corresponding to the servo parameter.  

For more details on how to operate the network configuration interface, refer to Section 11.1.1 in the 
CANopen Builder software help file 
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4. The Structure of the Request Message Devices: 

PLC device 
Content 

(Hex) 
Explanation 

High byte (Hex) Low byte (Hex) 

SDO 
request 

message 
mapping 

area 

D25000 0101 ReqID = 01 Command = 01  
D25001 0004 Reserved Size = 04  
D25002 0102 Type = 01 Node ID = 03 
D25003 2009 Index high byte = 20  Index low byte = 09  
D25004 0000 Reserved Subindex = 00  

 

5. Editing the Ladder Diagram in ISPSoft 

 

 

When M2=ON, after reading succeeds, the program stores the data from the target device in 
D24000–D24005. The value of D24005: 100 (Hex) is the value read from P0-09. 

 

6. The Structure of the Response Message Devices: 

 

PLC device 
Content 

(Hex) 
Explanation 

High byte (Hex) Low byte (Hex) 

SDO 
response 
message 
mapping 

area 

D24000 0101 ResID = 01 Status code = 01  
D24001 0006 Reserved Size = 08 
D24002 4303 Type = 43  Node ID = 03  
D24003 2009 Main index high byte = 20 Index low byte = 09  
D24004 0004 Reserved Subindex = 00 
D24005 0100  Datum 1= 01 Datum 0= 00  
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10.5 Troubleshooting 

10.5.1 CANopen Network Node State Display 

1. In the DVP-ES3/EX3/SV3/SX3 Series PLC, while you enable the CANopen function, it uses SR825–893 
as the special registers as shown in the following table. 

Special register Function 
SR825 Displays the state of CANopen DS301 Master 

SR830–SR893 Displays the state of 64 nodes in the network 
SR826  Flag for the state of the slave 1–16 
SR827 Flag for the state of the slave 17–32 
SR828 Flag for the state of the slave 33–48 
SR829 Flag for the state of the slave 49–64 
SR821 Version of CANopen DS301 
SR822 Displays the CANopen baud rate (unit: 1kpps) 

 
2. As a master, the DVP-ES3/EX3/SV3/SX3 Series PLC supports a maximum of 64 slaves ranging from 

node 1 to node 64. You can use SR826–829 to monitor the state of the nodes in the network. The 16 bits 
in SR826 correspond to 16 slaves and their corresponding relations are shown in the following table.  

Bit b7 b6 b5 b4 b3 b2 b1 b0 

Node Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 

Bit b15 b14 b13 b12 b11 b10 b9 b8 

Node Node16 Node15 Node14 Node13 Node12 Node11 Node10 Node 9 

When the node in the master node list is normal, the corresponding bit is OFF; when the node in the 
master node list is abnormal (for example, initializing fails or the slave is offline for some reason), the 
corresponding bit is ON. 
 

3. The error code of every node is displayed through the corresponding special register (SR830–893) and 
the relations between special register and corresponding node (1–16) is shown in the following table. 
(You can also judge for other correspondings that are not listed here.) 

Special 
register SR830 SR831 SR832 SR833 SR834 SR835 SR836 SR837 

Node Node 1 Node 2 Node 3 Node 4 Node 5 Node 6 Node 7 Node 8 
Special 
register SR838 SR839 SR840 SR841 SR842 SR843 SR844 SR845 

Node Node 9 Node10 Node11 Node12 Node13 Node14 Node15 Node16 
 

4. Node codes displayed in SR830–893 when the ASSeries PLC is the master:  

Code Indication How to correct 

0 
The node is error free or the node is 
not configured. 

N/A 

E0 
ASSeries PLC master module 
receives the emergency message 
sent from slave. 

Read the relevant message with the PLC program 

E1 PDO data length returned from the Set the PDO data length of the slave and 
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Code Indication How to correct 
slave is not consistent with the 
length set in the node list. 

re-download. 

E2 PDO of slave is not received. Check and ensure the setting is correct. 
E3 Downloading auto SDO fails. Check and ensure auto SDO is correct. 

E4 
Configuration of PDO parameter 
fails. 

Ensure that the PDO parameter setting is legal. 

E5 Error in key parameter setting. 
Ensure that the connected slave device is 
consistent with the configured slave in the 
software. 

E6 
The slave does not exist in the 
network Ensure that the power supply of slave is normal 

and slave is correctly connected to the network. 
E7 Slave error control is timed-out. 

E8 
The node IDs of master and slave 
repeat. 

Set the node ID of the master and slave again and 
ensure their node IDs are unique. 

 
5. Codes displayed in SR825 when the DVP-ES3/EX3/SV3/SX3 Series PLC is the master: 

Code Indication How to correct 

0 

In CANopen DS301 mode: the PLC 
works as master and is working 
normally. 

Not in CANopen DS301 mode: the 
master mode function is not 
activated. 

N/A 

F1 No slave in the list  
Add slave into the node list and then re-download 
the configuration data. 

F2 
The data are being downloaded to 
the PLC 

Wait to finish downloading the configuration data. 

F3 
The configuration receiving error in 
the PLC 

Download parameter configuration again. 

F4 Bus-OFF is detected. 
Check that the CANopen bus cables are properly 
connected and ensure that all the node devices run 
at the same baud rate before you reboot. 

F5 
The PLC setting error such as 
incorrect node address 

The node address in the DVP-ES3/EX3/SV3/SX3 
Series PLC should be between: 1–127. 

F8 
Internal error; the error is detected in 
the internal memory 

If the same error occurs after cycling the power, 
replace it with a new DVP-ES3/EX3/SV3/SX3 
Series PLC. 

FB The sending buffer in the PLC is full. 
Check that the CANopen bus cable is properly 
connected and then reboot. 

FC 
The receiving buffer in the PLC is 
full. 

Check that the CANopen bus cable is properly 
connected and then reboot. 
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6. Codes displayed in SR825 when the DVP-ES3/EX3/SV3/SX3 Series PLC is the slave:  

Code Indication How to correct 

0 Working normally 

N/A 

Note: When the heartbeat alam function is not 
activated, if the connection is normal before a 
disconnection occurs, the code for the slave will 
still be working normally after the connection is 
back on.  

A0 The PLC is being initialized. -- 

A1 The PLC is pre-operational. 
Check if the CANopen bus cable is properly 
connected. If the master communication is not 
activated, no handling is needed. 

A3 
The data are being downloaded to 
the PLC. 

Wait to finish downloading the configured data. 

B0 Heartbeat message time-out 
Check if the CANopen bus cable is properly 
connected. 

B1 
PDO data length returned from the 
slave is not consistent with the 
length set in the node list. 

Reset the PDO data length in the slave and 
download the new setting to the 
DVP-ES3/EX3/SV3/SX3 Series PLC. 

F4 BUS-OFF state is detected. 
Check if the CANopen bus cables are properly 
connected and ensure that all the node devices run 
at the same baud rate before you reboot. 

FB The sending buffer in the PLC is full. 
Check if the CANopen bus cable is properly 
connected and then reboot. 

FC 
The receiving buffer in the PLC is 
full. 

Check if the CANopen bus cable is properly 
connected and then reboot. 
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10.6 Application Example 
The following uses DVP-ES3 as a demonstration example. For EX3/SV3/SX3, the operations are all the 
same.  

The DVP-ES3 Series PLC can control Delta A2 servo rotation, and monitor the actual rotation speed of the 
motor in real time. It does this by mapping the relevant servo drive parameters to the corresponding PDO, and 
reads or writes the relevant servo drive parameters through the CAN bus. 

 

1. Connectting the Hardware 

 
Note: 

 Use a standard communication cable such as UC-DN01Z-01A / UC-DN01Z-02A / UC-CMC010-01A 
and connect the terminal resistors (Delta standard terminal resistor TAP-TR01) to both ends of the 
network when you construct the network. 

 M of ASD-A2-xxxx-M refers to the model code and currently only the M-model servo supports 
CANopen communication. 

2. Setting Servo Parameters: 

 Set servo parameters as shown in the following table. 

Parameter Setting Explanation 
3-00 03 Node ID of the A2 servo is 2 
3-01 400 CAN communication rate is 1Mbps. 
1-01 04 Speed mode 
0-17 07 Drive displays the motor rotation speed (r/min) 
2-10 101 Set DI1 as the signal for Servo On 
2-12 114 Set DI3 as the signal _SPD0 for speed selection  
2-13 115 Set DI4 as the signal _SPD1 for speed selection 
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3. Setting the CANopen Baud Rate and Node ID of DVP-ES3 Series PLC  

The DVP-ES3 Series PLC uses the default setting values: Node ID: 1 and baud rate: 1Mbps. 

You set the CANopen Node ID and baud rate for the DVP-ES3 Series PLC in the CANopen Builder 
software, as shown in the following steps. 

A. In ISPSoft, double-click HWCONFIG in the project management area to start HWCONFIG. 

 
 
 
 
 
 
 
 
 
 
 

B. Click CANopen Builder.  
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C. IF DVP-ES3 is in master mode, you can skip this step. If not, you can go to Properites and set it in 
Master mode. After that download the parameter to DVP-ES3. Set DVP-ES3 power off for 2 
seconds and supply power again and then proceed to the next step. 

 

 
 

D. Click the Online  button on the Toolbar to enter on-line mode.  
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E. Click the Scan Network  button on the Toolbar to scan the network. 

 

 

F. On the Network menu, click Master parameter to display the Master Configuration dialog box.  

 
 

Item Explanation Default 

Node ID Node ID of DVP-ES3 Series PLC on the 
CANopen network 1 

Baud rate CANopen communication rate 1M bit/second 
Work mode CANopen master/slave mode Master 
Cycle period Cycle time for sending one SYNC message 50ms 

Master heartbeat time Interval time for sending the master heartbeat 
message 200ms 

Configure the CANopen communication stations and rates in HWCONFIG.  
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G. After you complete the previous steps, click the Download  button on the Toolbar to download 
the parameters to the PLC.   

 

Note: you must reboot the DVP-ES3 Series PLC to enable the downloaded parameters.  

 

4. Scanning the Network: 

On the Network menu, click Online or click the  button to scan for the master and slaves on the 
CANopen network. The master and slave found by the scan appear in CANopen Builder. For more 
information, refer to Section 11.1.1 in the CANopen Builder software help file. 

 
5. Configurating Nodes: 

Double click the slave icon in CANopen Builder to display the Node configuration dialog box.  

 Error Control Protocol 

Sets the error control protocol for the master to monitor if the slave is offline. 

 Auto SDO Configuration 

Perform one write action to the slave parameter with SDO.  The write action is finished when the 
slave enters the operational state from the pre-operational state. You can configure up to 20 SDOs by 
clicking Auto SDO configuration. 
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 PDO Mapping and Properties 

Sets the mapping parameter and transmission type for the PDO. 

For more details on the function of these buttons, refer to Section 11.1.1 in the CANopen Builder 
software help file.  

 
 PDO Mapping:  

RxPDO1: mapping parameter P1-09; transmission type 255. 

RxPDO2: mapping parameter P3-06, P4-07; transmission type 255. 

TxPDO1: mapping parameter P0-09; transmission type 1. 

 
 

 PDO transmission type : 

PDOs can be classified into RxPDO or TxPDO. RxPDO data are sent from master to slave and 
TxPDO data are sent from slave to master. 

The PDO transmission types can be synchronous or asynchronous. In synchronous transmission, the 
master sends out the SYNC message in a fixed cycle. You set the length of the cycle in the Master 
Properties dialog box (default is 50ms). In asynchronous transmission, the message is sent out when 
the PDO mapping parameter changes. 
The following table describes the PDO Transmission types. 
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Transmission Type Description Remark 

0 

RxPDO 

When any change in the mapped data happens, 
RxPDO data is sent out immediately. The data 
the slave receives is valid only when receiving 
the next SYNCH message. RxPDO data is not 
sent out if there is no change in the data. SYNCH 

non-cycle 
 

TxPDO 

When any change in the mapped data happens 
and the slave receives the SYNC message, the 
data are sent out immediately. The TxPDO data 
are valid immediately after master receives them. 
TxPDO data is not sent out if there is no change 
in the data. 

N 
（N:1–240） 

RxPDO 

After N messages are sent out, and regardless of 
whether the mapped data changes, the data that 
the slave receives is valid only when receiving 
the next SYNCH message. 

SYNCH 
cycle 

 
TxPDO 

After N messages are sent out and regardless of 
whether the mapped data is changed, the data 
that the master receives is valid at once. 

254 

RxPDO 

The mapped data is sent out immediately when it 
changes and is valid when the slaves receives it. 
RxPDO data is not sent out if there is no change 
in the data. 

ASYNCH 

TxPDO 

The slave sends out the data once every one 
Event timer time.  After that, the TxPDO data is 
not allowed to be sent out within an inhibit timer 
time. 
When the Event timer and Inhibit timer are both 
equal to 0, the slave sends TxPDO data to the 
master immediately when the data changes, and 
the data that master receives is immediately 
valid. 

255 Same as Type254 

Note: 

 Synchronous transmission type can fulfill multi-axis motion at the same time. 

 If you monitor a real-time changing parameter such as the actual rotation speed of the motor, set 
the TxPDO to the synchronous transmission type; otherwise the frequent change in the slave data 
can block the CANopen network.  

 

After you finish setting the above parameters, double click the master device to display the Node List Setting 
dialog box. Select ASDA-A2 Drive, and click > to move the A2 drive to the right-side list, and then download 
the configured data. 
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The mapping relation between master and slave: 

DVP-ES3/EX3/SV3/SX3 Series PLC 
master register 

Data transmission on CANopen 
bus A2 device 

D25032  Low word of P1-09 of 
servo 

D25033 High word of P1-09 of 
servo 

D25034 P3-06 of servo 

D25037 P4-07 of servo 

D24032 
 Low word of P0-09 of 

servo 

D24033 
High word of P0-09 of 
servo 

6. Program control: D25032 is given the value 256 in ISPSoft; that is, the speed command is set as 
256r/min in the following diagram. 
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7. Program explanation 

When the DVP-ES3 Series PLC runs for the first time, set the parameter P3-06 for servo drive to F. 

 When M0 switches from OFF to ON, the instruction writes 256 to D25032 and then writes the value to  
the servo parameter P1-09 through RxPDO1. 

 When M1 switches from OFF to ON, change P4-07 to 5. DI1 and DI3 are ON. DI1 means the SERVO is 
ON and DI3 calls the speed specified by parameter P1-09 for servo rotation. 

 When M1 switches from ON to OFF, the speed command becomes 0 and the motor stops running. 
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10.7 Object Dictionary 
The following table lists the communication objects in the object dictionary. 

Index Subindex Object name Data type Attr. Default 
value 

H’1000 H’00 Device type Unsigned 32 bits R 0x00000000 
H’1001 H’00 Error register Unsigned 8 bits R 0 
H’1005 H’00 COB-ID SYNC Unsigned 32 bits RW 0x00000080 

H’1008 H’00 Manufacturer device name Vis-String R 
DVP-ES3/EX
3/SV3/SX3 
Series PLC 

H’1014 H’00 COB-ID EMCY Unsigned 32 bits R 0x80 + 
Node-ID 

H’1016 
-- Consumer heartbeat time    

H’00 Number of valid subindex Unsigned 8 bits R 1 
H’01 Consumer heartbeat time Unsigned 32 bits RW 0 

H’1017 H’00 Producer heartbeat time Unsigned 16 bits RW 0 

H’1018 

-- Identity Object    
H’00 Number of valid subindex Unsigned 8 bits R 3 
H’01 Vendor-ID Unsigned 32 bits R 0x000001DD 

H’02 Product code Unsigned 32 bits R 

0x00000055 
(ES3) 

0x0000006D 
(EX3) 

0x0000006F 
(SV3) 

0x0000006E 
(SX3) 

H’03 Revision number Unsigned 32 bits R 0x00010002 

H’1400 

-- RxPDO1 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO1 Unsigned 32 bits RW 0x00000200+
Node-ID 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1401 

-- RxPDO2 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 3 
H’01 COB-ID of RxPDO2 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1402 

-- RxPDO3 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 3 
H’01 COB-ID of RxPDO3 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
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Index Subindex Object name Data type Attr. Default 
value 

H’1402 H’03 Inhibit time Unsigned 16 bits RW 0 

H’1403 

-- RxPDO4 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 3 
H’01 COB-ID of RxPDO4 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1404 

-- RxPDO5 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 3 
H’01 COB-ID of RxPDO5 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1405 

-- RxPDO6 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 3 
H’01 COB-ID of RxPDO6 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1406 

-- RxPDO7 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 3 
H’01 COB-ID of RxPDO7 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1407 

-- RxPDO8 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 3 
H’01 COB-ID of RxPDO8 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1600 -- RxPDO1 mapping parameter    

H’1600 

H’00 Number of valid subindex Unsigned 8 bits RW 4 
H’01 The first mapped object Unsigned 32 bits RW 0x20000110 
H’01 The second mapped object Unsigned 32 bits RW 0x20000210 
H’02 The third mapped object Unsigned 32 bits RW 0x20000310 
H’03 The fourth mapped object Unsigned 32 bits RW 0x20000410 

H’1601 

-- RxPDO2 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1602 
-- RxPDO3 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
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Index Subindex Object name Data type Attr. Default 
value 

H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1603 

-- RxPDO4 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1604 
-- RxPDO5 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’1604 

H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1605 

-- RxPDO6 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1606 

-- RxPDO7 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1607 

-- RxPDO8 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 
H’02 The third mapped object Unsigned 32 bits RW 0 
H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1800 

-- TxPDO1 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO1 Unsigned 32 bits RW 0x00000180+
Node-ID 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 

H’1800 H’05 Timer Unsigned 16 bits RW 100 

H’1801 -- TxPDO2 communication 
parameter    
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Index Subindex Object name Data type Attr. Default 
value 

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO2 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1802 

-- TxPDO3 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO3 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1803 

-- TxPDO4 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO4 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1804 

-- TxPDO5 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO5 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1805 

-- TxPDO6 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO6 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 

H’1805 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1806 

-- TxPDO7 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO7 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1807 

-- TxPDO8 communication 
parameter    

H’00 Number of valid subindex Unsigned 8 bits R 5 
H’01 COB-ID of TxPDO8 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
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Index Subindex Object name Data type Attr. Default 
value 

H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1A00 

-- TxPDO1 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 4 
H’01 The first mapped object Unsigned 32 bits RW 0x20010110 
H’02 The second mapped object Unsigned 32 bits RW 0x20010210 
H’03 The third mapped object Unsigned 32 bits RW 0x20010310 
H’04 The fourth mapped object Unsigned 32 bits RW 0x20010410 

H’1A01 

-- TxPDO2 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A02 

-- TxPDO3 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 

H’1A02 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A03 

-- TxPDO4 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 

H’1A04 

-- TxPDO5 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A05 

-- TxPDO6 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A06 

-- TxPDO7 mapping parameter    
H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A07 -- TxPDO8 mapping parameter    
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Index Subindex Object name Data type Attr. Default 
value 

H’1A07 

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 
H’03 The third mapped object Unsigned 32 bits RW 0 
H’04 The fourth mapped object Unsigned 32 bits RW 0 
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11.1 Introduction 
DVP32ES300TEC is equipped with EtherCAT communication port. But before using EtherCAT communication, complete 
the initialization of EtherCAT communication with API2820 INITEC instruction.  

 

11.2 EtherCAT Port 
 Specification 

Item Specification 

Web 

Max. connection number 8 

Function 

 View device information 

 Account management 

 Firmware update 

EtherCAT 

Supported number of 
axes 

 16 

Mainly support Delta servo and inverter as EtherCAT slaves. 
(refer to API2820 INITEC instruction from programming 
manual for more information on the suppored models and the 
3rd party drivers). 

Baudrate  100Mbps 

Communication 
distance 

 The distance between two adjacent EtherCAT nodes should 
not not exceed 50 meters. 

Topology  Daisy chain 

Communication cycle  1000us 
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11.3 Wiring 

 
 
11.4 IP Settings 
 Before the execution of API2820 INITEC instruction, the EtherCAT port can be seen as Ethernet port. Go to the 

EtherCAT setting web page to see the basic information and perform firmware updates.  

 For configuration on DVP32ES300TEC, o to DIADesigner → Controller (DVP-ES3-(TEC)) → Hardware 
Configuration → Paremeter Setting → EtherCAT Port Setting → Ethernet Basic Setting. 

 

 
 

Note: You can use IP Manager Tool, but do not use it to set up the IP address to avoid conflicts with the PLC CPU 
project. 
 
 
11.5 SM/SR  
Refer to API 2803 DRVIC instruction from programming manual for more information on SM/SR. 
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11.6 EtherCAT Master 
1. DVP32ES300TEC CPU can connect to 16-axis Delta servo (ASDA-A2-E, ASDA-A3-E and ASDA-B3-E) and Delta 

inveter (C2000 and CH2000 Series). 

2. After establishing the physical wiring between the EtherCAT communication port and the EtherCAT slave, complete 
the initialization of EtherCAT communication with API2820 INITEC instruction before using EtherCAT communication.  

3. The following EtherCAT instructions are supported. Refere to Section 6.27 Delta CANopen Communication 
Instructions in ES3/EX3/SV3/SX3 Series Programming Manual for more details. 

API 
Instruction code Pulse 

instruction Function 
EtherCAT 

16-bit 32-bit Servo Inverter 
2801 ASDON – – Servo-ON and Servo-OFF V V 

2802 CASD – – Setting the acceleration time and deceleration time 
for a servo 

V V 

2803 – DDRVIC – Servo relative position control V – 

2804 – DDRVA
C – Servo absolute position control V – 

2805 – DPLSVC – Servo speed control V V 

2806 ZRNC DZRNC – Servo homing  V – 

2809 RSTD – – Sending Reset or NMT command V V 

2810 ZRNM – – Setting the homing mode for Delta servo V – 

2811 EMER – – Reading Emergency message  V V 

2812 – DCSFOC – Controlling the tracking function of a servo via 
communication 

V – 

2817 – DTQC – Torque control V – 

2818 – DTQLC – Speed of torque control V – 

2820 INITEC – – Initializing the slaves for EtherCAT 
communication V V 

2821 ECATR
W  – Reading and writing EtherCAT SDO data V V 

2822 MOTST – – Reading Motion state of an EtherCAT slave V V 

2823 ECATST – – Reading the state of an EtherCAT slave V V 
 

4. After the EtherCAT communication initialization is completed, if the PLC switches from RUN to STOP, the EtherCAT 
master function will be turned off. At this time, the EtherCAT communication port can be used as a MODBUS TCP 
slave or used for web page functionality. 
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11.7 Webpage 
After the IP configuration is complete, connect a network cable to the EtherCAT port and then you can enter the IP 
address in the search bar of your browser to connect to DVP32ES300TEC to view basic information and update 
firmware. The supported browsers are listed below.  

Supported browser Version 

Microsoft Internet Explorer V10.0 or later 

Microsoft Edge V20 or later 

Google Chrome V14 or later 

Apple Safari V5.1 or later 

 
1. Setting up the IP address in DIADesigner and then connecting a network cable to the EtherCAT port, after that you 

can enter the IP address in the search bar of your browser to connect to DVP32ES300TEC. Type the default value 
“Admin” in the field of User and no password is required to log in. After logging in, you can see the device 
information as shown in the image below.   

 
 
2. After logging in, you can go to the setting pages of each item on the left section of the screen.  
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 Information -> Device information: You can find basic product information in this section. This section is not 
password-protected; you can open this page without logging in.  

 Network configuration -> Account management: You can block unauthorized remote access to protect data 
and product security by setting up the username and password in this section. After configuration is 
complete, click “Apply” and “Save configuration”.  

 
  

 Network configuration -> Firmware update: Upload the firmware file through the webpage to update 
firmware of the EtherCAT port (function card).  
Note: It is recommended to set access permissions on the account management page to avoid 
unauthorized remote firmware updates. 

 
 

 Save config -> Save configuration: After any setting is done, you need to go to this page to save the 
configurations for the changes to take effect.  

 
 

 

11.8 Network Security 
To enhance security and performance of the system, it is suggested to use closed network or LAN with firewall protection 
to prevent cyber-attacks. 
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12.1 CPU Module Operations  

12.1.1 Procedure 

The following diagram describes the operation of the CPU module. 

 

The CPU module is supplied with power. 

The system enables the initialization.  
 The non-latched memory is initialized. 
 The downloaded program is checked. 
 The parameters in the CPU module are checked. 

Diagnosis processing: 
 The memory card and other setting are checked. 
 The I/O bus is checked. 
 The system parameter is checked. 

The data sent to the I/O module is refreshed. 
 The data sent to the digital I/O module is refreshed. 
 The data sent to the analog I/O module is refreshed. 
 The data sent to other modules are refreshed. 

Program execution:  
 The user program is executed, including POU & FB.  
 The interrupt subroutine is executed. 

The data sent from the I/O module is refreshed. 
 The data sent from the digital I/O module is 

refreshed. 
 The data sent from the analog I/O module is 

refreshed. 
 The data sent from other modules are refreshed. 

Communication service: 
 The communication through the CPU module 
 The internal communication between the CPU 

module and the I/O module 
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12.1.2 I/O Refreshing and Communication Service 

 Refreshing I/O  

The CPU module reads external I/O data periodically or outputs data to an external I/O. Refreshing the 

I/O includes the following.  

 Refreshing data in a digital I/O module 

 Refreshing data in analog I/O, temperature measurement and positioning modules 

All I/O refreshing executes in the same loop. The data in an input device refreshes before a program 

executes, and the data in an output device refreshes after the program executes. 

Unit Maximum data exchange Data exchange area 

Digital I/O module 
Depends on the number of input/output 

channels in the unit. 
Input relay/Output relay 

Analog I/O module 
Depends on the number of input/output 

channels in the unit. 
Data register* 

* Refer to special extension module exchange function from section 2.2.16 of DVP-ES3/EX3/SV3/SX3 

Programming Manual for more information. 

 Communication service 

Communication service is the unscheduled communication service for a network module. It includes the 
communication requests sent from external equipment to a CPU module, and the communication 
requests sent from the CPU module to the external equipment. The communication requests may be 
received from time to time but the data or state refreshing on the devices or components will only start 
afer the END instruction is scanned and executed if the coummunicaiton is concerning the internal 
devices or components of the PLC CPU.   

 

12.1.3 Execution Timing of Interrupts  

Interrupts can be categorized into three types, periodic interrupts, timer interrupts, and condition interrupts. The 
timing to execute any interrupt is after the current executing instruction is complete and the position and state of 
the next to be executed instruction is retained. After the interrupt is executed, the execution of the next 
instruction will resume.     
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12.2 CPU Module Operating Modes  

12.2.1 Operating Modes 

There are two operating modes. They can be used to control a user program and all tasks. 

STOP mode: A program is not executed under this mode. Users can initialize CPU configuration and other 

setting, download a program, check a program, and force a bit ON/OFF. 

RUN mode: A program is executed under this mode. Users can not initialize CPU configuration and other 

setting. 

 

12.2.2 Status and Operation under Different Operating Modes 

The following table lists the status and operation states for RUN and STOP modes. 

 Basic operation 

CPU 

mode 
Program 

I/O 

refreshing 
External output 

Program memory 

Non-latched 

area 

Latched 

area 

STOP 

The execution 

of the program 

stops.  

I/O refreshing 

executes. 

OFF. If you set the I/O 

module so that the final 

state of the external output 

on the I/O module is 

retained, the final state of 

the external output on the 

I/O module is retained. 

The data in the program 

memories is retained. 

RUN 
The program  

executes. 

I/O refreshing  

executes. 

The program controls the 

external output. 

The program controls the 

program memories. 
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 Relationship between the operating modes and tasks 

Mode Loop task Interrupt task 

STOP Execution of a loop tasks stops. 
Execution of an interrupt task 

stops. 

RUN 

 The tasks that have not been executed are in the 

HALT state. 

 If a task is active, or the instruction TKON is 

executed, the task executes. 

 If a task is not active, or the instruction TKOFF 

executes, the task does not execute. 

If the condition of the interrupt is 

met, the interrupt task executes. 

 

 Relationship between changing modes and the program memory 

Change of the mode Non-latched area Latched area 

STOP→RUN 
Data is cleared or retained depending 

on your setting. 
The data is retained. 

RUN→STOP The data is retained. The data is retained. 
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13.1  Data Tracer 
13.1.1 About Data Tracer 
Data Tracer is used for the real-time collection of variable symbols, values, states in devices, after some trigger condition 
is met so as to draw curve charts for analysis of value trends. Refer to Section 23.2 in ISPSoft User Manual or Section 
14.4.1 in DIADesigner User Manual for more details.  

 

 ISPSoft  

Step 1: Compile the current project before using the function. Click Wizard> Data Tracer to open the Data Tracer window 
as shown below. 

  

 

Step 2: Click the button  of Symbol Name to open the Add Sample Source window. 

 

 

Step 3: Click the button  of Symbol Name in the Add Sample Source window and select the variable symbol name to 
be added in the Choose Symbol window or directly type a device name in the Device Name box. 
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Step 4: Set up the sample period and trigger setting. 

 

 

Step 5: After setting up the parameters, click  on the icon toolbar to have the system in the online mode. Then click 
 to download the settings to the PLC.  

 
 

Step 6: After the sample parameter settings in the data tracer are completed and downloaded, any of the following three 
modes on the icon toolbar can be used for watching curves in the online mode. 

 

 

Step 7: Click  on the icon toolbar to export the data to your computer for future use.  
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 DIADesigner 

Step 1: Go to Controller -> Commission and double-click Data Tracer in the Project Explorer.   

 
 
 

Step 2: Type the variable or register that you’d like to sample as the image shown below. 
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Step 3: Set up the conditions of triggering and comparing.  

 
 

Step 4: Use the export button as indicated in a red box to export data and save data in the computer.   
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13.1.2 ISPSoft Demostration Example 
If X0 is a signal to open/close externally. Use Data Trace to measure the width of time when X0 is ON.  

 Steps:  

 Open Data Tracer and enter X0 for monitoring.  

 Set the Customized Time to 100 ms to take samping, set the trigger device to X0, set the trigger position to 10, 
and then set the compare condition to ON as the image shown below.  

 
 Set the mode to One-shot trigger and wait for the trigger (ON). Once it is triggered, it displays the recorded curve 
data.  

 The value in I∆X1 is 2500 ms, the time measured between two vertical lines, X1 and X2. for X0. 
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13.2 Data Logger 
13.2.1 About Data Logger 

Data logger is used for the long-term recording of variable symbols, values, states in devices, and drawing curve charts. 
The data is stored in the PLC and the memory card of the PLC for analysis of value trends. Refer to Section 23.3 in 
ISPSoft User Manual or Section 14.4.2 in DIADesigner User Manual for more details. 

 
Operation A 
 ISPSoft  

Step 1: Compile the current project before using the function. Click Wizard> Data Logger to open the Data Logger window 
as shown below.  

 
 

Step 2: Click the button  of Symbol Name to open the Add Sample Source window. 

 
 

Step 3: Click the button  of Symbol Name in the Add Sample Source window and select the variable symbol name to 
be added in the Choose Symbol window or directly type a device name in the Device Name box. 
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Step 4: After setting up the parameters, click  on the icon toolbar to have the system in the online mode. Then click 

 to download the settings to the PLC. And then click  to record data. 
 
Note: From here you can also follow Operation B to complete the recording and saving.   

 
 
 

Step 5: When the recording is done, click the uploade button to update the data for later viewing.   

 
 

Step 6: Click  on the icon toolbar to export the data to your computer for future use.  

 
 

Step 7: Click  on the icon toolbar or use SM and SR to save the data to the SD Card installed on the PLC.   
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Operation A 
 DIADesigner  

Step 1: Go to Controller -> Commission and double-click Data Logger in the Project Explorer.   

 
 

Step 2: Type the variable or register that you’d like to monitor as the image shown below. 
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Step 3: Set up the sampling number, sampling method and what to do after sampling points reached.   

 
Step 4: To have the system in the online mode and then download the settings to the PLC. After that click Start icon as 
indicated in the red box below to start data logger.  
Note: If a long-term recording and saving application is required by a PLC program, refer to Operation B below. 

 
 

Step 5: Use the export button as indicated in a red box to export data and save data in the computer.   

 
 

You can also use the save to a SD Card button as indicated in a red box to save data in the SD Card.   
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Operation B 
You can also use SM flags or SR registors to complete the data recording, data saving or set to store data on a SD card 
permanently. See the example below for reference.  
Example:  

 
 Check if the flag SM457 is ON. If the flag SM457 is ON, it indicates the valid recorded parameters are downloaded in 

data logger. And that means the operation A is done correctly.  

 Use inputs to enable/disable or set the flag SM454 to ON for the PLC to start recording. If you need to store data on 
a SD card, set SR902=16#5AA5. 

 When SM455 is ON or when the quantity of data has met the value set in SR900 (32-bit value), the system start 
saving data on a SD card.  
NOTE: While sending data to the SD card for storage, the PLC needs a period of undisturbing time, approximately 
tens of milliseconds. During this period, the PLC is not allowed to execute interrupts. Make sure the PLC is NOT 
executing any interrupts, especially the external input ones before starting to send data to the SD card for storage.  

 When SM455 is switching from OFF to ON, set SM456 ON. And the PLC starts to store the recorded data on the SD 
card. The default path and the file name are as shown below:  

 Default saving path:  

ES3: \SDCard\PLC CARD\ES3\Log 

EX3: \SDCard\PLC CARD\EX3\Log 

SV3: \SDCard\PLC CARD\SV3\Log 

SX3: \SDCard\PLC CARD\SX3\Log 

 Default file name 
DATA_LOGGER_yyyymmdd_hhmmss.log 
EX: DATA_LOGGER_20231108_161901.log 
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13.2.2 Related SM Flags and SR Registors 

SM / SR Attr. Description  

SM450 R 

Check here to see if a SD Card is installed in the PLC.  

ON: SD card inside  

OFF: No SD card 

SM452 R 

Check here to see if data is being stored on the SD card. 

ON: In the operation of storing 

OFF: Not in the operation of storing 

SM453 R 

Check here to see if there is any SD card operational error.  

ON: Abnormal 

OFF: Normal  

SR453 R 
Check here to see the last operational error code of the SD card. 

Note: Only available when SM453=ON 

SM454 R/W 
Set this flag to ON/OFF to start or stop recording. The system will not set this flag to OFF 
automatically even if the space for recording is full. You need to set the flag to OFF manually. 

SM455 R 
Check here to see if the recorded number has reached the set limit.  

ON: The quantity of recordings has reached the set number or the SD card is in cycle recording.   

SM456 R/W 

Used with SR902 to activate the settings in SR902 for the SD card. 

Note: Set the flag from OFF to ON and the PLC starts to store the recorded data on the SD card 
when SR902=16#5AA5. 

SM457 R 
Check here to see if there is any valid, downloaded, recorded parameters in the data logger.  

ON: The valid recorded parameters are downloaded in data logger. 

SR900 R 
Check here to see the quantity of the recorded data (32-bit value). 
Note: It increments the number of the recorded data by 1 for each record.  

SR902 R/W 

Control codes for recorded data. 

 16#5AA5: Store data to a default root and specified file name on the SD card. 

 0: The storing is done.  

 Others: Invalid numbers 

Note: Used with SM456 to activate this setting.  

Note: “R” in the column of attribute (Attr.) indicates the item is read only and the status can be read here. 

“W” in the column of attribute (Attr.) indicates you can set, delete or write a value for this item.   
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14.1  Troubleshooting 
14.1.1 Basic troubleshooting steps 

This chapter includes the possible errors the can occur during operation, their causes, and corrective actions.  

(1) Check the following: 

 The PLC should be operated in a safe environment (consider environmental, electronic, and vibration safeties). 

 Connect power supply correctly to the PLC. 

 Secure the module, terminal, and cable installations.  

12 14 
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 All LED indicators show correctly. 

 Set all switches correctly. 

(2) Check the following operational functions: 

 Switch the RUN/STOP state 

 Check the settings for the DVP-ES3 Series to RUN/STOP 

 Check and eliminate errors from external devices  

 Use the System Log function in ISPSoft to check system operation and logs 

(3) Identify possible causes: 

 DVP-ES3/EX3/SV3/SX3 Series or external device 

 CPU or extension modules 

 Parameters or program settings 

 

14.1.2 Clear the Error States  
Use the following methods to clear the error states. If the error source is not corrected, the system continues to show 
errors.   

(1) Switch the CPU model state to STOP and then to RUN. 

(2) Turn off the CPU and turn it on again.  

(3) Use ISPSoft to clear the error logs.  

(4) Reset the CPU to the default settings and download the program again.  
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An error 
occurred

Basic 
troubleshooting 

steps 
done

CPU module erro r 
o r modules erro r

ERROR LED ON

ERROR LED blinking 
normally 

(every 0.5 sec.)

E RROR LED blinking
s lowly (eve ry 1 sec., 

s top for 3 sec.)

Other LED blinking

Refer to section 14 1 1 for. .   
Bas ic troubleshooting steps  

Yes

No

Refer to DV P S eries Module Manual

Yes

No

No

Yes

No

Yes

Yes

No

Yes

Yes

No

CPU module
error

Module
error

ERROR LED blink ing 
fast

(every 0.2 sec.)

Af ter going through 
t roubleshoot ing steps,
the issues are sti ll not 

resolved. 

No

The system runs normally.

1. Refer to section 14.1.4 for the sys tem l og
2. Refer to section 14.3 for error codes and 
    LE D indicators for CP U modules
3. Refer to section 14.2 for troubleshooting for 
    CPU modules

1. Refer to section 14.1.4 for the sys tem l og
2. Refer to section 14.3 for error codes and 
    LE D indicators for CP U modules
3. Refer to section 14.2 for troubleshooting for 
    CPU modules

1. Refer to section 14.1.4 for the sys tem l og
2. Refer to section 14.3 for error codes and 
    LE D indicators for CP U modules
3. Refer to section 14.2 for troubleshooting for 

CPU modules

1. Refer to section 14.1.4 for the sys tem l og
2. Refer to section 14.3 for error codes and 
    LE D indicators for CP U modules
3. Refer to section 14.2 for troubleshooting for 
    CPU modules

1. Refer to section 14.1.4 for the sys tem l og
2. Refer to section 14.3 for error codes and 
    LE D indicators for CP U modules
3. Refer to section 14.2 for troubleshooting for 
    CPU modules

If the p roblem persists, p lease contact 
support.

14.1.3 Troubleshooting SOP 
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14.1.4 Viewing System Log and Error Step 
If ISPSoft is connected to a DVP-ES3 Series, you can view actions and errors in the DVP-ES3 Series by clicking System 
Log on the PLC menu. The CPU can store up to 20 error log sets. After the 20 sets are stored, the 1st log is replaced with 
the 21st if there are new logs coming in, and the old logs are replaced with the new ones sequentially. When the memory 
card is installed in the CPU module, 20 sets of the old logs are backed up in the memory card and up to 1000 logs can be 
recorded. If the stored logs exceed 1000, the oldest 20 logs are replaced with the newest 20 logs in the memory card.  

 ISPSoft 
(1) On the PLC menu, click System Log. 

 
(2) The System Log window appears. Click Clear Log to clear the error log in the window and the error log in the CPU 

module, and reset the CPU module. 

 
 Group No.: The number 1 indicates that the error occurred in the CPU module or the right-side module 1.   

 Module No.: The number 0 indicates that the error occurred in the CPU module or the remote module. T   

 PLC/Module name: Model names of the CPU, remote, and extension modules.  

 Error Code: Error codes in the error log. 

 Date & Time: The date and time the error occurred. The most recently occurring error is listed on the top.  

 The last column shows the descriptions for the error.  
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(3) If the error occured is an exceeding device ragne error (SM0 = ON), stored in SR0 or a program syntax error (SM5 = 
ON), stored in SR4 you can use the following steps to see the problematic step in the program.   

 SM0 = ON: Check the value (32-bit) in SR1 to see the latest exceeding device range error in the program.   

 SM5 = ON: Check the value (32-bit) in SR5 to see the latest syntax error step in the program.  

 After knowing which the problematic step is, go to ISPSoft -> Edit -> Step positioning and then enter the number of 
the problematic step, the system will take you to the specified step in the program. 

 

   
 

 DIADesigner 
(1) Double-click Device & Error Information under Controller in the project tree. 
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(2) The Device & Error Information window appears. Click  to refresh the log and click  to clear the error 
log in the window and the error log in the CPU module. 

 
 Group No.: The number 1 indicates that the error occurred in the CPU module or the right-side module 1.   

 Module No.: The number 0 indicates that the error occurred in the CPU module or the remote module. T   

 Module name: Model names of the CPU, remote, and extension modules.  

 Error Code: Error codes in the error log. 

 Date & Time: The date and time the error occurred. The most recently occurring error is listed on the top.  

 Name: Here shows the descriptions for the error.  
 Troubleshooting: Here shows methods for resolving errors. 

 
(3) If the error occured is an exceeding device ragne error (SM0 = ON), stored in SR0 or a program syntax error (SM5 = 

ON), stored in SR4 you can use the following steps to see the problematic step in the program.   

 SM0 = ON: Check the value (32-bit) in SR1 to see the latest exceeding device range error in the program.   

 SM5 = ON: Check the value (32-bit) in SR5 to see the latest syntax error step in the program.  

 After knowing which the problematic step is, go to DIADesigner -> Controller -> Auxiliary -> Step Position and then 
enter the number of the problematic step, the system will take you to the specified step in the program. 
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14.2  Troubleshooting for CPU Modules 
Check the LED indicators and the error codes from the CPU module and refer to the following table for troubleshooting. V 
in the Log column indicates the error is recorded in the log. X in the Log column indicates the error is not recorded in the 
log. H in the Log column indicates whether or not you can set recording the error in the log in HWCONFIG. Note: You can 
also find error log stored in SR, refer to Chapter 2 in the DVP-ES3/EX3/SV3/SX3 Series Programming Manual for more 
information.  

 

14.2.1 ERROR LED Indicators Are ON 
Error 
Code 
(16#) 

Description Solution  Flag Log 

000A Scan timeout 
1. Check the setting of the watchdog timer in HWCONFIG. 
2. Check whether the program causes a long scan time 

SM8 V 

 

14.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds 

Error 
Code 
(16#) 

Description Solution Flag Log 

000C The program in the PLC is 
damaged. Download the program again. SM9 V 

000D 
Device initial values and PLC 
program are not downloaded 
completely.  

Download the program again. SM9 V 

0010 CPU memory is denied. Contact the factory. SM9 V 

0020 CPU execution speed does not 
reach its maximum speed. Contact the factory. SM9 V 

002E CPU external memory access is 
denied. Contact the factory. SM9 V 

002F PLC programs are not consistent 
with the system logs. Download the program again. SM34 V 

0102 The interrupt number exceeds the 
range. 

Check the program, compile the program again, and 
download the program again. SM5 X 

0202 The MC instruction exceeds the 
range.  

Check the program, compile the program again, and 
download the program again. SM5 X 

0302 The MCR instruction exceeds the 
range.  

Check the program, compile the program again, and 
download the program again. SM5 X 

0D03 The operands used in DHSCS are 
not used properly. 

Check the program, compile the program again, and 
download the program again. SM5 X 

0E05 The operands HCXXX used in 
DCNT are not used properly. 

Check the program, compile the program again, and 
download the program again. SM5 X 

1000 
l 

10FF 
System error Contact the factory. - V 

140F Number of input and output points 
set in the DIO module exceeds the 

Check if the total number of inputs and outputs exceeds 
the limit (ES3/EX3: 240 points; SV3/SX3: 480 points). SM10 V 
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Error 
Code 
(16#) 

Description Solution Flag Log 

range. 

1410 
l 

1413 

The right-side module cannot be 
detected.  Check if the right-side module is correctly connected.  SM10 V 

1414 
The number of modules powered is 
inconsistent with the the number 
checked.  

When powered on, check if the automatic comparison 
function is enabled or disabled (SM227), and check the 
number of expansion points and the number of units set 
in SR1553 to SR1555. 

SM10 V 

1420 
Initialization error on the left-side 
module (number of left-side module 
exceeds 8 units.) 

Check the number of modules. SM10 V 

1421 
l 

1424 

The communication of the left-side 
module times out or the model name 
is incorrect. 

Check if the module is correctly connected or if the 
module is the same as connected.  SM10 V 

1425 Memory detection error on the 
left-side module. Check if the module is correctly connected. SM10 V 

200A Invalid instruction Check the program, compile the program again, and 
download the program again. SM5 V 

6010 The number of MODBUS TCP 
connections exceeds the range.  Check the number of superior devices (maximum is 32). SM 

1092 V 

6011 The number of EtherNet/IP 
connections exceeds the range. Check the number of connections (maximum is 16).  SM 

1093 V 

C000 
- 

CFFF 
The program syntax is incorrect. Save the PLC program and hand the file to the company 

or the technicians. - V 
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14.2.3 ERROR LED Indicators Blinking Rapidly Every 0.2 Seconds 
This happens when the power supply 24 VDC of the CPU module is disconnected, or the power supply is not sufficient, 
not stable or abnormal.  

Error 
Code 
(16#) 

Description Solution Flag Log 

002A The external voltage is abnormal. Check whether the external 24 V power supply to the 
module is normal. SM7 V 

 

14.2.4 ERROR LED Indicators Slow Blinking Every 3 Seconds and 
Lighting up for 1 Second 

Error 
Code 
(16#) 

Description Solution Flag Log 

0040 
The converted value of the built-in 
AD input channel 1 exceeds the 
range. 

Check the actual input signal. SM27 H 

0041 
The converted value of the built-in 
AD input channel 2 exceeds the 
range. 

Check the actual input signal. SM27 H 

0042 
The converted value of the built-in 
AD input channel 3 exceeds the 
range. 

Check the actual input signal. SM27 H 

0043 
The converted value of the built-in 
AD input channel 4 exceeds the 
range. 

Check the actual input signal. SM27 H 

0044 
Current input 4~20mA mode in the 
built-in AD input channel 1 is 
disconnected. 

Check the wiring. SM27 H 

0045 
Current input 4~20mA mode in the 
built-in AD input channel 2 is 
disconnected. 

Check the wiring. SM27 H 

0046 
Current input 4~20mA mode in the 
built-in AD input channel 3 is 
disconnected. 

Check the wiring. SM27 H 

0047 
Current input 4~20mA mode in the 
built-in AD input channel 4 is 
disconnected. 

Check the wiring. SM27 H 

1900 
- 

191C 

Heartbeat errors occurred in the 
slave under CANopen/ECAT mode  

1. Check the CANopen connection cable.  
2. Check if the specific slave is working properly.  
Note: The last 2 digits of the error code represent the ID 

number of the slave (convert hexadecimal to decimal). 

- V 
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14.2.5 The LED RUN and ERROR Indicators are Blinking Simultaneously 
Every 0.5 Seconds 

This happens when the firmware of the CPU module is being upgraded. If this happens once the power is supplied to the 
CPU module, it means errors occurred during the previous firmware upgrade. Users need to upgrade the firmware again 
or contact your point of purchase.     

 

14.2.6 The RUN and LED Indicators are Blinking One After Another Every 
0.5 Seconds.  

This happens when the CPU module memory card is backing up, restoring, or saving.  
 

14.2.7 Other Errors (Without LED Indicators) 
Error 
Code 
(16#) 

Description Solution Flag Log 

0011 The PLC ID is incorrect. Check the PLC ID. SM34 V 
0012 The PLC password is incorrect.  Check the PLC password. SM34 V 

002D The PLC maximum password attempts 
exceeded.  

Reset the CPU module or restore the CPU module 
to its factory settings. SM34 V 

0050 The memories in the latched special 
auxiliary relays are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

0051 The latched special data registers are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

0052 The memories in the latched auxiliary 
relays are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

0054 The latched counters are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, please contact the factory. 

SM6 V 

0055 The latched 32-bit counters are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

0056 The latched special auxiliary relay is 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6  V 

0059 The latched data registers are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

005D The CPU module does not detect a Check that the memory card is inserted correctly SM453 V 
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memory card. into the CPU module. 

005E The memory card is initialized 
incorrectly. Check whether the memory card is broken.  SM453 V 

0063 An error occurs when data is written to 
the memory card. 

Check whether the file path is correct or whether 
the memory card is malfunctioning. SM453 V 

0064 A file in the memory card cannot be 
read.  

Check whether the file path is correct, or whether 
the file is damaged. SM453 V 

1950 

The initialization of the Delta ASD-A2 
control has not yet been completed, the 
CANopen instructions cannot be 
executed. 

1. Check the CANopen connection cable.  
2. Check if the specific slave is working properly.  
3. If nothing is wrong, initialize the Delta ASD-A2 

again. 

- V 

19B0 Heartbeat timeout occurred in the slave 
mode Check the CANopen connection cable.  - V 

19B1 
The data length of PDO (process data 
object) in the slave mode is not matched 
with the setting.  

Revise the PDO data length setting in the slave 
mode and download the setting again.  

- V 

19E1 

The data length of PDO (process data 
object) in the slave mode is not matched 
with the setting of the scan list.  
Refer to CANopen communication 
related descriptions in AS Series 
Operation Manual for more details on 
the error codes 19E1 to 19E8.  

Revise the PDO data length setting in the slave 
mode and download the setting again.  

- V 

19E2 PDO in the slave mode is not received.  Check if the configurations are correctly set.  - V 

19E3 The function of auto downloading SDO 
fails at the first startup.  

Check if the SDO contents for auto downloading  
are correct.  

- V 

19E4 PDO configurations are set incorrectly.  Make sure to set the PDO configurations correctly. - V 

19E5 
The main settings are not consistent 
with the connected slave. 

Make sure the connected slaves are the ones 
configured in ISPSoft.  - V 

19E6 This slave does NOT exist in this 
network.  

Make sure the power supply of slave is normal and 
slave is correctly connected to the network.  

- V 

19E7 Timeout on the slave error control Make sure the power supply of slave is normal and 
slave is correctly connected to the network. 

- V 

19E8 The node IDs of master and slave are 
duplicated.  

Set the node ID of the master and slave again and 
make sure their node IDs are unique. - V 

19F3 Error in the configuration  
1. Download the parameter configuration again.  
2. If the problem persists, contact the local 

authorized distributors. 
- V 

19F4 CANopen communication is in the 
BUS-OFF state. 

1. Check if the network cable is normal and the 
shielded cable is grounded.  

2. Check if the start and end of the network cable 
are both connected with a 121Ω terminal 
resistor. 

3. Check if all the node devices run at the same 
baud rate on the network.  

- V 

19FB The sending registers exceed the range.  Revise the time to synchronize (suggested to use a 
longer time). 

- V 

19FC The receiving registers exceed the 
range.  

Revise the time to synchronize (suggested to use a 
longer time). 

- V 

2001 
Not in the right mode for the ASDA-A2 
while using the CANopen 
communication instruction. 

1. Use the FCOMP card in the function card slot to 
check if the operation mode is correct.  

2. Check the syntax error step in the program. 
SM0 V 
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Modify and compile the program and then 
download the program again. 

2003 The device used in the program 
exceeds the device range. 

Check the syntax error step in the program. Modify 
and compile the program and then download the 
program again. 

SM0 V 

200B The operand n or the other constant 
operands K/H exceed the range. SM0 V 

200C The operands overlap. SM0 V 

200D The binary to binary-coded decimal 
conversion is incorrect. SM0 V 

200E The string does not end with 00.  SM0 V 
2012 Incorrect division operation SM0 V 

2013 
The value exceeds the range of values 
that can be represented by the 
floating-point numbers. 

SM0 V 

2014 
The task designated by the TKON or 
YKOFF instruction is incorrect or 
exceeds the range. 

SM0 V 

2017 The instruction BREAK is written outside 
of the FOR-NEXT loop. SM0 V 

2027 No such position planning table number 
or the format is incorrect.  

1. Check the program, compile the program again, 
and download the program again. 

2. Check the settings of the position planning table. 
SM0 V 

2028 
High speed output instruction is being 
executed. Only one instruction can be 
executed at a time.  

Refer to SR28 for the record of the axis number and 
rearrange the output control procedures. - V 

6004 The IP address filter is set incorrectly. Set the Ethernet parameter for the CPU module in 
HWCONFIG again. SM1108 X 

600D RJ45 port is not connected.  Check the connection. SM1100 X 

6012 There are devices using the same IP 
address.  

1. Check if there are devices using the same IP 
address.  

2. Check if there is more than 1 DHCP or BOOTP 
server on the network.  

SM1101 V 

6100 The email connection is busy. 
Retry the email connection later. This error does not 
cause the PLC to stop running. Solve the problem 
by means of the related flag in the program. 

SM1113 X 

6103 The trigger attachment mode in the 
email is set incorrectly.  

Set up the trigger attachment mode in HWCONFIG 
> CPU Module > Device Setting > Options > 
Ethernet Port Advanced > Email > Trigger Setting > 
Trigger Attachment Mode.  

SM1113 X 

6104 The attachment in the email does not 
exist. 

Check whether the attachment exists in the 
memory card. SM1113 X 

6105 The attachment in the email is 
oversized. 

Check the size of the attachment. If the size is over 
2 MB, the file cannot be sent as an attachment. SM1113 X 

6106 There is an SMTP server response 
timeout. 

Check for the correct address and set up the SMTP 
server in HWCONFIG > CPU Module > Device 
Setting > Options > Ethernet Port Advanced > 
Email again. 

SM1113 X 

6107 There is an SMTP server response 
timeout. 

1. Check whether the status of the SMTP server is 
normal. 

2. Retry sending of the email later. This error does 
not cause the PLC to stop running. Solve the 

SM1113 X 
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problem by means of the related flag in the 
program. 

6108 SMTP verification failed  
Check for the correct ID/Password and set up in 
HWCONFIG > CPU Module > Device Setting > 
Options > Ethernet Port Advanced > Email again. 

SM1113 X 

6200 The remote communication IP address 
set in the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6201 The local communication port set in the 
TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6202 The remote communication port set in 
the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6203 The device from which the data is sent 
in the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6206 The device which receives the data in 
the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6208 The data received through the TCP 
socket exceeds the device range. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6209 The remote communication IP address 
set in the UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

620A The local communication port set in the 
UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 
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620C The device from which the data is sent 
in the UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

620F The device which receives the data in 
the UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6210 The data received through the UDP 
socket exceeds the device range. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6212 There is no response from the remote 
device after the timeout period. Make sure that the remote device is connected. - X 

6213 The data received exceeds the limit. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6214 The remote device refuses the 
connection. Make sure the remote device operates normally. - X 

6215 The socket is not opened. Check whether operational sequence in the 
program is correct. - X 

6217 The socket is opened. Check whether operational sequence in the 
program is correct. - X 

6218 The data has been sent through the 
socket. 

Check whether operational sequence in the 
program is correct. - X 

6219 The data has been received through the 
socket. 

Check whether operational sequence in the 
program is correct. - X 

621A The socket is closed. Check whether operational sequence in the 
program is correct. - X 

7011 The device communication function 
code in COM1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7012 The device communication address 
used in COM1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7013 The device used in COM1 exceeds the 
device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7014 The device length of the communication 
data in COM1 exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7017 The device checksum for the 
communication serial port of COM1 is 

1. Check the communication setting in the master 
and the slave. - H 
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incorrect. 2. Check the communication cable. 

7021 The device communication function 
code in COM2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7022 The device communication address 
used in COM2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7023 The device used in COM2 exceeds the 
device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7024 The device length of the communication 
data in COM2 exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7027 
The device checksum for the 
communication serial port of COM2 is 
incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7031 The device communication function 
code in the Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7032 The device communication address 
used in the Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7033 The device used in the Ethernet 
exceeds the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7034 The device length of the communication 
data in the Ethernet exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7037 
The device checksum for the 
communication serial port of the 
Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7041 The device communication function 
code in the USB is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7042 The device communication address 
used in the USB is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7043 The device used in the USB exceeds 
the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7044 The device length of the communication 
data in the USB exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7047 
The device checksum for the 
communication serial port of the USB is 
incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7203 Invalid communication function code 

1. Refer to the function codes defined by the   
communication protocols. 

2. Check if the product firmware and the software 
used are the most updated versions.  

- H 



DVP-ES3/EX3/SV3/SX3 Ser ies  Hardware and Operat ion Manual  

14-16 

_14 

3. Make a note of the operation procedures and 
screenshots of the error windows and hand this 
note to the company or the technicians from the 
agents. 

8105 
The contents of the program 
downloaded are incorrect. 
The program syntax is incorrect. 

1. Download the program and parameters again. 
2. Check the communication cable. 
3. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8106 

The contents of the program 
downloaded are incorrect. 
The length of the execution code 
exceeds the limit. 

1. Download the program and parameters again. 
2. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8107 

The contents of the program 
downloaded are incorrect. 
The length of the source code exceeds 
the limit. 

1. Download the program and parameters again. 
2. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8000 
- 

8FFF 

Errors occur between software and 
PLC. 

1. Check if the product firmware and the software 
used are the most updated versions.  

2. Make a note of the operation procedures and  
  screenshots of the error windows and hand this  
  note to the company or the technicians from the  
  agents. 
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14.3  Troubleshooting for Other Modules 
The error codes and troubleshootings for the modules can be found in the DVP Series Module Manual.  

 

14.4 LED Indicators and Error Codes for CPU Modules 
The error codes and LED indicators are presented in the following tables.   

 Descriptions used in the table 

a. Error code: If an error occurs in the system, an error code is generated. 

b. Description: The description of the error 

c. CPU status: If the error occurs, the CPU stops running, keeps running, or shows the status you defined for the 
error. 

 Stop: The CPU stops running when the error occurs. 

 Continue: The CPU keeps running when the error occurs. 

d. LED indicator status: If the error occurs, the LED indicator is ON, OFF, or blinks. 

 ERROR: System error 

 

 LED Indicator Description Table  

There are five types of error indicator states for of the CPU module errors, including LED indicator ON, OFF, blinking 
fast, blinking normally, and blinking slowly. When the LED indicator is ON, blinking fast/normally, clear the problems 
first in order to run the CPU module. When the LED indicator is blinking slowly, indicating a warning type of error 
codes, it does not require immediate action. Clear the problems when the module is powered off. 

Module Type LED Indicator Descriptions 

CPU 

Error Type 
ON: A serious error occurs in the module. 
Blinking fast (every 0.2 seconds): unstable power supply or hardware Failure. 
Blinking normally (every 0.5 second): system program errors or system cannot run. 

Warning Type 

Blinking slowly (every one second and off for three seconds): a warning is 
triggered, but the system can still run.  
OFF: a warning is triggered, but the system can still run. You can modify the rules of 
how a warning is triggered, or use the SM/SR to show the warnings. 

 

 Error Code Description Table  

Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

000A Scan timeout Stop V     

000C The program in the PLC is damaged. Stop   V   
0010 The access to the memory in the CPU is denied. Stop   V   
0011 The PLC ID is incorrect.  Continue     V 
0012 The PLC password is incorrect. Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

0026 RTC cannot keep track of the current time  Continue     V 

002A 24VDC power supply is not sufficient and then is 
recovered from low-voltage for less than 10 ms. Continue  V    

002D The PLC maximum password attempts exceeded. Continue     V 

002E The access to the external memory of the CPU is 
denied. Stop   V   

002F PLC programs are not consistent with the system 
logs. Stop   V   

0050 The memories in the latched special auxiliary relays 
are abnormal. Continue     V 

0051 The latched special data registers are abnormal. Continue     V 

0052 The memories in the latched auxiliary relays are 
abnormal. Continue     V 

0054 The latched counters are abnormal. Continue     V 
0055 The latched 32-bit counters are abnormal. Continue     V 
0056 The latched special auxiliary relay is abnormal. Continue     V 
0059 The latched data registers are abnormal. Continue     V 
005D The CPU module does not detect a memory card. Continue     V 
005E The memory card is initialized incorrectly. Continue     V 

0063 An error occurs when data is written to the memory 
card. Continue     V 

0064 A file in the memory card cannot be read.  Continue     V 

0102 The interrupt number exceeds the range. Stop   V   
0202 The MC instruction exceeds the range.  Stop   V   
0302 The MCR instruction exceeds the range.  Stop   V   

0D03 The operands used in DHSCS are not used 
properly. Stop   V   

0E05 The operands HCXXX used in DCNT are not used 
properly. Stop   V   

140F Number of input and output points set in the DIO 
module exceeds the range. Stop   V   

1410 
l 

1413 
The right-side module cannot be detected.  Stop   V   

1414 The number of modules powered is inconsistent 
with the the number checked.  Stop   V   

1420 Initialization error on the left-side module (number 
of left-side module exceeds 8 units.) Stop   V   

1421 
l 

1424 

The communication of the left-side module times 
out or the model name is incorrect. Stop   V   

1425 Memory detection error on the left-side module. Stop   V   

1800 
- 

180F 
Errors occurred in the extension modules Continue    V  
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Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

1900 
- 

191C 

Heartbeat errors occurred in the slave under 
CANopen/ECAT mode Continue    V  

1950 
The initialization of the Delta ASD-A2 control has 
not yet been completed, the CANopen instructions 
cannot be executed. 

Continue     V 

19B0 Heartbeat timeout occurred in the slave mode Continue     V 

19B1 The data length of PDO (process data object) in the 
slave mode is not matched with the setting.  Continue     V 

19E1 

The data length of PDO (process data object) in the 
slave mode is not matched with the setting of the 
scan list.  
Refer to CANopen communication related 
descriptions in AS Series Operation Manual for 
more details on the error codes 19E1 to 19E8.  

Continue     V 

19E2 PDO in the slave mode is not received.  Continue     V 

19E3 The function of auto downloading SDO fails at the 
first startup.  Continue     V 

19E4 PDO configurations are set incorrectly.  Continue     V 

19E5 
The main settings are not consistent 
with the connected slave. 

Continue     V 

19E6 This slave does NOT exist in this network.  Continue     V 

19E7 Timeout on the slave error control Continue     V 

19E8 The node IDs of master and slave are duplicated.  Continue     V 

19F3 Error in the configuration  Continue     V 

19F4 CANopen communication is in the BUS-OFF state. Continue     V 

19FB The sending registers exceed the range.  Continue     V 

19FC The receiving registers exceed the range.  Continue     V 

2001 Not in the right mode for the ASDA-A2 while using 
the CANopen communication instruction. Continue     V 

2003 The device used in the program exceeds the device 
range. Continue     V 

200A Invalid instruction Stop   V   
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Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

200B The operand n or the other constant operands K/H 
exceed the range. Continue     V 

200C The operands overlap. Continue     V 

200D The binary to binary-coded decimal conversion is 
incorrect. Continue     V 

200E The string does not end with 00.  Continue     V 
2012 Incorrect division operation Continue     V 

2013 The value exceeds the range of values which can 
be represented by the floating-point numbers. Continue     V 

2014 The task designated by the TKON or YKOFF 
instruction is incorrect, or exceeds the range. Continue     V 

2017 The instruction BREAK is written outside of the 
FOR-NEXT loop. Continue     V 

2027 No such position planning table number or the 
format is incorrect.  Continue     V 

2028 
The high speed output instruction is being 
executed. Only one instruction can be executed at a 
time. 

Continue     V 

6004 The IP address filter is set incorrectly. Continue     V 
600D RJ45 port is not connected.  Continue     V 

6010 The number of the MODBUS TCP connections 
exceeds the range.  Continue   V   

6011 The number of the EtherNet/IP connections 
exceeds the range. Continue   V   

6012 There are devices using the same IP address.  Continue     V 
6100 The email connection is busy. Continue     V 

6103 The trigger attachment mode in the email is set 
incorrectly.  Continue     V 

6104 The attachment in the email does not exist. Continue     V 
6105 The attachment in the email is too big. Continue     V 
6106 There is an SMTP server response timeout. Continue     V 
6107 There is an SMTP server response timeout. Continue     V 
6108 SMTP verification failed  Continue     V 

6200 The remote communication IP address set in the 
TCP socket function is illegal. Continue     V 

6201 The local communication port set in the TCP socket 
function is illegal. Continue     V 

6202 The remote communication port set in the TCP 
socket function is illegal. Continue     V 

6203 The device from which the data is sent in the TCP 
socket function is illegal. Continue     V 

6206 The device that receives the data in the TCP socket 
function is illegal. Continue     V 

6208 The data that is received through the TCP socket 
exceeds the device range. Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking  
slowly 

OFF 

6209 The remote communication IP address set in the 
UDP socket function is illegal. Continue     V 

620A The local communication port set in the UDP socket 
function is illegal. Continue     V 

620C The device from which the data is sent in the UDP 
socket function is illegal. Continue     V 

620F The device that receives the data in the UDP socket 
function is illegal. Continue     V 

6210 The data that is received through the UDP socket 
exceeds the device range. Continue     V 

6212 There is no response from the remote device after 
the timeout period. Continue     V 

6213 The data received exceeds the limit. Continue     V 
6214 The remote device refuses the connection. Continue     V 
6215 The socket is not opened. Continue     V 
6217 The socket is opened. Continue     V 
6218 The data has been sent through the socket. Continue     V 
6219 The data has been received through the socket. Continue     V 
621A The socket is closed. Continue     V 

7011 The device communication function code in COM1 
is incorrect. Continue     V 

7012 The device communication address used in COM1 
is incorrect. Continue     V 

7013 The device used in COM1 exceeds the device 
range. Continue     V 

7014 The device length of the communication data in 
COM1 exceeds the limit. Continue     V 

7017 The device checksum for the communication serial 
port of COM1 is incorrect. Continue     V 

7021 The device communication function code in COM2 
is incorrect. Continue     V 

7022 The device communication address used in COM2 
is incorrect. Continue     V 

7023 The device used in COM2 exceeds the device 
range. Continue     V 

7024 The device length of the communication data in 
COM2 exceeds the limit. Continue     V 

7027 The device checksum for the communication serial 
port of COM2 is incorrect. Continue     V 

7031 The device communication function code in 
Ethernet is incorrect. Continue     V 

7032 The device communication address used in 
Ethernet is incorrect. Continue     V 

7033 The device used in Ethernet exceeds the device 
range. Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking 
slowly 

OFF 

7034 The device length of the communication data in 
Ethernet exceeds the limit. Continue V 

7037 The device checksum for the communication serial 
port of Ethernet is incorrect. Continue V 

7041 The device communication function code in USB is 
incorrect. Continue V 

7042 The device communication address used in USB is 
incorrect. Continue V 

7043 The device used in USB exceeds the device range. Continue V 

7044 The device length of the communication data in 
USB exceeds the limit. Continue V 

7047 The device checksum for the communication serial 
port of USB is incorrect. Continue V 

7203 Invalid communication function code Continue V 

8105 
The contents of the downloaded program are 
incorrect. 
The program syntax is incorrect. 

Continue V 

8106 
The contents of the downloaded program are 
incorrect. 
The length of the execution code exceeds the limit. 

Continue V 

8107 
The contents of the downloaded program are 
incorrect. 
The length of the source code exceeds the limit. 

Continue V 

8000 
- 

8FFF 
Errors occur between software and PLC. Continue V 

C000 
- 

CFFF 
The program syntax is incorrect. Stop V 
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A.1 Disable Driver Signature Enforcement 

Driver signature enforcement provides a way to improve the security of the operating system by validating the 

integrity of a driver or system file each time it is loaded into memory. Because the Delta PLC USB driver does 

not include the driver signature, this section shows you how to disable driver signature enforcement in 

Windows to successfully install the Delta PLC USB driver. Once you disable the driver signature enforcement 

setting, it returns to its original state after you restart Windows. 

 

A.1.1 Disable Driver Signature Enforcement in Windows 8 

Follow these steps to disable driver signature enforcement in Windows 8. 

1. Press the Windows button  【WIN】+【I】 on your keyboard to display the Settings window. Click 

Change PC settings. 

2. The PC settings window appears. Click General and then click Restart now under Advanced startup.  
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3. After the computer restarts, under Choose an option, click Troubleshoot.  Under Troubleshoot, click 

Advanced options. 

 
 

4. On the Advanced options page, click Startup Settings, and then on the Startup Settings page, click 

Restart to restart the computer.  

 
 

5. Press the 7 or F7 key on your keyboard to choose Disable driver signature enforcement. Press Enter 

and the system directs you back to the Windows 8 operating system. Install the Delta PLC USB driver now 

by connecting the DVP-ES3 Series CPU module to your computer’s USB port. Refer to Section A2 for the 

steps to install the USB driver. 
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A.1.2 Disable Driver Signature Enforcement in Windows 10 

Follow these steps to disable driver signature enforcement in Windows 10. 

1. Click the Windows Start button and then click Settings. 

2. In the Settings window, click Update & Security. 

Setting Update & Security 

 

 

 

3. In the Settings window, click Recovery, and then click Restart now. 

Recovery Restart now 
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4. After the computer restarts, under Choose an Option, click Troubleshoot, and then click Advanced 

options. 

 
 

5. On the Advanced options page, click Startup Settings. On the Startup Settings page click Restart to 

restart the computer.  

 
 

6. On your keyboard, press 7 or F7 to choose Disable driver signature enforcement, and the system 

directs you to the Windows 10 operating system page. Install the Delta PLC USB driver.    
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A.2 Installing the USB Driver  

This section describes the steps to install the USB driver for a DVP-ES3/EX3/SV3/SX3 Series CPU module on 

Windows 10. To install the USB driver for a DVP-ES3/EX3/SV3/SX3 Series CPU module on another operating 

system, refer to the instructions in the operating system for information about installing new hardware. The 

installation method for the USB driver of the PLC CPU is the same, taking ES3 as an example below. 

(1) Supply power to the DVP-ES3 Series CPU module. Connect the DVP-ES3 Series CPU module to a USB 

port on the computer with a USB cable.  

(2) Windows detects the module. From the Windows Control Panel, open the Device Manager. The name of 

the USB device appears in the Device Manager window. Double-click DVP-ES3.  
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(3) In the DVP-ES3 Properties dialog box, click Update Driver…..  

 

(4) Click Browse my computer for driver software.  
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(5) After you install ISPSoft version 3.18 or later, the driver for the DVP-ES3 Series CPU module is under the 

folder where you installed ISPSoft (\drivers\Delta_PLC_USB_Driver\). Enter the path to the driver, or click 

Browse to browse to the correct folder. For DIADesigner, the path to the drives is 

DIAStudio\DIADesigner\DIADesigner version\drivers\Delta_PLC_USB_Driver\.  

Specify the correct path. If you installed the driver for the DVP-ES3 series CPU module to another location, 

specify the corresponding path. Click Next to continue the installation. 
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(6) Click OK. The system installs the driver. If the Windows Security window appears during the installation, 

click Install this driver software anyway. 

 

(7) When the installation completes, click Close. 
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(8) Open the Device Manager window again. If the name of the Delta USB device appears under Ports 

(COM & LPT), the installation of the driver is successful. The operating system assigns a communication 

port number to the USB device. 

 

 

Additional remarks 

 If you connect the PLC to a different USB port on the computer, the system may ask you to install the driver 

again. Install the driver again. After you install the driver, the communication port number that the operating 

system assigns to the USB device may have changed. 
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A.3 Notes on Utilizing USB Communication 

 Suggested to use USB communication in the following occasions: PLC program upload / download, 

PLC parameters monitoring, and firmware upgrade. 

 Suggested NOT to use USB communication for applications that require long time communication and 

without any connection drop.  

 When experiencing connection lost, you can unplug the USB cable and then plug it back in and try the 

communication again.  

 For the first time USB communication user, you need to install the USB driver for the ES3 Series PLC 

CPU.  

 If the communication is still not working after unplugging and plugging, you need to open the Devices 

(Windows settings -> Devices) to see if the USB driver is still valid. The USB driver may be lost due to 

Windows updates. If your USB driver is invalid, install the USB driver again.  
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B.1 Standard Modbus Device Addresses 

Device Type Format Device range 
Modbus address 

(Decimal number) 

DVP-ES3/EX3/SV3/SX3 

Series 

(Hexadecimal number) 

X Bit OOO X0~X377 124577~124832 6000~60FF 

Y Bit OOO Y0~Y377 040961~041216 A000~A0FF 

M Bit DDDD M0~M8191 000001~008192 0000~1FFF 

SM Bit DDDD SM0~SM4095 016385~020480 4000~4FFF 

SR Word DDDD SR0~SR2047 449153~451200 C000~C7FF 

D Word DDDDD D0~D29999 400001~430000 0000~752F 

S Bit DDDD S0~S2047 020481~022528 5000~57FF 

T 
Bit DDD T0~T511 057345~057856 E000~E1FF 

Word DDD T0~T511 457345~457856 E000~E1FF 

C 
Bit DDD C0~C511 061441~061952 F000~F1FF 

Word DDD C0~C511 461441~461952 F000~F1FF 

HC 
Bit DDD HC0~HC255 064513~064768 FC00~FCFF 

DWord DDD HC0~HC255 464513~464768 FC00~FCFF 

E Word D E0~E9 465025~465034 FE00~FE09 
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B.2 Function Codes and Number of Devices Supported 
for Modbus Protocols 

Function 

code 
Name Description Number of devices supported 

01 Read Coil Status X, Y, M, SM, S, T, C, HC 1~1600 bits 

02 Read Discrete Input Status X, Y, M, SM, S, T, C, HC 1~1600 bits 

03 Read Holding Registers X, Y, SR, D, T, C, HC, E 1~100 words, (1~50 for HC) 

04 Read Input Registers X 1~100 words 

05 Force Single Coil Y, M, SM, S, T, C, HC 1 bit 

06 Preset Single Register Y, SR, D, T, C, HC, E 1 word 

0F Force Multiple Coils Y, M, SM, S, T, C, HC 1~1600 bits 

10 Preset Multiple Register Y, SR, D, T, C, HC, E 1~100 words, (1~50 for HC) 

17 Read/Write Multiple Register Y, SR, D, T, C, HC, E 1~100 words, (1~50 for HC) 
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C.1 EMC Standards for an ES3/EX3/SV3/SX3 Series System 

C.1.1 DVP-ES3/EX3/SV3/SX3 Series System EMC Standards 

The EMC standards that are applicable to a DVP-ES3/EX3/SV3/SX3 series system are listed in the following 

tables. 

 EMI 

Port Frequency range Level (Normative) Reference standard 

Enclosure port 

(radiated) 

(measured at a 

distance of 10 meters) 

30-230 MHz 40 dB (μV/m) quasi-peak 

IEC 61000-6-4 
230-1000 MHz 47 dB (μV/m) quasi-peak 

AC power port 

(conducted) 

0.15-0.5 MHz 
79 dB (μV) quasi-peak 

IEC 61000-6-4 
66 dB (μV) average 

0.5-30 MHz 
73 dB (μV) quasi-peak 

60 dB (μV) average 

 

 EMS 

Environmental 

phenomenon 

Reference 

standard 
Test Test level 

Electrostatic 

discharge 
IEC 61000-4-2 

Contact ± 4 kV 

Air ± 8 kV 

Radio frequency 

electromagnetic field  

Amplitude modulated 

IEC 61000-4-3 
80% AM, 

1 kHz sinusoidal 

2.0-2.7 GHz 1 V/m 

1.4-2.0 GHz 3 V/m 

2.0-2.7 GHz 3 V/m 

2.7-6.0 GHz 3 V/m 

Power frequency 

magnetic field  
IEC 61000-4-8 

60 Hz 30 A/m 

50 Hz 30 A/m 
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 Conducted immunity test 

Environmental phenomenon 
Fast transient 

burst 
High energy surge 

Radio frequency 

interference 

Reference standard IEC 61000-4-4 IEC 61000-4-5 IEC 61000-4-6 

Interface/Port 
Specific 

interface/port 
Test level Test level Test level 

Data 

communication 

Shielded cable 1 kV 1 kV line-to-earth 10 V 

Unshielded cable 1 kV 1 kV line-to-earth 10 V 

Digital and analog 

I/O 

AC I/O 

(unshielded) 
2 kV 

2 kV line-to-earth 

1 kV line-to-line 10 V 

Analog or DC 

I/O(unshielded) 
1 kV 1 kV line-to-earth 10 V 

All shielded lines 

(to the earth) 
1 kV 1 kV line-to-earth 10 V 

Equipment power 
AC power 2 kV 

2 kV line-to-earth 
1 kV line-to-line 10 V 

DC power 2 kV 
0.5 kV line-to-earth 

0.5 kV line-to-line 10 V 

I/O power and 

auxiliary power 

output 

AC I/O and AC 

auxiliary power 
2 kV 

2 kV line-to-earth 

1 kV line-to-line 10 V 

DC I/O and DC 

auxiliary power 
2 kV 

0.5 kV line-to-earth 

0.5 kV line-to-line 10 V 
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C1.2 Installation Instructions to meet EMC Standards 

You must install an ES3/EX3/SV3/SX3 Series PLC in a control box. The control box protects the PLC and 

isolates electromagnetic interference generated by the PLC. 

(1) Control box 

 Use a conductive control box.  

 Make sure to ground the control box properly, and avoid insulation caused by the paint on the 

grounding bolts inside the control box. 

 Minimize the gaps in the control box to prevent radio waves from leaking. Use an EMI gasket on the 

gaps in the control box to suppress radio wave leakage. 

(2) Connecting a power cable and a ground 

Connect the PLC system power cable and the ground as described below. 

 Users can ground the module at any point on the aluminum rail, as well as at the module's ground 

terminal. 

 Twist the ground and the power cable together; the noise flowing through the power cable is then 

passed to the ground. The ground and the power cable do not need to be twisted if you install a filter 

on the power cable. 

 

C1.3 Cables 

 It is recommended to use shielded cables, when connecting digital I/O modules and analog I/O 

modules including temperature modules.   

 Ground the shielding cable at a single point. 
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D.1 Cautions 

Observe the following precautions before performing maintenance and inspection. Incorrect or careless operation 

will lead to injury or equipment damage. 

  To prevent a breakdown of a PLC Series system or a fire, ensure that the ambient environment does not 

contain corrosive substances such as chloride gas, sulfide gas or flammable substances such as oil mist, 

cutting powder, or dirt. 

  To prevent the connectors from oxidizing and to prevent electric shock, do not touch the connectors. 

  To prevent electric shock, turn off the power before pulling the connectors or loosening the screws. 

  To prevent cable damage, and to prevent the connectors from being loosened, do not put weight on the 

cables or pull on them. 

  Ensure that the input voltage is within the rated range. 

  To prevent product breakdown, fire, or injury, do not disassemble or alter the modules. 

  To prevent a controlled element from malfunctioning, ensure that the program and parameters are written 

into a new CPU module before restarting the PLC Series system.  

  To prevent incorrect output or equipment damage, refer to the related manuals for more information 

about operating the modules. 

  To prevent damage to the modules, touch grounded metal or wear an antistatic wrist strap to release 

static electricity from your body before working on a module. 

  To prevent noise from causing system breakdown, keep a proper distance from the system when using a 

cell phone or communication device. 

  Do not install a PLC Series system in direct sun or in a humid environment. 

  To prevent the temperature of an element from being too high, maintain a proper distance between the 

PLC Series system and heat sources such as coils, heating devices, and resistors. 

  To protect a PLC Series system, install an emergency stop switch and an overcurrent protection device.   

  Inserting and pulling a module several times can loosen the contact between the module and the 

backplane. 

  To prevent an unexpected shock from resulting in damage to the PLC Series system and a controlled 

element, ensure that the modules are correctly and firmly installed. 
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D.2 Daily Maintenance 

To keep a PLC Series system operating normally, ensure that the ambient environment and the PLC Series system 

conform to the cautions listed in section 8.1. You can then perform the daily inspection described below. If you find any 

problems, follow the solution and perform any necessary maintenance. 

 
D.2.1 Daily Inspection 

No. Item Inspection Criterion Remedy 

1 Appearance Check visually. Dirt must not be present. Remove the dirt. 

2 Installing of a backplane 

Check whether the set 
screws are loose. 

The backplane must be 
installed firmly. 

Tighten the screws. 

Check whether the 
backplane is installed on 
the DIN rail properly. 

Install the backplane on 
the DIN rail properly. 

3 Installing of a module 

Check whether the 
module is loose that the 
projection is inserted into 
the hole on the 
backplane, and that the 
screw is tightened. 

The projection under the 
module must be inserted 
into the hole in the 
backplane, and the 
screw must be tightened. 

Install the module firmly. 

4 Connection 

Check whether the 
removable terminal block 
is loose. 

The removable terminal 
block must not be loose. 

Install the terminal block 
firmly. 

Check whether the 
connector is loose. 

The connector must not 
be loose. 

Tighten the screws on 
the connector. 

 Power module LED 
indicator 

Check the status of 
power module 

Please refer to its 
module manual for more 
information on LED 
indicators. 

Please refer to its 
module manual for more 
information on 
troubleshooting. 

 CPU module LED 
indicator 

Check the status of CPU 
module 

 Extension module LED 
indicator 

Check the status of 
extension module 
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D.3 Periodic Maintenance 

In addition to daily inspection, you should perform periodic maintenance depending on the actual operating 

environment. After making sure that the ambient environment and the PLC Series system conform to the cautions 

listed in Section D.1, perform the periodic inspection described below. If you find any problems, follow the solution and 

perform any necessary maintenance. 

 

D.3.1 Periodic Inspection 

No. Item Inspection Criterion Remedy 

1 

Am
bi

en
t e

nv
iro

nm
en

t Ambient 

temperature/hu

midity 

The ambient temperature 

and the ambient humidity 

are measured by a 

thermometer and a 

hygrometer. 

The ambient temperature 

and the ambient humidity 

must conform to the 

specifications for the 

modules or the 

backplane. If the 

specifications are 

different, the strictest 

specifications have 

priority. 

To ensure that the system 

operates in a stable 

environment, determine 

why the environment 

varies, and resolve the 

issue. 

Atmosphere Measure corrosive gas. 
Corrosive gas must not 

be present. 

2 Supply voltage 
Measure the AC power 

supply. 

The power supply should 

meet the specifications 

for the power supply 

module. 

Check the power supply. 

3 

In
st

al
la

tio
n Looseness 

Check whether the 

module is loose. 

The module must be 

installed firmly. 

Please refer to its module 

manual for more 

information on installing 

the module. 

Adhesion of 

dirt 
Check the appearance. Dirt must not be present. Remove the dirt. 

4 

C
on

ne
ct

io
n Looseness of 

terminal 

screws  

Tighten the screws with a 

screwdriver. 

The screws must not be 

loose. 
Tighten the screws. 
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No. Item Inspection Criterion Remedy 

Looseness of 

connectors 
Pull the connectors. 

The connectors must not 

be loose. 

Tighten the screws on the 

connectors. 

5 
PLC system 

diagnosis 
Check the error logs. No new error occurs. 

Please refer to trouble 

shooting section for more 

information. 

6 Maximum scan time 

Check the states of 

SR413 and SR414 

through the device 

monitoring table in 

ISPSoft. 

The maximum scan cycle 

must be within the range 

specified in the system 

specifications. 

Determine why the scan 

time exceeds 

specifications. 
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